
Working with second Y-axis lines
The second Y axis is the axis line on XY scatter charts or dual-axis bar, line or area charts. 
The second Y axis measures a different quantity than the first Y axis. Because it's numeric; it
has a scale attached to it rather than headers.
Location of the second Y-axis line (Chart menu: Second Y axis):
To control where the axis and its scale display, choose Chart, Y axis. On the flyout menu, 
choose Display on Left, Display on Right, both, or neither. (You can't show both the first and 
second Y axes on the same side of the Charting Area.)
Grid lines and Scale:
Choose Chart, Second Y Axis to change the second Y-Axis scale and grid lines. Since major 
grid lines align with numbers on the numeric scale, specifying the number of major grid-line 
divisions will affect the number of scale divisions.
To show or hide the second Y-axis line:
Method 1: Show or hide-axis line and scale

· Choose Chart, Display Status to open the Display Status dialog box.
· To show the-axis or scale, click Second Y-Axis & Scale. An x indicates that the axis line

and its scale will show (at the default location on the left side of the chart).
· To hide the axis or scale, click off the Second Y-Axis & Scale check box.

Method 2: Make axis line transparent (axis line only):
· Select the axis line.
· Make it transparent by clicking the X, or transparent tile on the Outline tool's flyout.
· To restore the line, click in the area where it is. (If you've just made it transparent, 

choose Edit, Undo.) When its handles appear, choose a color from the on-screen color
palette or the color dialog box, accessed by clicking the first tile on the top row of the
Outline tool's flyout.



Adjusting the second Y-axis scale
The second Y axis is the scale attached to the 2nd Y-axis line.
Choose Chart, 2nd Y axis to change the following:

· Location of 2nd Y-axis scale. The scale is attached to the axis; choose Display on 
Right (the common location) and/or Display on Left, or neither.

To show/hide the 2nd Y-axis scale and its axis line:
1. Choose Chart, Display Status. 
2. Click the 2nd Y Axis & Scale check box. 

To hide the scale and axis:
· In the Display Status dialog box, click 2nd Y Axis & Scale again.



Working with the second Y-axis title
The second Y axis is a label that describes the 2nd Y axis. The axis title can be moved 
anywhere on the chart, but it should be located near the axis it describes.
To create and edit the 2nd Y-axis title:
This title is entered in a Data Manager cell tagged as 2nd Y-axis title. To edit the title, return 
to the Data Manager, select the cell, press F2 and change it in the contents box. To see in 
Data Manager which cell has been tagged as the title, scroll through the cells while watching
the chart elements list at the top of the Data Manager window. You'll see the cell's tag in the 
box.
To show/hide the 2nd Y-axis title:
Choose Chart, Display Status. In the Display Status dialog box, click the 2nd Y-axis Title 
check box.



Using Data Axis Major Grid Lines
Data Axis Major Grid Lines split up the data axis into equal divisions. "Major grid lines" can 
cross the whole chart, be just tick marks on the edge of the Charting Area, or both.
To set the number of major divisions: 

· Choose Chart, Data axis, and choose one of these options:
Automatic: Let CorelCHART automatically divide the chart with grid lines.
Manual: Specify the number of divisions, entering a number in the No. of Divisions text 
box.

To show or hide major grid lines:
Choose Chart, Data axis. On the flyout menu, choose Grid Lines. In the Grid Lines dialog box,
click the Major Grids check box. Choose grid lines or tick marks, or hide the lines by clicking 
No Grids.



Using Data Axis Minor Grid Lines
Data Axis Minor Grid Lines are placed between data axis major grid lines to offer more 
precise measurement. "Minor grids" can cross the whole chart, be tick marks on the axis 
line, or both.
To set the number of minor divisions (grid lines):

· Select "Grid Lines" (Chart menu: Data Axis) and choose one of the following:
Auto: Let Chart automatically divide the chart with grid lines.
Manual: Specify the number of divisions, entering a number in the Number    of 
Divisions" text box.

To show or hide major grid lines:
Choose Chart, Data axis. On the flyout menu, choose Grid Lines. In the Grid Lines dialog box,
click Major Grids, choose grid lines or tick marks, or hide the lines by clicking No Grids.



Making 3D Scatter labels
A 3D Scatter label describes a data point on an XYZ (3D) scatter chart.
To create or edit a scatter label:
These labels must be created, tagged and edited in Data Manager. Depending on how the 
data is arranged, the fourth row or column holds the label text. For instance, if the data is 
arranged by columns (column 1 holds X values, Column 2 holds Y values, column 3 holds Z 
values), then column 4 holds the labels. 
If no labels have been tagged, make sure the labels have been entered in the fourth column.
(If they're elsewhere in the Data Manager spreadsheet, you must cut and paste them as the 
fourth column of the data range by clicking and dragging to select the cells and choosing 
Edit, Cut and Edit, Paste. If they're not in the matrix at all, you must enter them as the fourth
column of the data range by clicking the first cell and typing, then using the cursor key to 
move to the next cell.) Then select the entire data range, click the scroll arrow on the chart 
elements drop-down list at the top of the Data Manager window, and click Data Range.
Once the labels have been tagged in the Data Manager, go to Chart View. Choose Chart, 
Display Status, and click the Data Labels check box.



Showing or hiding the left Z-axis scale
The Z axis is the vertical axis in 3D charts. The numbers (or data-based text such as time 
periods) set at regular intervals along the end of the left wall comprise the left Z-axis scale.
The Z-axis scale can be modified by choosing Chart, Vertical (Z) axis. 
To show or hide the left Z-axis scale:
Choose Chart, Display Status and click Left Z-axis Scale. An "x" in the check box indicates 
that the scale will appear.



Working with the left Z-axis title
The left Z-axis title is one of two titles that describes the vertical Z axis. This one is placed 
adjacent to the left wall.
To create or edit a left title:
In the Data Manager, select a cell and set it as Axis Title #3, and type the title in the cell. To 
edit the title, return to the Data Manager, select the cell, press F2, and make changes in the 
contents box.
To show or hide a left title:
Choose Chart, Display Status and click Left Scale Title. An "x" in the check box indicates that
the left title will appear.



Working with series headers
A series header is a descriptive label for a series of data on a 3D chart. Usually there is one 
header for each data group. When the appearance of one series header is changed, all are 
changed.
To create or edit series headers:
In the Data Manager, select a cell and set it as Row Header or Column Header, depending 
which axes your groups and series are arranged on. Type the title in the cell. To edit the title,
return to the Data Manager, select the cell, press F2, and make changes in the contents box.



Creating and editing series titles
A series title is the single title that describes what the series of data represent.
To create or edit a series title:
In the Data Manager, select a cell, set it as the Axis Title #1 or Axis Title #2, depending on 
which axes your groups and series are arranged on. Type the title in the cell. To edit the title,
return to the Data Manager, select the cell, press F2, and make changes in the contents box.



Showing or hiding the right Z-axis scale
The Z axis is the vertical axis in 3D charts. The numbers (or data-based text such as time 
periods) set at regular intervals along the end of the right wall comprise the right Z-axis 
scale.
The Z-axis scale can be modified by choosing Chart, Vertical (Z) axis. 
To show or hide the right Z-axis scale:
Choose Chart, Display Status and click Right Z-axis Scale. An "x" in the check box indicates 
that the scale will appear.



Creating or editing a Z-axis title
The Z-axis title is one of two titles that describes the vertical Z axis; this one is placed 
adjacent to the right wall.
To create or edit a right title:
In the Data Manager, select a cell, set it as the Axis Title #4, and type the title in the cell. To 
edit the title, return to the Data Manager, select the cell, press F2, and make changes in the 
edit box.
To show/hide a right title:
Choose Chart, Display Status, and click the Axis Title #4. An "x" in the check box indicates 
that the right title will appear.



Creating column header labels
Column header labels are the text in column header cells or, in Chart View, the column 
header area, in a table chart.
To create column header labels:

1. Enter column headers in a row in the Data Manager.
2. Select all the cells you've just entered into.
3. Select Column Header from the chart element list box.

Column headers can be formatted using the tools on the Text Ribbon and colored using the 
on-screen color palette or the effects available through the Fill tool.



Creating row header labels
Row header labels are the text within row header cells in a table chart.
To create row header labels:

1. Enter row headers in a column in the Data Manager.
2. Select all the cells you've just typed into.
3. Select Row Header from the chart elements list box.

Row headers can be formatted using the tools on the Text Ribbon and colored using the on-
screen color palette or the effects available through the Fill tool.



Creating a row header area
The row header area appears on the left-most column in a table chart; it contains all the row 
header cells.
To create the row header area:

1. Enter row headers in a column in the Data Manager.
2. Select the first (top) row header.
3. From the chart elements list box, select Row Header.

The row header area accepts colors. The area has an outline; you can change its color and 
width using the Outline tool.



Showing or hiding titles
The title of a chart is a label that describes the chart. It's normally displayed at the top of the
chart and is usually the largest text element. Title text can be formatted using the facilities 
on the on-screen text ribbon.
To show or hide the title:
Choose Chart, Display Status. In the Display Status dialog box, click the Title check box. To 
hide the title, click the check box again.



Creating a category header
Category headers are the identification labels assigned to groups of data. There is usually a 
header for each data group. When the appearance of one group header is changed, all are 
changed. (You can use the Text Ribbon, or the color palette, to change any headers.) The 
labels usually describe group data, but will describe series data.
Headers are attached to the category axis and cannot be moved independently of the axis. 
To set the location of the axis and headers, choose Chart, Category axis. On the flyout menu,
you can select Display on Bottom/Left and/or Display on Top/Right (or neither).
To create category headers:

1. Enter category axis headers in a column in the Data Manager.
2. Select all the cells you've just typed into.
3. Select Column Header from the chart elements list box.
4. Click Set.

To edit category headers, go to the Data Manager. Click the cell you wish to edit, press F2, 
and edit the cell in the contents box atop the Data Manager spreadsheet.



Working with X-axis titles
An X-axis title is a label that describes the X axis. The axis title can be moved anywhere on 
the chart, but it should be located near the axis it describes. This title is entered in the Data 
Manager.
To create or edit an X-axis title:
In the Data Manager, select a cell, set it as Axis Title #1, and type the title in the cell. To edit
the title, return to the Data Manager, select the cell, press F2, and make changes in the 
contents box.
To show or hide an X-axis title:
Choose Chart, Display Status and click Axis Title #1. To hide the title, click the check box 
again.



Working with Y-axis titles
A Y-axis title is a label that describes the Y axis. The axis title can be moved anywhere on 
the chart, but it should be located near the axis it describes. This title is entered in the Data 
Manager as "Y-axis Title". 
To create or edit a Y-axis title:
In the Data Manager, select a cell, set it as Axis Title #2, and type the title in the cell. To edit
the title, return to the Data Manager, select the cell, press F2, and make changes in the 
contents box.
To show or hide a Y-axis title:
Choose Chart, Display Status and click Axis Title #2. To hide the title, click the check box 
again. 





Chart menu for Vertical/Horizontal Bar Charts
Category Axis Displays a flyout menu with toggle commands for controlling the 

location of the category axis text, appearance of text and turning 
display of grid lines. The category text can appear at the top or bottom
of the chart or at both locations at the same time. Deselecting both 
options hides the category text from view. Text can be fitted 
automatically or staggered.

Data Axis Displays a flyout menu with toggle commands for setting the location 
of the numeric axis (right or left side, both or none), type (log or linear)
and direction (ascending or descending) of the scale, and appearance 
of text (autofitted or staggered). You can also specify the Scale Range, 
Number Format and Grid Lines in the appropriate dialog boxes.

2nd Data-Axis Contains the same options as the Data Axis. Only available for dual-
axis charts.

Axis Assignment... Opens a dialog box that controls the assignment of series to primary 
and secondary axes in dual-axis charts.

Data Reversal Toggle commands to Reverse Series data within groups or Reverse 
Groups along the non-numeric axis.

Data Analysis... Used to select scientific and financial statistical procedures, including 
the mean, standard deviation, moving averages and linear regressions.

Base of Bars Displays options to show the data from the Zero Line or from the Scale 
Minimum, the latter being the lowest value in the data range.

Bar Thickness Displays a selection of bar thicknesses. Hold down the mouse button 
and move down the flyout menu; a preview of each option is displayed.
Release the mouse button to make a selection.

Bar-Bar Spacing Displays a selection of bar spacing intervals. Hold down the mouse 
button and move down the flyout menu; a preview of each option is 
displayed. Release the mouse button to make a selection.

Marker Shape Displays a selection of bar and legend marker shapes. Hold down the 
mouse button and move down the flyout menu; a preview of each 
option is displayed. Release the mouse button to make a selection.

Show as Pictograph Select a bar, then click this option to activate it. This command 
divides each bar into slices based on the major grid lines. A pictograph 
(.CDR file) can then be selected through the Full-Color Fill icon in the 
Fill Tool flyout menu or the Pictograph roll-up. The pictograph will be 
copied into each rectangle formed by the bar and the major grid lines.

Display as Line Select a bar, then click this option. The data for that bar will appear as 
a line.

Emphasize Bar Choose a bar that you wish to emphasize and click this option. The 
outline and fill of the bar can then be modified using the Fill and 
Outline tools and the on-screen color palette.

Legend... Opens a dialog box containing controls for the chart's legend.
Display Status... Opens a dialog box containing check boxes for showing and hiding 

chart elements such as title, subtitle, data values and legend.



Axis Assignment dialog box
Use this dialog box to move series of data from one axis to another in any of the Dual Y Axis 
or Bipolar chart types. Select the data series you want to move and then click the Move 
button. 
You must have a least one data series per axis. If you want all series on a single axis, use a 
non-Dual Y or Bipolar chart type.



Scale Range dialog box
Use this dialog box to specify the scale range and whether minimum, maximum and out of 
range values are plotted on your chart.

Dialog Box Options
Range Display

Select Exclude Minimum and/or Exclude Maximum if you don't want the lowest and/or 
highest values to appear on the scale of the chart.
The other two options in this field become available when Manual Scale is selected. 
Choose the first option if you want the risers for out of range values plotted at the scale 
limits or the second if you don't want them plotted at all.

Range Method
Choose Automatic to set the upper and lower scale limits according to the minimum and 
maximum data values. Or, choose Manual and type or select the upper and lower scale 
limits in the From and To boxes.



Numeric dialog box 
Use the Numeric dialog box, also called the Number Format command in Chart View, to 
choose or create new numeric styles in both Chart View and Data Manager. The Numeric 
dialog box is available from the Chart menu's Data Axis flyout menu, from the Data 
Manager's Format menu, from pop-up menus and from the Ribbon Bars.
CorelCHART provides several built-in formats based on serial values used with dates. If none 
of the built-in formats suit your needs, you can create new ones by editing a built-in format 
code or typing your own codes. Numeric formats applied in Chart View affect all similar 
numeric data, while numeric formats applied in Data Manager affect only the selected 
cell(s).
User-defined formats can be conditional, i.e., the applied format depends on the result 
returned by a formula or the value typed. For example, you can create a numeric format 
which displays positive values in black and negative values in red.
CorelCHART uses symbols to represent how the number will look when formatted. The 
symbols m/d/yy for example, represent the appearance of one of the built-in date formats. 
Typing 10-2-93 in a Data Manager cell with this format produces this result: 10/2/93.

Dialog Box Options
Category and Formats

Use the scroll bar to browse the list of formats; there's a general-purpose format, and 
number, currency, date, time, percentage and scientific formats. The Formats box 
displays available formats for the selected category. 
See also Built-In Numeric Formats

Code
Displays the code of the selected format. Use the code box to edit the code, modify the 
format or create a new one. If a user-defined numeric format is deleted, all cells that use 
that format adopt the general format, which is the CorelCHART default.

Sample
Displays the selected format.

User Formats
The User Format text box displays the user-defined formats. The Add button is used to 
add a newly created style, built in the Code box, to the current category. Click the Change
button to apply the changes made to a custom format using the Code box. The Delete 
button removes a selected custom format from the list. 
See also Creating and Deleting custom formats and User defined numeric formats



Built-in Numeric Formats
The following is a description of CorelCHART's built-in numeric format categories.
Category and format(s) Description/Sample/Notes
All Lists formats for all categories
General Default format.

Displays up to nine digits to the right of the decimal 
point. Displays up to 11 digits to the left of the 
decimal point; if more than 11, switches 
automatically to scientific notation (see below).

Number
0 displays the number as is
0.00 displays two digits after decimal point
#,##0 thousands separator
#,##0.00 thousands separator/two decimals
#,##0;(#,##0) negative values displayed in brackets
([>100][/b];[/i])#,##0;[/i](#,##0) positive values bold if greater than 100, italicized if 

not; negative values italicized and in brackets
#,##0.00;(#,##0.00) thousands separator, two decimal digits and negative

values in brackets
[/b]#,##0.{[/c:red]00};[/i](#,##0.{[/c:blue]00}) Positive values: digits to the left of decimal

point are bold, digits to the right are red. Negative 
values in brackets, digits to the left of decimal point 
italicized, digits to the right are blue.

Currency
$#,##0.0;($#,##0.0)
${[/b/i]#,##0.0};(${[/u]#,##0.0})
$#,##.0.00;($#,##0.00)
${[/b]#,##0}.[/i]00;($#,##0{[/c:red].}00)
Note: CorelCHART automatically adds the new currency formats if the currency symbol, 
selected in Windows differs from the dollar sign. This new format is handled as a user-
defined format and you can edit and/or delete them.
Date Displays dates in one of six formats.
m/d/yy Month, day, year separated by /
[/b]m/[/r]d/[/i]yy Month in bold, day in default font and year italicized
dd-mmmm Day with leading zero (04) and month name 

displayed (March)
[/bold]dd{[/c:red]-}mmmm Day in bold, month name displayed in red
dddd mmmm-d-yyyy Weekday and month name displayed, day without 

leading zero and four-digit year notation (Thursday 
March- 24-1994).

{[/b]dddd} mmmm-d-yyyy Day name in bold, month name, day without a 
leading zero and four-digit notation for the year 
(Friday April-1-1994).

Note:    Date and Time formats may differ depending the Windows Calendar settings on your
computer.
Time



m/d/yy h:m:s AM/PM Date and time format. Displays both date and time, 
uses 12-hour clock.

h:m:s AM/PM Hours, minutes and seconds. Displays the time using 
12-hour clock.

h:mm AM/PM Hours and minutes. Uses a 12-hour clock.
h:mm [/c:yellow]AM/PM Hours and minutes, AM/PM displayed in yellow
hh:mm:ss Hours, minutes and seconds using a 24-hour clock 

(00-23)
{[/b]m-d-yy} {[/i]h:m:s} [/i/b]AM/PM Date displayed in bold, time italicized and AM/PM if 

bold/italic.
Note: The Date and Time formats may differ depending the Windows Calendar settings on 
your computer.
Percentage
0% Displays numbers as a percentage (multiplied by 

100) with a percent sign (%).
0[/italic]% % symbol italicized
#,###.00% Thousands separator and two digits after decimal 

point
{[/i]#},###.00[/b]% Thousands digit italicized, % symbol bold, two digits 

after decimal point.
Scientific Displays values in exponential (scientific) notation.
0.00e+00
([>0][/b];[/i/u])0.00e+[/sup:2]00 If value is above zero, it displays in bold, otherwise it 

is underlined and italic.
See also User-Defined Numeric Formats



User-Defined Numeric Formats: Overview
You can create your own numeric formats by editing the built-in format codes or by typing 
your own. The built-in formats can be edited and saved as new ones but cannot be deleted. 
There are two types of numeric formats you can create--General Conditional Format and 
Custom Conditional Formats.
Built-in or user-defined numeric formats are made up of symbols that tell Data Manager how 
to display numbers on the spreadsheet. The symbols, also called codes, used in numeric 
formats, make up the Numeric Format Interpreter Macro Language.
The Macro Language includes codes that define the structure to be applied to numbers, the 
font and color to be used and the conditions that have to be met for a format to be applied.
See one or more of the following topics for information on the syntax used in numeric 
formats and the different codes used to set the format attributes:
General Conditional Numeric Format
Custom Conditional Numeric Format
Font attribute codes
Codes for user-defined numeric formats



General Conditional numeric format
This topic describes the General Conditional Format syntax.
The General Conditional format--used to apply one format to all numbers or apply different 
formats to positive, negative or zero values--is made up of three sections separated by semi-
colons as shown below:
Section_1;Section_2;Section3
Section_1: contains the codes that define the format for positive numbers
Section_2: contains the codes that define the format for negative numbers
Section_3: contains the codes that define the format for zero values
If only one section is used (i.e., coded) in a custom format, all numbers entered use the 
format coded in that one section. If two sections are coded, positive and zero values adopt 
the section 1 format, negative values adopt the section 2 format. 
See also:
Font attribute codes
Codes for user-defined numeric formats
Custom conditional formats
Examples of general numeric format



Custom Conditional numeric formats
A Custom Conditional numeric format includes user-defined conditions, which are usually 
more complex than those available in the General Conditional formats. If a number meets 
the condition, the condition-dependent format is applied to that number; if not, another 
format is applied. 
You can create up to three conditional statements, one for each of the sections described in 
General Conditional numeric format. For example, you could create a format which states 
that all numbers greater than 100 should be bold, displayed in blue with two digits after the 
decimal point and all other values are red, with a point size of 6. 
The syntax is:
([conditional value][font_specification_1];[font_specification_2])placeholder(s)
In which:
[condition value] is the condition to be met. Value can be any number and the condition 
any of the symbols below:

= Equal to
> Greater than
< Less than
>= Equal to or greater than
<= Equal to or less than
<> Not equal to

[font_specification_1] represents the font attributes to be applied to the number if it 
meets the condition. See also Font attribute codes for details on coding font attributes. 
[font_specification_2] is the alternative format to be used for numbers that do not meet 
the condition.
placeholders include the digit placeholders and other symbols used in the format to 
represent a currency, a percentage or any other available symbol. See also Codes for user-
defined numeric formats for a list of placeholder codes.
See also Examples of custom conditional numeric format



Font attribute codes--numeric format
The following tables describe the codes used in setting font and color attributes in numeric 
formats. The italicized text is used to represent areas where you must type information.
Attribute Code
Font Face /f:font name here
Font Size /s:size here
Output color /c:color name or color number (See also Colors--numeric format)
Bold /b
Italic /i
Underline /u
Strikeout /s
Subscript /sub:offset in points (0-255)*
Superscript /sup:offset in points (0-255)*
Cancel Italic, Bold 
and Underline set
earlier in format /r    (the font and size are not changed; only the type styles are 

disregarded for the digits on the right of the /r code)
*Units of measurement cannot be changed, must be points.
Coding font attributes...
Notice the use of the forward slash / symbol; it precedes every font code.
You can set several font attributes within one set of square brackets [ ], e.g., in [/b/i/u]#.00,
all digits will be bold, italic and underlined. 
Effective range of font attributes...
Curly brackets {} are used to define the effective range in which the font attribute is 
applied. In {[/i]#.}[/b]00,  only the digits on the left of the decimal point, and the decimal 
point, are italicized; digits to the right of the decimal point are bold. 
If no effective range is defined, i.e., no curly brackets used, the font specifications are valid 
for all digits to the right of them until either the end of the section or until the /d code is 
used to reset the default font attributes.
See also: 
Codes for user-defined numeric formats 
Examples of general numeric format
Examples of custom conditional numeric format    



Color attribute codes--numeric formats
The following table lists available colors in the Numeric format interpreter and their color 
numbers. You can reference the color name or number when coding a new numeric format.
Color name Number
BLACK 1
WHITE 2
RED 3
GREEN 4
BLUE 5
YELLOW 6
CYAN 7
MAGENTA 8
Note: If you enable the Formula command in the Data Manager View menu, changing the 
color of numbers on your spreadsheet using in-cell editing automatically updates the code of
the number format. This new format is displayed in the User Formats box in the Numeric 
dialog box and is saved with your spreadsheet. 
You can assign a style name to the numeric format by typing a name in the styles drop-down
list box or by using the Styles command. Whether you assign a style name to the new 
numeric format or not, that format is available only for the spreadsheet in which it was 
created.
The Styles command also enables you to make the numeric format available to other 
spreadsheets by assigning a style name and saving that style in the current or a new style 
sheet (.CCT file). 



Codes used in user-defined numeric formats
Use the following codes to create custom numeric formats. See also Font attribute codes
Codes Descriptions
0 Digit placeholder. CorelCHART will replace each occurrence of the 

symbol with a digit from the value being entered. If the number has 
fewer digits than the number of zeros in the format, CorelCHART 
displays the extra zeros. For example, with the user-defined format 
000.000, the number 1.23 would display as 001.230. If the number has
more digits than the zeros in the format, the extra digits will display on
the left side of the decimal only. For example, the format 000.000 
will display 12345.6789 as 12345.679. If there are more digits on the 
right of the decimal point than there are zeros, the interpreter rounded 
off the number to as many decimals as there are zeros in the format.

# Digit placeholder. Follows the same rules as for 0 discussed above 
except that the interpreter does not display extra zeros if there are 
fewer digits in the entry than the format. If there are more digits to the 
right of the decimal point than number signs, CorelCHART rounds the 
number to the number of decimals in the format.

? Digit placeholder. Follows the same rules as 0 described above. 
However, if the number has fewer digits from either side of the decimal
point than question marks, CorelCHART adds space for sufficient zeros 
so that decimal points align in cells. If there are more digits to the right
of the decimal point than there are question marks, CorelCHART rounds
the number to the specified number of decimals.

- (hyphen) Symbol displayed for every occurrence of this code in the format.
. (period) Decimal point. Displays in accordance with the Windows Control Panel 

International settings.
, (comma) Thousands separator when inserted in the numeric format after #s or 

0s.
: (colon) Time separator.
; (semi-colon) 1) Separates the sections in General conditional format.

2) Separates font specifications within each section of Custom 
Conditional formats.

% Percentage sign displayed in the formatted entry. Multiplies the entry 
by 100 and adds % symbol.

$ Currency symbol displayed for every occurrence of this code in the 
format. Displays in accordance with the Windows Control Panel 
International settings.

"text" Displays whatever text is entered between the double quotation marks.
\ Displays the next character in the format as is. This is the same as 

enclosing characters in double quotation marks, i.e., "characters".
/ 1) Precedes font specification codes in format. 

2) Used as a separator in Date formats; displays in accordance with 
the Windows Control Panel international settings in this case.

E- E+ e- e+ The numeric format followed by e or E sign tells CorelCHART to display 
the number in exponent (scientific) form. E- or e- places a minus sign 



next to negative components and omits the plus sign for positive 
components. E+ or e+ places a minus sign by negative components 
and a plus sign by positive ones.

d,dd,ddd,dddd Day. A single d displays a day without leading zero (3), dd adds the 
leading zero (03), ddd shows the abbreviated day name (Mon, Tue, 
Wed, Thu, Fri, Sat, Sun) and dddd shows the full day name (Monday, 
Tuesday, etc.). The month and day names are stored in the INTL.RC file 
and can be modified.

m,mm,mmm Month. A single m displays month without leading zeros (1), mm 
displays leading zeros 

mmmm (01), mmm displays the abbreviated month name (Jan.) and mmmm 
shows the full month name.

yy,yyyy Year. yy displays only the last two digits of the year. If you enter yyyy, 
CorelCHART displays the full year number.

h, hh Displays the hour with or without a leading zero, i.e., (00-
23) or (0-23) . If the format includes Am or PM, the 
interpreter displays the hour based on a 12-hour clock.

m, mm Displays minutes when placed before seconds or after 
hours. Displays with (00-59) or without (0-59) a leading 
zero.

s, ss Displays the seconds with a leading zero (00-59) or 
without (0-59).

AM/PM, am/pm
A/P, a/p Displays time using 12-hour clock.
[ ] square brackets 1) Enclose font attributes specifications

2) Enclose the condition in custom conditional formats as well as the 
font specifications. The conditional formats should be separated with
";" signs.

Creating conditional formats you can use the following operators:
= Equal to
> Greater than
< Less    than
>= Equal to or greater than
<= Equal to or less than
<> Not equal to
{}curly brackets Define the effective range for font attributes; all digit placeholders 

enclosed in curly brackets conform to the font specifications
() brackets Enclose a custom conditional format.



Examples of custom general numeric formats
The following are examples of user-defined numeric formats using one, two and three 
sections:
Using one section: [/b/u/st]#[/b].00

This format applies the bold, underline and strike-out attributes to the digits located on the
left of the period. The digits after the period are bold only. This being a single-section 
format, all numbers entered, whether positive, negative or zero values, adopt the format. 

Using two sections: {[/b/u/st]#.00;[/c:RED]#.00}
The curly brackets define the range of digits affected by the font characteristics. In the 
example, curly brackets enclose the entire format; therefore all digits use the same font 
characteristics. The only difference is that negative values display in red. 

Using three sections: [/b/i]#.##;[/c:BLACK]-0.00;"Zero"
In the example, positive numbers are bold, italic and displayed in the #.## format. 
Negative numbers use the -0.00 format and display in black. Zero values cause the "Zero" 
text string to appear in the cell.



Examples of custom conditional numeric formats
The following are examples of custom conditional formats:
Example 1: ([>100][/b/c:RED];[/i/s:4])0.00

There is only one section in the example. If values are greater than 100, they display in 
red, bold with two digits after the decimal point. Values that are not greater than 100 are 
italic and have a point size of 4.

Example 2: ([>=24][/c:GREEN];[/c:RED/b])#.##;([<-5][/i];[/u/c:BLUE])-#.00;"Zero"
The example above is a three-section format. The first section (for positive numbers) 
stipulates that values equal to or greater than 24 are to be displayed in green; values less 
than 24 are to be bold and red. 
The second section (for negative numbers) stipulates that values less than -5 are to be 
italicized while other negative values will be underlined and displayed in blue; all negative 
values are to adopt the -#.00 format, which includes the minus sign and two digits after 
the decimal point.
The third section stipulates that cells that containing zero values will display the word 
"zero".



Grid Lines dialog box
Use this dialog box to specify how the grid lines in your chart are to appear.

Dialog Box Options
Major Divisions

Specify how you want the major grid lines and tick marks to appear
Show Major Grid Lines
Toggles the display of the major grid lines on and off. When selected the following 
options become available:
Normal: Displays the grid lines without tick marks.
Normal with Ticks: Displays the grid lines with tick marks outside the scale axis.
Inside Ticks: Displays ticks inside the scale axis and hides the grid lines.
Outside Ticks: Hides the grid lines but displays the ticks outside the scale axis.
Spanning Ticks: Displays ticks on both sides of the scale axis and hides the grid 

lines.
Auto: Displays the grid lines and tick marks at intervals determined by 

the data values in the chart.
Manual: Select this option and type the number of grid lines you want in the

Number of Divisions box.
Minor Divisions

Options for Minor Divisions are the same as those for Major Divisions. Minor Divisions are 
intermediate grid lines appearing between major grid lines.

Note: Major Divisions display in black and Minor Divisions display in white by default. The 
latter will not appear if your chart background is also white. You can change the color of 
major and minor grid lines by selecting one with the Pick tool and then clicking a color in the
on-screen palette with the right mouse button. 



3D Grid Lines dialog box
Use this dialog box to control the display of grid lines on 3D charts.

Dialog Box Options
Walls & Floors

Specify which grid lines you want displayed on the walls and floors by enabling or disabling
the appropriate options.

Risers
Specify which grid lines you want displayed on the risers by enabling or disabling the 
appropriate options. This option has no affect on 3D scatter charts.

Z-Axis Divisions
Choose Manual and type the number of divisions you want on the Z-Axis or choose 
Automatic and let CorelCHART determine the number based on the data values in the 
chart.



Data Analysis dialog box
Use this dialog box to fit curves and statistical lines to your data to highlight particular 
trends or values, such as the average. See also Using Data Analysis
·    Mean
·    Standard Deviation
·    Connected Line
·    Smooth Curve
·    Moving Average
·    Financial Moving Average
·    Scientific Moving Average
·    Linear Regression
·    Power Law Regression
·    Natural Logarithmic Regression
·    Exponential Regression
·    Polynomial Regression Line
·    Order box
·    Smooth Factor box
·    Show Formula
·    Show Correlation Coefficient



Legend dialog box
Use this dialog box to control how legends appear in your charts.

Dialog Box Options
Legend Display

Display Legend
Clear the check mark if you don't want the legend to appear in your chart. With the Legend
turned on you can choose an option from the left side of the dialog box to position the text 
in relation to the marker within the legend.
Note: The text's alignment determines its position on the marker. For example, if the text 
is left aligned, the last character in the text will appear on the marker. Use the alignment 
buttons in the text ribbon to change the text's alignment.
Autofit Legend Text
Fits the text to the size of the legend box. If you resize the legend box, the text resizes by 
the same proportions automatically. You cannot change the point size of autofitted text 
using the text ribbon.

Legend Layout
Automatic Legend Orientation
Positions the legend in the default location for that particular chart type.
Vertical
Arranges the legend items in a column.
Horizontal
Arranges the legend items side-by-side.



Display Status dialog box
Use this dialog box to control the display of various elements in your chart.
If you don't want a particular element to appear, deselect it. Clicking the ALL Text and NO 
Text buttons turns all elements on or off.
Clicking the Position box, available when Data Values is selected, displays options for 
positioning data values which lie outside the scale range. Select Outside Maximum, for 
example, and all values beyond the upper limit of the scale will display outside the chart 
frame.
The Format button displays the Numeric dialog box, used to set number formats.



Chart menu for Vertical/Horizontal Line Charts
Category Axis Displays a flyout menu with toggle commands for controlling the 

location of the category axis text, appearance of text and display of 
grid lines. The category text can appear at the top or bottom of the 
chart or at both locations at the same time. Deselecting both options 
hides the category text from view. Text can be fitted automatically or 
staggered.

Data Axis Displays a flyout menu with toggle commands for setting the location 
of the numeric axis (right or left side, both or none), type (log or linear)
and direction (ascending or descending) of the scale, and appearance 
of text (autofitted or staggered). You can also specify the Scale Range, 
Number Format and Grid Lines in the appropriate dialog boxes.

2nd Data Axis Contains the same options as the Data Axis. Only available for dual-
axis charts.

Axis Assignment... Opens a dialog box that controls the assignment of series to the 
primary and secondary axes in dual-axis charts.

Data Reversal... Displays a flyout menu with toggle commands to Reverse Series data 
within groups or Reverse the Groups themselves along the non-
numeric axis.

Data Analysis... Used to select scientific and financial statistical procedures, including 
the mean, standard deviation, moving averages and linear regressions.

Show Markers A toggle command to or hide a marker at each data point on the line.
Marker Shape Displays a selection of bar and legend marker shapes. Hold down the 

mouse button and move down the flyout menu; a preview of each 
option is displayed. Release the mouse button to make selection.

Marker Size Displays a selection of marker sizes. Hold down the mouse button and 
move down the flyout menu; a preview of each option is displayed. 
Release the mouse button to make a selection.

Display as Bar Select a line, then click this option. The data for that line will display as
a bar. 

Legend... Opens a dialog box containing controls for the chart's legend. Click the 
check boxes to activate each option.

Display Status... Opens a dialog box containing check boxes for showing and hiding 
chart elements such as title, subtitle, data values and legend.



Chart menu for Vertical/Horizontal Area Charts
Category Axis Displays a flyout menu with toggle commands for controlling the 

location of the category axis text, appearance of text and display of 
grid lines. The category text can appear at the top or bottom of the 
chart or at both locations at the same time. Deselecting both options 
hides the category text from view. Text can be fitted automatically or 
staggered.

Data Axis Displays a flyout menu with toggle commands for setting the location 
of the numeric axis (right or left side, both or none), type (log or linear)
and direction (ascending or descending) of the scale, and appearance 
of text (autofitted or staggered). You can also specify the Scale Range, 
Number Format and Grid Lines in the appropriate dialog boxes.

2nd Data Axis Contains the same options as the Data Axis. Only available for dual-
axis charts.

Axis Assignment... Displays a dialog box that controls the assignment of series to primary 
and secondary axes in dual-axis charts.

Data Reversal Toggle command to Reverse Series data within groups or Reverse the 
Groups themselves along the non-numeric axis.

Data Analysis... Used to select scientific and financial statistical procedures, including 
the mean, standard deviation, moving averages and linear regressions.

Base of Areas Displays options to show the data from the Zero Line or from the Scale 
Minimum, the Scale minimum being the lowest value in the data range.

Legend... Opens a dialog box containing controls for the chart's legend. Click the 
check boxes to activate each option.

Display Status... Opens a dialog box containing check boxes for showing and hiding 
chart elements such as title, subtitle, data values and legend.



Chart menu for Pie Charts
Pie Tilt Use the visual selector to determine the amount of tilt.
Pie Thickness Use the visual selector to control thickness.
Pie Rotation Use the visual selector to determine the degree of rotation. Each 

selection starts from zero degrees.
Pie Size Use the visual selector to determine the size.
Pies per Row... Available only for multiple pie charts. Enter a number in the Pies per

Row dialog box to change the layout of the pies.
Detach Slice Click a slice to select it, then click this option and use the visual 

selector to control detachment.
Delete Slice Deletes the selected slice.
Restore All Slices Restores the pie chart to its original appearance.
Slice Number Format... Displays a dialog for controlling how numbers display. You can use 

one of the formats provided or create your own. This command only 
works with ring pie charts.

Slice Feeler Size... Displays a dialog box for adjusting the length of the slice feelers
Hole Size Use the visual selector to control the size of the hole in a ring chart 

or multiple ring chart.
Ring Total Format Displays a dialog for controlling how numbers display. You can use 

one of the formats provided or create your own. This command only 
works with ring pie charts. The chosen format is applied only to the 
ring chart's total number, not the slice numbers.

Data Reversal Toggle commands to Reverse Series or Reverse Groups.
Legend... Opens a dialog box containing controls for the chart's legend. Click 

the check boxes to activate each option.
Display Status... Opens a dialog box with check boxes for showing and hiding chart 

elements such as title, subtitle, data values and legend.



Slice Feeler Size dialog box
Click a black node in the dialog box and drag to change the length of each segment of a 
slice feeler. In a single-pie chart, select one feeler, and your adjustments apply only to that 
feeler. In a multiple-pie chart, your adjustments apply to all feelers in the same data series.



Chart menu for 3D Riser/Floating Charts
Preset Viewing Angles Changes the perceived position of a 3D chart in space to one of 

16 preset angles. Hold down the mouse button and move down the 
flyout menu. A preview of each option is displayed. Release the 
mouse button to make a selection.

AutoShade Risers When checked, the risers of a 3D chart are automatically colored to 
give the effect of a light source illuminating the chart. 

AutoShade Cube When checked, the floor and walls of a 3D chart are automatically 
colored to give the effect of a light source illuminating the chart. 
Disable this option if you wish to use a graphic or special effect to fill
a selected floor or wall area.

Vertical [Z] Axis Used to select a linear or log scale, manipulate the scale range and 
specify the number format for the scale values.

Data Reversal Toggle command to Reverse Series data within groups or Reverse 
Groups along the non-numeric axis.

3D Grid Lines... Opens a dialog box containing options to control grid lines for walls, 
floor and risers.

Text View Options... Once a 3D text element is selected, the text can be autofitted so 
that it is sized automatically according to the available space. All 
headers can be made the same size or the headers can be made to 
change as the perspective changes.

Base of Bars Controls whether 3D risers rise from the floor, or rise or fall from the
zero plane. From Zero Plane stresses the difference between 
positive and negative values by having bars rise and fall from an 
invisible floor which is level with the zero value. The zero plane itself
never appears (unlike the Zero Line in 2D charts). From Scale 
Minimum makes all bars rise from the floor. 

Riser Sizing Hold down the mouse button and move down the flyout menu. 
Displays 16 sizes for the risers. A preview of each option appears. 
Release the mouse button to make selection.

Riser Colors Contains options for coloring risers.
Riser Type Hold down the mouse button and move down the flyout menu. A 

preview of each option appears. Release the mouse button to make 
a selection.

Display Status... Opens a dialog box containing check boxes for showing and hiding 
chart elements such as title, subtitle, data values and legend.



Text View Options dialog box
Use this dialog box to specify how you want text in 3D charts to appear. Select at least one 
text object before choosing the command. To specify options for multiple series headers, 
hold down the Shift key and click at least one header in each series.
Note: This dialog box changes depending on which 3D or 2D options or chart objects are 

selected.

Dialog Box Options
Autofitted Text

With this option selected, text resizes automatically as you scale the chart with the 3D 
Tool. Note that you cannot change the font size of autofitted text using the text ribbon.

2D Size Options
All headers the same size
Makes all text in the selected series the same size. 
Headers change size with perspective
Resizes the text so that it corresponds to the chart's perspective.

3D Perspective Text
Enabling this option removes the two choices mentioned above from the dialog box and 
replaces them with 3D Placement Options. The options are represented visually. You can
place your text parallel or perpendicular to the chart floor or walls, or align it towards or 
away from the chart's implied vanishing point.
Align To
The text can be aligned to either the inside or outside edge of the chart walls. This makes 
a difference when working with a chart that has thick walls.



Riser Colors
Options in the Riser Colors submenu let you choose the method by which color is applied to 
the risers. You still choose the actual color by using the On-screen color palette or the Fill 
tool.

Submenu Options
Color by Face

Makes all risers the same color.
Color by Series

Risers in a series have the same color. This emphasizes series data.
Color by Group

Risers in a group have the same color. This emphasizes group data.
Color by Height

Makes risers different colors, depending on their relative heights. Once you've chosen 
Color by Height, choose Color Range described below. Select a start and end color in the 
dialog box. Click OK, and you'll see the shorter risers are closer to the start color, and the 
taller risers are closer to the end color.

Color by Angle
Most often used for surface charts. Surfaces are colored by their angle from the viewer. To 
set the start and end colors, choose Color Range, and select a start and end color in the 
dialog box.

Color Range
Displays a dialog box for specifying the range of color when coloring by angle or by height.
The Start and End buttons are used to choose the first and last color of the range using 
the Select Color dialog box. 
Type the desired number of variations in color from the start to the end color in the 
Number of Divisions box.



Color Range dialog box
Use this dialog box to specify the range of colors in the chart risers. Specifying color range 
applies only when coloring by height or angle.
To specify a range of colors:

1. Click Start to display the Select Color dialog box and choose the color you want as the 
start color in the range. 

2. Click End and choose the end color.
3. In the Number of Divisions box, type the number of colors you want between the start 

and end colors.
A small number will produce a collection of colors, and a high number will produce a 

smooth color fill.



Chart menu for 3D Connect Series/Group Charts
Preset Viewing Angles Changes the perceived position of a 3D chart in space to one of 

16 preset angles. Hold down the mouse button and move down the 
flyout menu. A preview of each option is displayed. Release the 
mouse button to make a selection.

AutoShade Cube When turned on, the floor and walls of the 3D chart are 
automatically colored to give the effect of a light source illuminating
the chart. Disable this option if you wish to use a graphic or special 
effect to fill a floor or wall area.

AutoShade Risers When turned on, the risers of the 3D chart are automatically colored
to give the effect of a light source illuminating the chart.

Vertical [Z] Axis Used to select a linear or log scale, manipulate the scale range and 
specify the number format for the scale values.

Data Reversal A toggle command to Reverse Series data within groups or Reverse 
Groups along the non-numeric axis.

3D Grid Lines... Opens a dialog box containing options to control grid lines for walls, 
floor and risers.

Text View Options... Once a 3D text element is selected, the text can be autofitted so 
that it is sized automatically according to the available space. All 
headers can be made the same size or the headers can be made to 
change as the perspective changes.

Base of Bars Controls whether 3D risers rise from the floor or rise/fall from the 
zero plane. From Zero Plane emphasizes the difference between 
positive and negative values by having bars rise and fall from an 
invisible floor which is level with the zero value. The zero plane itself
never appears (unlike the Zero Line in 2D charts). From Scale 
Minimum makes all bars rise from the floor. 

Riser Sizing Hold down the mouse button and move down the flyout menu. A 
preview of each option is displayed. Release the mouse button to 
make selection.

Riser Colors Options for coloring risers.
Riser Type Hold down the mouse button and move down the flyout menu. A 

preview of each option appears. Release the mouse button to make 
a selection.

Display Status... Opens a dialog box containing check boxes for showing and hiding 
chart elements such as title, subtitle, data values and legend.



Chart menu for 3D Surface Charts
Preset Viewing Angles Changes the perceived position of a 3D chart in space to one of 

16 preset angles. Hold down the mouse button and move down the 
flyout menu. A preview of each option is displayed. Release the 
mouse button to make a selection.

AutoShade Cube When checked, the floor and walls of the 3D chart are automatically 
colored to give the effect of a light source illuminating the chart. 
Disable this option if you wish to use a pictograph or special effect 
to fill a floor or wall area.

Vertical [Z] Axis Enables you to select a linear or log scale, manipulate the scale 
range and specify the number format for the scale values.

Data Reversal Toggle switch to Reverse Series data within groups or Reverse 
Groups along the non-numeric axis.

3D Grid Lines... Displays a dialog box with options to control grid lines for walls, floor
and risers.

Text View Options... Once a 3D text element is selected, the text can be autofitted so 
that it is sized automatically according to the available space. All 
headers can be made the same size or the headers can be made to 
change as the perspective changes.

Base of Bars Controls whether 3D risers rise from the floor or rise/fall from the 
zero plane. From Zero Plane: Emphasizes the difference between 
positive and negative values by having bars rise and fall from an 
invisible floor which is level with the zero value. The "zero plane" 
itself never displays (unlike the Zero Line in 2D charts). From Scale
Minimum: All bars rise from the floor. 

Riser Sizing Hold down the mouse button and move down the flyout menu. A 
preview of each option is displayed. Release the mouse button to 
make selection.

Riser Colors Options for coloring risers.
Display Status... Opens a dialog box containing check boxes for showing and hiding 

chart elements such as title, subtitle, data values and legend.



Chart menu for 3D Scatter Charts
Preset Viewing Angles Changes the perceived position of a 3D chart in space to one of 

16 preset angles. Hold down the mouse button and move down the 
flyout menu. A preview of each option is displayed. Release the 
mouse button to make a selection.

AutoShade Cube When checked, the floor and walls of the 3D chart are automatically 
colored to give the effect of a light source illuminating the chart. 
Disable this option if you wish to use a pictograph or special effect 
to fill a floor or wall area.

Data Reversal Toggle switch to Reverse Series or Reverse Groups. Provides a 
different view of the data.

3D Grid Lines... Displays a dialog box with options to control grid lines for walls, floor
and risers. 

Text View Options... Once a 3D text element is selected, the text can be autofitted so 
that it is sized automatically according to the available space. All 
headers can be made the same size or the headers can be made to 
change as the perspective changes.

Data Point Size Hold down the mouse button and move down the flyout menu. A 
preview of each option appears. Release the mouse button to make 
a selection.

Data Point Shape Hold down the mouse button and move down the flyout menu. A 
preview of each option appears. Release the mouse button to make 
a selection.

Tie Lines Drops perpendicular lines from the data points to the left wall, right 
wall, floor or neighbor. You can also have a line drawn between 
points in a series. Each series can have different drop lines.

Data Point Colors You can choose to color the points by face, series, group, or by their 
distance from the left or right wall or the floor. 

Legend... Opens a dialog box containing controls for the chart's legend. Click 
the check boxes to activate each option.

Display Status... Opens a dialog box containing check boxes for showing and hiding 
chart elements such as title, subtitle, data values and legend.



Chart menu for Scatter Charts
X-Axis This option enables you to display the axis at the top or bottom. You 

can specify linear or log scale, scale range, number format, grid lines, 
ascending scale and autofitted or staggered scales.

Y1-Axis Displays a flyout menu with toggle switches. You can control the 
location of the numeric axis and its scale; you can also specify a linear 
or log scale, an ascending or descending scale, and autofitted and 
staggered text. You can specify Scale Range, Numeric Format and Grid 
Lines in the appropriate dialog boxes.

Y2-Axis Options for the second vertical axis line (same as Y-axis options).
Axis Assignment... Opens a dialog box that controls which series are assigned to primary 

and secondary axes in dual-axis charts.
Marker Shape Hold down the mouse button and move down the flyout menu. A 

preview of each option appears. Release the mouse button to make a 
selection.

Marker Size Hold down the mouse button and move down the flyout menu. A 
preview of each option appears. Release the mouse button to make a 
selection.

Legend... Opens a dialog box containing controls for the chart's legend. Click the 
check boxes to activate each option.

Display Status... Opens a dialog box containing check boxes for showing and hiding 
chart elements such as title, subtitle, data values and legend.



Chart menu for Polar Charts
Circular Axis Displays a flyout menu with options to show/hide the scale labels for 

the circular axis, choose a linear or logarithmic scale, set an ascending 
or descending scale and have the scale automatically fit the available 
space. From this flyout, you can also access dialog boxes to set the 
Scale Range, Number Format and Grid Lines options for the circular 
axis. 

Radial Axis Displays a flyout menu with options to display the radial scale above or
below the radial axis, choose a linear or logarithmic scale, set an 
ascending or descending scale, and have the scale automatically fitted 
or staggered. From this flyout, you can access dialog boxes to set the 
Scale Range, Number Format and Grid Lines options for the radial axis. 

2nd Radial Axis Same options as Radial Axis above. Only available for Dual Axis Polar 
charts.

Axis Assignment... Opens a dialog box that controls the assignment of series to primary 
and secondary axes in dual-axis charts.

Marker Shape Displays a selection of data and legend marker shapes. Hold down the 
mouse button and move down the flyout menu; a preview of each 
option is displayed. Release the mouse button to make a selection. The
shape assigned to a data marker is applied to all data markers for the 
series and to the appropriate legend marker.

Marker Size Hold down the mouse button and move down the flyout menu. A 
preview of each option appears. Release the mouse button to make a 
selection.

Legend... Opens a dialog box containing controls for the chart's legend.
Display Status... Opens a dialog box containing check boxes for showing and hiding 

chart elements such as title, subtitle, data values and legend.



Chart menu for Radar Charts
Circular Axis Displays a flyout menu with options to show/hide the circular axis 

headers and grid lines. The header text can be automatically fitted to 
the available space in the same flyout menu. 

Radial Axis Displays a flyout menu with options to display the radial scale above or
below the radial axis, choose a linear or logarithmic scale, set an 
ascending or descending scale, and have the scale automatically fitted 
or staggered. From this flyout, you can access dialog boxes to set the 
Scale Range, Number Format and Grid Lines options for the radial axis. 

2nd Radial Axis Same options as Radial Axis above. Only available for Dual Axis Radar 
charts.

Axis Assignment... Opens a dialog box that controls the assignment of series to primary 
and secondary axes in dual-axis charts.

Data Reversal Toggle commands to Reverse Series data within groups or Reverse 
Groups along the non-numeric axis.

Marker Shape Displays a selection of data and legend marker shapes. Hold down the 
mouse button and move down the flyout menu; a preview of each 
option is displayed. Release the mouse button to make a selection. The
shape assigned to a data marker is applied to all data markers for the 
series and to the appropriate legend marker.

Marker Size Hold down the mouse button and move down the flyout menu. A 
preview of each option appears. Release the mouse button to make a 
selection.

Legend... Opens a dialog box containing controls for the chart's legend.
Display Status... Opens a dialog box containing check boxes for showing and hiding 

chart elements such as title, subtitle, data values and legend.



Chart menu for Bubble Charts
X-Axis Displays a flyout menu with options to display the X axis scale above 

or below the bubble chart, choose a linear or logarithmic scale, or set 
an ascending or descending, or autofit or staggered scale. From this 
flyout, you can access dialog boxes to set the Scale Range, Number 
Format and Grid Lines options for the radial axis. 

Y1-Axis Displays a flyout menu with options to display the first (or only) Y axis 
scale to the left or right of the chart, choose a linear or logarithmic 
scale, or set an ascending or descending, or autofit or staggered scale. 
From this flyout, you can access dialog boxes to set the Scale Range, 
Number Format and Grid Lines options for the radial axis. 

Y2-Axis Flyout menu with options for second Y axis; only available for dual axis 
Bubble charts. options are the same as the ones for the Y1-Axis 
described above.

Axis Assignment... Opens a dialog box that controls the assignment of series to primary 
and secondary axes in dual-axis charts.

Marker Shape Displays a selection of data and legend marker shapes. Hold down the 
mouse button and move down the flyout menu; a preview of each 
option is displayed. Release the mouse button to make a selection. The
shape assigned to a data marker is applied to all data markers for the 
series and to the appropriate legend marker.

Marker Size Hold down the mouse button and move down the flyout menu. A 
preview of each option appears. Release the mouse button to make a 
selection.

Show Quadrant
Lines When checked, lines dividing the Bubble chart in four quadrants 

appear.
Legend... Opens a dialog box containing controls for the chart's legend.
Display Status... Opens a dialog box containing check boxes for showing and hiding 

chart elements such as title, subtitle, data values and legend.



Chart menu for High-Low-Open-Close Charts
Category Axis Displays a flyout menu with toggle commands for controlling the 

location of the category axis text, appearance of text and display of 
grid lines. The category text can appear at the top or bottom of the 
chart or at both locations at the same time. Deselecting both options 
hides the category text from view. Text can be fitted automatically or 
staggered.

Data Axis Displays a flyout menu with toggle commands for setting the location 
of the numeric axis (right or left side, both or none), type (log or linear)
and direction (ascending or descending) of the scale, and appearance 
of text (autofitted or staggered). You can also specify the Scale Range, 
Number Format and Grid Lines in the appropriate dialog boxes.

2nd Data Axis Contains the same options as the Data Axis. Only available for dual-
axis charts.

Axis Assignment... Opens a dialog box that controls which series are assigned to primary 
and secondary axes in dual-axis charts.

Data Reversal Toggle switch to Reverse Series data within groups or Reverse Groups 
along the non-numeric axis.

Data Analysis... Used to select scientific and financial statistical procedures, including 
the mean, standard deviation, moving averages and linear regressions.

Bar Thickness Hold down the mouse button and move down the flyout menu. A 
preview of each thickness available for the bars appears. Release the 
mouse button to make a selection.

Open & Close Width Hold down the mouse button and move down the flyout menu. 
A preview of each option for the size of the Open and Close ticks 
appears. Release the mouse button to make a selection. This option is 
available only for Open and Open/Close chart types; it is not for 
High/Low charts.

Legend... Opens a dialog box containing controls for the chart's legend. Click the 
check boxes to activate each option.

Display Status... Opens a dialog box containing check boxes for showing and hiding 
chart elements such as title, subtitle, data values and legend.



Chart menu for Spectral Mapped Charts
Series Header Gives options for the location of the series header (left or right side of 

the chart), the display of the text that makes up the headers, which 
can be fitted automatically or staggered. Another option is listed for 
showing or hiding the series grid lines.

Groups Header This option enables you to display the headers at the top or bottom of 
the chart, show or hide the group grid lines and control the display of 
the header text to fit automatically or be staggered. 

Spectrum Label Opens flyout menu options that allow you to display the legend 
spectrum label values above or below the legend spectrum and choose
between linear or log scales. You can also alter the scale range, 
number format and the grid line display. You can set an ascending or 
descending, or autofit or staggered scale. Open the Color Range dialog 
box  to select the start and end colors for the spectrum. The number of
divisions controls the number of color fills between the start and end 
colors.

Data Reversal Toggle command to Reverse Series or Reverse Groups.
Spectrum Opens the Color Range dialog box  for selecting the start and end 

colors for the categories displayed in the chart's spectrum. The number
of divisions controls the number of color fills between the start and end
colors.

Marker Shape Hold down the mouse button and move down the flyout menu. A 
preview of each option appears. Release the mouse button to make a 
selection.

Display Status... Opens a dialog box containing check boxes for showing and hiding 
chart elements such as title, subtitle, data values and legend.



Chart menu for Gantt charts
Category Axis Displays a flyout menu with options to display category headers to the 

left or right of the Gantt chart, or to show/hide the grid lines. You can 
also specify autofitted or staggered category text.

Data Axis Displays a flyout menu with options to have the data axis headers (or 
labels) displayed above or below the chart, choose a linear or 
logarithmic scale for the data axis and have it ascending or 
descending. You can also specify an autofitted or staggered scale for 
axis labels.

Data Reversal Toggle command to Reverse Series or Reverse Groups.
Bar Thickness Hold down the mouse button and move down the flyout menu. A 

preview of each thickness available for the bars appears. Release the 
mouse button to make a selection.

Legend... Opens a dialog box containing controls for the chart's legend. Click the 
check boxes to activate each option.

Display Status... Opens a dialog box containing check boxes for showing and hiding 
chart elements such as title, subtitle, data values and legend.



Chart menu for Histograms
Interval Axis Use this option to (a) display the axis at the top or bottom for a vertical

histogram and left or right for a horizontal histogram, (b) specify a 
linear or log scale, (c) select number format, (d) display or hide the grid
lines and (e) specify an autofitted or staggered scale.

Data Axis This option enables you to display the axis at the left or right, or top or 
bottom, specify a linear or log scale, adjust the scale range, select 
number format and grid lines and specify an ascending, autofitted or 
staggered scale.

Intervals... Displays the Histogram Intervals dialog box, used to specify the 
number of intervals on the X axis.

Marker Shape Hold down the mouse button and move down the flyout menu. A 
preview of each option appears. Release the mouse button to make a 
selection.

Show as Pictograph Select a bar, then click this option to activate it. This command 
divides each bar into slices based on the major grid lines. A pictograph 
(.CDR file) can then be selected from the vector option on the Fill Tool 
flyout or the Pictograph roll-up. The pictograph will be copied into each 
rectangle formed by the bar and the major grid lines.

Display Status... Opens a dialog box containing check boxes for showing and hiding 
chart elements such as title, subtitle, data values and legend.



Histogram Intervals dialog box
Use this dialog box to specify the number of intervals along the X axis in a histogram. You 
can set the number manually by choosing Manual and typing a value or let CorelCHART set 
them by choosing Automatic.



Chart menu for Table Charts
Divisions... Opens the Table Chart Divisions dialog box, used to specify no color 

divisions, color by row, color by columns, and whether headers are 
included.

Grids & Borders... Opens a dialog box showing a map of possible grid lines. Click a grid 
line to have it appear in the table chart. 

Uniform Cell WidthThis option gives all cells a uniform width. Note: You must deselect the
Autofit Table command to implement this option.

Uniform Cell Height This option gives all cells a uniform height. Note: You must 
deselect the Autofit Table command to implement this option.

Autofit Table Check this box to have CorelCHART automatically control table 
dimensions.

Display Status... Opens a dialog box containing check boxes for showing and hiding 
chart elements such as title, subtitle and legend.



Table Chart Divisions dialog box
Controls the use of colors to demarcate rows and columns in the chart. For example, you can
have columns colored alternately red, white and blue by setting Number of colors to cycle
through to three, and after closing the dialog box, selecting the three colors from the color 
palette.

Dialog Box Options
Rows/Columns Color Selection

No Color Divisions Applies the same color to all rows and columns, 
excluding the row and column headers

Color by Rows, Columns Alternates the colors by row or column. You specify 
the number of colors used in the Number of rows 
per color box.

Include Headers Applies the row or column color to its header.

Rows/Columns Color Setting
Number of columns between grids Enter the number of columns in the chart.

Number of colors per row If you want each row/column colored differently, 
then enter the number of rows/columns in the 
chart. Enter two or more if you want the same color
in adjacent rows/columns.

Number of colors to cycle through Enter the number of colors you want to alternate 
between. Entering two, for example, applies the 
same color to every second row/column.



Grids & Borders dialog box
Use this dialog box to turn parts of the grid on and off. Lines that are turned on appear in a 
darker gray than those that are turned off. Click parts you want to turn on or off or use the 
Select All and Deselect All buttons to turn them all on or off.





 Basics: Get started with CorelCHART

Creating a chart from sample data
Creating a chart from your own data
Saving a new chart
Opening a CorelCHART file
Saving an exisiting chart with a new name or new location
Opening Data Manager first
Dragging and dropping files
Using menus
CorelCHART roll-ups
Choosing tools
Ribbon Bars
Text Ribbon Bars
Switching between Chart View and Data Manager
Working with dialog boxes
Starting and exiting CorelCHART
Using Corel Online Help

Tip: For a tutorial on CorelCHART, browse through this module and try out the procedures 
shown. 

See also How to..., the CorelDRAW User's Guide (CorelCHART section) and Learning 
CorelDRAW



Overview
CorelCHART 5, with an impressive array of enhanced spreadsheet capabilities and its 
intuitive charting, is a powerful and dynamic data presentation tool. Using CorelCHART, you 
can simply and quickly produce complex and colorful charts and spreadsheets, add sizzle to 
your screen shows and slide presentations, or compute a multitude of mathematical 
formulas.
As part of the CorelDRAW suite of programs, CorelCHART emphasizes presentation. With 
CorelCHART, you have drawing tools, full color design and printing support and over 825 
typefaces to choose from. Available chart types include CorelCHART 4's line, bar, area and 
pie charts, histograms, scatter and 3D charts and, new in CHART 5, Bubble charts, Gantt 
charts, Polar charts and Radar charts. 
For descriptions of the various chart types, see the Glossary and Menus. See How to ... for 
Help with building your charts. For Help with Windows basics, press F1 from within 
CorelCHART Help.



Using Corel Online Help
Help shortcuts
Using secondary windows
How to use Context-sensitive Help
Opening other programs' Help files
Keeping Help on top
Using Help's Search feature
Using the History button
Using speed keys



How to use Context-sensitive Help
The CorelDRAW 5.0 suite of programs features the range of Context-sensitive Help indicated 
below:

· Context-sensitive Help pointer : Choose the Help pointer from the right side of 
the Ribbon Bar and click the menu item, tool, button, or interface item you want 
information about. Keyboard: Shift+F1

· Right mouse button Help: Click the right mouse button on the Toolbox, Ribbon Bar 
or Text Ribbon Bar. 
· Pop-Up Help: Rest the mouse pointer over any button on the Toolbox, Ribbon Bar or 
Text Ribbon Bar. The item's name will appear in a small yellow callout or "bubble." Pop-Up 
Help is turned on by default; you can turn it off from the Preferences dialog box, found in the
File menu.
· F1: Press F1 while you have any dialog box open--a Help topic specific to the dialog 
box will appear.

· Status line Help: Read the message in the Status line when you choose a menu 
command or tool, click a button on the Ribbon Bar or Text Ribbon or open a dialog box

· Help menu: Choose a Help item from the Help menu.



Using the History button
The History button, which lists the last 50 Help topics viewed, provides a useful alternative 
to the Contents buttons.
To use the History button:

1. Press "t" on the keyboard, or click the History button and scroll through the topics until 
you find the one you are interested in.

2. Click the topic you want to review and close the History window.
3. When you close the History window, the list of last topics viewed remains in memory.
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The History button, which lists the last 50 Help topics viewed, provides a useful alternative 
to the Contents buttons.
To use the History button:
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Opening other programs' Help files
You can open any of the Online Help files for the CorelDRAW suite of applications from the 
Programs subdirectory by double-clicking them in the main directory where you installed 
CorelDRAW, usually \COREL50\PROGRAMS. 

1. Choose Open from the CorelCHART Help Menu Bar. 
2. Double click [filename.hlp] from the File Name box.



Opening other programs' Help files
You can open Online Help files for other Microsoft Windows-compatible programs using the 
Help File Menu. The example below explains how to open Online Help for CorelDRAW!
To open CorelDRAW's Online Help:

1. Choose Open from the CorelCHART Help Menu Bar. 
2. Double click CORELDRW.HLP from the File Name box.

Note: You can also use the File Manager to open any Online Help file. To open another 
Corel application's Help file, go to the Corel Programs subdirectory, usually \
COREL50\PROGRAMS, and open the file you want to use by double-clicking the 
file, e.g., CORELDRW.HLP. 



Using Help's Search feature
Help Search keywords are usually limited to specific topic names or subjects. If the topic is 
procedural, the keyword describing it will take you to a Contents section. From there choose 
the topic you are looking for.
In general, try to use the terms used by CorelCHART, beginning with subject area in 
searching for help about dialog boxes, menu items or subject areas. In the example below, 
using the key words "Setting up spreadsheets" would not bring up the desired topics. 
To search for information about formatting spreadsheets:

1. With a Help window active, press "s" or click the Search Help button.
2. Type "spr" in the Search box. A list of topics appears in the Show Topics list box of the 

Search dialog box, including "spreadsheet." 
3. Press Enter with the term "spreadsheet" highlighted in the Show Topics list box. The 

topic "Format your spreadsheets" appears in the Go To list box.
4. Double-click the topic title "Format your spreadsheets." The list of topics for that area 

appears for you to choose from.
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Keeping Help on top
By default, Online Help windows remain open but drop out of sight when you activate 
another window. Sometimes, however, you may find it useful to keep Help windows visible 
while you work---the smaller secondary windows containing procedures are particularly 
useful this way. (Application menus will still appear on top of your Help window when called 
using speed keys.)
To keep a Help window on top:

1. Click the Help from Help Menu Bar in any main Help window.
2. Choose Always on Top.

This causes both main and secondary windows to remain on top. Resize as required.
Notes: You may toggle the On Top command on and off, and minimize on-top Help 

windows to icons. 
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Using secondary windows
Secondary Online Help windows, the smaller windows that appear when you click a 
procedural topic title in a Help contents listing, display concise step-by-step Help 
information. Secondary windows are useful because they cover a smaller portion of the 
active application window than main Help windows. And because they stay on top, 
secondary windows make it easier to carry out a procedure and view its Help topic at the 
same time without switching back and forth between windows.
Always on top: CorelCHART's secondary Help windows differ from main Help windows in 
that they are programmed to remain on top of your current application window until you 
need to close or minimize them. 
The following limitations apply to secondary windows:
Search: Help topics shown in secondary windows cannot be coded for search keywords. If 
you use Help's Search function for a topic in a secondary window, Help takes you to a main 
menu which will include the topics you are looking for.
Sizing: Unlike other window types in the Windows Operating System, secondary windows do
not "remember" when you change their default size and position. 
To resize a secondary window and retain that size for subsequent topics viewed during the 
current CorelCHART session, minimize the window rather than closing it when finished. The 
next time you open a topic held in a secondary window it will appear in the size and location 
you set for the minimized window.
The Buttons: Secondary window buttons cannot at this time be programmed for underlined
characters which "press the button" when you press the underlined letter on the keyboard; 
they must be clicked with the mouse pointer. Secondary windows also cannot include 
browse buttons.
Note:    Basics and How to... procedures which appear in secondary Help windows contain 
a special button which reopens their contents screens in the main Help window. Click the 
Basics button in Basics secondary windows to reopen the Basics contents screen in the main
Help window, and click the How to... button in How to... secondary windows to reopen the 
How to... contents in the main Help window.



Using speed keys
Speed keys, also known as hot keys, are keys that when pressed in combination execute 
menu commands. Some people prefer to use speed keys rather than reach away from the 
keyboard for the mouse and click two or more menu items or a tool button. 
To carry out a command using combination speed keys, such as Ctrl+Tab:

1. Press and hold down the first key, e.g., Ctrl.
2. Press and release the second key, e.g., Tab.
3. Release the Ctrl key. 
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Opening Data Manager first
1. Choose New from the File Menu.
2. Choose any chart type from the Gallery list.
3. Turn off Use Sample Data and click OK. 

A blank Data Manager spreadsheet will appear, but no chart will display in Chart View 
until you enter and tag data in a configuration matching the chart you chose from the 
Gallery.

See also How to... Use Data Manager: An Overview
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Creating a chart from sample data
Before you start, you may need to reflect on what type of chart best represents the data you
want to graph. See Choosing chart types, review the Gallery menu in Menus or browse 
through the Chart Types preview in the New chart dialog box.

1. Choose File New from the Menu Bar. The New Chart dialog box appears containing a list,
called the Gallery, of available chart types on the left and a preview box on the right.

2. Click once on the chart type name in the Gallery to see previews of the various sample 
charts for the type of chart you have highlighted. 
Below the preview window, you'll see the path and file name for the chart previewed. 
You'll also see its chart type, the required values and structure.

3. When you decide on the type of chart you want to create, choose its template by 
double-clicking its preview.



Creating a chart from sample data
Before you start, you may need to reflect on what type of chart best represents the data you
want to graph. See Choosing chart types, review the Gallery menu in Menus or browse 
through the Chart Types preview in the New chart dialog box.

1. Choose File New from the Menu Bar. The New Chart dialog box appears containing a list,
called the Gallery, of available chart types on the left and a preview box on the right.

2. Click once on the chart type name in the Gallery to see previews of the various sample 
charts for the type of chart you have highlighted. 
Below the preview window, you'll see the path and file name for the chart previewed. 
You'll also see its chart type, the required values and structure.

3. When you decide on the type of chart you want to create, choose its template by 
double-clicking its preview.



Creating a chart from your own data
The New Chart dialog box by default provides sample data when it builds charts from the 
templates, or predesigned charts, supplied with CorelCHART. Once you are familiar with the 
types of charts you want to build, you may want to build them from your own spreadsheet 
data. Review the templates for examples of how to structure your data if you encounter 
difficulties.
To create a new chart from your own data:

1. Choose File New from the Chart View File Menu.
2. Choose a chart type and click the Sample Data toggle to turn it off and click OK. A blank 

Data Manager spreadsheet appears.
3. Enter or import data and text as required.
4.  Select a cell or range of cells and tag them using the drop-down Tag list to the right of 

the Autoscan button.

5. Click Autoscan and go to Chart View by clicking  to see your results.
See also Choosing chart types, Cell     Smarts:    Moving around a spreadsheet  , The Right 
Mouse Button ... in a spreadsheet and The Right Mouse Button ... in columns and rows
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Choosing tools
If you wish, you can detach and reshape CorelCHART's Toolbox and move it to another part 
of the screen. The next to time you open CorelCHART, the Toolbox will be where you last left 
it.
To enable a tool:

· Click the tool's icon, or symbol.
The CorelCHART tools listed below have flyouts, panels that "fly out" when you click and hold
your mouse pointer on the object for a moment. Clicking the tool's flyout panels will activate
additional functions or open dialog boxes.

    Pencil tool

    Outline tool

    Fill tool

    Zoom tool
See also Chart View Tools and Ribbon Bars
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Opening a CorelCHART file
Use File Open to gain access to your edited charts.
To open a CorelCHART file:

1. Choose File from the Menu Bar, then click Open.
2. Find your CorelCHART file (.cch) in the Open Chart dialog box.
3. Click the file name once for a preview and twice to open the file.

Tip: For files you open frequently, setting up file icons will help speed up your work. 
See Creating file icons
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Saving a new chart
The first time you save a new chart file, the Save Chart dialog box appears, prompting you 
to give your chart a file name.
To save a new file:

1. Choose File from the Menu Bar, then click Save from the File menu.
2. Type a file name of eight characters or less in the File Name text box. CorelCHART will 

append a .cch extension for you, designating your file as a CorelCHART file.
Note:
The Save Presentation Exchange Data option, if enabled, appends information to the 
saved file allowing it to be opened in any Corel application.
Files saved in the current version of CorelCHART cannot be opened in earlier versions of the 
program.
CorelCHART's File Open command by default looks for .cch files only. The .cch extension 
reduces the length of file lists you must look through for your file and distinguishes it from 
other file types. 



Saving a new chart
The first time you save a new chart file, using the Save command, the Save Chart dialog box
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Note:
The Save Presentation Exchange Data option, if enabled, appends information to the 
saved file allowing it to be opened in any Corel application.
Files saved in the current version of CorelCHART cannot be opened in earlier versions of the 
program.



Saving an existing chart with a new name or in a new location
To change the name of an existing chart or save it to a different drive or directory, you must 
use teh Save As command.
To save an existing chart with a new name or in a new location:

1. Choose File from the Menu Bar, then click Save As from the File menu.
2. In the Save Chart dialog box, choose the drive and directory you want to save the chart 

to.
3. The current name of the chart appears in the File Name box.    Overwrite it or append to 

it if you want to change the chart's name. CorelCHART appends a .cch extension to the 
file name, designating it as a CorelCHART file.
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Using menus
Like other menu-driven software, CorelCHART's graphical user interface features drop-down 
Menus attached to the Menu Bar, located at the top of your screen. These menus make your 
work easier.
To activate a menu:

· Click once on the Menu Bar item you want to select at the top of the CorelCHART screen.
If you release the mouse button after clicking, the selected menu will drop down and 
stay open until you click the function you want to use.
See also Chart View Shortcuts, Data Manager Shortcuts and CorelCHART     roll-ups  
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CorelCHART Roll-ups
Roll-up windows contain many of the controls found in dialog boxes: command buttons, text 
boxes, drop-down list boxes and so on. But unlike most dialog boxes, the window stays open 
after you apply the selected options. This lets you makes adjustments and experiment with 
different options without having to continually re-open a dialog box. When you are not using 
a window, you can hide the controls leaving just the Title bar visible.
CorelCHART features five roll-up windows; for a brief description of each, click its name 
below. 

3D     Roll-up  
Fill     Roll-up  
Mosaic Roll-up
Pen Rollup
Pictograph     Roll-up  

See also How to... Use Roll-up windows, Chart View Tools, Data Manager Tools, Chart View 
Menus and Data Manager Menus



CorelCHART Roll-ups
Roll-up windows contain many of the controls found in dialog boxes: command buttons, text 
boxes, drop-down list boxes and so on. But unlike most dialog boxes, the window stays open 
after you apply the selected options. This lets you makes adjustments and experiment with 
different options without having to continually re-open a dialog box. When you are not using 
a window, you can hide the controls leaving just the Title bar visible.
CorelCHART features five roll-up windows; for a brief description of each, click its name 
below. 

3D     Roll-up  
Fill     Roll-up  
Mosaic Roll-up
Pen Rollup
Pictograph     Roll-up  

See also How to... Use Roll-up windows Chart View Tools, Data Manager Tools, Chart View 
Menus and Data Manager Menus



Switching to Data Manager
CorelCHART's Data Manager is a fully-functioning spreadsheet program. You may use 
Data Manager simply to hold the text and data you need to create your charts, or to create 
spreadsheet presentations to be used on their own.
To switch to Data Manager:

· Click  at the left side of Chart View Text Ribbon Bar.



Switching between Chart View and Data Manager
You may use CorelCHART's Data Manager simply to hold the text and data you need to 
create your charts, or to design spreadsheet presentations to be used on their own.
To switch to Data Manager:

· Click  at the top left-hand corner of the Chart View screen.
To switch back to Chart View:

· Click  at the top left-hand corner of the Data Manager screen.
Tip: After you have switched to Data Manager once as decribed above, use Ctrl+tab to

toggle between screens.



Starting and exiting CorelCHART
Starting CorelCHART:

· Double click the CorelCHART icon in the Windows Program Manager. The CorelCHART 
logo screen will appear, followed by a blank CorelCHART drawing window with only the 
File and Help menus available. The rest of the menus and the toolbox are dimmed and 
inaccessible until you have opened or created a chart.

Exiting CorelCHART:
· Choose File from the Menu Bar and click Exit.
Note: If you choose File Exit when there are unsaved changes in Chart View or a Data 

Manager spreadsheet, the Save Changes prompt will appear.



Starting and exiting CorelCHART
Starting CorelCHART:

· Double click the CorelCHART icon in the Windows Program Manager. The CorelCHART 
logo screen will appear, followed by a blank CorelCHART drawing window with only the 
File and Help menus available. The rest of the menus and the toolbox are dimmed and 
inaccessible until you have opened or created a chart.

Exiting CorelCHART:
· Choose File from the Menu Bar and click Exit.
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Working with dialog boxes
Dialog boxes are small boxes which "invite dialog." They appear when CorelCHART requires 
more information to complete a tool or menu task. Menu items which call up dialog boxes 
are followed by ellipses "..."
To carry out dialog box commands:

1. Enter text into text boxes within dialog boxes as required.
2. Using the mouse, click the dialog button you want to activate, such as OK or CANCEL.

Tip: Press the TAB and SHIFT+TAB buttons to move forward and back between areas of a 
dialog box. See also Chart View Shortcuts and Data Manager Shortcuts
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Dragging and dropping files
Drag and drop offers a quick and visual new way to open files. 
To open a chart using drag and drop:

1. Tile any open charts in the charting window and your file manager window.
NB: The charting window's empty background area must be visible--not the 
white background of an individual chart. Click the individual chart's Restore 
button to reduce as required.

2. Click and hold down the mouse pointer on the .CCH file in your Windows file 
manager.

3. Drag the file into Chart View and release the button when the pointer is at the 
location where you want the file to appear.
The new file's tiled document window will appear where you have "dropped" it in 
the charting window.

Note: If you already have a file open, make sure you drop the new file into the white 
background area of the charting window. If you drop it onto an open chart, the template but 
not the data from the new chart will be applied to the open chart.
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Ribbon Bars
CorelCHART's Ribbon Bars, sometimes called button bars, are located just under the Chart 
View and Data Manager Menu Bars. Clicking a button on a Ribbon Bar activates the 
command associated with it. Hold the mouse pointer over a button to see its name or right-
click for Context-sensitive Help.
The Chart View Ribbon Bar, contains the following buttons (from left): New, Open, Save, 
Print, Cut, Copy and Paste, Import and Export, Display Status, Legend, Numeric Format, Data
Analysis, Align, 3D Rollup, Copy Chart, Wireframe and Mosaic Rollup.
The Data Manager's Ribbon Bar includes (from left) New, Open, Save, Print, Cut, Copy and 
Paste, Import and Export, Set Page Break, Number Format, Borders, Patterns, Go to cell, 
Enter Formula Sort, Auto Recalculate, Grid Lines and Mosaic Rollup.
See also Chart View Tools and Ribbon Bars and Data Manager Ribbon Bars



Text Ribbon Bars
CorelCHART's Text Ribbon Bars, which include buttons and drop-down list boxes for setting 
text attributes such as font type and size selection, bold, underline, italic, alignment, inter-
character and inter-line spacing, are located just under the Chart View and Data Manager 
Ribbon Bars. Clicking Text Ribbon Bar button activates the command associated with it. Hold
the mouse pointer over a Text Ribbon button or list box to see its name or right-click for 
Context-sensitive Help.
See also Chart View Tools and Ribbon Bars and Data Manager Ribbon Bars



Help shortcuts
Press the key or keys on the left to produce the action described at right.

 Key(s) Result
F1 Displays the main CorelCHART Help Contents screen
F1-F1 Pressing F1 from within any Help window displays the Microsoft 

Windows Using Windows Help topics. 
F1 (in a given context) With a menu item selected or a dialog box or system message 

on screen, displays context sensitive Help (where available)

SHIFT+F1 Changes the pointer to  so that you can get Help on a specific 
command, screen region, or key. You can then choose a command, 
click the screen region, or press a key or key combination you want to 
know more about.

CTRL+F1 Opens Help's Search dialog box
CTRL+HOME Moves to top of the Help topic
CTRL+END Moves to the bottom of the Help topic
> Moves to the next topic 
< Moves to the previous topic
Note: As an alternative to clicking with the mouse, you may also use the keyboard to press 

Help buttons. Simply type a Help button's underlined letter to execute its function. 
E.g., to press the    Back button, press "b" on the keyboard; to press the Close button, 
press "c," and so on.





 CorelCHART Help Contents
CorelCHART features two principal tools to help you create impressive charts and 
spreadsheets--the chart-building screen, called Chart View, and a spreadsheet program 
called the Data Manager. 

            Using Corel Online Help
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Chart View Menus

A context sensitive pop-up menu appears in Chart View when an object is clicked with the 
right or secondary mouse button. See Chart View pop-up menu for an overview.
See also Data Manager menus



Data Manager Menus

A context sensitive pop-up menu appears in Data Manager when an object is clicked with the
right or secondary mouse button. See Data Manager pop-up menu for detailed information.
See also Chart View menus









Chart menu
The Chart menu varies depending on the type of chart in use. 
Choose a chart type from the list below to view the accompanying Chart menu.









Chart View pop-up menu

 A pop-up menu, like the one represented here, appears when you click any object in your 
chart with the right mouse button.

The pop-up menu has a title bar that describes the object you clicked to open it. If no menu 
commands are available for the selected object, only the title bar appears in the pop-up.

The pop-up menu is context sensitive--it lists menu commands that are available to modify 
the selected object or perform an operation which involves the object.    Most of the listed 
commands are also found in the Chart menu in Chart View or appear in flyout menus that 
appear when a command is clicked.















 





Chart View screen
Click a screen object for more information. See also Data Manager screen



Data Manager screen
Click a screen object for more information. See also Chart View screen



Data Manager pop-up menu
A pop-up menu appears when you click anywhere in a Data Manager spreadsheet with the 
right mouse button.    The pop-up menu is context sensitive--it lists menu commands 
available to modify the selected cell or object or perform an operation which involves the 
cell.
There are four different pop-up menus in Data Manager. Select an object below to see the 
pop-up menu that appears if you click the right mouse button on that object.

Cell
Row number or column letter
OLE object
Formula bar



Data Manager pop-up menu (Cell)
This pop-up menu appears when you click a cell in Data Manager with the right mouse 
button. Some commands are dimmed (i.e., unavailable) when you click an empty cell. 

Click a command for information on how it works.



Data Manager pop-up menu (Row or Column header)
This pop-up menu appears when you click a row number or column letter in your 
spreadsheet. Click a command for information on how it works.



Column width/Row height
The command name that appears in the Data Manager pop-up menu depends on the object 
you clicked in your spreadsheet, or row or column button. See the appropriate command 
according to the element you clicked:
Row Height (Format menu)
Column Width (Format menu)



Pop-up menu for OLE objects in Data Manager
This pop-up menu appears when you click a linked or embedded object (OLE object) in your 
spreadsheet. Note that the Edit Object command displays the OLE server application name 
in the menu. Click a command for information on how it works.



Edit OLE object command (Data Manager pop-up menu)
This command appears in the pop-up menu in Data Manager when you click an OLE object 
with the right mouse button.    In the menu, the OLE server application name appears.

When you click this command, the application in which the OLE object was created is 
launched provided it is installed on the computer you are using. The object appears in the 
application ready to be edited. When you choose Exit from the application's File menu, 
CorelCHART Data Manager appears and the OLE object is updated.



Data Manager pop-up menu (Formula bar)
This pop-up menu appears when you click the Formula bar in Data Manager. For the pop-up 
to appear, the editing cursor (blinking I-bar) must be active in the formula bar. Click a 
command for information on how it works.



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
3D charts
3D Connect Group chart
3D Connect Series chart
3D Floating chart
3D Riser
3D Riser chart
3D     Roll-up  
3D Scatter chart
3D Surface chart
Absolute Reference
Angle (screen)
Annotations
Area
Argument
Ascending Scale
ASCII
Aspect Ratio
Attached
Autofit Text
Autoscan
Axis Gridlines
Axis
Axis Riser Grid Lines
Axis Text

 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Bar
Basis
BiPolar Line
Bitmap
Bitmap pattern
Bitmap texture
Brightness
Bubble chart

 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Category
Calibration bar
Category
Category Axis
Category Axis Grid Lines
Category Axis Title
Category Header



Cell
Cell addresses
Chart objects
Charting Area
Charting window
Chart View
Check box
Chokes
Client (OLE)
CMYK
Combination charts
Color separations
Column Buttons
Column Header Area
Column Header Labels
Constrain
Connected Line
CorelCHART Roll-ups
CORELCHT.INI
CorelTRACE
Crop Mark
Curve Fit Correlation Coefficient



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Data Axis Major Grid Lines
Data Axis Minor Grid Lines
Data cell
Data Manager
Data Range
DDE
Densitometer Scale
Descending Scale
Deselect
Directory
Dithered color
Dithering
Double click
DPI
Drag and Drop
Drive
Dynamic Data Exchange (DDE)



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Editable Preview
Ellipse tool
Embedded object
Emulsion
Error values
Exponential Regression Line
Export
Expression



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Fibonacci
Fill     Roll-up  
Fill tool
Film recorder
Filter
Financial Moving Average
Font
Footer
Footnote
Formula (Reg. Line Label)
Formula
Formula label
Formula bar
Fountain Fill
Four-color process
Frequency (screen)
Full Color Pattern
Functions

 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Gamut
Gamut mapping
Gantt Charts
Grid Lines
Group



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Halftone Screen
Handle
Header
Header (spreadsheet)
Headers (Category Axis)
Headers (2nd Category Axis)
High-Low-Open-Close Charts
Highlighting box
Histogram
Horizontal area Charts
Horizontal bar Charts
Horizontal line Charts
Horizontal area Charts
Hotel text
HSB
Hue



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Image header
Image setter
In-cell editing
Integers
Inter-character spacing
Inter-line spacing
Irrational numbers



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Least squares approximation
Left Title
Left Wall
Left Z-Axis Scale
Linear Regression 
Linked object
List
Logarithmic Regression Line



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Maximize button
Mean/Average Line
Menu bar
Minimize button
Mixed Reference
Moiré pattern
Mosaic Roll-up
Mouse button (right)
Moving Average Line
Moving Average (Financial)
Multiple Select



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Natural Logarithmic Regression
Non-Numeric Axis
Numeric Axis



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Object Linking and Embedding (OLE)
OLE client application
OLE server application
On-screen Color Palette
Operators
Order box
Outline tool



 Glossary
A B C D E F G H I J K L M N O P O R S T U V W X Y Z 
Palette
PANTONE Spot Colors
Path
Pen Roll-up
Pencil tool
Pick tool
Pictograph
Pictograph     Roll-up  
Pie charts
Point Size
Polar Charts
Polygon
Polynomial Regression Line
Pop-up Menu
PostScript
Power Law Regression
Printable Page
Printers' references
Process Color
Pure color



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Radar Charts
Rational Numbers
Real Numbers
Rectangle Tool
Registration Marks
Relative Reference
Resolution
RGB
Ribbon Bar
Right mouse button
Right Title
Right Wall
Risers
Riser Bar
Roll-up windows
Row Header Area
Row Buttons
Row Header Labels
Row Title Area
Row Title Label



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Saturation
Scale
Scanner
Scatter Charts
Scatter Label (3D)
Scatter Line
Scatter Marker
Scientific Moving Average
Screen
Screen angle
Screen frequency
Scroll bars
Second Category Axis
Second Category Axis Title
Separators
Serial date values
Series
Series Header
Series Title
Server
Service Bureau
Show Correlation Coefficient
Smooth Box
Smooth Curve
Spectrally-mapped Chartss
Spot color
Spread
Spreadsheet
Spreadsheet error values
Spreadsheet Functions
Staggered Text
Standard Deviation Line



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Table
Template
Text Ribbon Bar
Text tool
Three-D charts
Three-D Connect Group chart
Three-D Connect Series chart
Three-D Floating chart
Three-D Riser chart
Three-D Riser
Three-D Roll-up
Three-D Scatter chart
Three-D Surface chart
Tick Mark
Title Bar
Title
Toggle
Toolbox
TRUMATCH
Two-Color Pattern



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Values
Vertical area Charts
Vertical bar Charts
Vertical line Charts



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Whole numbers
Window
Window border
Wireframe



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
X-axis (2D Scatter chart, Spectral chart)
X-axis title



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Y-Axis Scale
Y-Axis Title
Y-Axis Line
2nd Y-Axis Title
2nd Y-Axis Scale



 Glossary
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
Z-Axis Title (Right)
Z-Axis Scale (Right)
Z-Axis Scale (Left)
Z-Axis Title (Left)
Zero Line
Zoom tool



CMYK
The four letters represent Cyan, Magenta, Yellow, and Black, the ink colors used in four-color 
process printing. CorelCHART enables you to specify colors using CMYK values.



HSB
The initial letters in Hue, Saturation and Brightness are the components in the HSB color 
model. HSB is one of three color models CorelCHART provides for creating process colors.



RGB
The initial letters in Red, Green and Blue, the component colors in one of three color models 
CorelCHART provides for creating Process colors.



Brightness
In the HSB color model, the component that determines the amount of black in a color where
0% is black and 100% is white. See also Hue and Saturation.



Hue
In the HSB color model, hue is the main attribute in a color that distinguishes it from other 
colors. Blue, green and red, for example, are all hues. See also Saturation and Brightness.



Saturation
In the HSB color model, the component that determines the purity or intensity of a color. See
also Hue and Brightness.



Spot color
In offset printing, solid colors commonly specified using the PANTONE color matching 
system. Spot color is used whenever exact colors are required. CorelCHART also uses the 
PANTONE system to specify spot colors.



Process color
The primary colors used in four-color process printing: Cyan, Magenta, Yellow and Black. See 
also Four-color process.



Four-color process
Reproducing color artwork using four separate sheets of film, which represent the Cyan, 
Magenta, Yellow and Black content of the artwork.



PANTONE Spot Colors
A standard color matching system in which solid (spot) colors are specified using color 
sample books. You can use this system in CorelCHART to specify colors.
PANTONE also has a similar system for specifying process colors. It too, is available in 
CorelCHART.



Pictograph
A pictograph is a symbol or image, used to fill bar risers in a chart. Any file saved in a 
supported file format can be imported and used as a pictograph. This conveys your chart's 
message in a fast and visual fashion. Pictographs can only be used in horizontal and vertical 
bar charts and histograms. 



TRUMATCH
A color matching system for specifying process colors. You can use this system in 
CorelCHART to specify colors.



Crop Mark
Alignment marks at the corners of a page printed on a PostScript printer. Used as aids for 
trimming the paper to the proper size. Crop marks are turned on in the Print Options dialog 
box and appear only when the page size in CorelCHART is smaller than the paper size of the 
printer.



Combination charts
Combination charts include a mix of bar and line risers. Use combination charts to 
emphasize one data series over others. Note: Stacked Bar and Stacked Line charts cannot 
be used in combination charts because the risers are subdivided.
See also Making combination charts



Calibration Bar
Strips of color and gray printed with an illustration. Used as a reference for calibrating a 
monitor so that is displays colors as they appear in the printed output.



Curve Fit Correlation Coefficient
CorelCHART will calculate how closely a curve fit line intersects with the data points it is 
charting. The number will be between zero and one; one is a perfect fit, zero is a poor fit.



Film Recorder
Device that reproduces images from a computer screen on film. The film can then be 
developed into slides or prints using conventional photographic processes. CorelCHART can 
export files for use by film recorders that accept files in SCODL format.



Color separation
The process of separating the colors in an image into the primary printing colors: cyan, 
magenta, yellow and black.



Choke
Type of trap created by extending a background object into a foreground object. CorelCHART
provides an Overprint feature that enables you to create chokes. See also Spreads



Registration Marks
Crosshairs or other marks on paper or film used for aligning color separations. CorelCHART 
automatically adds registration marks when printing color separations to a PostScript printer.



Autoscan
Data Manager feature used to automatically scan your spreadsheet and apply appropriate 
tags to the cells according to the data sample layout. You can also "tag" or label your 
spreadsheet data manually. See also How to... Use Data Manager: An Overview 



Halftone screen
In photography, a sheet of glass or film with a grid pattern of lines used to convert a 
continuous tone image into dots of various sizes. In CorelCHART, halftone screens are 
specified by choosing PostScript from the Outline Color, Uniform Fill or Fountain Fill dialog 
boxes.



Directory
A directory is part of a structure used to organize files on a disk like a drawer in a filing 
cabinet. Directories have names and can be divided into subdirectories. For example, you 
could create a directory called LOGOS for storing logo designs.



Drive
A device in a computer that spins disks used to store information. Personal computers 
normally have a fixed disk drive labeled C and one or two floppy disk drives labeled A and B.



Full Color pattern
Fill composed of repeating vector images. CorelCHART supplies a collection of vector 
patterns to which you can add your own.



Two-Color pattern
Fill composed of repeating bitmap images. CorelCHART supplies a collection of bitmap 
patterns to which you can add your own. 



Bitmap texture
Variable fills that look like clouds, water, gravel, minerals and dozens of other natural and 
man-made substances. Bitmap textures display on your screen and print to any printer.



Smooth Curve
A curved line that is drawn through or near each data point in a series. A smooth curve is 
created as a line connecting points that have been evenly distributed between data points. 
The more points added, the smoother the curve. Point are added using the Smooth Factor 
box.



Smooth Factor box
To control smoothness, type in the number of points in the Smooth Factor text box. The 
higher the number, the smoother the curve (but the longer it may take to draw).



Bipolar Line
A horizontal line that goes through the center of a dual-axis chart, separating the chart into 
an upper half and a lower half. This allows charting of different data series on either side of 
the line.



Exponential Regression

A least squares approximation line of the form  for a selected series.



Power Law Regression 
A line that fits the data points in accordance with the power law regression formula

 
. This curved line is a least squares approximation of data for a selected series.



Natural Logarithmic Regression
A line that fits the data points in accordance with the natural log regression formula y = 
a(lnx) + b. This curved line is a least squares approximation of data for a selected series.



Polynomial Regression line
A line that curve fits to the data points following the polynomial regression formula: y = a0 +
a1x + a2x  + ... + anx
 where n = the order of the polynomial. Note that the order "0" draws a line at the mean of 

the data. This curved line is a least squares approximation of data for a selected series.



Pop-up menu
Pop-up menus give you quick access to many menu commands. Pop-up menus appear when
you click a chart object or a spreadsheet cell with the right mouse button. See also Right 
mouse button



PostScript
A page description language or protocol by which programs describe text and graphics they 
want the printer to output. Several features in CorelCHART require the use of a PostScript 
printer.



Printable Page
The rectangular area with the drop shadow containing your chart. The Printable Page 
appears inside the CorelCHART Charting Window. You can adjust the printable page settings 
using the Page Setup command in the Chart View File menu. 
In Data Manager, the printable page is the section of the spreadsheet which prints on a 
single sheet of paper. You can insert manual page breaks to choose the end of a page, and 
set other options using the Set Page Break and Page Settings commands in the Format 
menu. To preview the printable page(s) of your spreadsheet before printing, use the Print 
Preview command in the File menu. 



Header (spreadsheet)
A text string that appears at the top of every printed page of a Data Manager spreadsheet. 
The header can be any user-defined text string, the file name, the page number, the 
computer's date or time.    Spreadsheet headers are assigned using the Page Setup 
command.



Footer (spreadsheet)
A text string that appears at the bottom of every printed page of a Data Manager 
spreadsheet. The footer can be any user-defined text string, the file name, the page number,
the computer's date or time.    Spreadsheet footers are assigned using the Page Setup 
command.



Rectangle tool
Found in the Toolbox, the Rectangle tool is used to draw rectangles and squares to enhance 
CorelCHART annotations.



Mean
A horizontal or vertical line drawn at the mean of the data points. 
The "mean" equals the sum of the values divided by the number of values (e.g. [P1 + P2 + 
P3] / 3 ).



Moiré Pattern
Undesirable wave pattern in an image printed from color separations with incorrect halftone 
screen angles.



Moving Average 
A line drawn at the moving average of the data points. You must specify whether the 
average is Financial or Scientific and enter the number of periods used to calculate each 
moving average point in the Order box. 
By using moving averages (with the appropriate number of periods), you can eliminate 
cyclical, seasonal, or irregular patterns, and thus clearly see the moving trend. 
Unfortunately, you lose data at both ends of the series, and the program may calculate 
cycles or movements not present in the original data. Also, moving averages are easily 
affected by extreme values.



Financial Moving Average
A line drawn at the moving average of the data points. In the Data Analysis dialog box, you 
must enter, in the Order box the number of periods used to calculate each moving average 
point. 
By using moving averages (with the appropriate number of periods), you can eliminate 
cyclical, seasonal, or irregular patterns, and thus clearly see the moving trend. 
Unfortunately, you lose data at both ends of the series, and the program may calculate 
cycles or movements not present in the original data. Also, moving averages are easily 
affected by extreme values.



Scientific Moving Average 
A line drawn at the moving average of the data points. You must enter, in the Order box, the 
number of periods used to calculate each moving average point. 
By using moving averages (with the appropriate number of periods), you can eliminate 
cyclical, seasonal, or irregular patterns, and thus clearly see the moving trend. 
Unfortunately, you lose data at both ends of the series, and the program may calculate 
cycles or movements not present in the original data. Also, moving averages are easily 
affected by extreme values.



Category Axis Grid Lines
Grid lines cross the chart along the category axis perpendicular to the axis line. (For 
example, if the category axis line is the bottom of the chart, the grid lines run vertically.) 
Since the category axis is non-numeric, tick marks are not an option and there are no minor 
grid lines.



Headers (Second Category Axis)
Labels on the second category axis that describe the charted data. Headers are attached to 
the axis; they cannot be moved independently of the axis. 



Headers (Category Axis)
Labels on the category axis that describe the charted data. 
Headers are attached to the axis; they can not be moved independently of the axis. 



Second Category Axis Title
A label that describes the second category axis.
This title is entered in a Data Manager cell that you set as Second Category Axis Title. To edit
the title, return to the Data Manager, select the cell, press F2 and change it in the Tag list 
box.



Service Bureau
A commercial business that prints customer-provided artwork and documents, usually on 
high-resolution PostScript devices.



Spread
A type of trap created by extending a foreground object into a background object. 
CorelCHART provides an Overprint feature that enables you to create spreads and an Auto 
trapping feature that creates them    automatically. See also Chokes.



Riser Bar
A bar on a 2D bar chart that represents the data; risers ascend from a group axis or zero line
to a data point.



Standard Deviation
Shown by horizontal or vertical lines drawn at each standard deviation distance from the 
mean line along the numeric axis. CorelCHART determines this distance and makes it the 
interval for drawing lines above and below the mean line (visible or hidden).
For instance, if the mean = 100 and the standard deviation = 6, the first range of deviation 
will draw lines at 106 (100 + 6) and 94 (100    6). The second range will draw lines at 112 
and 88. The program will draw these pairs of lines until it runs out of room in the Charting 
Area.
In most cases, 66% of the data points will fall between the first two lines (the first range). 
The second range will contain 95% of the points. The third will contain about 99% of the 
points. 



Y Axis 
The vertical, axis line on XY scatter, high-low-close, spectral map charts and histograms. The
Y axis is numeric and has a scale associated with it rather than headers.
To control where the axis and its scale display, choose Chart, Y Axis. On the flyout menu, 
choose Display on Left (the default location), Display on Right, both, or neither.
Choose Chart, Y Axis to change the data axis's scale and grid lines. Since major grid lines 
align with numbers on the numeric scale, specifying the number of major grid-line divisions 
will affect the number of scale divisions.



Connected Line
A straight line connecting the data values of bar risers in a selected group.



Second Y Axis
The axis line on XY scatter charts or dual-axis bar, line or area charts. The second Y axis 
measures a different quantity than the first Y axis. Because it's numeric; it has a scale 
attached to it rather than headers.
Location of the second Y axis line (Chart menu: Second Y Axis):
To control where the axis and its scale display, choose Chart, Y Axis. On the flyout menu, 
choose Display on Left, Display on Right, both, or neither. (You can't show both the first and 
second Y axes on the same side of the Charting Area.)
Grid lines and Scale:
Choose Chart, Second Y Axis to change the second Y axis scale and grid lines. Since major 
grid lines align with numbers on the numeric scale, specifying the number of major grid-line 
divisions will affect the number of scale divisions.
To show or hide the second Y axis line:
Method 1: Show or hide axis line and scale

· Choose Chart, Display Status to open the Display Status dialog box.
· To show the axis or scale, click Second Y Axis & Scale. An x indicates that the axis line 

and its scale will show (at the default location on the left side of the chart).
· To hide the axis or scale,    click off the Second Y Axis & Scale check box.

Method 2: Make axis line transparent (axis line only):
· Select the axis line.
· Make it transparent by clicking the X, or transparent tile on the Outline tool's flyout.
· To restore the line, click in the area where it is. (If you've just made it transparent, 

choose Edit, Undo.) When its handles appear, choose a color from the on-screen color 
palette or the color dialog box, accessed by clicking the first tile on the top row of the 
Outline tool's flyout.



Second Y Axis Scale
The scale attached to the 2nd Y axis line.
Choose Chart, 2nd Y axis to change the following:

· Location of 2nd Y axis scale. The scale is attached to the axis; choose Display on Right 
(the common location) and/or Display on Left, or neither.

To show/hide the 2nd Y axis scale and its axis line:
1. Choose Chart, Display Status. 
2. Click the 2nd Y Axis & Scale check box. 

To hide the scale and axis:
· In the Display Status dialog box, click 2nd Y axis & Scale again.



Second Y Axis Title
A label that describes the 2nd Y axis. The axis title can be moved anywhere on the chart, but
it should be located near the axis it describes.
To create and edit the 2nd Y axis title:
This title is entered in a Data Manager cell tagged as 2nd Y axis Title. To edit the title, return 
to the Data Manager, select the cell, press F2 and change it in the contents box. To see in 
Data Manager which cell has been tagged as the title, scroll through the cells while watching
the chart elements list at the top of the Data Manager window. You'll see the cell's tag in the 
box.
To show/hide the 2nd Y axis title:
Choose Chart, Display Status. In the Display Status dialog box, click the 2nd Y Axis Title 
check box.



Data Axis Major Grid Lines
Grid lines that split up the data axis into equal divisions. "Major grid lines" can cross the 
whole chart, be just tick marks on the edge of the Charting Area, or both.
To set the number of major divisions: 

· Choose Chart, Data Axis, and choose one of these options:
Automatic: Let CorelCHART automatically divide the chart with grid lines.
Manual: Specify the number of divisions, entering a number in the No. of Divisions text 
box.

To show or hide major grid lines:
Choose Chart, Data Axis. On the flyout menu, choose Grid Lines. In the Grid Lines dialog box,
click the Major Grids check box. Choose grid lines or tick marks, or hide the lines by clicking 
No Grids.



Data Axis Minor Grid Lines
Grid lines placed between data axis major grid lines to offer more precise measurement. 
"Minor grids" can cross the whole chart, be tick marks on the axis line, or both.
To set the number of minor divisions (grid lines):

· Select "Grid Lines" (Chart menu: Data Axis) and choose one of the following:
Auto: Let Chart automatically divide the chart with grid lines.
Manual: Specify the number of divisions, entering a number in the Number    of 
Divisions" text box.

To show or hide major grid lines:
Choose Chart, Data Axis. On the flyout menu, choose Grid Lines. In the Grid Lines dialog box,
click Major Grids, choose grid lines or tick marks, or hide the lines by clicking No Grids.



Scatter Label (3D)
A label for a data point on an XYZ (3D) scatter chart.
To create or edit a scatter label:
These labels must be created, tagged and edited in Data Manager. Depending on how the 
data is arranged, the fourth row or column holds the label text. For instance, if the data is 
arranged by columns (column 1 holds X values, Column 2 holds Y values, column 3 holds Z 
values), then column 4 holds the labels. 
If no labels have been tagged, make sure the labels have been entered in the fourth column.
(If they're elsewhere in the Data Manager spreadsheet, you must cut and paste them as the 
fourth column of the data range by clicking and dragging to select the cells and choosing 
Edit, Cut and Edit, Paste. If they're not in the matrix at all, you must enter them as the fourth
column of the data range by clicking the first cell and typing, then using the cursor key to 
move to the next cell.) Then select the entire data range, click the scroll arrow on the chart 
elements drop-down list at the top of the Data Manager window, and click Data Range.
Once the labels have been tagged in the Data Manager, go to Chart View. Choose Chart, 
Display Status, and click the Data Labels check box.



Scatter Marker
Marker for a data point on a scatter chart.
Scatter markers are areas which accept colors and effects. The marker has a fill and outline; 
you can color each separately, and change the width of the outline using the Outline tool. 
You can also control the size and shape of color data-point markers by choosing Chart, Data 
Point Size and Chart, Data Point shape, respectively, and choosing an option from the flyout 
menus.



Axis Gridlines (3D charts)
There are three axes in a 3D chart. Each one can have a set of grid lines. Series grid lines 
travel on the floor parallel to the left wall (along the X axis). Group grid lines travel on the 
floor parallel to the right wall (along the 2nd Y axis). Z axis grid lines are the horizontal lines 
that travel across the two walls. 



Z-Axis Scale (Left)
The Z axis is the vertical axis in 3D charts. The numbers (or data-based text such as time 
periods) set at regular intervals along the end of the left wall comprise the left Z axis scale.
The Z axis scale can be modified by choosing Chart, Vertical (Z) Axis. 
To show or hide the left Z axis scale:
Choose Chart, Display Status and click Left Z axis Scale. An x in the check box indicates that 
the scale will appear.



Z-Axis Title (Left)
One of two titles that describes the vertical Z axis. This one is placed adjacent to the left 
wall.
To create or edit a left title:
In the Data Manager, select a cell and set it as Axis Title #3, and type the title in the cell. To 
edit the title, return to the Data Manager, select the cell, press F2, and make changes in the 
contents box.
To show or hide a left title:
Choose Chart, Display Status and click Left Scale Title. An "x" in the check box indicates that
the left title will appear.



3D Riser
A bar, pyramid, or other shape that represents data by rising from the floor (or an invisible 
zero plane) to a data point on a 3D chart. Other shapes include octagonal and cut-corner 
bars.



Axis Riser Grid Lines
Grid lines on risers for any of the three axes (series, or X axis, lines parallel to the left wall, 
group, or second Y axis, lines parallel to the right wall, and Z axis lines parallel to the floor). 



Series Header
Descriptive label for a series of data on a 3D chart. Usually there is one header for each data
group. When the appearance of one series header is changed, all are changed.
To create or edit series headers:
In the Data Manager, select a cell and set it as Row Header or Column Header, depending 
which axes your groups and series are arranged on. Type the title in the cell. To edit the title,
return to the Data Manager, select the cell, press F2, and make changes in the contents box.



Series Title
The single title that describes what the series of data represent.
To create or edit a series title:
In the Data Manager, select a cell, set it as the Axis Title #1 or Axis Title #2, depending on 
which axes your groups and series are arranged on. Type the title in the cell. To edit the title,
return to the Data Manager, select the cell, press F2, and make changes in the contents box.



Z-Axis Scale (Right)
The Z axis is the vertical axis in 3D charts. The numbers (or data-based text such as time 
periods) set at regular intervals along the end of the right wall comprise the right Z axis 
scale.
The Z axis scale can be modified by choosing Chart, Vertical (Z) Axis. 
To show or hide the right Z axis scale:
Choose Chart, Display Status and click Right Z axis Scale. An x in the check box indicates 
that the scale will appear.



Z-Axis Title (Right)
One of two titles that describes the vertical Z axis; this one is placed adjacent to the right 
wall.
To create or edit a right title:
In the Data Manager, select a cell, set it as the Axis Title #4, and type the title in the cell. To 
edit the title, return to the Data Manager, select the cell, press F2, and make changes in the 
edit box.
To show/hide a right title:
Choose Chart, Display Status, and click the Axis Title #4. An x in the check box indicates 
that the right title will appear.



Scatter Line
Line that connects each succeeding point in a series in a 3D scatter chart. Each data series 
is given a separate line.



Column Header Area
The top-most row in a table chart (not including the Subject Area cell); it contains all the 
column header cells.



Column Header Labels
The text in column header cells or, in Chart View, the column header area, in a table chart.
To create column header labels:

1. Enter column headers in a row in the Data Manager.
2. Select all the cells you've just entered into.
3. Select Column Header from the chart element list box.

Column headers can be formatted using the tools on the Text Ribbon and colored using the 
on-screen color palette or the effects available through the Fill tool.



Row Header Labels
The text within row header cells in a table chart.
To create row header labels:

1. Enter row headers in a column in the Data Manager.
2. Select all the cells you've just typed into.
3. Select Row Header from the chart elements list box.

Row headers can be formatted using the tools on the Text Ribbon and colored using the on-
screen color palette or the effects available through the Fill tool.



Row Title Label
A title that describes the row headers in a table chart. The row title label is located in the 
chart's top-left cell, known as the row title area.
The row title label can be formatted using the tools on the Text Ribbon and colored using the
on-screen color palette or the effects available through the Fill tool.



Row Header Area
The left-most column in a table chart; it contains all the row header cells.
To create the row header area:

1. Enter row headers in a column in the Data Manager.
2. Select the first (top) row header.
3. From the chart elements list box, select Row Header.

The row header area accepts colors. The area has an outline; you can change its color and 
width using the Outline tool.



Row Title Area
The top-left cell on a table chart that holds the row title. The title describes the row headers 
in the cells located above the row title area.



Bar (High-Low-Open-Close Chart)
A bar on a 2D High-Low-Open-Close chart that represents the data. Depending on which 
High-Low-Open-Close chart type you choose from the Gallery, a bar riser can have two lines 
extending from it (the open and close bars). This chart type is commonly used for stock 
market prices.



Ellipse tool
You can use the Ellipse tool to create an ellipse then alter its outline characteristics with the 
Outline tool and its fill with the Fill tool. Ellipses are useful in creating annotations.



Polygon
A series of connected straight lines that form a closed shape. You can create a polygon on 
the annotation layer using the second tile on the Pencil tool flyout. You can alter its outline 
characteristics using the Outline tool, and its fill using the Fill tool.



Order box 
When setting a moving average line in the Data Analysis dialog box, determines the number 
of values to be used to calculate the moving average within a period. 
If you enter 3 in the Order box, the program averages the first 3 values (P1, P2, P3). It then 
shifts over one value to take another 3-value average (P2, P3, P4). This continues (in groups 
of 3) until it reaches the final value.



Show Correlation Coefficient
CorelCHART will figure out how closely a curve fit line intersects with the data points it is 
charting.
In the Data Analysis dialog box, choose one of the available types of regression analysis by 
clicking the check box for that analysis type. Then click Show Correlation Coefficient below 
the list of regression types. Click OK to close the dialog box and return to your chart, and 
you'll see coefficient inside the Charting Area. The number will be between zero and one; 
one is a perfect fit and zero is a poor fit. This text can be moved anywhere on the chart, but 
should be placed close to the line it describes. Only one coefficient per series can be shown. 
See also Using Data Analysis



Chart View
As part of the CorelDRAW suite of programs, CorelCHART emphasizes presentation. With 
CorelCHART, you have drawing tools, full color design and printing support and over 825 
typefaces to choose from. Available chart types include CorelCHART 4's line, bar, area and 
pie charts, histograms, scatter and 3D charts and, new in CHART 5, Bubble charts, Gantt 
charts, Polar charts and Radar charts. 
CorelCHART's charting module is referred to as Chart View, while its spreadsheet program is 
called Data Manager



Charting Area
The area bounded by the chart's axes. The data is charted within the charting area, but 
many chart objects lie outside it, including scales, axis titles, and headers. You can apply 
CorelCHART's fill colors and patterns to the Charting Area. The color and width of the 
charting area's outline can be changed using the Outline tool.



Chart objects
Chart objects, unlike annotations, are included in the chart template itself (i.e., title, subtitle,
footnote, legend, data and category labels) and cannot be deleted from the chart. They are 
instead hidden from view using the Display Status dialog box in the Chart menu. You can 
display chart objects again with the Display Status command.



Footnote
The footnote of a chart usually indicates the origin of the chart data. It is often placed near 
the bottom of the chart, and shown in a small type size. Footnote text can be formatted 
using the facilities on the on-screen text ribbon and can be hidden from view by using the 
Display Status command in the Chart menu.



Title
The title of a chart is a label that describes the chart. It's normally displayed at the top of the
chart and is usually the largest text element. Title text can be formatted using the facilities 
on the on-screen text ribbon.
To show or hide the title:
Choose Chart, Display Status. In the Display Status dialog box, click the Title check box. To 
hide the title, click the check box again.



Zero Line
The line on a chart that shows where numeric values equal zero. It serves as the base for the
risers (if they show positive values. Risers with negative values hang from the zero line.)
The zero line serves as a visual divider between positive and negative values. It crosses the 
chart like a grid line but it is not formatted like one. A zero line will show over a grid line.



Zoom tool
Located in the vertical Chart View Toolbox, the Zoom tool is used to magnify or reduce a 
section of your chart. It has a flyout menu that includes several options for controlling the 
view of your chart. See also Chart View Tools and Ribbon Bar



Category Header
The identification labels assigned to groups of data. There is usually a header for each data 
group. When the appearance of one group header is changed, all are changed. (You can use 
the Text Ribbon, or the color palette, to change any headers.) The labels usually describe 
group data, but will describe series data.
Headers are attached to the category axis and cannot be moved independently of the axis. 
To set the location of the axis and headers, choose Chart, Category Axis. On the flyout menu,
you can select Display on Bottom/Left and/or Display on Top/Right (or neither).
To create category headers:

1. Enter category axis headers in a column in the Data Manager.
2. Select all the cells you've just typed into.
3. Select Column Header from the chart elements list box.
4. Click Set.

To edit category headers, go to the Data Manager. Click the cell you wish to edit, press F2, 
and edit the cell in the contents box atop the Data Manager spreadsheet.



Category Axis
An axis that has headers (text) rather than a numeric scale. The category axis line is a 
border line that can be displayed on two sides of the chart's frame.
Location options depend on the chart type orientation:

· Vertical bar, line, or area: bottom (the default location) and/or top.
· Horizontal bar, line, or area: left side (the default location) and/or the right side.
· Spectral Map: left side (the default location) and/or the right side.



 Show Formula
Displays the statistical formula for a given regression type or polynomial fit. See also Using 
Data Analysis



Category Axis Title
A label that describes the category axis. The axis title can be moved anywhere on the chart, 
but should be located near the axis it describes.
The category axis title describes the axis headers or special charting information. This title is
entered in Data Manager. To edit the title, return to the Data Manager, select the cell, press 
F2 and edit it in the contents box atop the Data Manager spreadsheet.



Second Category Axis 
An axis that has group or series header text rather than a numeric scale. This axis only 
occurs in spectral charts. The second category axis line borders one side of the chart. It 
usually has series headers.



X Axis (2D Scatter Chart, Spectral Map)
X Axis on a 2D Scatter Chart
An axis that has a numeric scale rather than headers (text). The X axis line is the horizontal 
(bottom or top) axis line.
X Axis on a Spectral Map
An axis that has headers (text) rather than a numeric scale. The X axis line is the horizontal 
(bottom or top) axis line.



X Axis Title
A label that describes the X axis. The axis title can be moved anywhere on the chart, but it 
should be located near the axis it describes. This title is entered in the Data Manager.
To create or edit an X axis title:
In the Data Manager, select a cell, set it as Axis Title #1, and type the title in the cell. To edit
the title, return to the Data Manager, select the cell, press F2, and make changes in the 
contents box.
To show or hide an X axis title:
Choose Chart, Display Status and click Axis Title #1. To hide the title, click the check box 
again.



Y Axis Title
A label that describes the Y axis. The axis title can be moved anywhere on the chart, but it 
should be located near the axis it describes. This title is entered in the Data Manager as "Y 
axis Title". 
To create or edit a Y axis title:
In the Data Manager, select a cell, set it as Axis Title #2, and type the title in the cell. To edit
the title, return to the Data Manager, select the cell, press F2, and make changes in the 
contents box.
To show or hide a Y axis title:
Choose Chart, Display Status and click Axis Title #2. To hide the title, click the check box 
again. 



Y axis Scale
The numeric scale attached to a Y axis line. 
The Scale Range can be set automatically or manually by choosing Chart, Data Axis, and 
choosing Scale Range on the flyout menu. If you click the manual check box, you can set 
upper and lower values of the range, start the scale at zero, and choose whether to display 
values that go beyond the range.



Formula Label (for Regression Line)
In the Data Analysis dialog box, choose one or more of the available types of regression 
analysis by clicking the check box for that analysis type. Then click Show Formula below the 
list of regression types. When you click OK to close the dialog box and return to your chart, 
you'll see the regression formula inside the Charting Area. This text can be moved anywhere
on the chart, but should be placed close to the line it describes. Only one formula per series 
can be shown.



Left Wall
The left-side vertical plane on a 3D chart. The left wall has depth as well as length and 
width, with no more than three surfaces visible at a time (by default top edge of the wall, the
inside surface, and the left, or outside, edge).
The wall surfaces can be automatically shaded, or you can manually give each surface a 
different color. For automatic shading, choose Chart, Auto Shade Cube, a toggle command.
The left wall surfaces are areas; they accept colors from the on-screen color palette and 
special effects created in the Fill tool. 



Right Wall
The right-side vertical plane on a 3D chart. The right wall has depth as well as length and 
width, with no more than three surfaces visible at a time (by default top edge of the wall, the
inside surface, and the right, or outside, edge).
The wall surfaces can be automatically shaded, or you can manually give each surface a 
different color. For automatic shading, choose Chart, AutoShade Cube, a toggle command.
The left wall surfaces are areas; they accept colors from the on-screen color palette and 
special effects created in the Fill tool.



Annotations
Annotations are graphic elements--text, boxes, arrows and other objects--that are created on
top of your chart, rather than in your chart's Data Manager window. You create them using 
the annotation tools on the toolbox--the Pencil, Rectangle, Ellipse and Text tools. Typical uses
include special explanations, arrows that point to items of interest, or circles that draw 
attention to important areas of a chart. Annotations can be colored and given special effects 
using the on-screen color palette and the Fill and Outline tools. Maximum character length 
for annotations is 2,048.



Area
Area refers to an Area Chart or Area Riser. Areas can be modified using the Fill and Outline 
tools, and the on-screen color palette.



Ascending Scale
A scale on which values increase moving up the scale. Most charts have an ascending scale. 
In bar, line and area charts, the ascending scale is controlled by choosing Chart, Data Axis, 
and choosing Ascending Scale from the flyout menu.



Descending Scale
A scale on which values decrease moving up the scale or right to left depending on the chart
type. Most charts have an ascending scale. In bar, line and area charts, you can change a 
scale from ascending to descending by choosing Chart, Data Axis, and turning off Ascending 
Scale on the flyout menu.



Attached
Indicates that two or more chart elements are linked, and cannot be separated from each 
other. 
Example: Headers are attached to the category axis. A numeric scale is attached to the data
and 2nd data axes.



Autofit Text
Chart menu option. When activated, CorelCHART makes a best guess in selecting the font 
size. This prevents text from overlapping. Most text items (scales, headers, data text, etc.) 
can be autofitted. 
Autofit controls are found by choosing Chart, and choosing Legend for the legend text and 
the flyout menus under the commands for the various axes.
NOTE: Autofitting a text item overrides the Text Ribbon tool. You must turn off autofitted text
for the text item you're altering before manually changing its point size.



Axis 
Axis lines are the outside edges of the chart's frame. 
Examples:
On a vertical bar chart, the bottom-most line is the category axis and the left-side line is the 
data axis (by default). A dual-axis chart will have a category axis and two data axes.



Axis Text
Text that is attached to an axis line and cannot be moved independently of the line. On 
numeric axis lines, the text will be a numeric scale. On a text-based category axis, the axis 
text will be the headers (for example, months, years or other time periods).
If the axis line is made longer or shorter, the axis text will move to accommodate the new 
length. This is true only if Autofitting is checked via the Legend dialog box.



Aspect Ratio
The ratio of the width of an image or object, to its height. You can change an object's aspect 
ratio by stretching it in one direction.



Category
When charting large masses of data, it helps to break down the data into categories. A 
category can be group data or series data.
On a bar, line, or area chart, the category axis has text labels that represent the categories. 



Point Size
Point size is used to determine the height of type (text). There are approximately 72 points 
(pts) to an inch and 12 points to a pica.
This text is set at 10 pt.

This text is set at 24 pt.



Least squares approximation
A method of creating a "best-guess" straight line, one that best reflects a collection of data 
points. 
The program tries a vast number of straight lines to find the one line where the sum of D1 +
D2
 +...+ Dn
 (where D = the vertical distance between a data point and the line) is the smallest number.

This method squares each distance (D) to eliminate negative values, in order to calculate a 
more accurate sum of the distances.



Non-Numeric Axis
An axis that is text-based. Header labels are attached to the axis. 
Note that numbers can be used in a non-numeric list, but they are labels and do not serve as
numeric scales.



Numeric (Data, 2nd Data, X, Y) Axis
An axis that is number-based. A numeric scale is attached to the axis, and always appears 
on the data axis.
Examples of numeric scales:
"10, 20, 30,"            "$50, $100, $150",              "3.0e+2, 3.5e+2, 4.0e+2"



Risers
Bars, pyramids, or other shapes that stretch from an axis (or zero line) to a data point. 
There are three basic types of 2D risers: bar risers, area risers, and High-Low-Open-Close 
risers. 
3D risers have more than one surface (such as pyramids or cut-corner bars). 



Scale
1. A set of numbers attached to a numeric axis that indicates the values of the data.
2. Changing the size of an object, or group of objects, while maintaining the original aspect 
ratio.



Header
A label for a category of data. In 2D charts, there are headers for groups. In 3D charts, there 
can be headers for groups and series.



Deselect
Turns off a toggle menu command or dialog box check box. When you deselect a check box 
item by clicking it, the "x" in the box disappears. Toggle menu items are selected when a 
check mark appears next to them, and deselected when the check mark is not visible.



Grid Lines
Horizontal or vertical lines that split up an axis into divisions.
Numeric axes can display major and minor grid lines. Major grid lines line up with numbers 
on the numeric scale. Minor grid lines are placed between major grid lines. 
Non-numeric axes have one set of grid lines, placed between headers.



Group 
Groups can be viewed in two ways:
In the Data Manager, choose Data, Data Orientation. In the Data Orientation dialog box, if 
you click Series are Rows, group data is represented in columns. If you click Series are 
Columns, group data is represented in the rows.
In Chart View, a group by default contains data points from one or more series. For example,
if a side-by-side bar chart has three pairs of bars, each pair is a group, and each bar is part 
of a series of three data points. A stacked bar chart has three bars, each with two colors 
representing the two series, and each stacked bar is group.



Series
Series can be viewed in two ways:
In the Data Manager, choose Data, Data Orientation. In the Data Orientation dialog box, if 
you click Series are Columns, series data is represented in the chart's columns. If you click 
Series are Rows, series data is represented in the rows.
In Chart View, a group by default contains data points from one or more series. For example,
if a side-by-side bar chart has three pairs of bars, each pair is a group, and each bar is part 
of a series of three data points. A stacked bar chart has three bars, each with two colors 
representing the two series, and each stacked bar is a group.



Staggered Text
Alternating labels are shifted down or sideways so that long header or scale labels do not 
overlap. Here are two examples:
30 -

20 -
10 -

0

Nebraska Oklahoma
North Carolina West Virginia



Tick Mark
Tick marks are short lines that cross (or line up on) the axis, but do not run across the chart 
as grid lines do. They appear only on numeric (data or X, Y) axes.



Fountain Fill
A graduated change from one color to another or a blend of two or more colors used to fill 
objects. To apply a fountain fill to an object, click the Fill tool. You can use the Fill Roll-up tool 
by clicking the second tile on the flyout menu, then clicking the second tile on the roll-up. 
You can select an existing fill, or create and save a new fill. Alternatively, click the Fill tool, 
then click the last tile on the top row of the flyout to open the Fountain Fill Effect dialog box. 
You can choose an existing fill, or create a new one.



Fill tool
The last tool in the CorelCHART Toolbox. It is used to fill chart elements and other objects 
with uniform colors, fountain fills, patterns or textures. An object must have a closed path to 
be filled. See also Chart View Tools and Ribbon Bar 



Data Manager
The Data Manager is the powerful spreadsheet program underlying your charts. Whether 
you're building a new chart or changing an existing one, the Data Manager--now a hefty 
16,384 rows by 256 columns--is a valuable data analysis tool. 
In Data Manager, you can create and analyse your own data or bring in chart data using OLE
2.0. Tags you assign to cells containing text or data in the Data Manager determine what 
part of the chart they'll be--title, footnote, legend, chart data, and so on. 
To open a chart's Data Manager window, click the Data Manager button above the Toolbox 
on the left side of the CorelCHART Text Ribbon Bar.



Spreadsheet error values
Spreadsheet error values, not to be confused with computer system error messages, are 
warnings returned by Data Manager when you use unrecognized syntax (usually operators, 
separators, functions or values) when entering formulas. 
See also 

· Spreadsheet error values 
· Technical Support



Spreadsheet
A matrix, or grid containing individual cells, used to contain, organize and make calculations 
with numerical and textual data. Spreadsheets used in microcomputers typically include a 
wide array of useful tools and functions to process the data. The Data Manager is the 
spreadsheet used with CorelCHART.



Data Range
The data range is the group of contiguous cells containing numeric data that will form the 
bars, lines, pies, or other markers in the chart. You must select and tag the data range in the
Data Manager.



Bitmap
An image composed of a series of dots (pixels). Scanners and paint programs such as 
CorelPHOTO-PAINT generate this type of image. By contrast, CorelCHART creates images 
using vector objects, shapes which are described in their files as mathematical equations.



Bitmap pattern
Fill composed of repeating bitmap images. CorelCHART supplies a collection of bitmap 
patterns, and you can add your own using the facilities in the Fill Roll-up tool.



Check box
A square box in a dialog box used to turn options on or off. An option is turned on when an x 
appears in the check box, and is turned off when the check box is empty. 



Constrain
Holding down the Ctrl key while moving an object, drawing ellipses and rectangles. 
Constrain limits your movements to specific directions or increments.



Double-click
To press and release the left mouse button twice in quick succession. 



Densitometer scale
Scales printed on each page of a color-separated document for the purpose of gauging the 
accuracy, quality and consistency of the output. You can print these scales by choosing an 
option in the Print Options dialog box.



Dithering
Simulating a color by putting dots of another color very close together. Windows uses 
dithering to display colors that PC graphics graphics adapters are unable to display.



Handles
Small squares that appear on the corners and sides of an object's highlighting box when the 
object is selected. Use these handles to move or resize an object.



Highlighting box
The invisible rectangle with eight handles that encloses a selected object. As you move, 
scale or otherwise transform an object, a dotted rectangle representing the highlighting box 
appears instead of the object.



Inter-character spacing
The amount of spacing between characters of text. Also called letter spacing. You can adjust 
inter-character spacing interactively using the two buttons labeled ABC on the Text Ribbon.



Inter-line spacing
The amount of spacing between the baselines of text. Also called leading. You can adjust 
inter-line spacing interactively using the two right-most buttons on the Text Ribbon.



Menu bar
The bar near the top of the window that contains the names of the CorelCHART menus. 



Multiple select
A method of selecting multiple objects with the Pick tool by holding down the Shift key and 
clicking the objects.



Palette
A collection of colors along the bottom of the CorelCHART window and in the Color dialog box
found under the Outline and Fill tools.



Pencil tool
Tool found in the CorelCHART Toolbox, used to create straight lines, curves and polygons. 
The default outline attributes of lines, curves and polygons can be reassigned with the 
Outline tool. 



Outline tool
Opens a flyout menu from which you can select outline thickness and color in a number of 
ways--including the Pen Roll-up, which provides quick access to various outline attributes. 
Note: You can also choose outline colors from the On-screen Color Palette.



Pick tool
The first tool in the Toolbox, it is used to select one or multiple objects, move objects and 
resize them. See also Chart View Tools and Ribbon Bar



On-screen Color Palette
The collection of colors along the bottom of the CorelCHART window. The on-screen color 
palette is inoperative when a Data Manager window is the current window.



#$Control menu box 
Located at the left end of the title bar in the CorelCHART window.
Clicking the Control Menu box displays commands for sizing and positioning the window.



Maximize button 
Located in the upper-right corner of the CorelCHART window and document windows if they 
are not fully expanded. Clicking the Maximize button expands the window to fill the entire 
screen. 
After you expand a window, the button changes to the Restore button . Use this button to 
return the window to its former size.
You can also maximize a window by choosing Maximize from its Control menu or restore it to
its original size by choosing Restore.

Shortcut
Double-clicking a window's title bar expands the window to full size.



Minimize button 
Located in the upper-right corner of the CorelCHART window and document windows. 
Clicking the minimize button shrinks the window to an icon at the bottom of the screen.

· As an icon, the application or presentation stays in memory, but its window does not 
take up space on your screen.

· To restore the window, double-click its icon or click the icon and choose Restore from its 
Control menu.



Text tool
The Text tool is used to add artistic text or annotations to a chart.



Font
A set of characters in a given typeface and pointsize, e.g., 10-point Times Roman. Most fonts
are available in families that include different weights or styles such as bold and italic.



Text Ribbon Bar
Clicking a button on a Text Ribbon Bar executes the command associated with it. Hold the 
mouse pointer over a button or drop-down list box to see its name, or right-click with the 
mouse for Context-sensitive Help.
Both Chart View and Data Manager have a Text Ribbon Bar located near the top of the 
screen, below the Ribbon Bar. CorelCHART's Text Ribbon Bars include buttons and drop-down
list boxes for setting text attributes such as font type and size selection, bold, underline, 
italic, alignment, inter-character and inter-line spacing. 
Note: Chart View and Data Manager have different Text Ribbon Bars. Right click on any part

of either Text Ribbon Bar for Help.



Ribbon Bar
Clicking a button on a Ribbon Bar executes the command associated with it. Hold the mouse
pointer over a button to see its name or right-click for Context-sensitive Help.
The Chart View Ribbon Bar, contains the following buttons (from left): New, Open, Save, 
Print, Cut, Copy and Paste, Import and Export, Display Status, Legend, Numeric Format, Data
Analysis, Align, 3D Rollup, Copy Chart, Wireframe and Mosaic Rollup.
The Data Manager's Ribbon Bar includes (from left) New, Open, Save, Print, Cut, Copy and 
Paste, Import and Export, Set Page Break, Number Format, Borders, Patterns, Go to cell, 
Enter Formula Sort, Auto Recalculate, Grid Lines and Mosaic Rollup.
See also Chart View Tools and Ribbon Bar



Title Bar
Located along the top of the CorelCHART window and in each document window. The 
CorelCHART Title Bar shows the name of the program plus the name and location of files in 
fully-expanded presentation windows. 
In non-maximized document windows, the Title Bar shows the file's name and location or the
word "Untitled-1", "Untitled-2" etc., for new charts you have not yet been saved. 
If it is less than full-size, dragging the Title Bar moves the window.
The Title Bar may contain buttons for controlling the window.



Scroll Bars
Bars along the bottom and right side of a Data Manager document window. You use the scroll
bars to view parts of a spreadsheet outside the current viewing area.



No Help Available
Context-sensitive Help is not available for the selected item. Press Ctrl+F1 to search for Help
by keywords, press F1 to open the Help contents screen and or click Technical Support.



Export
Export is used to define the process of saving an existing file under a different file format. An
export filter performs the conversion of the file into another file format. The purpose of the 
export process is to use a file, or part of a file, in other software applications. You can export 
your chart or chart data from CorelCHART.



Emulsion
The light-sensitive coating material found on a piece of film.



Filter
A program that translates information from one file format to another. Filters allow files 
created in one application to be inserted or used in another. CorelCHART includes many 
filters enabling you to import data or graphics into CorelCHART and export CorelCHART files 
to other applications.



Data Cell
The intersection of a column and row in the Data Manager spreadsheet. Data cells, 
recognized as individual data units in Data Manager, are used to hold data in the form of 
numbers, formulas and text. 
Note:    Text that is wider than the current cell is visible unless the adjacent cell also 
contains data. To display any text hidden in this way, widen its column. Where a number 
contains more digits than can be displayed in the current column width, number signs 
appear in the cell. To display the number correctly, widen its column.



Mixed reference
References are used in formulas to identify cells. Mixed references use one absolute co-
ordinate and one relative coordinate (i.e., $E4). In this case, the column is absolute, which 
means that it will remain at column E if you move the cell that contains this reference. The 
row coordinate is relative and will be updated if such a change occurs.
Syntax: (column letter.Row number) or (Column letter,$Row number)
The $ identifies the absolute part of that reference, i.e., either the row number or column 
letter remain as they are when the cell containing the reference is moved. 
See also Relative reference and Absolute reference. 



Absolute reference
References are used in formulas to identify cells. Absolute references indicate the 
absolute position of cells in a spreadsheet. If you move or copy cells that use absolute 
references, they still refer to the original cell reference(s).
Syntax: ($Column letter,$Row number) 
For example, if a formula used the cell reference ($A$2); when the formula was moved to 
another location on the spreadsheet, the cell reference would still point to cell A2--the 
second cell to the right of the first row of the spreadsheet. 
See also Relative reference and Mixed reference.



Relative reference
References are used in formulas to indicate the position of cells in relation to the cell 
containing a formula. If you move or copy cells that use Relative References, CorelCHART 
automatically updates the references included in formulas to the new location of the 
referenced cell.
Syntax: (Column letter,Row number)
For example, a cell C10 contains a formula which includes the reference C5. If the formula is 
moved to cell D15, the reference will change so that it still point to the cell that is five cells 
to the left. The new reference will be D10. 
See also Absolute reference and Mixed reference in the CorelCHART glossary.



Operators
Signs or symbols used to add, subtract, multiply or divide (+, - , *, /, (),{}, and ^) inserted in
formulas to activate various mathematical or logical operations. 
See also Using the Enter Formula command and List of Operators



Separators
Data Manager requires separators such as commas, semicolons, colons, spaces and double 
periods ( , ; :    .. ) to distinguish arguments, expressions or values in formulas. You may also 
set up your own separators using the Word Separator command.
See also Operators



Values
Values are any variable data recognized by Data Manager, in cell addresses, functions, 
formulas or numbers.



In-cell editing
With in-cell editing, you can set individual attributes directly in a cell. For example, you can 
make the first character bigger than others, give it a different font or even apply a different 
color with the on-screen color palette.
Note:    Text that is wider than the current cell is visible unless the adjacent cell also 
contains data. To display any text hidden in this way, widen its column. Where a number 
contains more digits than can be displayed in the current column width, number signs 
appear in the cell. To display the number correctly, widen its column.



Cell addresses
Cell addresses, which refer to the column and row intersections of cells, are used in formulas
and by commands such as printing. Cell address references determine the range(s) of values
Data Manager uses in a given operation.
Example:  To print all the data from the top left-hand corner of a spreadsheet to the row 10,
column 10, you would choose Print and enter the cell addresses A1 to J10.



Formula bar

 
The Formula bar, located just below the Tag Bar, is used for composing spreadsheet formulas
in the Data Manager. 



Spreadsheet Functions
Ready-made formulas that can be used in combination with other functions, values and 
operators to produce a result. The Data Manager's nearly 300 spreadsheet functions perform
a wide variety of operations in the following categories: Conversion, Date and Time, DDE, 
Engineering, Finance, Information, Logic, Lookup and Reference, Math and Trig, Statistics and
Text.
Tip: In Data Manager, press F12 to open the Enter Functions dialog box, choose a 

spreadsheet function and then click the Dialog's Help Button for a specific Help topic.



Fibonacci
A sequence of numbers in every number is the sum of the two numbers immediately 
preceding it; 1,1,2,3,5,8,13. CorelCHART's Fill Series feature enables you to create Fibonacci 
series automatically.



Formula
A formula is one or a series of operations performed on various types of data which produces
a different result. When formulas are entered into a spreadsheet cell, only the result appears
in the cell. To view a formula after it is entered, click the cell and then press F2, then use the 
Formula bar for editing. Formulas may include constant numbers, cell addresses, operators, 
cell ranges and functions, but may not exceed 255 characters. See also Spreadsheet error 
values



Trap
Also referred to as chokes or spreads. The process of adding a slight overlap between 
adjacent areas of color to avoid gaps caused by registration errors. You can create traps in 
CorelCHART when printing color separations.



Embedded Object
A file, or part of a file, created in an application that is inserted into a file in another 
application. In CorelCHART, objects can be embedded in Data Manager. An embedded object
becomes part of the CorelCHART spreadsheet or chart. You can still make changes to this 
object by double clicking it in the spreadsheet. The server application opens with the object 
displayed for editing.    You can also embed a chart created in CorelCHART in an OLE client 
application.



Linked Object
A file, or part of a file, created in an application that is inserted into a file in another 
application. CorelCHART enables you to insert linked objects or data in Data Manager. You 
can also insert a chart as a linked object in another application such as CorelDRAW, 
CorelSHOW and many more. A linked object maintains a connection with the application that
it was created in. Any changes made to the object in the server or parent application, 
updates the object in Data Manager. 



Section (in numeric format)
One of three possible components of a numeric format. The syntax for a numeric format is:
Section_1;Section_2;Section_3
where each section is a series of codes that assign attributes to numbers. The attributes can
include the font, size, style and color. Section_1 is the format for positive numbers, Section_2
is the format for negative numbers and Section_3 is the format for zero values.
If a numeric format has only one section, the format is applicable to all numbers. If it has two
sections, the first one is the format for positive and zero values and the second one is for 
negative numbers.



Argument
An independent variable upon which the value of a function depends (Merriam Webster)
Example:    In the formula, SUM(1+2, A1..C4), the numbers 1 and 2 and cell references A1 
and C4 are arguments, while SUM is a function, the parentheses () and plus sign are 
operators and the periods are separators,



Integers
The number set consisting of all the positive whole numbers, their negatives, and zero. 
Integers are a subset of rational numbers.
Example:    10, -10 and 0 are integers



Real numbers
The number set comprised of all the rational numbers and irrational numbers.    Integers are 
a subset of the rational numbers.
Example:    25 and -10 are integers and real numbers because they are positive and 
negative whole numbers; 25.349 is a real number, but not an integer    because it includes 
decimal places



Rational numbers
Integers or the quotients of integers divided by non-zero integers with either a finite number
of decimals or an infinite number of decimals with a known sequence.
Example:    The fraction 1/9, which produces the repeating decimal 0.111111, is a rational 
number, as is 1/2, whose decimal equivalent is 0.5. 



Irrational numbers
Numbers that can be expressed as infinite decimals with an indefinite sequence and that 
cannot be expressed as the quotient of two integers 
Example:    The square root of 2, which is 1.414213562373 



Whole numbers
The positive integers and zero



Basis Day count basis

0 or omitted US (NASD) 30/360
1 Actual/actual
2 Actual/360
3 Actual/365



Linear regression
A least squares approximation line of the formula y = a0+a1x for a selected series. This 
formula is equal to a polynomial fit with the Order set to 1. Linear regression is determined 
by the following formula:

where x is an independent variable, Y is a dependent variable, E(Y|x) is a conditional 
expectation of random variable Y for fixed value of the variable x. In practice the 
parameters 0 and 1 of the linear regression are unknown, and their values evaluated through
Y and x variables.
Parameter 0 determines the intercept of the linear regression.
Parameter 1 determines the slope of the linear regression.



Expression
Any variable--positive, negative, fractional or whole numbers or formulas.



List
List represents any combination of integers, cell references separated by commas, or an 
array of values.



Charting window
The Chart View screen, including the large white background surrounding the printable page 
area, but excluding the Title, Menu, Ribbon, Status and Scroll bars and the Toolbox. Click at 
the top of the current charting window during drag and drop operations.



OLE client application
A program which accepts linked or embedded objects from Object Linking and Embedding 
(OLE) applications. OLE objects can be edited from within the client application once they've 
been placed there. Double-click the object to launch the server application within the client 
application. CorelCHART 5's Chart View is an OLE 2.0 server application, while Data Manager 
is an OLE client. 



OLE server application
A program which provides linked or embedded objects to Object Linking and Embedding 
(OLE) applications. Once created, OLE objects can be edited from within the client 
application. Double-click the object to launch the server application within the client 
application. CorelCHART 5's Chart View is an OLE 2.0 server application, while Data Manager 
is an OLE client. 



Object Linking and Embedding (OLE)
Windows' Object Linking and Embedding (OLE) 2.0 offers two ways to connect files from 
separate programs--linking and embedding. As the term implies, "linked objects" are files 
created in one application, the server, which remain linked to a file in another program, the 
client. When you update the original linked file, it can be updated in both locations. Chart 
View acts as an OLE server but not a client while Data Manager acts as an OLE client 
application. In either case, double-clicking a linked or embedded object switches you back to
that file in a special session of the server application to make your changes.



Right mouse button
The right mouse button acts as a context sensitive tool in both Chart View and Data 
Manager screens. In a spreadsheet, click and release the right mouse button in a cell to call 
up a popup format menu right where you're working. Clicking the right mouse button in 
Chart View also results in numerous helpful popup menus. After you open a popup menu, 
click the left mouse button on the command listed in the popup to put it to work for you. 
The right mouse button also provides Context-sensitive Help when clicked on the Toolbox, 
Ribbon Bars or Text Ribbon Bars.
References to the right and left mouse buttons assume they have not been reassigned. See 
also Mouse tricks



Dynamic Data Exchange (DDE)
Dynamic Data Exchange is the precursor to Object Linking and Embedding. DDE enables you
to create a link from one or more cells in a host application which are then updated 
automatically whenever the linked file is reopened in the client application.



Toolbox
The collection of icons (initially) located at the left side of the Charting Window. Each icon 
represents a Charting Window tool, such as the Pick, Zoom, Text, Outline and Fill tools.
In version 5, the Toolbox can be detached and reconfigured to "float," or in other words be 
moved to locations of your choice. The Toolbox can also remain "grouped," as shown at the 
left at the side of the screen, ungrouped into a large rectangle, resized into another shape 
showing each tool and its all flyouts, or hidden from view. See also Chart View Tools and 
Ribbon Bar



Style
In Data Manager, a style is a combination of formatting options that can be saved and used 
to format other cells in the same spreadsheet.    The style can include your selection of font 
attributes, alignment within the cell, numeric format, borders and patterns.    Styles are 
created, saved and edited using the Style command.



Style sheet
Available in Data Manager, a style sheet is a file with the .CCT extension which includes 
several styles.    A style sheet can be made available to any CorelCHART spreadsheet, 
therefore the styles it includes can also be used in any spreadsheet.    Style sheets are 
created, saved, modified and chosen by using the Style command.



Template
A chart template includes parameters that determine the appearance of the chart. The 
parameters include the chart type, font, color and fill information, display status of various 
chart elements and much more. Any .CCH file (CorelCHART's file format) is a chart template 
that can be applied to other charts by using the Apply Template command.



Serial values
Though normally displayed in the default date format of day/month/year, dates are in fact 
converted by the Data Manager to serial values similar to Julian dates. Serial date values 
start at 1, representing December 31, 1899, and end at 65,000 in the year 2077. Serial 
time values begin at 00:00:00, or midnight, and are counted in seconds.



Serial date values
Though normally displayed in the default date format of day/month/year, dates are in fact 
converted by the Data Manager to serial values similar to Julian dates. Serial date values 
start at 1, representing December 31, 1899, and end at 65,000 in the year 2077. Serial 
time values begin at 00:00:00, or midnight, and are counted in seconds.



CorelCHART Roll-ups
Roll-up windows contain many of the controls found in dialog boxes: command buttons, text 
boxes, drop-down list boxes and so on. But unlike most dialog boxes, the window stays open 
after you apply the selected options. This lets you makes adjustments and experiment with 
different options without having to continually re-open a dialog box. When you are not using 
a window, you can hide the controls leaving just the Title bar visible.
CorelCHART features five roll-up windows; for a brief description of each, click its name 
below. 

3D     Roll-up  
Fill     Roll-up  
Mosaic Roll-up
Pen Rollup
Pictograph     Roll-up  

See also How to... Use Roll-up windows



Fill Roll-up

The Fill Roll-up, available from the Fill tool flyout menu , applies colorful fountain fills, 
two-color and full-color patterns, and bitmap textures to chart elements and annotations.



Pictograph Roll-up
The Pictograph Roll-up, available from the Fill tool flyout menu, adds pictographs, or graphic 
pictures, to bar charts and histograms.



3D Roll-up
The 3D Roll-up, available from the Ribbon Bar and View Menu, alters the size, scale or 
perspective of 3D charts.



Mosaic Roll-up
The Mosaic Roll-up, available from the Ribbon Bar and File Menu (both Chart View and Data 
Manager), is a file management utility designed to facilitate drag and drop of a wide range 
of files.



Pen Roll-up
The Pen Roll-up, available from the Outline Pen tool flyout, gives you quick access to a 
variety of outline attributes, dotted and dashed linestyles, line thicknesses, colors, and 
arrowheads and other line endings.



Gray Component Replacement (GCR)
Technique for reducing the cyan, magenta and yellow in an image and replacing them with 
an appropriate amount of black.
When you use GCR, separations print with improved sharpness, better color fidelity, and 
increased contrast. Separations will also print with better consistency during the print run. 
You set your GCR when you build your Color System Profile using Color Manager. GCR can 
make quality separations even better, especially for darker images or those that contain 
considerable amounts of problem colors such as purples, browns, deep reds, flesh tones, and
grays.
CorelCHART's GCR tool in Color Manager enables you to set the GCR to different levels along
the tonal range depending on the output device or printer. You produce skeletal blacks by 
setting the GCR level to very low values near the highlights, and to higher values in the 
shadows. Because high levels of GCR reduce the total amount of ink, deep shadow and black
areas may appear to be less glossy and have less depth. You can compensate for this by 
using less GCR in the shadow areas.



Undercolor Removal (UCR)
UCR refers to the reduction of the cyan, magenta and yellow colors in the dark or neutral 
shadow areas to reduce the total amount of ink coverage. In an ideal printing environment, a
press would be able to print any combination of ink densities, up to 100% of each of the four
colors, or what is known as 400% TAC (Total Area Coverage). However, the maximum 
generally accepted TAC is 300%. TAC values higher than the maximum generally cause 
problems with black ink transfer, ink drying, and ink trapping.



Black Point
A black produced by 100% of each of the CMYK components is darker than one produced by 
full amounts of CMY. The black point specifies the blackness level relative to these two 
references in a range from 0 to 1.0. A black point of 0.0 yields a black as dark as a 3-color 
black (CMY). A black point of 1.0 yields a black as dark as a full 4-color black (i.e., darker).
Note: Black point only specifies the apparent darkness of black. The actual CMYK 
percentages used to produce this appearance is determined by the GCR and UCR settings in 
the Prepress Controls dialog box.



Dot Gain
Halftone dots that make up an image gain in size from the time you view them on film to the
time they come off the press. This unavoidable increase in size results in colors that appear 
more intense in the printed image than intended. Fortunately, dot gain can be compensated 
for during the color separation process.
Factors that contribute to dot gain are the quality of the paper, especially its absorbency; the
properties of the ink, and the capabilities of the printing press.
CorelCHART's Dot Gain control can compensate for all four colors separately (CMYK), or for 
all four collectively (Master). The compensation technique reduces the size of a given pixel 
in the image to compensate for the fact that the same dot will increase in size on the 
printing press. For example, a pixel having a density value of 60% when measured before 
printing might have a measured value of 70% when printed on paper. If you want to 
maintain the 60% value, the value must be reduced such that the increase caused by dot 
gain will result in the desired 60% dot. So when you calculate a dot gain and then apply a 
percentage, you enter a positive number that represents the percentage of decrease that 
you wish to apply to the pixels in that channel(s). 



Vector graphics
Also referred to as object-based graphics. Graphics created in programs such as CorelDRAW 
in which shapes are represented as a series of lines or bezier curves and fills. These contrast
with bitmap or raster graphics which are created pixel by pixel in paint programs and by 
scanners.



Bezier curves
A method CorelDRAW and other computer graphics programs use to represent curved 
surfaces. A Bezier curve has two endpoints and a set of control points that allow you to mold
the shape of the curve. You can also resize a Bezier curve without losing image quality.



Photographic
The mapping necessary for the reproduction of photographs. CorelCHART uses a 
photographic color mapping to compress colors into your printer's gamut of colors. This 
technique preserves the tonal characteristics and relationships of colors in the photographs 
you are trying to print. This way, photographs reproduce with enhanced contrast and color 
variation. See also Colorimetric and Gamut Mapping



Colorimetric
Colorimetric refers to the colorimetric chroma mapping necessary for the reproduction of 
spot colors. CorelCHART remaps colors outside of the printer's    to the edge of the gamut, 
preserving colors inside the gamut to ensure more accurate spot color reproduction. 
If you are printing an object that is mostly vector drawings, or CorelDRAW graphics and text, 
choose a colorimetric System Color Profile. See also Photographic and Gamut Mapping.



Undercolor removal (UCR)
In color printing, a technique for reducing the amount of cyan, magenta and yellow ink in 
shadows and neutral areas of an image and replacing them with an appropriate amount of 
black. Another technique called Gray Component Replacement (GCR), also substitutes 
amounts of CMY ink with black but over a greater color range.



Gamut Mapping
Gamut Mapping is the reassigning of colors outside of the range of colors a printer is capable
of producing. The range of colors you can specify from a palette or capture with a scanner 
can be larger than a printer can reproduce. CorelCHART uses two kinds of gamut mapping: 
Colorimetric for spot colors and vector based art and Photographic for bitmap art.



Gamut
A gamut is the range of colors a device can reproduce. The human eye has a very large color
gamut. Photographs have a large gamut as well. A monitor, with its RGB gamut can also 
display many colors. Where gamut mapping becomes really important is with printers and 
output devices. These gamuts can be very limited and care must be taken when producing 
artwork to be reproduced on different printers. If you do use colors outside of the printer's 
gamut, CorelSHOW's Color Manager will ensure that those colors are mapped into the 
printers gamut as accurately as possible. See also, Colorimetric, Photographic and Gamut 
Mapping.



CORELPRN.INI
A text file with printing-related information shared by all installed Corel applications. This file
is in the CORELDRW\CONFIG subdirectory and can be edited by double-clicking it in the 
Windows File Manager. Changes you can make to this file include disabling the message box 
that warns when the printer and page orientation in a Corel application do not match.



Drag and Drop
A popular new feature of OLE 2.0, Drag and Drop enables you to select and "drag" 
information from one application window and "drop" it into another. When used from an OLE 
server to an OLE client application, Drag and Drop can create linked or embedded objects 
which can be automatically or manually updated as required. But the function is a visual way
to move information within or between windows, regardless of whether it is used for linking 
and embedding.
Linking and embedding procedures vary somewhat between applications. Check the client 
application's documentation for additional information.



Window border
The narrow white double line surrounding any reduced window.
To resize a window:

1. Point, click and hold the mouse button on a window border. 
2. While holding the mouse button down, drag up, down, left or right to resize an 

application window or an open file window. 
Note: You may also choose Size from the Control menu then use the arrow keys to resize 
reduced (non-maximized) windows.
To resize a window diagonally:

· Point to the window corner, click and drag as above.



Window
A rectangular area on your computer screen in which applications are displayed. Corel 
application windows have a Title bar, menu bar and two ribbon bars at the top, a toolbox 
initially attached to the left side, and scroll bars at the sides or bottom.



Screen angles
When printing color separations, the angles at which each of the four process colors are 
printed to avoid undesirable moire patterns. These angles can be specified in CorelCHART. 
See also Halftone screen.



Resolution
In printing, a term referring to the number of dots per inch (dpi) the printer is capable of 
printing. Typical laser printers have resolutions of 300 dpi while image setters have 
resolutions of approximately 1200 or 2400 dpi. The more dots per inch, the smoother the 
output.



Screen frequency
Screen frequency is measured in lines per inch (lpi). Screen frequency affects images such 
as photographs and tints of color. A laser printer might produce an acceptable screen at 60 
lpi. A high resolution image setter may be capable of producing a 150 line screen. Screen 
frequency can be set in the Print Options - Options dialog box. See also Halftone screen.



Path
The fundamental entity from which vector objects in CorelCHART and CorelDRAW are 
constructed. A path can be open (line) or closed (circle). It can be made up a single line or 
curve segment or many joined together. When two or more paths are combined into a single
path, they are called subpaths.



Pure color
Any color that individual pixels on a computer screen can assume. On a monochrome 
screen, there are only two pure colors, black and white. Color screens typically display 8, 16 
or 256 pure colors. See also Dithered color.



Linked object
A reference or placeholder for information inserted into a file. Changes made to the 
information from the application that created the linked object are automatically reflected in 
the destination files.



Embedded object
Information from a file created in one application that's been inserted into a file in another 
application. For example, you can embed a graphic created in CorelCHART into a Microsoft 
Word document. The embedded information can be edited from within the application in 
which it is embedded.



Wireframe view
One of two ways of viewing objects in the charting window. In wireframe view, objects 
display in skeleton form without fills or outlines. Since the screen redraws faster in this view, 
you may want to use it for editing complex drawings. In the other view--editable preview--
you see the outlines and fills of objects as you create them.
You can switch freely between views by choosing Wireframe from the Chart View menu or 
pressing Shift+F9.



Editable Preview
One of two ways to view objects in the drawing window. In editable preview (the default 
view), you see the outlines and fills of objects as you create them. In the wireframe view, 
objects are displayed in skeleton form. Since objects redraw more quickly without outlines 
and fills, you may find it more efficient to edit complex drawing in wireframe view.
You can switch freely between views by choosing Wireframe from the View menu.



Row Buttons
Every row in the Data Manager spreadsheet is numbered.    The row button can be used to 
set row height or select an entire row.    Data Manager spreadsheets 16,384 rows. See also 
Column Buttons



Column Buttons
Every column in the Data Manager spreadsheet is identified by a letter, or pair of letters, on 
the column button. Clicking a column button selects all cells in that column. Data Manager 
spreadsheets have 256 columns. The columns are labelled from A to Z, then from AA to AZ 
and so on up to IF. See also Row Buttons



Toggle
Like electric toggle switches, toggle commands turn a function on or off each time you click 
them. For example, Undo is a toggle command. If you delete an object, pressing Ctrl+Z 
undoes the deletion and pressing Ctrl+Z again repeats it.



Hotel text
Available for column and row titles, hotel text in Chart View sets text up vertically. To toggle 
hotel text on or off, right-click a row or column title.



Printers' references
The series of buttons, described below, under the Preview area of the Print Options dialog 
box.

Information button:    Prints the filename of the publication, the current date and 
time, Tile and Plate number outside the top and bottom margins of the Printable Page. Also 
includes the color profile, color name, the screen frequency and screen angle when you print
color separations at the bottom of the printable page.

If the size of the Printable Page (as set in the Page Setup dialog box) exceeds the size
of the paper you are printing on, file info will not appear. Use the File info within page 
option if your Printable Page is the same size as your page setup.

For larger page sizes, use the Page Setup command in the Layout menu to define a 
custom page size smaller than the printer paper. You may have to resize your publication to 
fit on the new page size.

Crop marks button:    Prints crop marks applied to the current page. 

Registration marks button:    Prints registration marks of a color-separated 
publication on each page so the printer can line up the colors properly.

Calibration bar button:    Prints a calibration bar of the six basic colors (RGB and 
CMYK).

Densitometer scale button:    Prints a densitometer scale on each page of a color-
separated publication.

Negative button:    Creates a reverse image of the publication that images directly 
on film. Check with your service bureau, but many bureaus prefer to set negative image on 
their imagesetter.

Emulsion button:    Choose when printing to film to print the publication emulsion 
side down. Check with your printer as to whether they prefer the emulsion side up or down.



Printable page

The rectangle with the drop shadow that appears in the drawing window. Also called the 
"Page border", the Printable page corresponds to the paper size not the printer's "image 
area" which includes margins. The width of the margins varies depending on the printer.



Halftone screen
In photography, a sheet of glass or film with a grid pattern of lines used to convert a 
continuous tone image into dots of various sizes. In CorelCHART, halftone screens are 
specified for Spot Colors by choosing PostScript from the Outline Color, Uniform Fill or 
Fountain Fill dialog boxes. Process color screens are set in the Print Separations dialog box 
under Custom Halftone. 





Drag and Drop within Data Manager
When used within a single application, Drag and Drop is a simple way to move data around.
To drag a selection within Data Manager:

1. Highlight an area of a spreadsheet.
2. Point to the top line of the selection with the mouse pointer. 
3. When the pointer changes from a white cross to an arrow, click and hold the mouse 

button while you reposition or "drag" the pointer and data to another open Data 
Manager window or another part of the current spreadsheet.

4. Release the mouse button to "drop" the data into its new location.



Using Paste Inside
The Paste Inside command allows you to fill a chart element with the contents of the 
Windows Clipboard. 
To fill an object with the contents of the Clipboard:

1. In an application of your choice, open a file or create the objects you wish to use as fill 
in CorelCHART.

2. Copy or cut the objects to the Clipboard
3. In CorelCHART, select a chart element.
4. Choose Paste Inside from the Edit menu. The Clipboard contents fill the selected object.



Printing a spreadsheet
1. Choose Print from the Data Manager File menu.
2. In the Print Data dialog box, choose the options you want.
3. Click Setup to change the default printer and/or its setup.



Choosing a default printer
When you print from Data Manager, your spreadsheet is automatically sent to the default 
printer. If you have installed other printers, you can specify which one you want CorelCHART 
to use. The printer you specify remains active until you exit CorelCHART.
Note: Before you print a final copy of the spreadsheet, or send a print file to an service 
bureau for film or direct imaging, make sure that you've built your System Color Profile with 
Color Manager for the particular output device chosen.
To select a printer:

1. Choose Print Setup from the File menu.
You can also select a printer from the Print dialog box. See Print command.

2. In list box under Printers, choose a printer.
Only installed printers appear. For information on installing printers, see your Microsoft 
Windows User's Guide.

3. Click the Setup button to choose the Orientation and Paper options.



Setting up the active printer
You can specify the default settings for the active printer from Data Manager.
To set up the active printer:

1. Choose Print Setup from the File menu.
You can also select a printer from the Print dialog box. See Print command.

2. Choose Setup.
3. Select the paper source, size and orientation.
4. Choose Options for more advanced choices. Click Help for information about the 

options.



Printing a range of cells
You can print a selected range of cells in a given spreadsheet.
To print a range of cells:

1. In Data Manager, choose Print from the File menu.
2. In the Print Data dialog box, in the Print Cells group, do one of the following:

· choose All to print all rows that contain data. 
· to print a range of rows, enter the number of the first row in the From box and

the number of the last row in the To box.
3. In the Columns section, do one of the following:

· choose All to print all columns that contain data. 
· to print a range of columns, enter the letter of the first column in the From 

box and the letter of the last column in the To box.
Note: when you select a range of cells to print, the Print Pages options in the Print Data 
dialog box are automatically dimmed because the number of pages that print corresponds to
the range of cells selected.



Printing a range of pages
You can specify a range of pages to print only a section of a long spreadsheet.
To print a range of pages:

1. In Data Manager, choose Print from the File menu.
2. In the Print Data dialog box, in the Print Pages click the radio button that precedes the 

word "From".
3. In the From box, type the page number of the first page you want printed.
4. In the To box, type the page number of the last page you want printed.

Note: If you have set the First Page Number to a number other than one, enter the page 
numbers for the print range accordingly, i.e., if the number five is assigned to the first page 
and you want to print the first ten pages, the print range is from page five to page fifteen.



Setting the first page number for a printed spreadsheet
You can assign a page number other than one to the first page of the spreadsheet. Use this 
procedure when cover or presentation pages will precede the printed spreadsheet in a 
document.
To set the first page number for a spreadsheet:

1. In Data Manager, choose Print from the File menu. The Print Data dialog box appears.
2. In the First Page Number box, type the number you want to assign to the first printed 

page of the spreadsheet.
Note: The first page number is also valid when selecting a range of pages to print in the 
Print Pages group, i.e., if the number five is assigned to the first page and you want to 
print the first ten pages, the print range is from page five to page fifteen.



Creating headers and footers
You can set headers and footers that appear on every printed page of your spreadsheet.
To create headers and footers:

1. Choose Page Setup from the Data Manager File menu. The Page Setup dialog box 
appears. Choosing Print from the File menu and clicking the Page button does the 
same.

2. In the Header text box, type the text you want at the top of each printed page.
3. In the Footer text box, type the text you want at the bottom of each printed page.
4. In both the Header and Footer boxes, insert the text alignment codes to the left of the 

text and the automatic codes if needed. See Header and Footer Formats for a list of 
codes.

5. Click the Font button to select the font face, style and size for printing the headers and 
footers.



Setting the spreadsheet margins
1. Choose Page Setup from the Data Manager File menu. The Page Setup dialog box 

appears. Choosing Print from the File menu and clicking the Page button does the 
same.

2. Click the arrow in the Units box to choose units of measurement from the drop-down list.
3. In the Margins group, type the width of the four margins in the Left, Top, Right and 

Bottom boxes.
Note: Most printers have minimum margin widths, which override a spreadsheet margin set 
to zero. The margins you set in Data Manager are added to your printer's minimum margins. 
Use Print Preview to see how the spreadsheet will print on-screen.



Printing row numbers and column letters
You can set row and column button labels to print.
To print row numbers and column letters:

1. In Data Manager, choose Page Setup from the File menu.
2. Check the Print Labels check box to print the row numbers and column letters.



Printing spreadsheet gridlines
1. In Data Manager, choose Page Setup from the File menu.
2. Check the Print Grid check box.



Printing cell borders and patterns
You have a choice when printing to show the borders and patterns applied to cells using the 
commands from the Format menu.
To print cell borders and patterns:

1. In Data Manager, choose Page Setup from the File menu.
2. Check the Print Shadow check box to print the patterns applied to cells.
3. Check the Print Borders check box. 



Saving printing time by turning off OLE objects
To shorten printing times for drafts, you can turn off the Print OLE Objects option in the 
Page Setup dialog box. 
To turn off printing for OLE objects in a spreadsheet:

1. In Data Manager, choose Page Setup from the File menu.
2. Deselect the Print OLE Objects check box. 



Printing a spreadsheet from Print Preview
The Print Preview command can be used as an alternative to the Print command. Print 
Preview gives you a visual representation of your spreadsheet pages and to all print options 
available through the Print command.
To print a spreadsheet using Print Preview:

1. In Data Manager, choose Print Preview from the File menu. The first page of the 
spreadsheet appears in the Preview screen.

2. Press the PgDn key to see the next pages, PgUp to go backwards. Click the Goto button 
to go to a specific page.

3. Click the Zoom button to magnify the view of the preview, click it again to zoom away.
4. Click Margins to set the top, left, bottom and right margins.
5. Click Page to open the Page Setup dialog box used to create headers and footers and 

choose the elements of the spreadsheet that will print (Row and column labels, cell 
borders and patterns, grid and OLE objects)

6. Click Setup to choose and setup a printer.
7. Click Close to exit the Print Preview without printing.
8. Click Print to display the Print Data dialog box.
9. In the Print Data dialog box, choose the range of pages or cells to print, type the 

number of copies and the page number of the first page.



Creating file icons
Using drag and drop to create file icons for CorelCHART files you use regularly can speed up 
your work. The files will load automatically when you launch CorelCHART. 
To create file icons, just drag and drop as shown below:

1. Open the Windows File Manager or an equivalent file management program.
2. Resize the file manager window so that other Program Groups are visible.
3. Open the drive and directory where your file is located
4. Click the file and drag it into a Program Group window.

Windows automatically creates the icon you need in the chosen Program Group.
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Launching files from File Manager
Using Windows File Manager or an equivalent utility to start a work session saves time by 
opening the file and program you want to use at the same time to begin a work session.
To open a file from File Manager:

1. Open the File Manager from Windows Main Program Group.
2. Choose the directory containing your file.
3. Locate the file you want to work with and double-click its icon.



Working with multiple charts
You can have multiple CorelCHART windows, i.e., charts and corresponding spreadsheets, 
opened at the same time. 
To view several charts at a time:

1. Open the charts you want to view.
2. Choose Cascade (Shift+F5), Tile Vertically (Shift+F4) or Tile Horizontally from the 

Window Menu.
Tip: You can also "iconize," or reduce to icons, extra open Data Manager or Chart 

windows, just as you can program windows. Your file windows will appear at the 
bottom of the CorelCHART window and CorelCHART will automatically resize open 
file windows to keep iconized files visible.



Entering dates and times
Data Manager recognizes the following date and time formats and separators. Follow these 
conventions when entering dates and times. The earliest available date is 
December 31, 1899, and the last available date is June 4, 2079.
12/03/93 Displays month first, then day, then year
3-Dec-93 Displays day first, then month, then year
3-Dec Displays day, then month
Dec-93 Displays only the month and year
11:33 Displays hours and minutes
11:33:44 Displays hours, minutes and seconds
11:33 AM Displays the time using the 12-hour clock
12/03/93 11:33 Displays date and time
Use "/" or "-" to separate year, month, and day; use ":" to separate hour, minute, and 
second.



Using alphanumeric date and time values in formulas
DATEVALUE, DAYS360 and TIMEVALUE are the only Date and Time Functions which normally 
recognize alphanumeric values. 
To use alphanumeric date and time values with other Date and Time Functions: 

· Nest DATEVALUE, DAYS360 or TIMEVALUE in your formula.
The syntax =DAY("July-16-1994") returns #BAD DATA!, but 
=DAY(DATEVALUE("July-16-1994")) = 16

or
· Reference a cell or range of cells containing any recognized date/time format by Data 

Manager, i.e., =MONTH(A1) = 4 if cell A1 contains Thursday April-14-1994.



Setting chart page size and orientation
You can change the size and orientation of a chart page to match the page size of the printer
or other output device you are using. 
To set the size and orientation of the page:

1. Choose Page Setup from the Chart View File menu.
2. Choose the Orientation option you want. The options are Portrait and Landscape.

When you print the chart, a message will appear if the Printable Page and printer page 
orientation (as specified with the Print Setup command) do not match. The message will
ask if you want CorelCHART to change the printer orientation to match Printable Page.

3. Do one of the following:
· Choose one of the preset page sizes.
· Choose Custom and type the Horizontal and Vertical dimensions you want.
To use a different unit of measurement, choose one from the units box. CorelCHART will 
convert the value to its equivalent in the unit you choose.
Clicking the Set From Printer button will set the size and orientation of your page to 
whatever is specified for the currently active printer.



Setting up a spreadsheet's printable page
The page settings you choose with the following procedure take effect only when you print 
your spreadsheet. See also Print Preview command and Print setup
To set up the spreadsheet's printable page:

1. Choose Page Setup from the File menu.
2. In the Page Setup dialog box, type header or footer text if you want a text string to 

appear at the top or bottom of every printed page. Headers and footers are saved 
automatically with your spreadsheet. See also Header and Footer Formats

3. Click the Font... button to choose a typeface, style and size for the header and footer. 
See also Font dialog box

4. Click OK to return to the Page setup dialog box.
5. Type the amount of space you want between the edge of the paper and the printed 

spreadsheet in the Margins text boxes. Click the units box if you want to change units of
measurement.

6. Click one or more of the options. Print Shadow prints the cell patterns applied with the 
Pattern command, Grid prints cell gridlines, Borders prints borders added with the 
Borders command and Labels prints row numbers and column letters. The Color option, 
available only when printing to a color printer, prints color borders and patterns. 



Setting page orientation
1. Choose Print Setup from the File Menu.
2. Click Setup in the Printer Setup dialog box.
3. Choose a page layout--Portrait or Landscape--from the Orientation box at the bottom left

of the resulting dialog box. 



Automatically filling series
The Fill Series command automatically speeds up your work by filling a larger range of cells 
based on existing data. Fill Series works with dates, times and number sequences. See also 
Fill series command (Data menu)
To use Fill Series:

1. Select a range of at least two cells upon which you want to base your autofill.
2. Extend the selection to the end of the range you want to fill.
2. Click Fill Series from the Data Menu.
3. Choose the options which apply and click OK.



Using the Enter Formula dialog box
The Enter Formula dialog box contains a listing of nearly 300 spreadsheet functions available
in the Data Manager in the following subject areas: Conversion, Date and Time, DDE, 
Engineering, Finance, Information, Logic, Lookup and Reference, Math and Trig, Statistics and
Text. See also Spreadsheet Functions 
To enter a formula:

1. Click the Enter Formula button on the Ribbon Bar or press F12.
2. Key in your formula, including any required functions and separators into the Editor box 

at the top of the Enter Formula dialog box.
or,

1. Choose a function category from the Functions Text Box at the bottom right of the Enter 
Formula dialog box. 

2. Click the function list on the right-hand side of the dialog box. Scroll to and click the 
function you're looking for.

3. Choose a function and then key in the required arguments.
Tips: Choose a spreadsheet function and then click the Dialog's Help Button for a 

specific Help topic.
It is not necessary to use the equal sign operator at the beginning of your 
formula if you're using the Enter Formula dialog box.
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Entering formulas directly into a cell
If you are familiar with the functions and syntax a given formula requires, you can enter it 
directly into a cell rather than using the Enter Formula dialog box. See also Spreadsheet 
Functions
To enter a formula directly:

1. Choose the cell where you want to enter your formula.
2. Type an equal sign (=), your function, (e.g., SUM) values or cell addresses, operator(s) 

and separators.
3. If you don't know the addresses of the cells you want to include, scroll to the area, click 

the first cell in the desired range and drag the mouse pointer until the entire range is 
selected and click OK.



Using Context-sensitive Help with Functions
Context-sensitive Help is available for all spreadsheet functions from the Enter Formula 
dialog box.
To get context-sensitive Help about a spreadsheet function:

1. Choose a function category (Conversion, Date and Time, DDE, Engineering, Finance, 
Information, Logic, Lookup and Reference, Math and Trig, Statistics or Text) from the 
Functions list box.

2. Click a spreadsheet function, e.g., in the Enter Formula dialog box's Functions list box 
under Math & Trig functions, choose sum.

3. Choose the Dialog's Help Button.
A Help window will open with a specific Help topic about the selected function.



Using the Formula bar
The Formula bar, located just below the Tag Bar, is used for composing spreadsheet formulas
in the Data Manager. 

1. Click the Formula bar
2. Press the equal sign.
3. Key in your formula including any required functions, cell references and separators and

click OK.
See also Entering formulas directly into a cell



Editing a formula directly in a cell
There are two methods for editing a spreadsheet formula--using the Formula bar or editing 
directly in the cell that contains the formula. Editing the formula in a cell works only when 
the Formula command is turned off (the default) in the View menu.
To edit a formula directly in a cell:

1. Choose the cell containing the formula. 
2. If the Formula command in the View menu is enabled, click it to turn it off.
3. Press F2. The formula appears in the cell.
4. Click inside the formula to position the cursor, which becomes a blinking I-bar.
5. Edit the formula.
6. Press the Enter key to apply the changes. The formula is replaced by its result in the 

cell.



Editing a formula using the Formula bar
The Formula bar is located just below the Tag Bar. 
To edit a formula using the Formula bar:

1. Select the cell which contains the formula.
2. Click the Formula bar to position the cursor, which becomes a blinking I-bar.
3. Make the desired changes to the formula.
4. Press the Enter key to apply the changes. The new result appears in the cell.



Entering cell references
Cell references are used within formulas. They tell Data Manager where to look for the data 
needed in the formula. There are three types of references: relative, absolute and mixed.
To enter a cell reference in a formula:

1.  Position the insertion point in the formula where the reference is to appear.
2.  Do one of the following:

· relative reference: Type the column and row co-ordinates of the cell to which 
you want the formula to refer, without spaces e.g., E4.

· absolute reference: Type the dollar sign ($) before the column and row co-
ordinates of the cell, e.g., $E$4.

· mixed reference: Type a combination of the syntax used in the two previous 
points; type the $ before either the column or row co-ordinate to make half of the
reference relative and the other absolute.



Applying pictographs
Pictographs can only be used in horizontal and vertical bar charts and histograms. 
To apply a pictograph:

1. In Chart View, select a bar riser.
2. In the Chart menu, choose Show as Pictograph. If the current chart type does not 

support this feature, the command is not displayed in the Chart menu.
3. Click the Fill tool. The fill flyout menu appears.
4. Click the pictograph button which is the last on the top row of the flyout menu. This 

opens the Pictograph Roll-up.
5. Click Import. In the Import dialog box, locate the CDR file you want to use as a 

pictograph and click OK.
6. The chosen CDR file is displayed in the Pictograph Roll-up. Click Apply. The selected riser

is filled with several pictographs, one for each division on the numeric scale.
See also Using the Pictograph Roll-up



Using the Pictograph Roll-up
The Pictograph Roll-up is used to select or import pictographs, which can replace default 
risers.
To apply pictographs to a chart riser:

1. In Chart View, select a bar riser.
2. In the Chart menu, choose Show as Pictograph. Note: If the current chart type does not 

support this feature, the command is not displayed in the Chart menu.
3. Click the Fill tool. The Fill flyout menu appears.
4. Click the pictograph button--the last button on the top row of the flyout menu. 
5. Click import. In the Import dialog box, locate the CDR file you want to use as a 

pictograph and click OK.
6. The chosen CDR file is displayed in the Pictograph Roll-up. Click Apply. The selected riser

is filled with several pictographs, one for each division on the numeric scale.
See also Applying pictographs



Changing chart types from the Gallery
The Gallery menu lists and displays all available chart types. 
To change a chart type:

1. Open the chart you want to change.
2. From the list in the Gallery menu, click a chart category. A flyout menu appears which 

lists the various chart types available in the selected category.
3. Press and hold the mouse button.
4. Drag the mouse down, over the chart type names. A color visual preview of the 

highlighted chart type appears to help you make your selection.
5. Release the mouse button when the appropriate type is displayed. Your chart is 

converted to the selected chart type.
See also Choosing chart types and Changing chart types with drag and drop



Changing chart types with drag and drop
You can apply a new template to your current chart without changing the underlying data 
using drag and drop.
To drag and drop a new template onto your current chart:

1. Tile your file manager and charting windows.
2. Drag any CorelCHART file from the CorelDRAW50 \PROGRAMS\CHART subdirectory onto 

your current chart.



Using Corel clipart in your charts
Corel provides an extensive clipart library on CD-ROM with the CorelDRAW suite of 
applications. You can import the clipart images in your charts as chart objects. Clipart can 
also be used as pictographs in bar charts and histograms. See also How to... Change a 
chart's appearance 
To use a clipart image as a pictograph:

1. Select a bar riser from a bar chart or histogram.
2. Select Show as Pictograph from the Chart menu. The selected riser displays lines that 

separate it in several equal sections.
3. Click the Fill tool. The fill flyout menu appears.
4. Click the Pictograph button, the last on the top row of the flyout menu. This opens the 

Pictograph Roll-up.
5. Click import. In the Import dialog box, choose the drive letter for your CD-ROM drive and

locate the clipart (.CDR) file you want to use as a pictograph and click OK.
6. Click Apply to fill the riser sections with the selected clipart.



Drawing straight lines
The Pencil tool is used draw straight lines, polygons and curves. You can set attributes for 
lines by using the Outline tool.
To draw a straight line:

1. Click the Pencil tool. A flyout menu appears.

2. Click the Line tool    
3. Move to where you want to start the line and click and hold the mouse button. 
4. Drag the mouse to where you want the line to end. Release the button.



Drawing polygons
The Pencil tool is used draw straight lines, polygons and curves. You set fill and outline 
attributes for polygons with the Outline and Fill tools.
To draw a polygon:

1. Click the Pencil tool. A flyout menu appears.

2. Click the polygon button    .
3. Move to where you want to start the polygon and click the mouse button. 
4. Release the mouse button and move to another location and click again. Repeat this 
process until you have the desired shape, then double-click to close the polygon.



Drawing curves
The Pencil tool is used draw straight lines, polygons and curves. You can set attributes for 
those curves by using the Outline tool.
To draw a curve:

1. Click the Pencil tool. A flyout menu appears.

2. Click the freehand drawing tool    .
3. Move to where you want to start the curve and click the mouse button. Hold the 
mouse button down while drawing.



Drawing squares and rectangles
1. Click the Rectangle tool and move the cursor to where you want to start the rectangle.
2. Click and drag the mouse until you have the desired rectangle, then release.

Holding down the Ctrl key while dragging draws a square.



Rounding the corners of rectangles and squares
1. Click the corner of a rectangle or square with the right mouse button.
2. From the pop-up menu, choose Corner Roundness. 
3. Choose one of the degrees of roundness from the flyout menu.

Shortcut
To switch back and forth between the Rectangle and the Pick tools, press the space bar 
with either one selected.



Drawing circles and ellipses
1. Click the Ellipse tool and move the cursor to where you want to start the ellipse.
2. Click and drag the mouse until you have the desired ellipse, then release.

Holding down the Ctrl key while dragging draws a circle.

Shortcut
To switch back and forth between the Rectangle and the Pick tools, press the space bar 
with either one selected.



Adding text to a chart
1. Click the Text tool. 
2. Move the cursor to where you want the text to begin and click. The cursor changes to a 

blinking I-bar, called the insertion point.
3. Type in your text. 



Creating 3D text
While the default setting is two-dimensional, in 3D charts, you can display titles, axis 
markers, series and group headers in 3D perspective.
To show text in 3D perspective:

1. Click a title, axis marker, series or group header with the right mouse button.
2. Choose Text View Options... from the popup menu.
3. Click 3D perspective text.
4. Choose from the 3D Placement Options listed. 

You can place your text parallel or perpendicular to the chart floor or walls, or align it 
towards or away from the chart's implied vanishing point.

5. Choose Align to... Inside Edge or Outside Edge of the chart walls.
See also Autofitting headers in 3D charts



Autofitting headers in 3D charts
In three-dimensional charts, you can display all 2D headers all the same size (the default 
setting) or have them change size to match their relationship to the chart. The higher the 
number, the larger the title. See also Creating 3D text
To set autofitted text options:

1. Click a title, axis marker, series or group header with the right mouse button.
2. Choose Text View Options... from the popup menu.
3. Click Headers Change Size With Perspective.



Editing text in Chart View
To edit and format text:

1. Select the Text tool then, move the cursor to the text you want to edit. 
2. Click the text.
3. Once the I-bar cursor appears do any of the following:

 To Do this
Move insertion point Point and click on the new location, or press the followings keys or 

combinations of keys:
, ¯, ¬, ® moves in direction of arrow
HOME moves to start of text
END moves to end of current line
Select any text Drag across the text with the mouse.
Delete text Press the BACKSPACE or DEL key to delete one character at a time or select 

the characters and press the DEL key. 
Add text Move the insertion point to where you want the text to start, then type.
Replace text Select text and begin typing.
Copy to Clipboard Select text and press CTRL+C or choose Copy from the Edit menu.
Cut to Clipboard Select text and press CTRL+X or choose Cut from the Edit menu.
Paste Press CTRL+V or choose Paste from the Edit menu.



Changing the font, size and style (Chart View)
The Text Ribbon bar allows you to set or change many text attributes quickly and easily. The 
text itself can be an inherent part of the chart such as the title, subtitle, footnote, data or 
category axis labels, or annotation text, created using the Text tool.
To change the font, size and style:

1. Select the text object with the Pick tool.
2. Click the Font Name list box. Type or choose a font from the list. The font is applied to 

text object.
3. In the Font Size list box, type a point size for the text or choose one from the drop-down 

list. 

4. Click  to make the text bold, 

 to italicize text and/or 
 to underline it.

5. Choose Refresh Window from the View menu if parts of the text are not visible or are 
slightly offset.



Setting text alignment in Chart View
In Chart View, the alignment of text within its bounding box can be modified. The Text 
Ribbon bar alignment buttons can be used for annotation text created using the Text tool, or 
text objects inherent to the chart itself, such as the title, subtitle and footnote.
To change the text alignment:

1. Select the text with the Pick tool.
2. Do one of the following:

· Click  to have the text align to the left of its bounding box.

· Click  to center the text in its bounding box.
· Click  to align the text to the right.
· Click  to increase the spacing between characters so that the text is aligned with 
the left and right side of its bounding box.



Adjusting interline spacing in Chart View
The spacing between lines of one text object can be adjusted in Chart View. The change is 
applied to all lines within the selected text object.
To adjust the interline spacing:

1. Select the text object you want to edit. The selection must have at least two lines.

2. Click  to increase the space between all lines in the object. Click 

 to reduce it.
3. Repeat step 2 until the spacing is as required.



Adjusting inter-character spacing (Chart View)
Inter-character spacing, known as kerning, can be adjusted in Chart View for annotation text 
and a chart's title, subtitle or footnote; the spacing set is applied to all characters in a text 
object. 
To adjust inter-character spacing:

1. Select the text you want to edit.

2. Click  to increase the spacing between characters, 

 to reduce it. 
3. Repeat step 2 until the spacing is as required.



Hiding or showing chart objects
Hiding chart objects increases the redraw speed and space on your page. You can choose 
precisely which chart objects you want to hide and show, or hide all text on your chart. The 
hidden objects still exist and are saved with the chart.
To hide or show elements of a chart:

1. Choose Display Status from the Chart menu and do any of the following:
· In the Display Status dialog box, check the object boxes for the chart objects you want 

displayed. The objects included in the dialog box vary according to the chart type you 
are using.
or

· Clear the boxes for the chart objects you want to hide.
or

· Click NO Text to hide all text, ALL Text to display all the text.



Deleting chart objects
Unlike chart objects, annotations created with drawing tools and imported objects can be 
removed from the current chart as follows:

1. Select the object with the Pick tool.
2. Press the DEL key.



Making combination charts
CorelCHART allows you to make combination charts.
To make a combination chart:

1. Open a Bar or Line chart. 
2. Select the riser you want to emphasize.
3. If you're working with a line chart, choose Display as Bar from the Chart menu. If you're 

working with a bar chart, choose Display as Line. 
4. To revert to the original riser type, deselect Display as Line/Bar.



Selecting objects
To select one object:

1. Choose the Pick tool.
2. Click the object or its outline.

When an object is selected, a highlighting box with eight handles appears around the 
object (in some cases only a highlighted box appears).

To select multiple objects:
1. Click the Pick tool.
2. Press and hold down the Shift Key.
3. Click every object you want to select or their respective outlines.



Moving objects
1. Choose the Pick tool.
2. Do one of the following:

· click anywhere there is no handle on the object's highlighting box 
· click anywhere on the object's fill

3. Hold down the mouse button and drag the object to its new location.



Resizing annotation objects
Annotation objects are objects created with the Chart View drawing tools and added to the 
chart.
To resize annotation objects:

1. Select an annotation object. It is surrounded by eight square selection handles.
2. Do one of the following:

· Click and drag a corner handle to resize the object while maintaining its original 
aspect ratio. A dotted rectangular bounding box appears. It represents the selected 
object as you are scaling it.

· Drag a middle selection handle to stretch or compress the object in one direction. The
object's aspect ratio will change.

3. Release the mouse button when the bounding box has the desired size. The object's 
edges are at the precise location of the bounding box.

Note: Text annotation objects can only be scaled proportionately. They cannot be stretched 
or compressed. When you drag a middle handle, both the text's width and height are 
modified.



Resizing chart objects
Some chart objects such as the risers and legend markers cannot be resized individually 
with the Pick tool. They are however resized when the chart or legend background are scaled
or stretched. Riser size for some chart types can be modified by choosing a command from 
the Chart menu.
To resize chart objects:

1. Select the object with the Pick tool. The object is surrounded by square selection 
handles. If the object is enclosed in a rectangular frame when selected, it is a chart 
object that cannot be individually resized.

2. Do one of the following:
· Click and drag a corner handle to scale the object and maintain its aspect ratio. A 

rectangular dotted bounding box; representing the selected object as you are resizing
it, appears.

· Drag a middle selection handle to stretch or compress the object in one direction. The
object's aspect ratio will change.

3. Release the mouse when the bounding box is of the desired size. The object redraws.
Note: Text objects (title, subtitle, footnote) cannot be stretched. Dragging the top or bottom 
middle handle of a text objects scales it. Dragging the left or right middle handle relocates 
the text within the bounding box without changing its size. The object is scaled down when 
you drag the handle enough to make the bounding box shorter than the original text object.



Reversing the order within groups and series
Reversing the order within groups and series can be a useful way to show a different 
emphasis for data and is available for in all chart types except table charts. Reversing a 
series changes the order of the related items. Reversing groups makes the data run from 
last to first on the category axis. 
To reverse data:

1. Click the right mouse button on any bar, pie, slice, line or riser.
2. Choose Data Reversal. A flyout will appear, containing the Reverse Series and Reverse 

Groups toggle commands.
3. Choose Reverse Series or Reverse Groups. The reversal will be executed and will appear

as a check mark on the flyout the next time you choose Data Reversal.



Applying templates from other charts
A chart template is any saved chart file (.CCH).
To apply another chart template to your current chart:

1. Choose Apply Template from the File menu. The Open Chart dialog box will appear.
2. In the File Name box, type the name of the chart template you want to open or select 

one from the lists contained in the folders under the Corel 5.0\CHART subdirectory. 
If the template you want is in another drive or directory, select the drive from the Drives
box and the directory from the Directories box.
Note: When you click a .CCH template in the File Name list box, you'll see a Preview of 

the chart, and a description if available, in the Preview box.
See also
Changing chart types from the Gallery
Changing chart types with drag and drop



Changing the scale range
Altering a chart's scale range manipulates data to show the trends you want to highlight.
To change a scale range:

1. Click any data value on a data axis with the right mouse button.
2. Choose from the scale choices identified--Linear Scale, Log Scale, Ascending Scale, 

Autofitted Scale, Staggered Scale--or click Scale Range... to open a dialog box.
3. Choose from the options listed (Exclude Minimum or Exclude Maximum, and Automatic 

Scale or Manual Scale) and click OK.
See also Scale Range dialog box



Displaying legends
1. In Chart View, choose Legend from the Chart menu. 
2. In the Legend dialog box, click Display Legend. 

See also Modifying legend layout



Modifying legend layout
The Legend command in the Chart menu lets you change the orientation, layout and text 
item location of your chart legend. 
To modify the legend layout:

1. Choose Legend from the Chart menu. The Legend dialog box appears.
2. To hide the legend, click Display Legend to deselect it.
3. Do one or more of the following:

· click Autofit Legend Text to have the text automatically sized to fit the legend box. If 
you change the legend box size, the text is resized automatically. You cannot change 
the point size of autofitted text using the text ribbon.

· choose a position for the text in relation to the legend marker, the legend's 
rectangular display area, by clicking a text option. The text's alignment determines 
its position on the marker. For example, if text is left aligned, the last character will 
appear on the marker. Use the alignment buttons on the Text Ribbon to change text 
alignment.

4. Choose the legend orientation by clicking an option. Automatic Orientation places the 
legend in the default location for the current chart type.

5. If you select Vertical or Horizontal, you can determine the number of markers per 
column or row. Type the number in the box.



Modifying legend layout
The Legend command in the Chart menu lets you change the orientation, layout and text 
item location of your chart legend. 
To modify the legend layout:

1. Choose Legend from the Chart menu. The Legend dialog box appears.
2. To hide the legend, click Display Legend to deselect it.
3. Do one or more of the following:

· click Autofit Legend Text to have the text automatically sized to fit the legend box. If 
you change the legend box size, the text is resized automatically. You cannot change 
the point size of autofitted text using the text ribbon.

· choose a position for the text in relation to the legend marker, the legend's 
rectangular display area, by clicking a text option. The text's alignment determines 
its position on the marker. For example, if text is left aligned, the last character will 
appear on the marker. Use the alignment buttons on the Text Ribbon to change text 
alignment.

4. Choose the legend orientation by clicking an option. Automatic Orientation places the 
legend in the default location for the current chart type.

5. If you select Vertical or Horizontal, you can determine the number of markers per 
column or row. Type the number in the box.



Applying patterns to cells
You can apply a pattern or shadow to a cell or range of cells to emphasize a particular string 
of data or differentiate groups of data.
To apply a pattern:

1. Select a cell or a range of cells.
2. Choose Patterns from the Format menu.
3. In the Patterns dialog box, choose a pattern from the Brushes group.
4. Select background and foreground colors by clicking the color selection boxes to display 

the drop-down color palette.



Removing cell patterns
1. Select the cell(s) for which you want to delete the pattern.
2. Choose Clear from the Edit menu or press the DEL key.
3. In the Clear Options dialog box, check Patterns in the Format group. Clear the boxes for 

the data and formats you want to keep.



Switching between Chart View and Data Manager
You may use CorelCHART's Data Manager simply to hold the text and data you need to 
create your charts, or to design spreadsheet presentations to be used on their own.
To switch to Data Manager:

· Click  at the top left-hand corner of the Chart View screen.
To switch back to Chart View:

· Click  at the top left-hand corner of the Data Manager screen.
Tip: After you have switched to Data Manager once as described above, use Ctrl+tab 

to toggle between screens.



Entering information in a cell
Each cell in Data Manager can contain text, values or formulas. You can type up to 255 
characters in a cell. Some characters may not be shown in a cell if a column is not wide 
enough and an adjacent cell contains data. 
To enter information into a cell:

1. Select the cell in which you want to enter information.
2. Type the entry. The information you are typing appears simultaneously in the selected 

cell and in the Formula bar.
3. Press Enter to accept the information entered or Esc to cancel your entry and remove 

the data from the cell.



Entering information in a group of cells
Selecting a range of cells before entering data can speed up your work.
To enter information in a group of cells:

1. Select a range of cells by holding down the mouse button and dragging from the top 
left-hand corner to the bottom right-hand corner of the desired range.

2. Release the mouse button. The first selected cell remains active.
3. Type the first entry. The entry appears in the Formula bar and in the current cell.
4. Press Enter. The cell immediately below the first cell is now current. If you have reached 

the bottom of the first column of selected cells, the first cell in the next column is 
current.

5. Repeat steps 3 and 4 to enter data in the range as necessary.



Editing cell contents
1. Select the cell
2. Click the Formula bar.
3. Make the changes to the cell's contents in the Formula bar.
4. Press Enter to accept the changes or Esc to cancel them and retain the previous data.
See also Editing a formula directly in a cell



Moving to a specific cell using a cell address
The GoTo command is convenient when you know the address you want to be the current 
cell. 
To move to a specific cell using a cell address:

1. From the Data menu, choose GoTo.
2. In the Go to Cell dialog box, type the address of the cell you want to move to.
3. Click OK. The specified address is the current cell.



Selecting multiple cells
1. Click the cell in the upper left corner of the area you want to select.
2. Hold down the mouse button and drag the mouse cursor to the lower right corner of 

the area.
3. Release the mouse button. The selected range of cells is highlighted and the first cell 

in the range becomes the active cell.



Selecting an entire row or column
Clicking the right mouse button on a Column or Row button (at the top and left sides of a 
spreadsheet) activates the popup format menu. The popup includes the following options for
formatting, inserting and deleting rows and columns:
Insert Inserts a column to the right of the column selected, or beneath the row 

selected
Delete Deletes the column(s) or row(s) selected.
Column Width Brings up a column width box. Reset width in the default measure of 

points, or change the measure to millimeters, centimeters, or picas and 
points.

Row Height Brings up a row height box. Reset row height in the default measure of 
points, or change the measure to millimeters, centimeters, or picas and 
points.

To select multiple rows or columns, position the mouse pointer over a column or row header,
press the left mouse button and drag in either direction until the desired number of columns 
or rows are selected. To deselect, click anywhere else in the spreadsheet.
Note:You may also select multiple rows and columns or blocks of data by clicking the first 

cell you want to select and dragging diagonally, vertically over the area with the 
mouse.

See also Scrolling and selecting cells and Right mouse button shortcuts... in a spreadsheet



Tagging cells automatically
1. Enter or paste your data into the spreadsheet following the layout for the sample data in

the template for the chart type you want to create. Ignore the elements that your chart 
does not use and leave the corresponding cells blank. To tag only a portion of a 
spreadsheet, select the data range.

2. Click the Autoscan button in the Tag bar. Autoscan looks for the chart elements in 
particular places and assigns the appropriate tags.

See also Tagging cells manually



Tagging cells automatically
1. Enter or paste your data into the spreadsheet following the sample layout. Ignore the 

elements that your chart does not use and leave the corresponding cells blank. To tag 
only a portion of a spreadsheet, select the data range.

2. Click the Autoscan button in the Tag bar. Autoscan looks for the chart elements in 
particular places and assigns the appropriate tags.

See also Tagging cells manually



Tagging cells manually
This procedure is an alternative to tagging cells automatically which is useful when the 
layout of your data does not correspond to the sample layout.
To tag cells manually:

1. Select a cell or group of cells.
2. From the drop-down tag list, choose the tag to be assigned to the selected cell(s).



Sorting data
The Sort command in the Data menu allows you to sort data. You can sort all of the data or a
partial area. Several options allow you to control how CorelCHART sorts the data.
To sort data:

1. Select the range of cells you wish to sort.
2. Choose Sort from the Data menu. The Sort dialog box appears.
3. Click either Rows or Columns to choose the type of sort and type the address of the cell 

to use as the sort criteria.
4. Click the Ascending or Descending radio button to choose the sort order.
5. Check the Adjust Formulas option to recalculate relative references in formulas after the

sort.
6. Check the Move Formats option to move the cell format along with the data during the 

sort.
7. Press Enter to start sorting. The sorted data is displayed in the spreadsheet.



Finding data
The Find command is a fast way to search for a specific cell. The Find Previous and Find Next 
commands are used to move through several or all occurrences of specific data in a large 
spreadsheet.
To find specific data:

1. Choose Find from the Data menu. The Find dialog box appears.
2. Type the text, formula or formula value to locate in the Find box.
3. Specify the following options:

· in the Look by group, the search order: by rows or by columns
· in the Look in group, the kind of data to look for: formulas, formula value or text
· the direction of the search starting from the current cell: forward or backward

4. Check the Ignore Case option to ignore upper case text.
5. Check the Whole Cell option if the entire cell contents should match the search string.
6. Click the Find button. The first cell containing the search string is highlighted. 
7. Use the Find Next or Find Prev commands in the Data menu to find the next or previous 

occurrence of the search string.



Finding and replacing data
The Find & Replace command in the Edit menu allows you to locate a specific string in a 
spreadsheet and replace it with a new string.
To replace data:

1. Choose Find & Replace from the Edit menu. 
2. Type the string to locate in the Find What box. To find only the instances when the 

search string is the entire cell contents, check the Whole Cell option.
3. Type the string to replace the search string with in the Replace With box.
4. To replace the whole cell contents, check the Whole Cell option next to the Replace With

box. To replace only the part of the cell that matches the search string, disable the 
Whole Cell option.

5. Specify the following options:
· in Search for group, choose the type of data to look for: text, formulas or values
· in Search by, choose the search order: by row or column

6. Check the Match Case option to find only the strings that match the combination of 
upper and lower case characters of the Find What string.

7. Check the Verify on Replace option if you want to be notified when the search string is 
found.

8. To start searching, do one of the following:
· Click Replace All to replace all occurrences of the search string. If the Verify on 

Replace option is enabled, a second dialog box appears. Click Find Next to skip the 
current string and find the next one. Click Replace to replace the current cell and find 
the next one. Click Replace All to override the Verify on Replace option selected 
previously. 

· Click Find Next to see the first occurrence of the search string and stop the process. If
the Verify on Replace option is enabled, a second dialog box appears:

· Click Find Next to skip the current cell and find the next one. Click Replace to replace  
the current cell. Click Find Next again to move to the next occurrence. Repeat as 
many times as needed.

· Click Replace All to override the Verify on Replace option specified previously and 
replace all occurrences without being advised.



Changing the font, size and style in Data Manager
You can change the font, typestyle and point size used in spreadsheet cells by using the Font
Command in the Format menu or the Text Ribbon bar. 
To change the font, size and style:

1. Select a cell or range of cells containing text or numeric values.
2. Click the Font Name list box. Type or choose a font from the list. The font is applied to 

the text.
3. In the Font Size list box, type a point size for the text or choose one from the drop-down 

list. 

4. Click  to make the text bold, 

 to italicize it and/or 
 to underline it.

Each attribute is applied to the text in the selected cells immediately after you set it. 
Note: Text attributes can be saved in a style. Style can be applied to other cells and made 
available to all CorelCHART spreadsheets giving you quick access to customized settings. 
See also Style command 



Setting horizontal text alignment in Data Manager
To set the horizontal alignment of text in cells:

1. Select a cell or range of cells.
2. Choose Alignment from the Format menu.
3. In the Alignment dialog box, in the Horizontal group, do one of the following:

· check Left to align the cell contents to the left
· check Center to center the contents in the cell
· check Right to align the cell contents to the right
· check Auto to align text to the left and numeric values to the right of the cell

4. Type a value in the Indent box to set the alignment to anywhere between the choices 
mentioned above. The indent is calculated from the left of the cell and uses the units 
you set in the units box.

5. Check Word Wrap if you want long text strings in a single cell to display on several 
lines within the cell.

Note: The horizontal alignment of cell contents can also be set using the Text Ribbon bar 

alignment buttons. 



Setting vertical text alignment in Data Manager
The vertical alignment of cell contents--text or numeric values--can only be set in the 
Alignment dialog box. The horizontal alignment can be set in the dialog box or with the Text 
Ribbon bar alignment buttons.
To set the vertical alignment of cell contents (text and numeric values):

1. Select a cell or range of cells.
2. Choose Alignment from the Format menu.
3. in the Vertical group of the Alignment dialog box, check the radio button that 

corresponds to the desired alignment. The text or value can be aligned with the top or 
bottom of the cell. The Baseline option centers the cell contents; this is more visible 
when row height has been increased.



Editing individual characters in a cell
You can set attributes for individual characters with in-cell editing.
To edit attributes of individual characters in a cell:

1. Select a cell.
2. Press F2. The cell is highlighted.
3. Click the cell. A blinking cursor appears in the cell.
4. Select characters by pressing and holding down the mouse and dragging over the 

characters. Release the mouse. The characters are highlighted.
5. Set the font, typestyle and point size using the Text Ribbon bar.
6. Repeat steps 4 and 5 to modify the attributes of other characters in the cell.



Editing text with the pop-up menu
Cell text attributes can be modified with the Data Manager pop-up menu. This method is 
available when changing the attributes of all characters in a cell or range of cells.
To edit text attributes using the pop-up menu:

1. Select a cell or range of cells.
2. Click the right mouse button. The pop-up menu appears.
3. Click Font to access a the Font dialog box for choosing a font, size and style. Click OK to 

apply the changes to the cell.
4. Repeat step 2 and choose Alignment to set the justification of the cell contents.
5. Repeat the process to apply other attributes found in the pop-up menu such as Numeric 

format, Borders, Patterns or Styles.



Recalculating the spreadsheet
Data Manager offers several ways to determine when and how it recalculates spreadsheet 
values. If you are working on a large spreadsheet, recalculating after every change slows 
you down.
To recalculate automatically do one of the following:

1. Choose Auto Recalc from the Options menu. A marker appears next to the command 
name in the menu. Data Manager will recalculate all formulas in your spreadsheet after 
every change made.

2. Press the Auto Recalc button in the Data Manager text ribbon. The button, when active, 
is highlighted and has the same effect as the Auto Recalc command mentioned above. 

To recalculate now:
1. Choose Recalc Now from the Options menu. Data Manager immediately recalculates all 

formulas in the spreadsheet.



Updating your chart
As you edit data in a Data Manager spreadsheet, by default the corresponding chart in Chart
View changes. The Data Manager Data menu includes options to control when the changes 
take effect in Chart View.
To update the chart at a specific time:

1. Deselect Auto Update Chart from the Data Manager's Data menu.
2. Choose Update Chart Now from the Data Manager Data menu when you want to update.

Data Manager remains current as the chart is updated in the background. 



Adjusting row height using the mouse
1. Position the mouse pointer over the bottom portion of the row number for the row to be 

adjusted.
2. The cursor changes to a horizontal double. Drag the cursor up or down until the desired 

row height is set.



Adjusting row height with numeric precision
1. Select an entire row or group of cells in a row. you can select several rows at once if you

want each one to have the same height.
2. Choose Row Height from the Format menu.
3. In the Row Height dialog box type the desired height. Click the units box to change the 

units of measurement.
4. Click the Default Value box to return to the default row height of 16 points.



Adjusting column width with numeric precision
1. Select an entire column or cells in a column. You can select several columns at once if 

you want all of them to have the same width.
2. Choose Column Width from the Format menu.
3. In the Column Width dialog box type the desired width. Click the units box to change the

units of measurement.
4. Click the Default Value box to return to the default column width of 50 points.



Adjusting column width using the mouse
1. Position the mouse pointer on the column heading towards the left or right edge.
2. The cursor changes to a vertical double arrow. Drag the mouse to the right or left until 

the column width is correct.



Hiding columns and rows
You can hide entire columns and rows from view--a useful alternative to moving data you do 
not currently need to see or print. Rows or columns are hidden if button labels are not 
consecutive.
To hide columns or rows:

1. Position the mouse pointer on the edge of the column or row heading. The pointer 
becomes a double-arrow.

2. Drag towards the other edge of the column or row you wish to hide.
3. Release the mouse button. 
The column or row is now hidden.
See also Unhiding columns and rows



Unhiding columns and rows
You can redisplay or "unhide" hidden columns and rows. Hiding columns offers a useful 
alternative to moving data you do not currently need to see or print. You can tell rows or 
columns are hidden if button labels are not consecutive.
To unhide columns or rows:

1. Position the mouse pointer over the line separating the row or column you want to 
unhide. 
The pointer becomes a double-arrow.

2. Drag the double-arrow cursor towards the right to unhide a column. Drag down to 
unhide a row.

See also Hiding columns and rows



Applying cell borders
You can apply a border to selected cells to emphasize a particular data string or visually 
differentiate different types of data.
To apply a cell border:

1. Select one or several cells.
2. Choose Borders from the Format menu.
3. Click the border location. The Outline option applies a border to all four sides of the 

cell(s).
4. Click a border style.
5. Click the Color selection box to choose a border color from the drop-down color palette.



Removing cell borders
1. Select the cell(s) for which you want to remove the border.
2. Choose Clear from the Edit menu or press the DEL key.
3. In the Clear Options dialog box, check Borders in the Format group. Clear the boxes for 

the data and formats you want to keep.



Setting horizontal page breaks
Although Data Manager sets default vertical and horizontal page breaks in your data, you 
may also divide print jobs manually using the Set Page Break command.
To set a horizontal page break:

1. Click the cell immediately below where you want the horizontal page break to appear.
2. Click the Set Page Break button on the Data Manager's Ribbon Bar or choose Set Page 

Break from the Format Menu. The page break is indicated by a thin blue line that 
stretches across the spreadsheet.
Note: The Set Page Break function, both from the Ribbon Bar and from the Format 

Menu, is a toggle command. To reverse your action, simply repeat it.



Setting vertical page breaks
Although Data Manager sets default vertical and horizontal page breaks in your data, you 
may also divide print jobs manually using the Set Page Break command.
To set a vertical page break:

1. Position the mouse pointer immediately to the right of the position where you want to 
create the vertical page break.

2. Click the Set Page Break button on the Data Manager's Ribbon Bar or choose Set Page 
Break from the Format Menu. The page break is indicated by a thin blue line that runs 
down the spreadsheet.
Note: The Set Page Break function, both from the Ribbon Bar and from the Format 

Menu, is a toggle command. To reverse your action, simply repeat it.



Turning the grid on and off
· Choose Grid from the View menu. This command switches the grid display on and off.



Displaying chart tags
· Choose Chart Tags from the View menu. This command switches the tags display on and

off.



Creating custom numeric formats
You can create custom numeric formats in both Chart View and Data Manager. CorelCHART 
applies new numeric formats to the data values in the current chart or selected Data 
Manager cells and adds the format to the end of the User Formats list. If you edit an existing 
format, the original remains in the list and the edited format is added to the end of the User 
Formats list.
Chart View:

1. Click a data value with the right mouse button and then choose Number format from the
popup.

2. Type a new code in the Code box, or select and edit one of the built-in formats from the 
Formats list box.

3. Click the Add and OK buttons successively.
CorelCHART applies the new numeric format to all data values.
Data Manager:

1. Select a cell or range of cells.
2. Click the right mouse button and choose Numeric from the Format menu.
3. Type a new code in the Code box, or select and edit one of the built-in formats from the 

Formats list box.
4. Click the Add and OK buttons successively.

See also Understanding Data Formats and User Defined Numeric Formats



Deleting custom numeric formats
You can delete custom numeric formats in both CorelCHART and Data Manager. 
Chart View:

1. Select a data value with the right mouse button and then choose Number format from 
the popup.

2. Select the format you want to delete from the User Formats list.
3. Click the Delete button. The custom numeric format is deleted.

Data Manager:
1. Select a cell or range of cells.
2. Click the right mouse button and choose Numeric from the Format menu.
3. Select the format you want to delete from the Numeric list.
4. Click the Delete and OK buttons successively.

See also Understanding Data Formats and User Defined Numeric Formats



Making custom numeric formats available to all documents
The Style command is used to save formatting options for use in other CorelCHART 
spreadsheets. The options saved in a style can include a numeric format.
To make a user-defined format available to all documents:

1. Choose Style from the Format menu.
2. In the Style dialog box, do one of the following

· click the Number check box on the left side to include the current user-defined 
numeric format in the new style

· click the Number button on the right side to access the Numeric dialog box (Format 
menu), create a new numeric format, click Add and OK. 

3. At the top of the Style dialog box, in the Name drop-down list, type a name for a new 
style or choose the existing style name you wish to assign the numeric format to.

4. If you created a new style name, click the Add button to insert the new style in the list. 
This style, and its numeric format, is now available to format cells in the current 
spreadsheet.

5. Click Save. The Save Styles dialog box appears for saving all styles listed in a style 
sheet (.CCT).

6. Type a name for the style sheet. The new style sheet is available to all spreadsheets. 



Creating a style
The Style command is used to save formatting options for use in spreadsheets. 
To create a style:

1. Choose Style from the Format menu.
2. In the components group, click the options buttons on the right to see the dialog boxes 

used to set attributes for font, alignment, numeric format format, borders and patterns. 
3. In the Name drop-down list at the top of the Style dialog box, type a name for a new 

style or choose an existing style name to which you wish to assign new attributes.
4. If you created a new style name, click the Add button to insert the new style in the list. 

This style is now available to format cells in the current spreadsheet.



Deleting a style
The Style command is used to save formatting options for use in a spreadsheets. 
To delete a style:

1. Choose Style from the Format menu.
2. In the Name drop-down list at the top of the Style dialog box, choose the name of the 

style you want to delete.
3. Click delete.



Selecting a style
In Data Manager, combinations of formatting options can be saved as styles for quick 
access.
To select an existing style:

1. In Data Manager, choose the cell(s) to which you want to apply a different style.
2. In the Text Ribbon Bar, click the arrow to the right of the Styles drop-down list box.
3. In the styles list, click the style. It is applied to selected cell(s).



Making a style available to all spreadsheets
When you create a new style and add it to the styles drop-down list located in the Text 
Ribbon Bar, that style is available to the current spreadsheet only. It must be saved in a style
sheet (.CCT files) to be available to all CorelCHART spreadsheets.
To save a style in a style sheet:

1. Open the spreadsheet which contains the style(s) you want to make available to all 
documents.

2. In Data Manager, choose Style from the Format menu.
3. In the Style dialog box, click the Save button.
4. In the Save Styles dialog box, select the appropriate drive and directory and type a file 

name for the new style sheet.
All styles listed are saved in the new style sheet.



Choosing a style sheet
Style sheets (.CCT files) include a variety of styles which in turn, include several formatting 
options to use to change the appearance of your Data Manager spreadsheet. The Style 
command is used to create styles and save style sheets.
To choose a different style sheet:

1. In Data Manager, choose Style from the Format menu.
2. Click the Load button.
3. In the Load Styles dialog box, choose a style sheet (.CCT). Click OK.

All styles found in the selected style sheet (.CCT) are listed in the styles drop-down list 
in the Text Ribbon.



Choosing numeric formats
You can apply a variety of numeric formats in both CorelCHART and Data Manager. 
Chart View:

1. Select a data value with the right mouse button and choose Number format from the 
popup.

2. Select the category that contains the format you want to use from the Category list.
3. Choose the numeric format you want from the Formats list box and click OK.

CorelCHART applies the new numeric format to all data values.
Data Manager:

1. Select a cell or range of cells.
2. Click the right mouse button and choose Numeric from the popup.
3. Select the category that contains the format you want to use from the Category list.
4. Choose the numeric format you want from the Formats list box and click OK.

CorelCHART applies the new numeric format to the selected cells.
See also Built-in Data Formats and User Defined Numeric Formats



Inserting rows
1. In Data Manager, select a row by clicking the row number located on the left side of the 

spreadsheet.
2. To insert multiple rows, click and drag the cursor down the row numbers. 
3. Choose Edit, Insert.

The selected row and all rows below it shuffle down, and a row of empty cells (with 
default formats) is inserted. In the case of a multiple selection, the rows shuffle down by
the number of new rows inserted.



Inserting columns
1. Select the column to the right of the insertion location by clicking the column letter.
2. To insert multiple columns, click and drag through the column letters of the columns you

want to select.
3. Choose Edit, Insert.

The selected column and all columns to the right shuffle right, and a column with empty
cells is inserted. In the case of a multiple selection, the columns shuffle to the right by 
the number of columns inserted.



Deleting rows 
1. In the Data Manager, select a row by clicking its row number, located on the left side of 

the spreadsheet.
2. To delete multiple rows, click and drag the cursor down the row numbers of the rows 

you want to select. 
3. Choose Delete from the Edit menu.

The selected row disappears and all rows below it move up. In the case of a multiple 
selection, the rows move up by the number of rows deleted.



Deleting rows 
1. In the Data Manager, select a row by clicking its row number, located on the left side of 

the spreadsheet.
2. To delete multiple rows, click and drag the cursor down the row numbers of the rows 

you want to select. 
3. Choose Delete from the Edit menu.

The selected row disappears and all rows below it move up. In the case of a multiple 
selection, the rows move up by the number of rows deleted.



Deleting columns
1. In Data Manager, select the column you want to delete by clicking its column letter.
2. To delete multiple columns, click and drag through the column letters of the columns 

you want to select.
3. Choose Edit, Delete.

The selected column disappears and all columns to the right of it shuffle to the left. In 
the case of a multiple selection, the columns shuffle to the left by the number of 
columns deleted.



Deleting columns
1. In Data Manager, select the column you want to delete by clicking its column letter at 

the top of the spreadsheet.
2. To delete multiple columns, click and drag through their column letters.
3. Choose Edit, Delete.

The selected column disappears and all columns to the right shuffle to the left. In the 
case of a multiple selection, the columns shuffle to the left by the number of columns 
deleted.





 Chart View shortcuts
Tool tips
Menu keys
Speed keys
Mouse tricks
Dialog box shortcuts
Ribbon Bars
Text Ribbon Bars
Creating file icons
Help shortcuts
Shortcut key conventions
Windows shortcuts

See also Data Manager shortcuts



Speed keys
 Key(s) Action

CTRL+R Refreshes the current window

CTRL+TAB Toggles between Data Manager and Chart View

F2 Activates the Zoom cursor

F6 Chooses the Rectangle tool

F7 Chooses the Ellipse tool

F8 Chooses the Text tool

F10 Activates/deactivates the Menu Bar

Note:    This function is available after you have opened Data Manager once by the 
conventional method, either by clicking the Data Manager icon at the top of the Toolbox or 
choosing View Chart Data from the Chart View Edit menu.

ESC-ESC Deactivates the Menu Bar
Menu speed keys

Common menu keys
File menu keys
Edit menu keys
View menu keys
Arrange menu key
Window menu keys
Help shortcuts



Ribbon Bars
CorelCHART's Ribbon Bars, sometimes called button bars, are located just under the Chart 
View and Data Manager Menu Bars. Clicking a button on a Ribbon Bar activates the 
command associated with it. Hold the mouse pointer over a button to see its name or right-
click for Context-sensitive Help.
The Chart View Ribbon Bar, contains the following buttons (from left): New, Open, Save, 
Print, Cut, Copy and Paste, Import and Export, Display Status, Legend, Numeric Format, Data
Analysis, Align, 3D Rollup, Copy Chart, Wireframe and Mosaic Rollup.
The Data Manager's Ribbon Bar includes (from left) New, Open, Save, Print, Cut, Copy and 
Paste, Import and Export, Set Page Break, Number Format, Borders, Patterns, Go to cell, 
Enter Formula Sort, Auto Recalculate, Grid Lines and Mosaic Rollup.
See also Chart View Tools and Ribbon Bars and Data Manager Ribbon Bars



Text Ribbon Bars
CorelCHART's Text Ribbon Bars--located just under the Chart View and Data Manager Ribbon 
Bars--include buttons and drop-down list boxes for setting text attributes such as font type 
and size selection, bold, underline, italic, alignment, inter-character and inter-line spacing. 
Clicking Text Ribbon Bar button activates the command associated with it. Hold the mouse 
pointer over a Text Ribbon button or list box to see its name or right-click for Context-
sensitive Help.
See also Chart View Tools and Ribbon Bars and Data Manager Ribbon Bars



Tool tips
Press the key or keys on the left to produce the action described at right.
 Key(s) Action

CTRL-DRAG-SIZE-HANDLE With the Pick tool active, dragging the sizing handle of an ellipse or 
rectangle constrains size increase/decrease to multiples of the 
original 

CTRL-ELLIPSE Constrains an ellipse drawn to a circle. (Hold the mouse button and 
Ctrl key down and drag in any direction)

SHIFT-ELLIPSE Draws the ellipse from the center outward

CTRL-SHIFT-ELLIPSE Draws a circle from the center outward

CTRL-RECTANGLE Constrains rectangles to squares

SHIFT-RECTANGLE Draws the rectangle from the center outward

CTRL-SHIFT-RECTANGLE Draws a square from the center outward

SPACE BAR Activates the Pick tool when a drawing tool is current

Activates the last drawing tool used when the Pick tool current

ESC Deselects all objects



Menu keys
Common menu keys
File menu keys
Edit menu keys
View menu keys
Arrange menu key
Window menu keys



Common menu keys
The following speed keys are common to all menus. Press the key or keys on the left to 
produce the action described at right.

 Key(s) Result

ALT Activates the menu bar. Press any underlined letter from the 
menu bar to pull down that menu (see the next paragraph). 
Deselect the menu bar by pressing ESC or clicking anywhere in 
the active window

ALT-{MENU LETTER KEY} Opens the drop-down menu. To pull down the menu you want to
use, select its underlined letter after or while pressing the ALT 
key. E.g., ALTFA opens the Save As dialog box.

ALT-"-" or ALT-SPACE BAR Opens the control menu for the current window

ALT-LEFT or ALT-RIGHT ARROW Moves left or right through menus

ARROW KEYS When scrolling through menus, if the selection bar is closer to 
the top, bottom, left or right side, pressing the ARROW key in that
direction side takes you to the opposite end of the menu or 
screen.

UP or DOWN ARROW (2) Chart View's Gallery, Chart and Arrange menus feature 
secondary, or flyout menus, which are indicated by a pointer at 
each menu's right side. To use the arrow keys in a CorelCHART 
flyout menu, with the flyout open, press the UP ARROW to see the
top chart listed, or the DOWN ARROW to see the bottom chart.



File menu keys
 Keys Result

CTRL+N Opens the New Chart dialog box

CTRL+O Opens the Open Chart dialog box

CTRL+S Resaves the current chart and spreadsheet file, replacing previous 
information. 

CTRL+P Opens the Print dialog box

CTRL+J Opens the Preferences dialog box, which controls Display Options, Curve 
Flatness, Preview Colors, and Miter Limit

ALT+F4 Closes both Data Manager and Chart View. A Save Changes message 
appears if there are unsaved changes.



Edit menu keys
 Keys Result

CTRL+Z Undoes the last editing operation

CTRL+X Cuts selected text, data or objects to the Windows Clipboard for retrieval

CTRL+C Copies selected text, data or objects to the Windows Clipboard for retrieval

CTRL+V Pastes or inserts at the current cursor location any previously cut or copied
text, data or objects from the Windows Clipboard

DEL Deletes the currently selected object

CTRL+D Duplicates a drawing object

CTRL+T Copy Chart: copies the current chart for use as an OLE object



Arrange menu keys
 Key Result

CTRL+A Align command:    Opens the Align objects dialog box 



View menu keys
 Key Result

SHIFT+F9 Toggles between wireframe and editable preview modes

CTRL+W Refresh window:    Updates the current chart window



Window menu keys
 Key Result

SHIFT+F5 Cascades all open charts and spreadsheets

SHIFT+F4 Tiles all open charts and spreadsheets horizontally
See also Help shortcuts



Mouse tricks
Selecting objects
Right mouse button shortcuts ... in Chart View
Right mouse button context sensitivity



Selecting objects
Perform the mouse action on the left to produce the result described at right.
 Key(s) or Mouse Action Result

SHIFT+LEFT MOUSE BUTTON With the Pick tool activated, hold down the SHIFT key to select two 
or more objects at once



Right mouse button shortcuts ... in Chart View
The right mouse button opens context-sensitive pop-up menus in both Chart View and Data 
Manager screens.
To activate a right mouse button menu in Chart View:

· Click and release the right mouse button anywhere in a charting window. This will 
open a context sensitive popup menu right where you're working. As the example 
below shows, you may then toggle on or off a range of options on the spot!



Right mouse button context sensitivity
The right mouse button opens context sensitive pop-up menus in both Chart View and Data 
Manager screens and opens context-sensitive Help about the Toolbox, Ribbon Bar and Text 
Ribbon.
To open context-sensitive Help with the right mouse button:

· Click the right mouse button with the pointer over any Tool, Ribbon Bar button or Text 
Ribbon item.



Help shortcuts
Press the key or keys on the left to produce the action described at right.
 Key(s) Result

F1 Displays the main CorelCHART Help Contents screen

F1-F1 Pressing F1 from within any Help window displays the Microsoft 
Windows Using Windows Help topics. 

F1 (in a given context) With a menu item selected or a dialog box or system message on 
screen, displays context sensitive Help (where available)

SHIFT+F1 Changes the pointer to  so that you can get Help on a specific 
command, screen region, or key. You can then choose a command, 
click the screen region, or press a key or key combination you want 
to know more about.

CTRL+F1 Opens Help's Search dialog box
CTRL+HOME Moves to top of the Help topic
CTRL+END Moves to the bottom of the Help topic
> Moves to the next topic 
< Moves to the previous topic
Note: As an alternative to clicking with the mouse, you may also use the keyboard to 

"press" Help buttons. Simply type a Help button's underlined letter to execute its 
function. E.g., to press the    Back button, press b on the keyboard; to press the Close 
button, press c, and so on.



Creating file icons
Using drag and drop to create file icons for CorelCHART files you use regularly can speed up 
your work because the files will automatically load when you launch CorelCHART. 
To create file icons, just drag and drop as shown below:

1. Open the Windows File Manager or an equivalent file management program.

2. Resize the file manager window so that other Program Groups are visible.

3. Open the drive and directory where your file is located

4. Click the file and drag it into a Program Group window.
Windows automatically creates the icon you need in the chosen Program Group.



Dialog box shortcuts
Pressing the key or key combinations indicated at left with a dialog box open will produce 
the results shown at right.

 Key(s) Result

F1 Opens Help Context Sensitive Help about the current dialog box 
(where available)

TAB Moves from field to field (left to right and top to bottom)

SHIFT+TAB Moves from field to field in reverse order

ALT+LETTER Presses the command button, or chooses the option or group whose 
underlined letter matches the one you type

ARROW key Moves from option to option within a group of options

ENTER Presses a selected command button

Or, chooses the selected item in a list box and executes the 
command

Note: A command button is selected or current when it has a bold black border, as shown 
below.

ESC Closes a dialog box without completing the command (same as the Cancel button in 
a dialog box)
ALT+DOWN ARROW Opens a drop-down list box
ALT+UP OR DOWN ARROW Selects item in a drop-down list box
SPACEBAR Cancels a selection in a list box

Selects or clears a check box
CTRL+SLASH Selects all the items in a list box
CTRL+BACKSLASH Cancels all selections except the current one
SHIFT+ARROW key Extends selection in a text box

SHIFT+HOME Extends selection to first character in a text box

SHIFT+END Extends selection to last character in a text box



Windows shortcuts
The following keys can be used from any window, regardless of the application you are 
using.

 Key(s) Result

CTRL+ESC Switches to the Task List

ALT+ESC Switches to the next application window or minimized icon, including full-
screen programs

ALT+TAB Switches to the next application window, restoring applications that are 
running as icons

PRINT SCRN Copies the entire screen to the Windows Clipboard

ALT+PRINT SCRN Copies the active window screen to the Windows Clipboard

CTRL+F4 Closes the active window

F1 Displays CorelCHART's main Help Contents screen (see also Help 
shortcuts)

ALT+SPACEBAR Opens the Control menu for an application window

ALT+HYPHEN Opens the Control menu for a document window

ALT+F4 Closes an application

ALT+ENTER Switches a non-Windows application between windowed and full-screen 
operation

ARROW key Moves a window when you have chosen Move from the Control menu



Shortcut key conventions
The following conventions are used when referring to shortcut keys:

· Keys which must be used in combination are shown linked by a plus sign, e.g., CTRL  +  TAB  .
See also Using speed keys.

· Where shortcut keys may be pressed successively, they are linked by a hyphen. E.g., 
ALT-F opens the File Menu. Press the ALT key, release it and then press and release the F 
key to open the drop-down File Menu. The menu stays open until you select a menu 
item's underlined letter, which activates that command or opens a dialog box.

· Reference to the right mouse button assumes that the mouse buttons have not been 
reassigned. Our apologies to left-handed users who have reassigned their mouse 
buttons and use the left mouse button as the secondary button.

· For more detail on a given topic:
· click the Contents button at the top of the Help screen and choose the Help subject 

best suited to your query
· click the How to ... button under the Help Menu Bar, or
· search Help for your topic by keyword

For help with Online Help conventions, press F1 now (F1-F1 from an application) to open the 
Microsoft Windows Using Windows Help file. See also Help shortcuts





 Data Manager shortcuts
Moving around a spreadsheet
Right mouse button shortcuts ... in a spreadsheet
Right mouse button shortcuts ... in columns and rows
Right mouse button context sensitivity
Scrolling and selecting cells
Automatically filling series
Menu keys
Speed keys
Ribbon Bars
Text Ribbon Bars
Dialog box shortcuts
Creating file icons
Shortcut key conventions
Windows shortcuts

See also Chart View shortcuts



Menu keys
Common menu keys
File menu keys
Edit menu keys
View menu keys
Format menu keys
Data menu keys
Window menu keys
Help shortcuts

See also Speed keys



Speed keys
Press the key or keys on the left to produce the action described at right.
 Key(s) Result

F2 Activates the Formula Bar

TAB Moves the cursor one cell to the right

ENTER Enters the current information and moves the cursor one cell down

SHIFT+F4 Tiles any open CorelCHART files vertically

F5 Chooses the Pencil Tool

SHIFT+F5 Cascades open CorelCHART files

F12 Opens the Enter Formula dialog box

CTRL+TAB Toggles between Data Manager and Chart View. 

Note:    This function is available after you have opened Data Manager once by the 
conventional method, either by clicking the Data Manager icon at the top of the Tool Box or 
choosing View Chart Data from the Chart View Edit menu.

ESC Closes an open dialog box

ESC-ESC Deactivates the Menu Bar
Menu keys

Common menu keys
File menu keys
Edit menu keys
View menu keys
Format menu keys
Data menu keys
Window menu keys
Help shortcuts



Scrolling and selecting cells
Perform the mouse action on the left to produce the result described at right.

    Mouse action Result

Click above or below 
the thumb slide on the 
vertical scroll bar

Scrolls one screen up or down

Click to the left or right
of the thumb on the 
vertical scroll bar

Scrolls one screen left or right

Click and drag 
diagonally, horizontally
or vertically in a 
spreadsheet 

Selects a range of cells

Click and drag along 
row or column buttons

Selects several rows or columns at once

Moving around a spreadsheet
The following key combinations will help you get around your spreadsheets quicker. See also
Scrolling and selecting cells

 Keys Result

CTRL+ HOME Moves the cursor to the first cell (cell A1) in a spreadsheet

CTRL+ END Moves the cursor to the bottom right of the data range

CTRL+ LEFT or RIGHT ARROW Moves the cursor to the extreme left (column A) or right side 
(column IV, or 256) of a spreadsheet

CTRL+ UP or DOWN ARROW Moves the cursor to the top (Row 1) or bottom (Row 16,384) of a 
spreadsheet

PAGE UP or PAGE DOWN Moves the cursor up or down a full screen.

In the Formula Bar

F2 Activates Formula Bar editing

F2-F2 Activates in-cell editing

HOME Moves to the beginning of the Formula Bar

ESC Cancels current formula input

Note: Pressing PAGE UP or PAGE DOWN automatically repositions the spreadsheet window, 
placing the cursor at the top of the next window and scrolling data in the previous 



window off screen.



View menu keys
 Keys Result

CTRL+G Grid toggle:    Toggles Data Manager gridlines on or off

CTRL+W Refresh window:    Updates any changes to the current window



Common menu keys
The following speed keys are common to all menus. Press the key or keys on the left to 
produce the action described at right.

 Key(s) Result

ALT Activates the menu bar. Press any underlined letter from the 
menu bar to pull down that menu (see the next paragraph). 
Deselect the menu bar by pressing ESC or clicking anywhere in the
active window

ALT-{MENU LETTER KEY} Opens the drop-down menu. To pull down the menu you want to 
use, select its underlined letter after or while pressing the ALT key. 
E.g., ALTFA opens the Save As dialog box.

ALT-"-" or ALT-SPACE BAR Opens the control menu

ALT-LEFT or ALT-RIGHT ARROW Moves left or right through menus.

UP or DOWN ARROW When scrolling through menus, if the selection bar is closer to the
top, bottom, left or right side, continuing toward that side takes 
you to the opposite end of the menu or screen.

UP or DOWN ARROW Chart View's Gallery, Chart and Arrange menus feature 
secondary, or flyout menus, which are indicated by a pointer at 
each menu's right side. To use the arrow keys in a CorelCHART 
flyout menu, with the flyout open, press the UP ARROW to see the 
top chart listed, or the DOWN ARROW to see the bottom chart.



File menu keys
 Key(s) Result

CTRL+N Opens the New Chart dialog box

CTRL+O Opens the Open Chart dialog box

CTRL+S Saves a previously saved chart and spreadsheet, replacing previous 
information

Note:    Choosing CTRL+S for a new chart or spreadsheet file calls up the 
Save As dialog box.

F9 Displays a print preview of a spreadsheet

CTRL+P Opens the Print Data dialog box

CTRL+J Opens the Preferences dialog box, which controls Display Options, Curve 
Flatness, Preview Colors, and Miter Limit

ALT+F4 Closes both Data Manager and Chart View. A Save Changes message 
appears if there are unsaved changes.



Edit menu keys
 Key(s) Result

CTRL+Z Undoes the last editing operation

CTRL+X Cuts selected text, data or objects to the Windows Clipboard for retrieval

CTRL+C Copies selected text, data or objects to the Windows Clipboard for retrieval

CTRL+V Pastes or inserts at the current cursor location any previously cut or copied
text, data or objects from the Windows Clipboard

DEL Opens the Cut and Clear dialog box, giving options for the deletion of any 
text, data or objects selected

ALT+F3 Find & Replace:    Opens the Find & Replace dialog box. This function allows
you to search for text, formulas or values by row or column. You may 
search backward and forward and match upper and lower case.



Format menu keys
 Keys Result

Ctrl+F Patterns: Opens the Patterns dialog box

Ctrl+Q Set page break: Sets manual page breaks in your printed data



Data menu keys
 Key(s) Result

F12 Enter Formula:    Calls up the Enter Formula Dialog Box. See also How to ... 
Use functions and formulas and Enter Formula command (Data menu)

SHIFT+F7 Auto Recalculate toggle:    The default setting is on, as indicated by a check
mark next to the menu item. If you are working with large amounts of data
and your computer is taking extra time to perform the calculations, you 
may want to turn Auto Recalculate off.

F7 Recalculate Now:    Recalculates data when selected if Auto Recalculate is 
turned off.



Window menu keys
 Keys Result

SHIFT+F5 Cascades all open charts and spreadsheets

SHIFT+F4 Tiles all open charts and spreadsheets horizontally
See also Help shortcuts



Right mouse button context sensitivity
The right mouse button opens context-sensitive pop-up menus in both Chart View and Data 
Manager screens and opens context-sensitive Help about the Toolbox, Ribbon Bar and Text 
Ribbon.
Opening context-sensitive Help with the right mouse button:

· Click the right mouse button with the pointer over any Tool, Ribbon Bar button or Text 
Ribbon item.



Right mouse button shortcuts ... in a spreadsheet
Clicking the right mouse button anywhere in a spreadsheet will call up a pop-up format 
menu; its selections and their results appear below. See also Right mouse button 
shortcuts ... in columns and rows and Right mouse button shortcuts... in Chart View. 
    Menu Item Result

Cut Cuts text or graphics (active only when text or data selected)

Copy Copies text or graphics (active only when text or data selected)

Paste Pastes text or graphics (only if text or data have been cut or copied)

Clear Opens a dialog box listing options for deleting data or formats

Numeric... Opens the Numeric format dialog box.    Choose from preset    numeric styles 
or create your own.

Font... Opens the Font format and selection box

Borders... Calls up the Borders dialog box, which allows you to set fills and patterns for 
spreadsheet cells

Alignment... Opens the Alignment dialog, which allows you to set preferences for text 
alignment or justification and turn on word wrap

Patterns... Opens the Patterns dialog, used to add patterns to one or more selected 
cells

Style... Opens the Style dialog box. Styles are saved formatting combinations, 
including font, alignment, numeric format, cell borders and patterns.

Best Fit Executes the Best Fit command



Right mouse button shortcuts ... in columns and rows
Clicking the right mouse button on a Column or Row button (at the top and left sides of a 
spreadsheet) activates a pop-up format menu. The pop-up includes the following options for 
formatting, inserting and deleting rows and columns:

Cut Cuts text or graphics (active only when text or data selected)

Copy Copies text or graphics (active only when text or data selected)

Paste Pastes text or graphics (only if text or data have been cut or copied)

Insert Inserts a column to the right of the column or selected, or beneath the row
selected

Delete Deletes the column(s) or row(s) selected.

Numeric... Opens the Numeric format dialog box.    Choose from preset    numeric styles 
or create your own.

Font... Opens the Font format and selection box

Borders... Calls up the Borders dialog box, which allows you to set fills and patterns for 
spreadsheet cells

Alignment... Opens the Alignment dialog, which allows you to set preferences for text 
alignment or justification and turn on word wrap

Patterns... Opens the Patterns dialog, used to add patterns to one or more selected 
cells

Style... Opens the Style dialog box. Styles are saved formatting combinations, 
including font, alignment, numeric format, cell borders and patterns.

Column Width On a column button, brings up a column width box. Reset width in the 
default measure of points, or change the measure to millimeters, 
centimeters, or picas and points.

Best Fit Executes the Best Fit command, which adjusts the width or height of the 
selected column or row to match the largest item in a cell in that row or 
column.

Row Height On a row button, brings up a row height box. Reset row height in the 
default measure of points, or change the measure to millimeters, 
centimeters, or picas and points.

To select multiple rows or columns, position the mouse pointer over a column or row header,
press the left mouse button and drag in either direction until the desired number of columns 
or rows are selected. To deselect, click anywhere else in the spreadsheet.
Note: You may also select multiple rows and columns or blocks of data by clicking on the 

first cell you want to select and dragging diagonally, vertically over the area with the 
mouse.



See also Scrolling and selecting cells and Right mouse button shortcuts ... in a spreadsheet



After you have opened Data Manager normally for the first time (e.g., using Edit-View Chart 
Data), you can use CTRL+TAB to toggle between Data Manager and Chart View.



Automatically filling series
The Fill Series command automatically speeds up your work by filling a larger range of cells 
based on existing data. Fill Series works with dates, times and numbers sequences. See Fill 
series command (Data menu) for details about the available options
To use Fill Series:

1. Select a range of at least two cells upon which you want to base your autofill.
2. Extend the selection to the end of the range you want to fill.
2. Click Fill Series from the Data Menu.
3. Choose the options which apply and click OK.



Help shortcuts
Press the key or keys on the left to produce the action described at right.

      Key(s) Result

F1 Displays the main CorelCHART Help Contents screen

F1-F1 Pressing F1 from within any Help window displays the Microsoft 
Windows Using Windows Help topics. 

F1 (in a given context) With a menu item selected or a dialog box or system message on 
screen, displays context sensitive Help (where available)

SHIFT+F1 Changes the pointer to  so that you can get Help on a specific
command, screen region, or key. You can then choose a 
command, click the screen region, or press a key or key 
combination you want to know more about.

CTRL+F1 Opens Help's Search dialog box
CTRL+HOME Moves to top of the Help topic
CTRL+END Moves to the bottom of the Help topic
> Moves to the next topic 
< Moves to the previous topic
Note: As an alternative to clicking with the mouse, you may also use the keyboard to press 

Help buttons. Simply type a Help button's underlined letter to execute its function. 
E.g., to press the    Back button, press "b" on the keyboard; to press the Close button, 
press "c," and so on.



Ribbon Bars
CorelCHART's Ribbon Bars, sometimes called button bars, are located just under the Chart 
View and Data Manager Menu Bars. Clicking a button on a Ribbon Bar activates the 
command associated with it. Hold the mouse pointer over a button to see its name or right-
click for Context-sensitive Help.
The Chart View Ribbon Bar, contains the following buttons (from left): New, Open, Save, 
Print, Cut, Copy and Paste, Import and Export, Display Status, Legend, Numeric Format, Data
Analysis, Align, 3D Rollup, Copy Chart, Wireframe and Mosaic Rollup.
The Data Manager's Ribbon Bar includes (from left) New, Open, Save, Print, Cut, Copy and 
Paste, Import and Export, Set Page Break, Number Format, Borders, Patterns, Go to cell, 
Enter Formula Sort, Auto Recalculate, Grid Lines and Mosaic Rollup.
See also Chart View Tools and Ribbon Bars and Data Manager Ribbon Bars



Text Ribbon Bars
CorelCHART's Text Ribbon Bars--located just below the Chart View and Data Manager Ribbon 
Bar--include buttons and drop-down list boxes for setting text attributes such as font type 
and size selection, bold, underline, italic, alignment, inter-character and inter-line spacing. 
Clicking a Text Ribbon Bar button activates the command associated with it. Hold the mouse 
pointer over a Text Ribbon button or list box to see its name or right-click for Context-
sensitive Help.
See also Chart View Tools and Ribbon Bars and Data Manager Ribbon Bars



Dialog box shortcuts
Pressing the key or key combinations indicated at left with a dialog box open will produce 
the results shown at right.

 Key(s) Result

F1 Opens Help Context Sensitive Help about the current dialog box 
(where available)

TAB Moves from field to field (left to right and top to bottom)

SHIFT+TAB Moves from field to field in reverse order

ALT+LETTER Presses the command button, or chooses the option or group whose
underlined letter matches the one you type

ARROW key Moves from option to option within a group of options

ENTER Presses a selected command button

Or, chooses the selected item in a list box and executes the 
command

Note: A command button is selected or current when it has a bold black border, as shown 
below.

ESC Closes a dialog box without completing the command (same as the Cancel button in 
a dialog box)
ALT+DOWN ARROW Opens a drop-down list box
ALT+UP OR DOWN ARROW Selects item in a drop-down list box
SPACEBAR Cancels a selection in a list box

Selects or clears a check box
CTRL+SLASH Selects all the items in a list box
CTRL+BACKSLASH Cancels all selections except the current one
SHIFT+ARROW key Extends selection in a text box

SHIFT+HOME Extends selection to first character in a text box

SHIFT+END Extends selection to last character in a text box



Creating file icons
Using drag and drop to create file icons for CorelCHART files you use regularly can speed up 
your work because the files will automatically load when you launch CorelCHART. 
To create file icons, just drag and drop as shown below:

1. Open the Windows File Manager or an equivalent file management program.
2. Resize the file manager window so that other Program Groups are visible.
3. Open the drive and directory where your file is located
4. Click the file and drag it into a Program Group window.

Windows automatically creates the icon you need in the chosen Program Group.



Windows shortcuts
The following keys can be used from any window, regardless of the application you are 
using.

 Key(s) Result

CTRL+ESC Switches to the Task List

ALT+ESC Switches to the next application window or minimized icon, including full-
screen programs

ALT+TAB Switches to the next application window, restoring applications that are 
running as icons

PRINT SCRN Copies the entire screen to the Windows Clipboard

ALT+PRINT SCRN Copies the active window screen to the Windows Clipboard

CTRL+F4 Closes the active window

F1 Displays CorelCHART's main Help Contents screen (see also Help 
shortcuts)

ALT+SPACEBAR Opens the Control menu for an application window

ALT+HYPHEN Opens the Control menu for a document window

ALT+F4 Closes an application

ALT+ENTER Switches a non-Windows application between windowed and full-screen 
operation

ARROW key Moves a window when you have chosen Move from the Control menu



Shortcut key conventions
The following conventions are used when referring to shortcut keys:
· Keys which must be used in combination are shown linked by a plus sign, e.g., CTRL  +  TAB  . 

See also Speed keys.
· Where shortcut keys may be pressed successively, they are linked by a hyphen. E.g., ALT-

F opens the File Menu. Press the ALT key, release it and then press and release the F key 
to open the drop-down File Menu. The menu stays open until you select a menu item's 
underlined letter, which activates that command or opens a dialog box.

· Reference to the right mouse button assumes that the mouse buttons have not been 
reassigned. Our apologies to left-handed users who have reassigned their mouse buttons
and use the left mouse button as the secondary button.

· For more detail on a given topic:
· click the Contents button at the top of the Help screen and choose the Help subject 

best suited to your query
· click the How to ... button under the Help Menu Bar, or
· search Help for your topic by keyword

For help with Online Help conventions, press F1 now (F1-F1 from an application) to open the 
Microsoft Windows Using Windows Help file. See also Help shortcuts
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Advanced Calibration features--Overview
The Color Manager is a powerful tool. Its basic features, namely the configuration of two (or 
three) devices into a System Profile, will be easily and quickly mastered by all users. The 
advanced calibration features, however, are intended to be used by informed users only. A 
solid understanding of color and calibration is essential for successful use of these features.
The System Color Profile dialog box leads to a series of further dialog boxes. 
Before using the advanced calibration features, you may want to review: Working with basic 
System Profiles



Accessing the advanced features
You access the advanced features for all devices, whether monitor, printer or scanner, in one
of two ways: by choosing "Other" from the device list, or by clicking the Edit button.
To access the advanced features:

Do one of the following:
· Other:  If your device is not listed in the System Color Profile dialog box, choose Other 

from the device list. This will give you access to the calibration dialog box for that type 
of device.

· Edit:    If your device is listed but you want to review or modify the default settings 
offered by the Color Manager, click Edit to access the calibration dialog box for that 
particular device.



Calibrating your monitor numerically
Monitor calibration can be done numerically or interactively.
To calibrate your monitor numerically:

1. In the Monitor Calibration dialog box, enter the monitor characteristics for Red, Green 
and Blue. For each of the three colors, you must specify the gamma as well as the 
chromaticity (x, y). These values can be supplied by the monitor manufacturer.

2. Enter a white point temperature in degrees Kelvin.
Click Reset to return to the default values if need be.

Note: If you chose Other from the monitor list, a text entry field at the top of the Monitor 
Calibration dialog box allows you to enter a name for the monitor. This name is added to the 
monitor list for future recall.



Calibrating your monitor numerically
Monitor calibration can be done numerically or interactively.
To calibrate your monitor numerically:
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and Blue. For each of the three colors, you must specify the gamma as well as the 
chromaticity (x, y). These values can be supplied by the monitor manufacturer.

2. Enter a white point temperature in degrees Kelvin.
Click Reset to return to the default values if need be.

Note: If you chose Other from the monitor list, a text entry field at the top of the Monitor 
Calibration dialog box allows you to enter a name for the monitor. This name is added to the 
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Calibrating your monitor interactively
Monitor calibration can be done interactively or numerically.
To calibrate your monitor interactively:

1. In the Monitor Calibration dialog box, click Interactive.
The Interactive Monitor Calibration dialog box appears.

CAUTION: The gamma and white point must definitely be adjusted, as they differ from 
monitor to monitor, even within a given brand. The chromaticity values, however, 
SHOULD NOT be adjusted, for the reasons listed in step 4.
2. Do one of the following:

· Adjust the gamma for each color channel in turn (Red, Green and Blue) by scrolling 
up or down until both sides of the color box appear the same.

· Adjust the color gamma for one channel then enable Identical to set an identical 
gamma for all three channels.

Click Preview to evaluate the effect of your adjustments.
3. Use the slider bar to specify a cooler or warmer white point. The value in degrees 

Kelvin is displayed to the right of the slider bar. 
Click Preview to evaluate the effect of your adjustments.

4. It is strongly recommended that default chromaticity values be left as is, for a number 
of reasons: chromaticity values are stable and almost identical from monitor to 
monitor; the default values    are correct; visual adjustments are difficult to discern and 
evaluate.
If you must, you can adjust the chromaticity by dragging the Red, Green and Blue 
markers to achieve the desired result. The x and y values are displayed below the color
boxes. Note that the effect of your adjustments will be difficult to evaluate in the 
Preview.
Click Reset to return to the default values if need be.

Note: If you chose Other from the monitor list, a text entry field at the top of the Monitor 
Calibration dialog box allows you to enter a name for the monitor. This name is added to the 
monitor list for future recall.
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of reasons: chromaticity values are stable and almost identical from monitor to 
monitor; the default values    are correct; visual adjustments are difficult to discern and 
evaluate.
If you must, you can adjust the chromaticity by dragging the Red, Green and Blue 
markers to achieve the desired result. The x and y values are displayed below the color
boxes. Note that the effect of your adjustments will be difficult to evaluate in the 
Preview.
Click Reset to return to the default values if need be.

Note:    If you chose Other from the monitor list, a text entry field at the top of the Monitor 
Calibration dialog box allows you to enter a name for the monitor. This name is added to the 
monitor list for future recall.



Calibrating your printer:    General notes
When it comes to your printer, two separate operations must be performed:
· calibration
· characterization
Calibration
The printer calibration process varies depending on whether the device employs a CMYK or 
RGB color model.
Characterization
The printer characterization process is the same for both color models. Use either a Color 
Match file or the visual method to perform the characterization.
Spectrophotometer / colorimeter settings:
When characterizing your printer, you may choose from the supplied files or generate your 
own. To generate your own IM, GRY or RNH files, you will need a spectrophotometer or a 
colorimeter. The measurement device should be set up as follows:
· Set the White Base to "abs" and calibrate it with the manufacturer-supplied white.
· Set the Illumination Type to D65.
· Set the Eye Angle to 2 degrees.
· Set the Filter to None (do not use D65 or Pol).



Calibrating your CMYK printer
1. In the Printer Calibration dialog box, choose CMYK as printer type.
2. Choose Printer if you are measuring from a paper print or imagesetter proof. Choose 

Film if measuring from imagesetter film. We recommend measuring from a proof 
because it is faster and produces accurate results.

3. Enter a percentage for Total Area Coverage (TAC). This refers to the maximum 
allowable quantity of ink (i.e., total combined amount of C, M, Y and K inks).

4. Adjust the K curve in the CMYK Plates box. Click Reset to return to the default values if 
need be.

5. A default dot gain is provided. It is appropriate for most jobs. Verify with your printing 
shop before changing this value.

Note:    CorelDRAW ships with some ready-made ink models.    An .IM file to match or 
approximate your printer may be available. Check the list.    If an appropriate .IM file exists, 
you need not perform steps 6 and 7--just continue at step 8.

6. Click Print CMYK Patterns. The Print dialog box appears. Choose a printer. The CMYK320
color pattern file is printed to the chosen printer.

7. Use a spectrophotometer or colorimeter to measure the CIE XYZ values of each color 
square in numerical sequence (from 1 to 320). Enter the measurements in an ASCII file 
with three columns: X, Y and Z (with a space separating the columns). Name the file to 
reflect the printer and give it a .IM extension--for example, TEK300I.IM for data 
measured from the printout of a Tektronix 300I. Copy the file into the COREL50\COLOR 
subdirectory. Return to the Printer Calibration dialog box. 

8. Choose the appropriate .IM file.
9. Click Calculate.
10. The Color Match option becomes available. Click the button. The Printer 

Characterization dialog box appears. Establish printer characterization according to 
one of the two methods described under: 
Characterizing your printer using a Color Match file
Characterizing your printer using the visual method
When you return to the Printer Calibration dialog box after characterizing the printer, 
choose OK.

Note: If you chose Other from the printer list, a text entry field at the top of the Printer 
Calibration dialog box allows you to enter a name for the printer. This name is added to the 
printer list for future recall.



Calibrating your RGB printer
1. In the Printer Calibration dialog box, choose RGB as printer type.
2. Click Print RGB Patterns.    The Print dialog box appears. Choose a printer. The RGB80 

color pattern file is printed to the chosen printer.
3. Use a spectrophotometer or colorimeter to measure the CIE XYZ values of the 

grayscale squares only, in numerical sequence (from 65 to 80). Enter the 
measurements in an ASCII file with three columns: X, Y and Z (with a space separating 
the columns). Name the file to reflect the printer and give it a .GRY extension--for 
example, CJ10.GRY for data measured from the printout of a Canon CJ10. Copy the file 
into the COREL50\COLOR subdirectory. Return to the Printer Calibration dialog box. 

4. Choose the .GRY file you have created.
5. Click Color Match. The Printer Characterization dialog box appears. Establish printer 

characterization according to one of the two methods described under: 
Characterizing your printer using a Color Match file
Characterizing your printer using the visual method
When you return to the Printer Calibration dialog box after characterizing the printer, 
choose OK.

Note: If you chose Other from the printer list, a text entry field at the top of the Printer 
Calibration dialog box allows you to enter a name for the printer. This name is added to the 
printer list for future recall.



Characterizing your printer using a Color Match file
Printer characterization can be performed using a Color Match file or using the visual 
method.
To perform characterization using a Color Match file:

1. In the Printer Characterization dialog box, choose File.
2. Click Print Testing Patterns. The test pattern file is printed to the chosen printer.
3. Use a spectrophotometer or colorimeter to measure the CIE XYZ values of each color 

square in numerical sequence (from 1 to 80). Enter the measurements in an ASCII file 
with three columns: X, Y and Z (with a space separating the columns). Name the file to 
reflect the printer and give it a .RHN extension--for example, TEK300I.RHN for data 
measured from the printout of a Tektronix 300I. Copy the file into the COREL50\COLOR 
subdirectory.

4. Return to the Printer Characterization dialog box. Choose the .RHN file you have 
created.



Characterizing your printer using a Color Match file
Printer characterization can be performed using a Color Match file or using the visual 
method.
To perform characterization using a Color Match file:

1. In the Printer Characterization dialog box, choose File.
2. Click Print Testing Patterns. The test pattern file is printed to the chosen printer.
3. Use a spectrophotometer or colorimeter to measure the CIE XYZ values of each color 

square in numerical sequence (from 1 to 80). Enter the measurements in an ASCII file 
with three columns: X, Y and Z (with a space separating the columns). Name the file to 
reflect the printer and give it a .RHN extension    for example, TEK300I.RHN for data 
measured from the printout of a Tektronix 300I. Copy the file into the COREL50\COLOR 
subdirectory.

4. Return to the Printer Characterization dialog box. Choose the .RHN file you have 
created.



Characterizing your printer using the visual method
Printer characterization can be performed visually or using a Color Match file.
To perform characterization using the visual method:

1. You must calibrate your monitor before proceeding if the visual characterization of your
printer is to be meaningful. Click Calibrate Monitor. If a Monitor calibration circuit is in 
place, it will be used. Otherwise, a dialog box will appear to allow you to calibrate your 
monitor.

2. In the Printer Characterization dialog box, choose Visual.
3. Click Print Testing Patterns. The test pattern file is printed to the chosen printer.
4. Adjust the colors interactively or by entering numeric values so that they approximate 

the test printout. Adjustments follow the norms of the HSB (Hue, Saturation, 
Brightness) model.
If you are not pleased with the changes you have made to a color, click Reset Color to 
start fresh.



Characterizing your printer using the visual method
Printer characterization can be performed visually or using a Color Match file.
To perform characterization using the visual method:

1. You must calibrate your monitor before proceeding if the visual characterization of your
printer is to be meaningful. Click Calibrate Monitor. If a Monitor calibration circuit is in 
place, it will be used. Otherwise, a dialog box will appear to allow you to calibrate your 
monitor.

2. In the Printer Characterization dialog box, choose Visual.
3. Click Print Testing Patterns. The test pattern file is printed to the chosen printer.
4. Adjust the colors interactively or by entering numeric values so that they approximate 

the test printout. Adjustments follow the norms of the HSB (Hue, Saturation, 
Brightness) model.
If you are not pleased with the changes you have made to a color, click Reset Color to 
start fresh.



Working with basic System Profiles
A color management system must take into account all factors involved for all the devices 
used for color acquisition, viewing and reproduction. This is done by building a System 
Profile. A System Profile indicates which monitor and printer are part of your publishing 
system. It may also include a scanner if you are working with Corel PHOTO-PAINT.
If any component of your system changes, you must make this change known to the Color 
Manager by updating your System Profile. Similarly, if you have access to multiple devices, 
you will need to build a System Profile for each combination of two (or three) devices that 
you use. 
Once built, simply select and enable the appropriate System Profile according to the devices 
your project currently calls for.
See also:

Basic
Creating a basic System Profile
Selecting a System Profile
Advanced
Advanced calibration features



Creating a basic System Profile
All you need to know about your system is the brand name and model number of each 
device. The Color Manager has built-in information sheets for a large number of devices and 
chances are yours will be in the lists. You do not need to know the technical properties of 
your devices; just pick their names from the lists and save the configuration as a System 
Profile.
To create a basic System Profile:

1. Choose Color Manager from the File menu.
The System Color Profile dialog box appears.

2. Choose a monitor.
3. Choose a printer.
4. Choose a scanner (optional). This can only be done from an application that support 

scanners, such as Corel PHOTO-PAINT.
5. Enter descriptive comments in the Notes box to help you better manage your System 

Profiles (optional).
6. Click Generate. 

The Generate Profile dialog box appears.
7. Enter a name for the System Profile.
8. Click OK. System Profile generation will take a few minutes.
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Selecting an existing System Profile
Your work may entail working with a number of various devices of each type. You may 
therefore need to load a different System Profile depending on the task at hand. System 
Profiles can be created as explained under Creating a basic System Profile. Once created, 
selecting one is easy.
To select an existing System Profile:

1. Choose Color Manager from the File menu.
The System Color Profile dialog box appears.

2. From the Current Profile list, choose a System Profile.
3. Click Select.
Note: By default, AutoMatch is enabled, ensuring that automatic color matching is 
performed. This is the normal way to proceed and the default should be left as is, unless you
want to force a different color matching method.
If you are working in CorelDRAW, AutoMatching means the Color Manager will automatically 
differentiate between bitmapped and vector objects, and optimize each type of object 
accordingly. In Corel PHOTO-PAINT, AutoMatching means that the System Profile is optimized
for bitmaps. Another application may be optimized for line art.
You can force the Color Manager to optimize the color matching for line art by enabling 
Illustration. Similarly, if you want to force the Color Manager to optimize the color matching 
for bitmaps, enable Photographic.



System Color Profile dialog box
The System Color Profile dialog box allows you to create a system color profile to help 
CorelCHART capture, display and print color across different devices more accurately.

Dialog Box Options

Current Profile
Displays the name of the current color profile. If you have different printers, you may wish 
to build different color profiles and then select the appropriate one before working on 
images for that output device.

Notes
Allows you to attach notes to your system profile. Useful for keeping track of different 
equipment setups.

Monitor
Displays monitor choices.

Printer
Displays printer choices. 

Automatch
Enables the two different color gamut mapping systems, Illustration and Photographic. 
CorelCHART automatically senses whether it is printing a vector or bitmapped object and 
applies the appropriate gamut map.

Photographic
Enables the Photographic color mapping only. Use to force Photographic color mapping 
regardless of object type.

Illustration
Enables Colorimetric color mapping for working with spot colors. Use to force colorimetric 
color mapping regardless of object type.
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Monitor Calibration
Allows you to calibrate your monitor to enhance color accuracy.

Dialog Box Options
Monitor Characteristics
Defines the monitor gamma settings. As you increase the gamma level you are increasing 
the brightness of your midtone gray levels. Chromaticity defines hue and saturation or 
chroma. It's important to use the manufacturer recommended levels of chromaticity for your
monitor. If you do not have manufacturer recommended levels and wish to modify gamma or
chromaticity settings use Interactive Monitor Calibration.
White Point Reset
Defines the color temperature of your monitor in creating white. Returns the gamma and 
chromaticity values to default.
Interactive Calibration
Interactive calibration lets you adjust gamma, white point and chromaticity interactively. 
Adjust the color fields to enhance color accuracy. Chromaticity should be set to the 
manufacturer's specifications. Gamma or brightness is variable according to the level of light
in the room and the brightness and contrast controls on your monitor. White point 
temperature for an individual monitor will have a factory default but monitors can vary from 
their default. 



Printer Calibration
Allows you to calibrate your printer to enhance color accuracy.

Dialog Box Options
Printer Type Defines whether the printer prints using four colors (CMYK) or three 

(RGB).

UCR Choose Film or Printer, depending on the output device you are 
configuring. TAC (Total Ink Coverage) adjusts the level of UCR. See 
your printer for the appropriate level of UCR. It depends on paper 
stock and the printer used.

Dot Gain Halftone dots that make up an image "gain" in size from the time you
view them on film to the time they come off the press. This 
unavoidable increase in size results in colors that appear more 
intense in the printed image than intended. 

Dot Gain is calculated two ways: 

The default Dot Gain is calculated by the ink model. This gives you an
average value and is set automatically by Color Manager. This is the 
recommended level of dot gain.

If you need to reset Dot Gain for a specific job you can set a constant 
dot gain level. Consult with your printer before changing this setting.

Ink model field Defines the ink model for the selected printer.

Color Match Allows you to match your printer and monitor color accuracy.

Print CMYK Patterns... Allows you to generate a test file to be measured to create a 
new Ink Model.

Calculate Updates the calibration changes you have made before you continue 
on to Color Match.

Reset Returns the black point value to default.

OK Accepts the changes you have made.
Cancel Abandons the changes you have made.

Printer Characterization
Characterization establishes a normalized color relationship between your device and the 
CIE based reference Color System. This characterization may be based on 
spectrophotometric measurements (File) or visual methods (Visual).

Visual

Print Testing Print these patterns to match 
Patterns against the view field in the Printer Characterization dialog box.



Calibrate Monitor If you have not already done so, calibrate your monitor before 
continuing with your Color Match.

Reset Returns Hue, Saturation and Brightness to the default values.
OK Accepts the changes you have made.
Cancel Abandons the changes you have made.

File

Print Testing Print these patterns and measure
Patterns the CIE X Y Z values in order to create a new RHN file.
File Name Choose an existing RHN that matches your output device or choose a

new RHN that you have built.



Restore command (Control menu)
Returns the active window to its previous size and location.

You can also restore a window by clicking its Restore button 
· Does not affect a window moved or resized with Move or Size.



Move command (Control menu)
Moves the active window with the keyboard direction keys. 
· This command is unavailable if the window is maximized.
· You can use this command to move application icons and dialog boxes that have a Control

menu.

For more information, see your Microsoft Windows User's Guide.



Size command (Control menu)
Resizes the active window with the keyboard direction keys.
· This command is unavailable if the window is maximized.

For more information see your Microsoft Windows User's Guide.



Minimize command (Control menu)
Shrinks the active window to an icon at the bottom of the CorelCHART window.

· Using the Minimize command is equivalent to clicking the Minimize button .
· You can use Restore to return the minimized window to its former size.



Maximize command (Control menu)
Enlarges the active window to fill the entire screen.

· Using the Maximize command is equivalent to clicking the Maximize icon .
· You can choose Restore or click the Restore button  to return the window to its 
former size.



Close command (Control menu)
Closes the active window. 
· Closing CorelCHART is the same as choosing Exit from the File menu.

· Double-clicking the Control Menu button  is equivalent to choosing the Close 
command. 



Switch To command (Control menu)
Opens the Task List, which lists all the applications currently running on your system.
Dialog Box Options
Switch To
Opens the selected application.
End Task
Closes the selected application.
Cancel
Closes the Task List.
Cascade
Overlaps all open applications so that their Title bars are visible.
Tile
Sizes all open applications to fit on the screen.
Arrange Icons
Arranges the icons of all minimized applications evenly across the bottom of the CorelCHART
window. 



New command (File menu)
Opens the New chart dialog box. Choose a chart type from the Gallery to start building a 
chart.
Dialog Box Options
Gallery

Lists all available chart categories. Several chart types, displayed in the Chart Types 
preview window on the right side of the dialog box, are available in each category. 

Chart Types
Shows the various chart types for the chosen category in the Gallery list displayed on the 
left. A written description of the highlighted chart type appears below the preview window. 
Double-click the chart type to select it.

Use Sample Data
Choose this option to use the sample data included in each CorelCHART template when 
you create a new chart. Replace the sample data with your own and add titles and other 
annotations as required. The chart itself appears in the Chart window when you click OK.
Deselect this option to go directly to a Data Manager window. Enter the data required in 
the configurations used in the sample charts and click Autoscan to generate the selected 
chart type from your own data. 

Shortcut
Pressing CTRL + N displays the New Chart dialog box



Open command (File menu)
Displays the Open Chart dialog box, used to load existing CorelCHART files from any drive.
Dialog Box Options

The File Name, List Files of Type, Directories and Drives lists and boxes allow you to 
choose CorelCHART (.CCH) files from the drives and directories on your computer system. 
Files created in CorelCHART versions 3 and 4 can be opened in CorelCHART 5.

Preview
When checked, the Preview window displays the chart type currently selected in the File 
Name box.

Options>>
Displays options for finding and annotating files.
Sort by Sorts files in the File Name list alphabetically or chronologically with the most

recently saved file listed first.
Notes Lets you store remarks with your files.

Shortcut
Pressing CTRL + O displays the Open Chart dialog box



Save (File menu)
Saves the current chart and its data. Allows you to select the appropriate drive and directory
where you wish to save the file. 
When saving a new file which has no title, this command displays the Save Chart dialog box,
prompting you to assign a file name to your chart.
When saving a file that has already been saved, the Save command saves the chart in the 
same location and uses the same file name. The Save As command is used to save a new 
file or an existing file in a new location or with a different file name.

Shortcut
Pressing CTRL + S Saves the File or displays the Save Chart dialog box



Save As (File menu)
Displays the Save As dialog box allowing you to save a new CorelCHART (.CCH file) to a 
specified directory or save an existing file with a new name or in a new drive/directory.
The Save Presentation Exchange Data option, if enabled, appends information to the 
saved file, allowing it to be opened in any Corel application.
Note: Files saved in the current version of CorelCHART cannot be opened in earlier versions 
of the program.



Close command (File menu)
This command removes the active chart and its window from the screen but leaves 
CorelCHART open. If the active chart has never been saved, or has been modified since the 
last save, a Save Changes dialog appears, asking if you want to save the file and/or the 
changes applied to it. 
From the Save Chart dialog box click: 
· Yes to return to CorelCHART, 
· No to abandon your changes and close the current charting window, or
· Cancel the closing operation and return to the document.



Apply Template command (File menu)
Use this command to apply a new chart template to the current chart but retain the data 
from the original. 
Any chart you create, edit and save in CorelCHART (.CCH file) can be used as a template. 
CorelCHART's sample templates are installed in the \CHART subdirectory of the CorelDRAW 
main directory, e.g., \COREL50\CHART. The applied template contains any and all graphic 
information saved with the chart, such as text attributes, location of the chart on the page, 
riser shape and attributes, 3D positioning, fill and outline colors and bitmaps.
Use templates if you want to maintain a consistent look for several charts, such as corporate
colors or a company logo.



Import command (Chart View File menu)
Brings graphics into CorelCHART from other programs. 
Dialog Box Options
File Name

Type the name of the file you want to import, or select it from the list. To list a different 
type of file, choose the type from the List Files of Type box.

Directories
Select the directory where the file you want to import is stored.

Drives
Select the drive where the file you want to open is stored.

List Files of Type
Use this feature to select the type of file you want to import. You can import the following 
file types into Chart View: All Files *.* (Choose this option if you are unsure of the source 
application of the file you want to import. CorelCHART will attempt to identify the source 
automatically.); Corel Presentation Exchange (*.cmx); CorelDRAW! Graphic (*.cdr;*.pat); 
CorelTRACE (*.eps); Windows Bitmap (*.bmp;*.dib;*.rle); CompuServe Bitmap (*.gif); 
Computer Graphics Metafile (*.cgm); JPEG Bitmap (*.jpg;*.jff;*.cmp); Kodak Photo CD 
Image (*.pcd); Paintbrush (*.pcx); Scitex CT Bitmap (*.sct;*.ct);Targa Bitmap 
(*.tga;*.vda;*.icb;*.vst);TIFF Bitmap (*.tif;*.sep;*.cpt); Windows Metafile (*.wmf); Adobe 
Illustrator 1.1, 88, 3.0 (*.ai;*.eps);AutoCAD DXF (*.dxf); GEM File (*.gem); HPGL Plotter File 
(*.plt);IBM PIF (*.pif); Lotus PIC (*.pic); Macintosh PICT (*.pct);Micrografx 2.x, 3.x 
(*.drw);PostScript (Interpreted) (*.eps;*.ps); WordPerfect Graphic (*.wpg).
See also Technical Support

Filter Information
Displays the developer and version number of the filter used to import the selected file 
type.

Preview
Displays a preview of the selected file in the file preview window. A preview will only 
display if there is a preview header available. Deselect the Preview check box to skip 
preview.

Bitmap Load Image list box
Use this list box to choose between Full-sized, Cropped or Resampled image sizes.

Options
Displays a Sort drop-down list box. You can use this box to sort the files listed by name or 
date. If a single file is highlighted in the file list, the file's size, format, image size and date 
are displayed below the Sort box.

See also
Please consult Technical Support for information on supported import file formats and 
limitations.



Export command (Chart View File menu)
Saves the current chart in a format that other programs can read. 
Dialog Box Options
File Name

Proposes a name for the export file (the same name as the chart). Accept it, or type your 
own. The file extension corresponds to the Export file format selected from the List Files 
of Type box.

Directories
Select the directory containing the file you want to export.

Drives
Select the drive containing the file you want to export.

List Files of Type
Use to select the type of file you want to export. Available file formats include Windows 
Bitmap (*.bmp,*.dib,*.rle); Compuserve Bitmap (*.gif); Computer Graphics Metafile 
(*.cgm); JPEG Bitmap (*.jpg; *.jff; *.jtf; *.cmp); OS/2 Bitmap (*.bmp); Paintbrush (*.pcx); 
Scitex CT Bitmap (*.ct; *.sct); Targa Bitmap (*.tga, *.vda, *.icb, *.vst); Tiff Bitmap (*.tif); 
Windows Metafile (*.wmf); Adobe Illustrator (*.ai, *.eps); AutoCAD DXF (*.dxf); GEM File 
(*.gem); HPGL Plotter File (*.plt); IBM PIF (*.pif); Macintosh PICT (*.pct); Matrix/Imapro 
SCODL (*.scd) and WordPerfect Graphic (*.wpg). See also Technical Support

About...
Displays the developer and version number of the filter used to export the selected file 
type.

Selected Only
Exports only currently selected objects.

See also
Please consult Technical Support for information on supported export file formats and 
limitations.



Export Bitmaps dialog box
Use this dialog box to specify how you want to export files in any of the bitmap export 
formats, such as PCX (PCC), TIFF, TGA, GIF or 4 color TIFF, Windows BMP and OS/2 BMP.
Dialog Box Options
Color

Exports color bitmaps from your drawing. Select the number of colors you want in the 
exported file from the list box.
The greater the number of colors, the larger the exported file.
(16 colors = 4 bits)
(256 colors = 8 bits)
(16 million colors = 24 bits)

Grays
Exports colors in your drawing as shades of gray. Select the number of shades you want in 
the exported file from the list box.
You can convert gray shades and colors to black and white by selecting Black and White 
from the list box.
(black and white = 1 bit)
(16 shades of gray = 4 bits)
(256 shades of gray = 8 bits)

Dithered
Dithers the colors and gray shades in the exported file. Dithering may produce better 
results when exporting fewer colors than the original image. If the image contains fountain
fills or color blends, dithering can cause obvious banding in the exported bitmap. Here are 
some guidelines to help you decide whether to dither the bitmap:
· If you are exporting 16 or 256 colors or grays, use dithering.
· If you intend to scale the bitmap in another application, dithering is not recommended.

Compressed
Compresses the exported file so that it takes less disk space. Take note, however, that 
compressed files take more time to save and load.
Compression is optional for some bitmap formats; for others, compression is always 
performed.

Resolution
Specifies the resolution (in dots per inch) for bitmaps exported at a size of 1 to 1. Choose 
one of the preset resolutions from the list box, or choose Custom and type or select the 
resolution in the DPI box.
Note: As resolution increases, so does the size of the export file and the time required to 
print the image.

Size
Specifies the dimensions of the exported bitmap. Choose one of the preset sizes from the 
list box or choose Custom and type or select the dimensions in the Width and Height 
boxes.
If a size is not selected, the size of the image in CorelCHART is used. Smaller bitmaps (with
lower resolution) or larger bitmaps (with higher resolution) can be created by scaling the 
image up or down in CorelCHART prior to exporting.
If the dimensions you choose are not proportional to the bitmap's original aspect ratio, 
CorelCHART will remove extra pixels. Removing them prevents the bitmap from having 



undefined borders and appearing distorted.
About

Displays the developer and version number of the filter used to export the selected file 
type.

Reset
Returns to the settings in effect when you opened the dialog box.

Projected uncompressed file size
Shows the estimated size of the exported file before compression. Compressed files will be
smaller than the value displayed.
Note: To get an empty border around your bitmap, create a rectangle around your image 
where you want the border. Then, assign No Fill and No Outline to the rectangle.

See also
Technical Notes



Export--Bitmaps
Technical Notes
Scaling Bitmaps

If you enlarge a bitmap in another application, you will lose resolution. If you shrink a 
bitmap, the result should be acceptable, but you will be wasting disk space storing unused 
information.

File Size
To avoid unnecessarily large bitmap files (a full page at 300 dpi uncompressed can take 
several megabytes of disk space), scale the CorelCHART graphic to the same size as the 
space it will occupy in your word processing or page layout package or change the 
destination size in the dialog box.

Compression Schemes
Compression can only be applied to images that are 16- or 256-color, 16- or 256 gray (i.e., 
4- or 8-bit images).
CorelCHART uses the following compression schemes:

Windows BMP RLE (Run-Length Encoding). Very few applications support compressed BMP 
files; most will generate error messages or display the bitmap improperly.

Compuserve GIF LZW (GIF Version 89A)

CorelPHOTO-PAINT RLE (PCX Version 3.0)

Targa TGA Exports either RLE-compressed color-mapped images or RLE compressed 
RGB images (types 9 and 10 as defined by AT&T Electronic Photography and 
Imaging Center). The type of file produced depends on the number of colors 
exported: 24-bit color TGA files will be exported as RLE-compressed RGB 
bitmaps. Very few applications support compressed TGA files.

TIFF PackBits (TIFF Version 5.0). A user-definable switch under the    
[CorelTIFFExport] section of your CORELFLT.INI file should be set to 1 when 
exporting images for use in WordPerfect.

Fountain Fills
The number of bands used to represent fountain fills in the exported file is determined by 
the    Preview Fountain Step setting in the Preferences - Display dialog box.



Page Setup command (File menu)
Sets the page size and orientation for the chart.
Dialog Box Options
Paper Size

Select one of the standard paper sizes or select Custom and type the dimensions (up to 
30x30 inches) in the Horizontal and Vertical boxes. Note that Slide selects a page 
dimension with the same aspect ratio as a 35mm slide.

Set From Printer Uses the same paper size and orientation as the currently active 
printer.

Portrait Prints the drawing down the length of the paper.
Landscape Prints the drawing across the width of the paper.
Width Displays the currently select page width.
Height Displays the currently selected page length.
Units box Drop-down box used to set the units of measurement.



Print command (File menu)
Prints the current chart according to the options you specify.
Note: Before you print a final print file, or send a print file to an output bureau for film or 
direct imaging, make sure that you've built your System Color Profile with Color Manager for 
the output device chosen.
Dialog Box Options

Print Range
·    Check All to print all pages in a multi-page document. 
·    Selected Objects is dimmed, therefore not available when printing from CorelCHART.
·    Current Page prints the page displayed in the view window.
·    Pages is not available when printing charts because Chart View does not support 
multiple page documents. You can however print a large chart on several pages by 
choosing the Print Tiled Pages option in the Print Options dialog box.

Setup
Allows you to select specific printer options such as paper size, orientation, paper source, 
that are unique to the printer selected. See also, Windows Control Panel Help, Printers. See
also Print Setup command.

Options
Displays the Print Options dialog box, used to set advanced options for controlling the 
layout, color separations and other options.

Printer
Shows the active printer. If other printers are installed, select the one you want to use from
the list. You can also select installed printers with the Print Setup command in the File 
menu.

Printer Quality
Choose a level of resolution depending on the printer chosen. Resolution is measured in 
dots per inch (dpi). 

Printer Color Profile
Displays the color profile currently in use. The profile is created using the Color Manager.

Copies
Prints multiple copies of the current drawing. You can print as many as 999 copies, 
depending on the type of printer you are using.

Print to File
Creates a file that can be printed from DOS. Commonly used to print files from systems 
which do not have CorelCHART installed or when sending files to a service bureau for high-
resolution printing. Choose OK and a dialog box opens, prompting you to type a file name. 
See also Print to File dialog box
For Mac When printing to file, select this option if you are printing on a device 

controlled by a Macintosh computer. Available only with Print to File 
checked.

Collate Copies
When printing several copies of a multi-page document, check this option to print the 
entire range of pages several times. Clear the option to print multiple copies of the first 



page and then the second page and so on until the last page.
Shortcut

Pressing CTRL + P opens the Print dialog box



Print Setup command
(File menu)
Use Print Setup to select a printer or print options for your chart or spreadsheet
Dialog Box Options
Printer(s)

Selects the default printer or a printer listed in the box under Specific Printer. Only 
installed printers appear in the list. You install printers through the Windows Control Panel.

Print Quality
For selection of a different resolution, as available from the printer's driver.

Setup...
Contains the following options:
Paper Source

Choose upper or lower paper tray, or manual feed as required.
Paper Size

Selects paper size and source. Click on the arrows on the right of the Size and Source 
boxes to see a list of options you can choose.

Number of Copies
Choose the number of copies you want to print of the current chart or spreadsheet 
page.

Page Orientation
Selects orientation of the printer page. Choose an orientation that matches the 
orientation specified for your drawing with the Page Setup command.

Options
Displays a dialog box from which you can choose default options for the selected 
printer. For more information, click Options and choose Help.

Note: Before you print a final print file, or send a print file to an output bureau for film or 
direct imaging, make sure that you've built your System Color Profile with Color Manager 
for the output device chosen.



Color Manager command (File menu)
Color Manager creates a System Color Profile by learning about your monitor, scanner 
and printers. The profiles help CorelCHART more accurately capture, display and print color 
across different devices.
This System Color Profile ensures:
· colors that you view on your monitor closely resemble the colors your printer produces.
· the images and colors you include in your documents are accurately described to your 

printer. 
· colors from your scanner are adjusted to accurately reflect the colors of the image being 

scanned. Images cannot be acquired directly from a scanner in CorelCHART. You can 
however include your scanner specifications in a color profile built in CorelCHART using 
Color Manager.

Note:    The Color Manager's built-in defaults are pre-tested settings; use them whenever 
possible.
See also More about Color Manager
Dialog Box Options
Current Profile

Displays the name of the current color profile. If you have different printers, you may wish 
to build different color profiles and then select the appropriate one before working on 
charts for that output device.

Notes
Allows you to attach notes to your system profile. Useful for keeping track of different 
equipment setups.

Monitor
Displays monitor choices. Clicking Edit opens the Monitor Calibration dialog box.

Printer
Displays printer choices. Clicking Edit opens the Printer Calibration dialog box.

Scanner
Displays scanner choices. Scanners are not supported in CorelCHART--use CorelDRAW or 
Corel PHOTO-PAINT.

Automatch
Enables the two different color gamut mapping systems, Illustration and Photographic. 
CorelCHART automatically senses whether it is printing a vector or bitmap object and 
applies the appropriate gamut map.

Photographic
Enables the Photographic color mapping only. Use to force Photographic color mapping 
regardless of object type.

Illustration
Enables Colorimetric color mapping for working with spot colors. Use to force colorimetric 
color mapping regardless of object type.



Printer Characterization
Characterization establishes a normalized color relationship between your device and the 
CIE based reference Color System. This characterization may be based on 
spectrophotometric measurements (File) or visual methods (visual). The dialog box options
vary depending on the method you choose. Both are described below.

Visual
Print Testing Patterns
Print these patterns to match against the view field in the Printer Characterization dialog 
box.
Calibrate Monitor
If you have not already done so, calibrate your monitor before continuing with your Color 
Match.
Reset Color
Returns Hue, Saturation and Brightness to the default values.
OK
Enters the changes you have made and closes the dialog box.
Cancel
Abandons the changes you have made and closes the dialog box.
See also Working with basic System Profiles and Using advanced printer calibration 
features

File
Print Testing Patterns
Print these patterns and measure the CIE X Y Z values in order to create a new RHN file.
File Name
Choose an existing RHN that matches your output device or choose a new RHN that you 
have built.
See also Advanced Calibration features
For GCR, UCR, Black Point, and Dot Gain definitions, see Prepress Definitions.



More about Color Manager
Color Manager is a sophisticated color management system that provides three levels of 
color support.
Calibration

Color Manager creates a standard for image acquisition, viewing and reproduction devices.
These devices include monitors, hardcopy printers, film recorders, image setters and 
scanners. Note: CorelCHART does not support use of scanners; please use CorelDRAW or 
Corel PHOTO-PAINT.

Characterization 
Characterization establishes a normalized color relationship between your device and the 
CIE based reference Color System. This characterization may be based on 
spectrophotometric measurements or visual methods.

Gamut Mapping
Gamut Mapping provides a method of mapping colors to different printer gamuts. Gamut 
mapping enhances the accuracy of colors displayed on your monitor and the color and 
tonal ranges printed by your output device. CorelCHART uses two types of color mapping: 
Colorimetric for illustrations and Photographic for photographs. Gamut mapping works 
automatically according to the System Color Profile selected.



Prepress Definitions
Click the terms shown below for definitions of the Color Manager's Prepress controls.
Gray Component Replacement (GCR)
Undercolor Removal (UCR)
Black Point
Dot Gain
See also

Working with basic System Profiles
Using advanced printer calibration features



Exit command (File menu)
Exit ends the current CorelCHART session and returns the user to the Windows Program 
Manager.
If some active documents have not been saved, or have been modified since the last save,    
CorelCHART will prompt you to save those files.



Undo command (Edit menu)
Reverses the last action taken.



Cut command (Edit menu)
Removes selected annotations and places them onto the Windows clipboard.



Copy command (Edit menu)
Places a copy of selected annotations onto the Windows clipboard.



Paste command (Edit menu)
Places cut, copied or deleted annotations onto the current chart from the Windows clipboard.



Paste Inside command (Edit menu)
Copies the clipboard contents into the selected annotation or chart element. The command 
is dimmed if the clipboard contents are not in the required format (CMF, WMF, BMP or DIB) 
or the Clipboard is empty.
You can use this command, for example, to insert a graphic from CorelDRAW into the 
background of your chart. The contents become the default fill for all annotations created 
with the Ellipse, Rectangle or Pencil tools.



Delete command (Edit menu)
Removes the selected annotation(s), but does not save it to the clipboard. The chart title, 
subtitle and footnote can be deleted. Other chart elements, category titles, legend and so 
on, cannot be deleted. They can however be hidden from view by using the Display Status 
command.



Duplicate command (Edit menu)
Makes a copy of an annotation slightly offset from the original object.



Copy Chart command (Edit menu)
Copies the entire chart to the Windows clipboard where it can be pasted into another 
Windows application or inserted as an OLE object into a client application. 



Chart View/Data Manager command (View menu)
Toggles the current window between Chart View and Data Manager.



Toolbox command (View menu)
Displays a flyout menu for selecting a toolbox option.
Visible makes the toolbox visible or invisible
Floating When checked, the Toolbox detaches from its usual location on the left side of the 

screen. You can also detach the Toolbox by holding down the Shift key, clicking on the 
Toolbox and dragging it to a new location.
When the Toolbox is floating, you change its layout from vertical to horizontal or any 
intermediate arrangement.
Any floating Toolbox also has a control menu box listing various options.

Shortcut
To dock a detached Toolbox, double-click anywhere in its Title bar.



Floating toolbox control menu
Displays the following options for controlling the toolbox layout.

Floating Toggles the Toolbox between floating and detached states
Grouped Choosing this option groups the tools. When deselected, 

all tools are displayed including the flyout tools such as 
the Zoom, Rectangle and Ellipse tools. 

Close Hides the toolbox. To redisplay it, choose Toolbox-Visible 
from the View menu.

Color Palette (View menu)
Displays a flyout menu used to choose the type of color palette that appears at the bottom 
of the CorelCHART window. You can remove the palette from view to free up screen space. A 
bullet-marker appears next to the current flyout menu selection.
The Color Palette options are: None, Uniform Palette, Custom Palette, FOCOLTONE Process, 
PANTONE Spot Colors, PANTONE Process Colors or TRUMATCH Process Colors.



3D Roll-Up command (View menu)
Displays the 3D Roll-Up. The command is enabled only when you are working with 3D-riser 
or 3D-scatter charts. The 3D Roll-Up is used to: 
· alter size, scale and perspective 
· modify length of axes and thickness of walls
· rotate and move 3D charts
Click a red arrow and hold the mouse button down until you achieve the desired result. The 
longer you hold down the mouse button, the more of the effect you'll get.
Button/
Check box Action

Enlarges or reduces the charting area; moves the chart vertically or horizontally in 
the charting window.

Makes the chart larger or smaller without changing its position on the page.
2D Pan moves the chart vertically or diagonally anywhere on the page without 

changing the size of the chart.
3D Perspective controls the chart's perspective by making part of the chart appear 

closer and larger, and part of the chart appear further away and smaller. The less parallel 
the lines of the chart are, the more distorted the chart is. The chart can become very 
distorted as though seen through a fisheye lens or have very little distortion as seen through
a telephoto lens. Increasing distortion can give the chart a dramatic look and emphasize 
data by placing it closer to the viewer.

Changes the length of any axis.

Tilts the chart in three dimensions.
Show Graph Deselecting the box leaves a wireframe outline reflecting changes in the 

original chart.
Undo Undoes your changes and returns you to the chart window.
Redraw Redraws the chart to show changes.



Pictograph Roll-Up command (View menu)
Displays the Pictograph Roll-Up, used to fill an object with an imported graphic. Choose an 
object with the Pick tool and select a picture on the roll-up to fill the entire object with that 
picture.
Choose Show as Pictograph from the Chart menu. Select any bar in a series and select a 
picture from the Pictograph Roll-Up. Multiple copies of the picture will form each bar. The size
of each picture is set by the width of the bars and the frequency of the major grid lines on 
the data axis.
Roll-Up Controls
Roll window icon 

Hides the controls, leaving just the title bar visible.

 Pattern List
Click anywhere inside the large, central preview area of the Pictograph roll-up to display a 
list of patterns. Click the pattern you want and choose OK. Choosing Cancel ignores your 
selection and closes the list.
Choosing File displays a menu for saving, deleting and importing patterns.

Delete Item Deletes the selected pattern from the list.
Import Pattern Displays another dialog box that lets you create a pattern from an 

imported    graphic.
Import

Brings files created in other applications into the charting window.
Apply

Applies your choices to the selected object.



Color Correction command (View menu)
Color Correction allows you to increase the accuracy of your screen preview. Note: 
CorelCHART slows screen redraw slightly when previewing bitmaps.
Displays a flyout menu used to specify a level of color correction. Color Correction improves 
and optimizes the linearity of your monitor so that pictures appear on-screen as close as 
possible to a white-balanced photograph. The options are:

None Uses no color correction, allowing for the fastest screen draw.
Fast Uses some color correction based on your System Color Profile 

created using Color Manager, which improves the color display yet 
maintains a fast screen redraw. 

Accurate Uses color correction based on your System Color Profile to display 
colors more accurately. Slows down the screen redraw of bitmaps. 
See also Working with basic System Profiles and Using advanced 
printer calibration features

Simulate Printer An advanced option based on your System Color Profile. Choosing 
this option slows down the screen refresh of bitmaps, but is useful for
previewing colors before sending the file to the printer.



Wireframe command (View menu)
Displays the chart in wireframe mode. Only the outline of the chart is displayed. The overall 
performance of CorelCHART improves when working in wireframe mode.



Vertical/Horizontal Bar (Gallery menu)
A chart that uses bars to show the magnitudes of several categories. Bars run vertically, 
while the numeric scale travels in the same direction as the bars.
Vertical Bar charts show how values change over time. In contrast to line charts, vertical bar 
charts are best for a limited time series--just a few years, quarters, months, or whatever 
time period you're working with. Vertical bar charts are good for handling multiple series for 
comparison purposes. 
Subtypes: Side-by-Side, Stacked, Dual Axis Side-by-Side, Dual Axis Stacked, Bipolar Side-
by-Side, Bipolar Stacked and Percent



Vertical/Horizontal Line (Gallery menu)
A chart that uses lines to show the magnitudes of several categories. The numeric scale is 
perpendicular to the lines.
Vertical Line charts are best for showing changes in a group of values over longer periods of 
time. If you're trying to plot three or four series of values on a line chart, and they intersect 
so often you lose track of which is which, consider a vertical bar or vertical area chart. 
Subtypes: Absolute, Stacked, Bipolar Absolute, Bipolar Stacked, Dual Axis Absolute, Dual 
Axis Stacked and Percent



Vertical/Horizontal Area (Gallery menu)
A chart that uses area risers to show the magnitudes of several categories. The numeric 
scale is perpendicular to the areas.
Vertical Area charts show continuous proportions and totals. Like line charts, vertical area 
charts don't handle multiple series well; the areas representing larger quantities tend to 
obscure those representing smaller quantities. If this is the problem with your vertical area 
chart, consider a stacked vertical bar chart. 
Subtypes: Absolute, Stacked, Bipolar Absolute, Bipolar Stacked, Dual Axis Absolute, Dual 
Axis Stacked and Percent



Pie (Gallery menu)
Pie charts show the relative sizes of data points, compared to their sums. The slices show 
proportions, not absolute values. Slice labels name the slice and can include the slice's 
percentage or its absolute value.
For multiple pie charts, if you assign each pie to represent a time period, each conveys the 
contribution of parts to a whole and how the whole itself can grow or shrink over time.
Subtypes: Pie, Ring Pie, Multiple Pie, Multiple Ring Pie, Multiple Proportional Pie and Multiple
Proportional Ring Pie



3D Riser (Gallery menu)
Charts that represent data with three-dimensional bars or other riser shapes that rise from 
the floor of the chart. Three-dimensional charts suggest a connection between the three 
groups of data. 
Subtypes: Bar, Pyramid, Octagon and Cut-Corner Bar



3D Floating (Gallery menu)
Three-dimensional charts suggest a connection between three groups of data. Three-
dimensional floating charts represent data with three-dimensional cubes or spheres in three 
dimensions. 
Subtypes: Cube and Sphere



3D Connect Series (Gallery menu)
Three-dimensional charts suggest a connection between three groups of data. In 3D Connect
Series charts, markers or data points in a series are connected to form three-dimensional 
floating lines or areas, usually representing year-over-year economic performance. Ribbon 
and step lines let you see below them, while areas rise from the floor. 
Subtypes: Area, Ribbon and Step



3D Connect Group (Gallery menu)
Three-dimensional charts suggest a connection between three groups of data. Markers or 
data points in a group are connected to form three-dimensional floating "lines" or areas. 
Ribbon and step lines let you see below them, while areas rise from the floor. 
Subtypes: Area, Ribbon and Step



3D Surface (Gallery menu)
Three-dimensional charts suggest a connection between three groups of data. Data points 
are connected to form a net. The areas between the points are planes that can be colored to
make the net look like a solid surface rather than a wireframe. For large amounts of data, 
surface charts help show hot spots both high and low areas in the data.
A 3D surface with contour lines can be made by activating grid lines for the riser and making
the edges of the riser surface transparent. 
Subtypes: Surface, Surface with Sides and Honeycomb Surface



3D Scatter (Gallery menu)
Three-dimensional scatter chart data is random along all three axes. Unlike the other 3D 
charts, the data is not spaced evenly along the floor (X and Y axes).
Since the data points are floating in space, there are several visual methods to help gauge 
their values: 
· Color by distance from floor, left wall, or right wall
· Tie lines to the floor, left wall, right wall, or neighbor.
Subtypes:  XYZ Scatter and XYX Scatter with Labels



Scatter (Gallery menu)
Scatter charts show the correlation of two sets of numbers by plotting where the variables 
intersect. Scatter charts are useful when the co-ordinates on the horizontal scale--often time
intervals--are irregular.
Subtypes: X-Y Scatter, X-Y Dual Axes, X-Y with Labels and X-Y Dual Axes with Labels



Polar (Gallery menu)
This chart type is based on an X-Y plane in which each data point represents the distance (or
radius) and angle from the X axis.
Subtypes: Single and Dual Axis



Radar (Gallery menu)
Used to display the occurrence of data or the variation of data in relation to each other. 
Several series of data can be represented on a single radar chart. The different data points 
in a series are connected by lines.
Subtypes: Regular, Stacked Radar and Dual Axis Radar



Bubble (Gallery menu)
Similar to a scatter chart, a bubble chart represents three-variable, or trivariate, data:    the 
standard X and Y axis and the Z variable, represented by the size of the data point or bubble
as it is called in this chart type.
Subtypes: Bubble, Dual Axis Bubble, Bubble with Labels and Dual Axis Bubble with Labels



Gantt (Gallery menu)
This chart type is used to represent the duration, start and end times of particular events.



High-Low-Open-Close (Gallery menu)
This is a traditional stock-market chart type. Vertical lines indicate the highest and lowest 
values, while horizontal bars indicate the opening and closing values. 
Subtypes: HiLo, HiLo Dual Axes, HiLoOpen, HiLoOpen Dual Axes, HiLoOpenClose and 
HiLoOpenClose Dual Axes



Spectral Map (Gallery menu)
Spectral maps are specialized charts used with data that carries some kind of spatial 
relationship, such as geographical data. Showing a population density across a group of 
contiguous areas of a city would be one application for a spectrally-mapped chart.



 Histogram (Gallery menu)
Histograms display the distribution of data. The difference between the largest and smallest 
data values is broken into equally-spaced intervals. The histogram displays a count of the 
number of data points in each interval. The shape of the chart is often the traditional 
Gaussian or bell-shaped normal distribution curve.
Subtypes: Vertical Histogram and Horizontal Histogram



Table Charts (Gallery menu)
Table charts display data in columns and rows. This format is often used for data that is 
difficult to chart in any other way, or in scientific and technical settings where a graph's data
is shown next to it in a table.



Order command (Arrange menu)
The order flyout menu appears with the following options:

To Front
Places the selected annotation in front of all other annotations.

To Back
Places the selected annotation behind all other annotations.

Forward One
Moves the selected annotation layer forward one level.

Backward One
Moves the selected annotation layer back one level.



Align command (Arrange menu)
Use the Align command to realign drawing objects vertically and horizontally.
Vertical Alignment

Top Aligns one or more drawing objects with the top edge of the last selected 
object.

Center Aligns one or more drawing objects with the center of the last selected 
object.

Bottom Aligns one or more drawing objects with the bottom edge of the last selected 
object.

Horizontal Alignment
Left Aligns one or more drawing objects with the left edge of the last selected 

object.
Center Aligns one or more drawing objects with the center of the last selected 

object.
Right Aligns one or more drawing objects with the right edge of the last selected 

object.
Align to Center of Page

Centers selected drawing objects at the center of the charting window, overlaying each 
successively aligned object on top of the previous one.

Shortcut
Pressing CTRL+A with two or more drawing objects in the charting window displays the 
Align dialog box.



Make Same Size... (Arrange menu)
Displays a flyout submenu used to apply vertical and/or horizontal dimensions of one 
drawing object (rectangle, square, ellipse or circle) to another. 
With the Pick tool active, hold down the SHIFT key and click the original object. Click the 
object you want to give matching horizontal or vertical dimensions. Selection handles will 
appear around both objects. From the Menu bar, choose Arrange, Make Same Size. From the 
flyout menu, choose one of the following:
Same Horizontal
· Choose Same Horizontal to apply the horizontal dimension of object 1 to object 2.
Same Vertical
· Choose Same Vertical to apply the vertical dimension of object 1 to object 2.
Horizontal and Vertical
· Choose Horizontal and Vertical to apply the horizontal and vertical dimensions of object

1 to object 2.



Auto Update Chart command
When selected (the default), immediately redraws the whole chart to update any changes to
the chart's data as they occur.



Preferences command (File menu)
Controls interface and display settings. You can change these settings at any time, but they 
will revert to the defaults when you close CorelCHART.
Dialog Box Options
Interface preferences options

When checked:
Show Ribbon Bar displays the button bar located immediately below the menu bar, 
which gives you quick access to several menu commands.
Show Text Ribbon Bar displays the ribbon located immediately above the chart area, 
which includes buttons and list boxes for formatting text objects.
Show Status Line displays a line below the On-screen color palette. Information about 
selected commands and tools appear in this line.
Show Pop-Up Help displays name of tools and Ribbon Bar buttons when you rest the 
mouse pointer over the tool's icon.
Interruptible Display allows you to stop a screen redraw by clicking the mouse or 
pressing a key.

Display Options
Preview Fountain Steps
Determines the number of bands used to represent fountain fills on the screen. Also affects
the appearance of fountain fills in charts exported in the following formats:

· Illustrator (AI, EPS)
· Computer Graphics Metafile (CGM)
· MAC PICT (PCT)
· All bitmap formats

Selecting a lower value (less than 20) speeds up screen redraws, but results in noticeable 
banding.
You can control the number of bands used to print fountains with the Fountain Steps 
setting in the Print Options dialog box.
Note: The Steps setting in the Fountain Fill dialog box overrides the settings in this dialog 
box and in the Print Options dialog box for selected objects.
Greek Text Below
If your file contains large amounts of small text, selecting a high GTB value (maximum 
500) causes the text to display as small blocks, resulting in faster screen redrawing. Using 
this option does not affect the appearance of printed text.
Note: Depending on how high you set Greek Text Below, Greek text becomes readable 
when you magnify it with the Zoom tool. For example, 10-point text becomes readable 
with the setting at approximately 125.
Miter Limit
Affects the appearance of corner joints. Any corner that is less than the Miter Limit will 
have a beveled point. Those above the limit will come to a sharp point. This limit exists to 
avoid corners that extend far beyond the actual corner at small angles.

Preview Colors
Controls how CorelCHART displays colors on your screen, and has no effect on the printed 
output. To use these settings, you must have a monitor or graphics adapter that can 
display 256 simultaneous colors and a Windows screen driver that takes advantage of this 
capability.
256-Color Dithering Displays color using CorelCHART's dithering scheme.



Windows Dithering Displays color using the screen driver's default dithering scheme. 
If you have a 256-color adapter, your screen may redraw faster 
with this option selected. However, only 15 of these colors will be 
used in the dithering scheme.

Shortcut
Pressing CTRL+J displays the Preferences dialog box



Refresh window command (View menu)
Immediately redraws the current window, updating changes and removing any "dirt" left on 
the screen by earlier manipulation.



Cascade command (Window menu)
Makes all open windows overlap each other so that the title bar of each window is visible.



Tile Vertically command (Window menu)
Sets up two or more CorelCHART windows in equal frames arranged vertically.



Tile Horizontally command (Window menu)
Sets up two or more CorelCHART windows side by side and in equal sizes.



Arrange Icons command (Window menu)
Used to line up icons representing minimized CorelCHART files.



Close All command (Window menu)
Closes all active CorelCHART windows but leaves CorelCHART running.



1-2-3 File List (Window menu)
Lists all open windows or documents, including those minimized to icons. Choose any name 
or key any number on the list to make the window active. You can have 25 or more files 
open at once, depending on your computer's Random Access Memory (RAM).



Contents (Help menu)
Displays the CorelCHART Help contents. Click a topic area or title for descriptive or 
procedural help.



Screen/Menu Help (Help menu)

Displays the Help pointer . Choose Screen/Menu Help or its icon at the right end of the 
Ribbon Bar for context-sensitive Help about a menu command or screen region.



Search for Help (Help menu)
Displays the Search dialog box that lets you find Help information using keywords.



Quick Tour command (Help menu)
This command, which appears in the menu only if you have installed the Quick Tour CD-
based tutorial, launches the tutorial.



About CorelCHART (Help menu)
Displays information about CorelCHART. Click the System Info button for information about 
your computer hardware and operating system.



Control Menu
Restore command
Returns the active window to its previous size and location. You can also restore a window by

clicking on its Restore button 
· Does not affect a window moved or resized with the Move or Size commands.
Move command 
Moves the active window with the keyboard direction keys. This command is unavailable if 
the window is maximized.
Size command 
Resizes the active window with the keyboard direction keys. This command is unavailable if 
the window is maximized.
Minimize command
Shrinks the active window to an icon at the bottom of the CorelCHART window. You can use 
the Restore command to restore the minimized window to its former size.
Maximize command 
Enlarges the active window to fill the entire screen. You can choose the Restore command or 
click the Restore button to return the window to its former size.
Close command 

Closes the active window. Double-clicking the Control Menu button  is equivalent to 
choosing the Close command. 
Switch To command 
Opens the Task List, which lists all the applications currently running on your system.
Dialog Box Options
Switch To Opens the selected application.
End Task Closes the selected application.
Cancel Closes the Task List.
Cascade Overlaps all open applications so that their Title bars are visible.
Tile Sizes all open applications to fit on the screen.
Arrange Icons Arranges the icons of all minimized applications evenly across the bottom 

of the CorelCHART window. 

For more information see your Microsoft Windows User's Guide.



Window menu
Tile Vertically
Sets up two or more CorelCHART windows in equal-sized frames arranged vertically.
Tile Horizontally
Sets up two or more CorelCHART windows in equal side-by-side frames arranged horizontally.
Arrange Icons
Used to line up icons representing CorelCHART files that have been minimized.
Close All
Closes all active CorelCHART windows but leaves CorelCHART running.
1-2-3 File List
This section of the Window menu displays the list of all open files. You can 25 or more files 
open at once, depending on your computer's Random Access Memory (RAM).





Import command (File menu)
Imports data from other applications.

Dialog Box Options
File Name list box

Displays the default file extension *.CDS until you type in the name of the file you want to 
open, or select the file name you want from the list box. 

Drives
Contains the list of all available disk drives.

Directories
Contains the list of all available directories.

List Files of Type
Contains the list of all the available file formats: Corel Sheet (.CDS) Corel Sheet v. 4 (.TBL), 
text (.TXT), Comma Separated Values (.CSV), Rich Text Format (.RTF), Excel v. 3 and 4 
(.XLS).

Ansi to Oem
Check this option if the file you want to open uses the OEM standard.



Export command (File menu)
Saves CorelCHART spreadsheets in formats recognized by other applications.

Dialog Box Options
File Name

Proposes a name (e.g., SHEET1.CDS) if you have not saved a document before. Either 
accept the name or type a new file name.

Drives
Contains the list of all available disk drives.

Directories
Contains the list of all available directories.

List Files of Type
Contains the list of all the available file formats. Select the appropriate format for the 
application in which you intend to use the spreadsheet. Available formats are: Corel Data 
Sheet (.CDS), Tab separated text (*.txt), Comma Separated Values (.CSV), text (.TXT), Rich 
Text Format (.RTF), Excel 3.0 (*.xls) and Excel 4.0 (*.xls).

Ansi to Oem
Check this option if you need to save a file using the OEM standard. This exports the file 
with the DOS character set.



Print Preview command (File menu)
Displays a window that shows your spreadsheet as it will appear when printed. You can 
change the margins on screen before printing.
Zoom

Magnifies the page or returns to the full-page view. You can also magnify selected parts of 
the page by pointing to an area and clicking.

Margins
Lets you set the margins and chart size visually. When you click this button, dotted lines 
appear, indicating the positions of the paper margins. Dragging the lines changes the 
margins. After changing the margin settings, CorelCHART recalculates the number of 
spreadsheet cells fitting these settings.

Print
When you are ready to print, click Print. The Print dialog box will appear with options for 
controlling how the data prints.

Page
Click on this button to open Page setup dialog if you want to change page options.

Setup
If you want to select printer or to change printer parameters, click this button to display 
the Printer Setup dialog box.

Go to
Displays the Go to Page dialog box, where you can specify the page you want to preview.

Close
Closes the preview window and returns to the spreadsheet window.



Go To Page dialog
Enter the number of the page you want to see in the preview window and click OK.



Print command (File menu)
Displays the Print Data dialog box and prints the spreadsheet according to the options you 
choose. The selected printer and its connection are displayed at the top of the dialog box. 
You can change these with the Print Setup command.

Dialog Box Options
Copies

Specify the number of times you want the spreadsheet printed.
First Page Number

Specify the number to be assigned to the first page of your document.
Note: The page numbers in the From and To boxes under Print Pages should be 
calculated starting from this page, i.e., if number five is assigned to the first page and you 
want to print the first seven pages, the print range is from page five to page twelve.

Print Cells
Select All to print all rows and columns or choose From and specify the range you want 
printed in the From and To boxes. Selecting a range of cells to print automatically disables
the Print Pages group in the Print Data dialog box. 

Print Pages
Specify the pages you want to print. You can specify a range of pages if the All options are 
selected for both rows and columns under Print Cells. Type the first page number you 
want to print in the From box and the last page number in the To box.

Two-Sided Printing
Select this option if you want to print odd and even pages separately. When checked, a 
dialog box asks you if you want to print the odd-numbered pages. After your response, the 
dialog appears asking you if you want to print even-numbered pages. For two-sided 
printing, say yes to printing the odd or even-numbered pages, and when the odd-number 
pages are finished printing, place them in the printer tray to print the remaining pages on 
the reverse side.

Page
Displays the Page Setup dialog box, which enables you to change the layout of the pages 
to be printed.

Setup
Displays the Printer Setup dialog box to let you select the printer or to setup printer 
options.



Page Setup command (File menu)
Use this command to control the appearance of the printed spreadsheet.

Dialog Box Options
Header and Footer

Headers and footers are text strings that appear respectively at the top and bottom of 
every printed page of a spreadsheet. Type the header and footer text and/or field codes. 
The default settings print the document name as a header and the word "Page" and a 
page number as a footer, both being centered on the page. Note:    Only one header and 
footer can be set at a time for each spreadsheet. See also Header and Footer Formats

Margins
Determines the amount of space between the edge of the paper and the printed 
spreadsheet. You can set different margins for each side of the page. Either accept the 
default settings or enter the new values in the edit boxes.

Options
Choose what you want to print.
Print Patterns Select this option to print shading added to cells with the Patterns 

command in the Format menu. Clear to print cell contents only.

Print Grid Select this option to print cell gridlines. Clear to print cell contents only.

Print Borders Select this option to print borders added with the Borders command in 
the Format menu. Clear to print cell contents only.

Print Labels Select this option to print row and column headings. 

Print OLE Objects 
Select this option to print objects created in another OLE server
Deselect this option to omit OLE objects when printing spreadsheet drafts.

Font
Displays the Font Format dialog box to set the font, style, and size for printing headers and
footers.



Header and Footer Formats
From the Page Setup dialog box, you can create headers and footers that put a title, date or 
page number at the top or bottom of each printed page of your spreadsheet. CorelCHART 
automatically uses the document name as the header and the word "Page" and the page 
number as the footer. You can delete or change them. Headers and footers are saved 
automatically with the document.

Header and Footer codes
Code Effect

Position
codes

&L Aligns text against left 
margin.

&C Centers text between 
margins.

&R Aligns text against right 
margin.

Automatic
insert 
codes

&D Inserts the computer 
date.

&T Inserts the computer 
time.

&F Inserts the name of the 
spreadsheet or chart.

Page 
codes

&P Inserts the page number.

You can combine the codes shown in the table with your own text to create custom headers 
and footers. If text overlaps the header or footer, use the Page Setup command to change 
the top or bottom margin.
Use the Font button in the Page Setup dialog box to select type face, style and size for 
headers and footers.



Font command (Format menu)
Changes the type face, size, style, and color of selected cells.

Dialog Box Options
Font, Style, Size

Choose the typeface, style and size you want. CorelCHART lists only those fonts installed 
for the selected printer driver.

Effects
Choose the formatting effects you want and clear those you don't. As you select and 
deselect effects, the visual preview on the bottom right-hand side is updated.

Color
Controls the text color. Select the color you want from the list box. You must have a color 
monitor to display, or a plotter or color printer to print color formatting. Click the More 
button to select from a different color palette or create a color using the Color selection 
dialog box

Sample
Shows the effects of the options you've chosen before you apply them to the spreadsheet.



Printer Setup command (File menu)
Use this command to select the printer and printer options you want to use to print your 
spreadsheet.

Dialog Box Options
Printers

Selects the printer you want to use. Only installed printers appear in the list. You may 
install printers through the Windows Control Panel.

Setup
Displays a dialog box where you can choose default settings for the printer you select. The
settings available are Paper Source, Paper Size, Orientation and number of copies. An 
Options button displays a dialog box of additional options. For more information, choose 
the Help button after you choose the Options button.



Cut command (Edit menu)
Removes the selection from the spreadsheet and places it on the Clipboard. The selection 
can be a cell, range of cells or characters in the Formula bar. This command displays the Cut
and Clear Options dialog box for selecting the data types and formats to be placed on the 
Clipboard.

· If Cut is followed by Paste Data, the cell contents and formats are pasted into the area 
down and to the right of the selected cell.

· To paste below the selected range of data, choose the Fill Down command. To paste 
data to the right, choose Fill Right.

· If you need to "paste" just a portion of the Clipboard contents, select the area in the 
spreadsheet and then choose the Paste Data command. The selected area will be filled 
starting from the upper-left cell. Note:    The paste area must be the same size (i.e., 
number of cells wide and high) or a multiple of the selection. For larger selected areas, 
Data Manager will recopy the data to fill the paste area.

· Use the Delete command if you want to remove selected cells and shift other cells to 
fill the space.



Cut and Clear Options dialog box
Provides choices as to the data types and formats placed on the Clipboard or cleared from 
the selected cell or cells.

· Select the data types and formats you want to cut or clear 
· Deselect those data types and formats you want to retain

Dialog Box Options
Data

Select one or several types of data to be cut or cleared in selected cells. The options are 
formulas, variables or text. Your choices will be retained until you choose them for all cut 
and clear operations during the current CorelCHART session.

Formats
Select one or several of the formatting attributes to be cut or cleared for the chosen 
type(s) of data. The Format Options you can cut and clear are All, which removes the five 
available attributes--font, numeric format, alignment, borders and patterns.



Copy command (Edit menu)
Copies the selection to the Clipboard. The selection can be a cell, range of cells or 
characters in the Formula bar.

· If Copy is followed by Paste, the cell contents and formats are pasted into the area 
down and to the right of the selected cell.

· To paste below the selected range of data, choose the Fill Down command. To paste to 
the right, choose Fill Right.

· If you need to "paste" just a portion of the Clipboard contents, select the area in the 
spreadsheet and then choose the Paste command. The selected area will be filled 
starting from the upper-left cell.



Paste Data command (Edit menu)
The Paste Data command places previously cut or copied Clipboard data into the current 
spreadsheet, beginning at the current cell. 
When you paste data from a group of cells, you may select a paste area that is a multiple of 
the original to repeat the data. The selected paste area must, however, be of the same 
shape as the original, or a mesage box appears stating that the cut and paste areas are 
different shapes.
Example:    If you cut or copied cells C7, D7 and E7, containing the values 30, 35 and 40, 
you could paste them to a selected cell area of the same shape (three cells in a row) or a 
multiple of the original shape. If you pasted the data into six cells in a row, e.g., F7-K7, the 
data would paste into the first three cells and repeat in the next three as follows: 30, 35, 40, 
30, 35, 40.



Paste Special command (Edit menu)
Use this command to paste data from the Windows Clipboard. When chosen, the Paste 
Special command displays one of two dialog boxes.
The dialog box displayed depends on the source of the Clipboard data:    CorelCHART or 
another source application. Choose the appropriate topic:
Paste Special: From Data Manager
Paste Special: From another application



Paste Special:    From Data Manager
You can specify whether the copied formulas or values are added to, subtracted from, 
multiplied by, or divided into the contents of the paste area cells. Paste Special can also be 
used to transpose a range of values.
Paste

Choose the data types and formats--all, formulas, values, text and/or formats--that should 
be pasted from the Clipboard.

Operation
Select the operation--none, subtract, add, divide, multiply--that should be applied to the 
pasted data and the paste area data. Choose None if you don't need any.

Swap Args
Select to change the order of arguments for Dividing and Subtracting. By default, the first 
argument in the operation is the value from the cell in the paste area. Swapping makes the
value in the Clipboard the first argument in the operation.

Transpose
Select if you want to transpose the orientation of the data you are pasting. Data from the 
top row of the copied area will be pasted into the left column of the paste area; data from 
the left column will be pasted into the top row.



Paste Special:    From another application
Dialog Box Options for data from another application
Source

Shows the source of the Clipboard data or object.
Paste and Paste Link

Click one of the two options. Paste embeds the data in the CorelCHART spreadsheet. Paste 
Link maintains a link so that any changes made to the source file will be reflected in your 
spreadsheet.

As
If you choose Paste, this box lists various data formats (eg., Server application object, 
Unformatted text, Comma separated text, Rich Text Format, Picture (Metafile)) you may to 
use when you paste the data into your spreadsheet.
If you choose Paste Link, only the format of the server application--the application the 
data was created in--is listed so that the file will retain a link with the source file. 

Result
Provides information about the selections that are highlighted in the Paste and Paste Link 
area.



Paste Link Data command (Edit menu)
Pastes copied data into the selected cells and establishes a link with the data in the source 
application. When the source data changes, the pasted data reflects those changes. The 
source can be a Microsoft Excel worksheet or another DDE-compliant application.



Clear command (Edit menu)
Removes the contents of the selection from the spreadsheet. Unlike the Cut and Copy 
commands, the Clear command does not copy data to the Clipboard. Data previously copied 
to the Clipboard will not be replaced by cleared data. As with Cut and Copy, data to be 
removed using the Clear command can be a cell, range of cells or characters in the Formula 
bar. The Clear command displays the Cut and Clear Options for choosing the type(s) of data 
and the formats to clear from the selected cells.



Insert command (Edit menu)
Use this command to insert one or several rows/columns of empty cells.



Delete command (Edit menu)
The Delete command removes entire rows or columns and the contents of the cells they 
include.



Insert Object command (Edit menu)
This command inserts an OLE object created in another application into your spreadsheet. 
The object can be linked or embedded.
Dialog Box Options
Create New

Displays a list of OLE object types (based on the OLE server applications installed on your 
computer) in the Object Type list box. You can insert an object from any of these 
applications into your spreadsheet. 
Create New also launches the appropriate application so that you can create a new object 
to be embedded in your spreadsheet.

Create from File
Enables the insertion of an object based on an existing file. The list box displays the 
directory for the selected OLE server and a Browse button to select a file in another 
directory. The Link box is used to establish a link between the object and the original file 
where it was created. Not choosing Link embeds the object.

Result
This text box describes the type of object that the selected application inserts in your 
spreadsheet.



Links command (Edit menu)
Displays the Links dialog box, used to change the properties of linked objects or break the 
links altogether.
Dialog Box Options
Link

Shows a list of all links in the current spreadsheet. Highlight a link to select it.
Source/Type

Identifies the linked files and the server applications.
Update

Updates the link automatically.
Update Now

Updates the link when you click this button.
Open Source

Opens the server application and the file containing the linked object.
Change Source

Changes the source object.
Break Link

Breaks the link between the object and the server application. The object becomes 
embedded in your spreadsheet.



Fill Down command (Edit menu)
This command copies the contents of two or more cells to cells located below them. 
The command is available (not dimmed) when you select two or more cells containing the 
source data. You then drag with the mouse down the same column to select the cell range 
where the data is to be filled.



Fill Right command (Edit menu)
This command copies the contents of two or more cells into a range of cells located 
immediately to their right.
The command is available (not dimmed) when you select two or more cells containing the 
source data. You then drag with the mouse to the right to select the range of cells to be 
filled.



Chart command (View menu)
This command displays the current chart. Click the Data Manager button to return to the 
current Data Manager window from Chart View.



Borders command (Format menu)
Adds border lines in selected cells.

Dialog Box Options
Borders
Left, Top, Right, Bottom

Check the borders you want to be displayed and clear those for those you don't. You can 
use any combination of these options.

Outline
Check-this option if you want the whole cell to be outlined.

Style
Displays all the available line styles. Click on the line type you want to display the borders 
with. 

Color
From the drop-down list box select the color for the borders. Click the More button to 
select from a different color palette or create a color using the Color selection dialog box

Note: Colors and line styles can be applied independently of the various borders (i.e., top, 
bottom, right, left) of a cell or range of cells.



Numeric dialog box 
Use the Numeric dialog box, also called the Number Format command in Chart View, to 
choose or create new numeric styles in both Chart View and Data Manager. The Numeric 
dialog box is available from the Chart menu's Data Axis flyout menu, from the Data 
Manager's Format menu, from pop-up menus and from the Ribbon Bars.
CorelCHART provides several built-in formats based on serial values used with dates. If none 
of the built-in formats suit your needs, you can create new ones by editing a built-in format 
code or typing your own codes. Numeric formats applied in Chart View affect all similar 
numeric data, while numeric formats applied in Data Manager affect only the selected 
cell(s).
User-defined formats can be conditional, i.e., the applied format depends on the result 
returned by a formula or the value typed. For example, you can create a numeric format 
which displays positive values in black and negative values in red.
CorelCHART uses symbols to represent how the number will look when formatted. The 
symbols "m/d/yy," for example, represent the appearance of one of the built-in date formats.
Typing 10-2-93 in a Data Manager cell with this format produces this result: 10/2/93.
Dialog Box Options
Category and Formats

Use the scroll bar to browse the list of formats; there's a general-purpose format, and 
number, currency, date, time, percentage and scientific formats. The Formats box 
displays available formats for the selected category. 
See also Built-In Numeric Formats

Code
Displays the code of the selected format. The code box enables you to edit the code to 
modify the format or create a new one. If a user-defined numeric format is deleted, all cells
that use that format adopt the general format, which is the CorelCHART default.

Sample
Displays the selected format.

User Formats
The User Format text box displays the user-defined formats. The Add button is used to 
add a newly created style, built in the Code box, to the current category. Click the Change
button to apply the changes made to a custom format using the Code box. The Delete 
button removes a selected custom format from the list. 
See also Creating and Deleting custom formats and User defined numeric formats



Patterns command (Format menu)
Adds a pattern to the background of selected cells.

Dialog Box Options
Patterns

Shows all the available brushes you can use for shading cells. Click the brush in the palette
to make it active.

Colors
Use the Foreground and Background drop-down list boxes to select colors for the 
pattern. Click the More button to select from a different color palette or create a color 
using the Color selection dialog box



Alignment command (Format menu)
Aligns the contents of selected cells vertically and/or horizontally. You can also use the left, 
center, or right alignment buttons on the tool bar to align text and numbers in cells.

Dialog Box Options
Vertical

Displays three options for the vertical alignment of all selected cells. They are Top, 
Bottom and Baseline. The Baseline alignment centers the data according to the row 
height. 

Horizontal    
Gives four options: Left, Center, Right and Auto. The Auto option Aligns the numeric 
entries to the right and the text entries to the left. By default, the spreadsheet cells have 
the Auto alignment type.
The Indent box is used to set the alignment anywhere between the options mentioned. It 
specifies an indent from the left. The units of measurements box includes five indent 
choices.

Word Wrap
Displays long strings of text on multiple lines within a cell. Wrapped text may be left-
aligned, right-aligned, or centered in a cell.



Set Page Break command (Format menu)
Set Page Break enables you to insert a page break to the left of or immediately above a 
selected cell. 
The command name changes to Remove Page Break  when the active cell is immediately 
below or to the right of a page break. You can then use the command to remove the page 
break.



Style command (Format menu)
Enables you to save combinations of cell formatting attributes as styles. The options can 
include font, alignment, numeric format, cell borders and patterns. Styles are used to apply 
attributes to cells in the same spreadsheet. You can save styles in a style sheet (.CCT file) for
use in other spreadsheets. The Styles drop-down list in the Data Manager text ribbon bar 
includes all styles for the current style sheet.
Dialog Box Options
Name

Drop-down list of style names. Use the list to assign a file name to a new style or choose a 
style to modify.

Description
Shows the attributes that make up the currently highlighted style.

Components
This section is used to choose formatting options to be included in the style. Check the 
components you want and clear the ones you do not want as part of the style.
The Font, Alignment, Number, Border and Patterns buttons are used to set the formatting 
options for the style. 

Add, Delete, Load, Save
Add
Is used to add a new style in the list for the current spreadsheet. When you save the file, 
the added style is saved with the file but it is not available to other documents. 
Save
Saves the style in a style sheet which is a file with the .CCT extension. The .CCT file and 
the styles it contains are available to any spreadsheet. You can add many styles to the 
same style sheet and create new style sheets.
Delete 
Permanently removes an existing style from the current list. 
Load
Loads saved style sheets (.CCT files) for use in a spreadsheet.



Row Height command (Format menu)
Changes the height of selected rows. Only one cell in a row needs to be selected to change 
that row's height.

Dialog Box Options
Row Height

Used to type or select the height. A value of 0 (zero) hides the row. 
To specify the height in a different unit, click the units box and select the unit you want.

Default Value
Resets the row height to default value (16 points).



Column Width command (Format menu)
Changes the width of selected columns. Only one cell in a column needs to be selected to 
change that column's width.

Dialog Box Options
Column Width

Used to type or select the width. A value of 0 (zero) hides the column.
To specify the height in a different unit, click the units box and select the unit you want.

Default Value
Resets the column width to default value (58 points).



Center Across Selection (Format menu)
This command positions text in the center of a selected horizontal range of cells. 
For example, type a word in a cell, click that cell and drag the mouse to the right to highlight
a total of four cells. When you choose this command, the text string is centered across the 
range of four cells which means that part of the text is in the second cell and part of it is in 
the third. 
If the selected cell contains a numeric value or formula, the Center Across Selection 

command behaves exactly like the center alignment button --it centers the value or 
formula in its cell, not across a range of cells.



Best Fit command (Format menu)
Adjusts the width or height of the selected column or row to match the largest item in a cell 
in that column or row. When used with a range of cells, the Best Fit command adjusts both 
row height and column width at once.



Data Orientation command (Data menu)
Use this dialog box to control how the data is plotted on the chart.

Dialog Box Options
Series Orientation

Choosing Rows are Series displays text in the first column of the spreadsheet on the 
legend as series names. The text in the first row (category names) appears on the 
horizontal axis of the chart as tick-mark labels.
Choosing Columns are Series displays text in the first row of the spreadsheet on the 
legend as series names. The text in the first column (category names) appears on the 
horizontal axis of the chart as tick-mark labels.

Charted Data Point Orientation
These options are used most often with Hi-Low-Open-Close charts. Choosing Vertically 
Grouped Cell Values plots the high and low values on separate bars. Choosing 
Horizontally Grouped Cell Values plots each high and low pair on the same bar.



Word Separator command (Format menu)
When editing cell contents in CorelCHART, you can double-click a word and all the characters
that make up that word are automatically selected. CorelCHART looks for word separators 
and selects all characters located between two consecutive separators. A blank space is 
always a word separator.
It is useful at times to have other characters recognized as word separators. If, for example, 
you are editing a large financial spreadsheet that has the currency symbol ($) displayed in 
most of the cells, and you want to edit only the number digits, adding the $ symbol as a 
word separator simplifies and speeds up the work significantly. If a cell has $5,895.00 as its 
contents, the $ symbol is not selected when you double-click any of the numbers.
The Word Separator command displays a dialog box for adding or removing characters that 
act as word separators in your spreadsheet. The characters displayed in the dialog box when
you first open it are all considered word separators. You can remove all of them except the 
space which is always a word separator by default. You can add any character in the dialog 
box. 
The list of word separator characters is saved in the global CorelCHART settings. They are 
therefore valid for all spreadsheets and for every CorelCHART session until you modify the 
list.



Find & Replace command (Edit menu)
Searches for a specified data string, and replaces the search string with another string. You 
can have the find & replace operation done manually--you are prompted to replace or find 
the next occurrence of the string at every occurrence found. The option to Replace All does
the work automatically without warning at every occurrence.
You can search the entire spreadsheet by placing the cursor in the very fist cell of the 
spreadsheet or limit the search to a selected range of cells.
Note: If the active cell is somewhere in the middle of your spreadsheet, the search will 
begin from that cell and go forward or backward according to the options you set.

Dialog Box Options
Find What

Type the text you want to search for. Proposes the last text or value you searched for, 
which you can accept or change. You can type in any character, number, or punctuation 
mark. The Whole Cell option, if checked, ignores cells which contain more than the 
specified characters. Deselect the Whole Cell option to search for all occurrences of the 
characters.

Replace With
Specifies the string that will replace the searched string. Proposes the last string used as 
replacement. The Whole Cell option, if checked, replaces the entire cell contents with the 
replacement string. Clearing it replaces only the characters that match the search string 
and leaves other characters in the cell as they are.

Search for
Determines the type of data to search for--text, formulas or values.

Search by
Determines the order of the search--row by row or column by column.

Direction
Define the direction of searching: forward or backward.

Match Case
Select this option if you want CorelCHART to find only the strings that match the 
combination of upper and lowercase letters you type in the Find What box.

Verify on Replace
Select this option if you want to confirm each replacement.

Find Next
Finds the next occurrence of a string in the Find What box. Replaces this occurrence if the
Verify on Replace check box is cleared.

Replace All
Replaces all the occurrences of a string in the Find What box with a string from the 
Replace With box.



Find Next command (Edit menu)
Searches for the next occurrence of the string of characters you specify in the Find dialog 
box.



Go To Cell command (Data menu)
Use the Go To Cell command to jump from your current location to another cell address.



Sort command (Data menu)
Use this command to sort rows or columns of the data range according to the contents of a 
key row or column.



Insert Sorted Item dialog box
Provides a fast and easy method for inserting a new item in a sorted data range. The item is 
inserted at the appropriate location according to the sort order and key you specify in the 
dialog box. This command inserts the new item and sorts the selected data in one operation,
thus eliminating the need to sort the data again after adding a new item.
Dialog Box Options
Item

Used to type the new item to insert.
Insert

Specifies whether to sort rows or columns when inserting the new item.
Key

Identifies the column or row to insert item to. Type any reference to the cell from that row 
or column.



Enter Formula dialog box (Data menu)
The Enter Formula dialog box contains a formula editor, a listing of all available spreadsheet 
functions--and Context-sensitive Help for each one--and a listing of the available operators 
and separators. See also Spreadsheet Functions

Dialog Box Options
Editor

Enter your formula in this window using the keyboard or dialog box buttons. Formulas must
include arguments and operators, and may include functions and separators.
See also List of Operators

Functions
Drop-down list of the 11 Function categories--Conversion, Date and Time, DDE, 
Engineering, Finance, Information, Logic, Lookup and Reference, Math and Trig, Statistics 
and Text. The Data Manager includes nearly 300 Spreadsheet Functions. Click the down 
arrow to see the function categories. Double-click a function name to place the position of 
the cursor in the Editor field. After this, the cursor is positioned to input the function's 
arguments.

Functions List Box
Click a Function name in the Functions List Box and then click the Help button for a 
specific Help topic about the selected function. See also Using Context-sensitive Help with 
Functions

Copy
Copies the selected fragment of the formula onto the Clipboard. Use Paste to place the 
contents of the Clipboard into the formula you are editing.

Cut
Copies the selection to the Clipboard. Use Paste to place the contents into the formula you 
are editing.

Paste
Copies the contents of Clipboard into the formula starting from the cursor position.

Clear All
Clears the formula in the Editor window.

Undo
Removes the last characters typed.

Numeric Keyboard
Use this set of buttons to enter numeric arguments and operators with a mouse. Click the 
button to insert the selected symbol to the marker position in the Editor bar.

Enter
Closes the dialog box and enters the formula from the Editor box into the current cell.

Help
Displays Context-Sensitive Help when clicked with a function selected in the Functions list 
box.





Grid command (View menu)
Switches the display of gridlines on and off.



Chart Tags (View menu)
Switches the display of chart tags on and off.
Chart tags are the cell color shadows and cell frames that appear in your tagged 
spreadsheet cells. The chart tags are a visual aid for quickly identifying which cells have 
been tagged, what are the data series, the column headers and so on. 



Page Breaks command (View menu)
Switches the display of automatic page breaks on and off. Manual page breaks set with the 
Set Page Break command are always displayed.



Formula command (View menu)
This command is used to control the CorelCHART in-cell editing feature. Using in-cell editing, 
you can edit the contents and format of a cell in the cell itself, rather than moving to the 
Formula bar. This speeds up your work session. Both in-cell editing modes are described 
below.
In-cell editing with the Formula command enabled
Enables you to apply attributes to the selected cell's content. This is valid for cells 
containing text, values or formulas. Available attributes are font, type style, point size and 
color of characters. Select the cell you want to edit, press F2, click the cell, highlight the 
characters to be modified and apply the attributes using the text ribbon bar and the on-
screen color palette.

Numeric values
If the cell contains a numeric value, format changes are included automatically in that 
value's format in the Numeric dialog box. The modified format appears in the User Formats
box and can be saved as a style and added to a style sheet. See alsoStyle command.
Formulas
If the cell contains a formula, in-cell editing enables you to change the formatting 
attributes of the result of the formula. The numeric format is also updated automatically.

In-cell editing with the Formula command disabled
When the Formula command is deselected, you can change both the contents and the 
formatting attributes with in-cell editing. This is valid for cells containing text, numeric 
values and formulas.

Numeric values
Pressing F2 enables you to edit the numeric values themselves or their current format. 
When editing the format with the Formula command disabled, only the selected cell's 
appearance changes, the numeric format is not updated until the Formula command is 
enabled as described above.
Formulas
Cells containing formulas display the formula when you press F2, allowing you to edit the 
formula itself. Changes made to the attributes, also appear in the formula's result.



Fill Series command (Data menu)
Fills a number of cells in a row or column with a series of dates, times or sequential 
numbers.
Dialog Box Options
Series in

Chooses the orientation of the series. The choices are rows or columns. 
Fill

Lists the types of series available. The options are:
Linear fills each cell in the series with the next incremental linear value
Growth fills cells in the series with a multiple calculated from existing data in the 

series
Log fills cells with incremental values of a logarithmic progression
Fibonacci fills cells with incremental values in the Fibonacci progression
String fills cells with series of days of the week, month or year. The increments 

are based on the difference between the strings in existing cells or by the 
step value described below.

Autofill fills cells according to the data already in the series
String

Lists the string types you can use. The options are available only when a String series is 
selected. The nature of the Linear, Growth, Logarithmic and Fibonacci calculations and
the existing data used in an Autofill series dictate the type of string to use. The string 
options are therefore dimmed and unavailable for them.

Trend
Derives a mathematical progression from the data already in the series and applies the 
progression to the chosen Fill type.

Formula
Click this option and the Formula button at the bottom of the dialog box to create a 
formula to be used to create the series. The Enter Formula dialog box dialog box appears.

Step Value
Enter the amount by which you want each cell to increase over the previous cell.

Stop Value
Enter the value at which you want the series to end.



Auto Recalculate command (Data menu)
The Auto Recalculate command when checked, calculates all dependent formulas every 
time you make a change to a value or formula



Recalculate Now command (Data menu)
If Auto-Recalc is turned off, choose this command to recalculate your spreadsheet at a 
specific time. Choose this command every time you want to recalculate the spreadsheet.



Auto Update Chart command (Data menu)
If selected, this command immediately redraws the whole chart to update any changes to 
the data as they occur.



Update Chart Now command (Data menu)
CorelCHART will update the current chart when you click this option. Choose this command 
every time you want to update the chart.



Get Data From Database
This command accesses CorelQUERY, a Corel data query application included in your 
CorelDRAW package. This enables you to insert data coming from various sources into your 
CorelCHART spreadsheet. The command displays a flyout menu. You can create a new query 
file and insert it or select an existing query file.
New File

Displays the Data Source dialog box and the CorelQUERY window in the background. In the
Data Source dialog, you can choose a data source from the ODBC Data Sources list or click
Add to add a new data source to the list. 
The Configure button is used to associate the data source name you are adding, with the 
directory containing the data files and application drivers CorelQUERY should use. The 
Remove button removes the currently selected data source from the list.
When the data source is selected, the CorelQUERY window becomes active. See the Help 
menu in the CorelQUERY window for further information. See also Making queries: an 
overview.

Open File
Displays the Load a Data Query from Disk... dialog box, used to insert an existing query file
in your CorelCHART spreadsheet. The Data Query file format is .DSQ. When you click OK, 
the selected query table data is pasted in your CorelCHART spreadsheet as data. The data 
can be edited and formatted in Data Manager. There is no link established between this 
data and the corresponding data source.



1,2,3 File List (Window menu)
This section of the Window menu displays the list of all open spreadsheets.



Font, Border and Pattern Color Selection dialog box
Use this dialog box to specify the selected object's outline or uniform fill color using various 
models and custom palettes. As well, you can select colors from existing files in the Mixing 
area.
If you are using a color monitor, remember that the colors you see will not match the printed
colors exactly. To accurately specify Process colors, use the CorelDRAW Process Color Chart. 
If you are choosing colors from the TRUMATCH or FOCOLTONE palettes or either of the 
PANTONE palettes, then use the corresponding Color Reference.
Dialog Options
Show

Selects the color model. The options are: CMYK, RGB, HSB, Grayscale, Standard Colors, 
FOCOLTONE, PANTONE Spot colors, PANTONE Process colors, TRUMATCH, Custom Palette.

Preview
The color model selected determines the display of the colors in the Preview box.

CMYK Shows CMYK model and list boxes for each of the components.
RGB Shows RGB model and list boxes for each of the components.
HSB Shows HSB model and list boxes for each of the components.
Grayscale Shows grayscale model and Gray Level list box.
Standard Colors Shows Standard Colors model.
FOCOLTONE Shows FOCOLTONE model, Show Color Names checkbox and a 

Search for: box.
PANTONE Spot Shows spot colors, Show Color Names checkbox, Tint and 

Search for: boxes.
PANTONE Process Shows process colors, Show Color Names checkbox, Tint and 

Search for: boxes.
TRUMATCH Shows TRUMATCH colors, Show Color Names checkbox, Tint and 

Search for: boxes.
Current/New color Displays the current color in the top half and the new selected color

in the bottom half. 
New

Field used for the entry of a new color name.
PostScript Options...

Displays the PostScript Options dialog box. Only available when working with Spot colors. 
Used to specify halftone screens for Spot colors. See alsoPostscript Options dialog box

Custom Palettes
Click the arrow button to display the following menu choices: 
· Add Color, Delete Color and New palette commands
· Open Palette dialog box
· Save Palette As dialog box 
· Set As default command, used to set the current palette as the default. The Preview 

box displays the colors in the selected custom palette.



Mixing Area
Used to choose colors from existing files, the Show Preview box, the Custom Palette 
Preview box or any combination of the three. Click the arrow button to display the 
following menu choices: 
· Load Paint Area File dialog box
· Save Paint Area File As     dialog box  
· Clear paint area command. 
The Paintbrush button paints the selected color in the Paint Area and can mix that color
with colors already in the paint area. The Eyedropper button selects a color from the 
paint area which is then displayed in the Current/New preview box.



THE FOLLOWING TOPICS ARE DUPLICATES CREATED TO ENABLE BROWSE SEQUENCES IN 
DATA MANAGER. THE TOPICS HAVE BEEN STRIPPED OF KEYWORDS AND THE _DUP 
EXTENSION HAS BEEN ADDED TO THEIR CONTEXT STRING. THEY CAN ONLY BE ACCESSED BY
BY USING BROWSE.



New command (File menu)
Opens the New chart dialog box. Choose a chart type from the Gallery to start building a 
chart.

Dialog Box Options
Gallery

Lists all available chart categories. Several chart types, displayed in the Chart Types 
preview window on the right side of the dialog box, are available in each category. 

Chart Types
Shows the various chart types for the chosen category in the Gallery list displayed on the 
left. A written description of the highlighted chart type appears below the preview window. 
Double-click the chart type to select it.

Use Sample Data
Choose this option to use the sample data included in each CorelCHART template when 
you create a new chart. Replace the sample data with your own and add titles and other 
annotations as required. The chart itself appears in the Chart window when you click OK.
Deselect this option to go directly to a Data Manager window. Enter the data required in 
the configurations used in the sample charts and click Autoscan to generate the selected 
chart type from your own data. 

Shortcut
Pressing CTRL + N displays the New Chart dialog box



Open command (File menu)

Displays the Open Chart dialog box, used to load existing CorelCHART files from any drive.

Dialog Box Options
The File Name, List Files of Type, Directories and Drives lists and boxes allow you to 
choose CorelCHART (.CCH) files from the drives and directories on your computer system. 
Files created in CorelCHART versions 3 and 4 can be opened in CorelCHART 5.

Preview
When checked, the Preview window displays the chart type currently selected in the File 
Name box.

Options>>
Displays options for finding and annotating files.
Sort by Sorts files in the File Name list alphabetically or chronologically with the most

recently saved file listed first.
Notes Lets you store remarks with your files.

Shortcut
Pressing CTRL + O displays the Open Chart dialog box



Save (File menu)
Saves the current chart and its data. Allows you to select the appropriate drive and directory
where you wish to save the file. 
When saving a new file which has no title, this command displays the Save Chart dialog box,
prompting you to assign a file name to your chart.
When saving a file that has already been saved, the Save command saves the chart in the 
same location and uses the same file name. The Save As command is used to save a new 
file or an existing file in a new location or with a different file name.
Shortcut
Pressing CTRL + S Saves the File or displays the Save Chart dialog box



Save As (File menu)
Displays the Save As dialog box allowing you to save a new CorelCHART (.CCH file) to a 
specified directory or save an existing file with a new name or in a new drive/directory.
The Save Presentation Exchange Data option, if enabled, appends information to the 
saved file, allowing it to be opened in any Corel application.
Note: Files saved in the current version of CorelCHART cannot be opened in earlier versions 
of the program.



Close command (File menu)
This command removes the active chart and its window from the screen but leaves 
CorelCHART open. If the active chart has never been saved, or has been modified since the 
last save, a Save Changes dialog appears, asking if you want to save the file and/or the 
changes applied to it. 
From the Save Chart dialog box click: 

· Yes to return to CorelCHART, 
· No to abandon your changes and close the current charting window, or
· Cancel the closing operation and return to the document.



Mosaic Roll-Up
Displays Corel MOSAIC, a file management application, as a roll-up window in CorelCHART. 
The Mosaic roll-up is used to display a collection of thumbnails, each thumbnail representing
a file. You can use drag and drop to open or import files displayed in the roll-up in your chart 
or spreadsheet.
Two Mosaic roll-up windows can be opened at the same time in an application, allowing you 
to move or copy files between collections using drag and drop. 

Control menu box    
Use to roll up, roll down, close the Mosaic roll-up window, arrange all opened roll-up 
windows or close them all.

Directory drop-down list 
Located immediately below the Control menu box, the directory drop-down list enables you
to select or change the directory, library or catalog displayed in the Mosaic Roll-Up. A file 
folder icon precedes each directory name in the list, a book icon precedes catalog names 
and a book collection precedes library names. An open collection, of any type, has an open
file folder preceding its name.

Open collection button  
Use to open a second Mosaic roll-up window. It displays the Open Collection dialog box 
where you choose the type of collection you wish to open; directory, library (.CLB) or 
catalog (.CLC). To open a directory, select the file type you want to see, All Image Files to
see thumbnails of all graphic files or All Files to see thumbnails of all files in the directory.
The Options button displays additional options to sort files, see notes associated and 
keywords associated with them and a Find button to find files that have specific keywords.
The keyword options are not available in every Corel application.

Thumbnail size and orientation
The thumbnail size, orientation and other settings used in the collection are the ones 
saved when the standalone mode of Corel MOSAIC was last used.

Drag and Drop to the application
You can import a file into the application by clicking its thumbnail and dragging it to the 
current document in the application. Files of any files formats supported by CorelCHART 
can be imported.

Moving and copying files between collections
You can copy a file to a different collection by clicking its thumbnail and dragging it to the 
collection of your choice. Holding down the Shift key while dragging the file moves it 
instead of copying it.



Color Manager command (File menu)
Color Manager creates a System Color Profile by learning about your monitor, scanner 
and printers. The profiles help CorelCHART more accurately capture, display and print color 
across different devices.
This System Color Profile helps ensure that:

· colors that you view on your monitor closely resemble the colors that your printer can 
print

· the images and colors that you include in your documents are accurately described to 
your printer. 

· colors from your scanner are adjusted accurately to reflect the colors of the image 
being scanned. Images cannot be acquired directly from a scanner in CorelCHART. You 
can however include your scanner specifications in a color profile built in CorelCHART 
using Color Manager.

Note:    The defaults built into the Color Manager are pre-tested settings; use them 
whenever possible.
See also More about Color Manager

Dialog Box Options
Current Profile

Displays the name of the current color profile. If you have different printers, you may wish 
to build different color profiles and then select the appropriate one before working on 
charts for that output device.

Notes
Enables you to attach notes to your system profile. Useful for keeping track of different 
equipment setups.

Monitor
Displays monitor choices. See also Monitor Calibration

Printer
Displays printer choices. See also Printer Calibration

Scanner
Displays scanner choices. Scanners are not supported in CorelCHART. Use CorelDRAW or 
Corel PHOTO-PAINT.

Automatch
Enables the two different color gamut mapping systems, Illustration and Photographic. 
CorelCHART automatically senses whether it is printing a vector or bitmapped object and 
applies the appropriate gamut map.

Photographic
Enables the Photographic color mapping only. Use to force Photographic color mapping 
regardless of object type.

Illustration
Enables Colorimetric color mapping for working with spot colors. Use to force colorimetric 
color mapping regardless of object type.





Preferences command (File menu)
Controls settings which affect how CorelCHART displays the spreadsheet and objects on 
screen and how CorelCHART performs certain operations. You can change these settings at 
any time.

Dialog Box Options
Interface preferences options

When checked:
Show Ribbon Bar displays the button bar located immediately below the menu bar which
gives you quick access to several menu commands.
Show Text Ribbon Bar displays the ribbon located immediately above the chart area 
which includes buttons and list boxes for formatting text objects.
Show Status Line displays a line below the on-screen color palette. Information about 
selected commands and tools appear in this line.
Show Pop-Up Help displays name of tool in when you rest the mouse pointer on the tool.
Interruptible Display enables you to stop a screen redraw by clicking the mouse or 
pressing a key.

Display Options
Preview Fountain Steps
Determines the number of bands used to represent fountain fills on the screen. Also affects
the appearance of fountain fills in charts exported in the following formats:

· Illustrator (AI, EPS)
· Computer Graphics Metafile (CGM)
· MAC PICT (PCT)
· All bitmap formats

Selecting a value lower than 20 speeds up screen redraws, but results in noticeable 
banding.
You can control the number of bands used to print fountains with the Fountain Steps 
setting in the Print Options dialog box.
Note: The Steps setting in the Fountain Fill dialog box lets you override the settings in this 
dialog box and in the Print Options dialog box for selected objects.
Greek Text Below
Simplifies the appearance of text below the size specified. If your file contains large 
amounts of small text, selecting a high value (maximum 500) causes the text to display as
small blocks, resulting in faster screen redrawing. Using this option does not affect the 
appearance of text when printed.
Note: Depending on how high you set Greek Text Below, greeked text becomes readable 
when you magnify it with the Zoom tool. For example, 10-point text becomes readable 
with the setting at approximately 125.
Miter Limit
Affects the appearance of corner joints. Any corner that is less than the Miter Limit will 
have a beveled point. Those above the limit will come to a sharp point. This limit exists to 
avoid corners that extend far beyond the actual corner at small angles.

Preview Colors
Controls how CorelCHART displays colors on your screen, and has no effect on the printed 



output. To use these settings, you must have a monitor or graphics adaptor that can 
display 256 simultaneous colors and a Windows screen driver that takes advantage of this 
capability.
256-Color Dithering Displays color using CorelCHART's dithering scheme.

Windows Dithering Displays color using the screen driver's default dithering scheme. 
If you have a 256-color adapter, your screen may redraw faster 
with this option selected. However, only 15 of these colors will be 
used in the dithering scheme.

Shortcut
Pressing CTRL+J displays the Preferences dialog box



Undo command (Edit menu)
Reverses the last action taken.



Toolbox command (View menu)
Displays a flyout menu for selecting a toolbox option.

Visible makes the toolbox visible or invisible
Floating when checked, this option enables you to move the Toolbox away from its usual 

location on the left side of the screen by holding the Shift key and dragging the 
Toolbox.
When the Toolbox is floating, you change its layout from vertical to horizontal or any 
intermediate arrangement. See Changing the Toolbox layout.
The floating toolbox has a control menu box which lists various options.

Shortcut
To dock a detached Toolbox, double-click anywhere in its Title bar.



Color Palette (View menu)
Displays a flyout menu for choosing the color palette that appears at the bottom of the 
CorelCHART screen. You can hide the palette to free up screen space. A diamond-shaped 
marker appears next to the current flyout menu selection.
The flyout menu options are: FOCOLTONE, PANTONE or TRUMATCH process color palettes. 
PANTONE spot color palette, user-made custom palette, standard uniform palette or no 
palette at all.



Color Correction command (View menu)
Displays a flyout menu used to specify a level of color correction. Color Correction 
improves/optimizes the linearity of your monitor so that pictures appear as similar on-screen
as possible to a white-balanced photograph. The options are:
None No color correction
Fast General approximation
Accurate Best screen colors
Simulate Printer Displays screen colors as they would appear when printed



Refresh window
Immediately redraws the current window, updating changes and removing any "dirt" left on 
the screen by earlier manipulation.





Using Data Analysis
Overview: Data Analysis
Choosing Data Analysis methods
Calculating the mean
Determining Standard Deviation
Using moving average
Using Financial Moving Average
Using Scientific Moving Average
Finding Linear Regression curves
Using Power Law Regression
Drawing Exponential Regression lines
Plotting Natural Logarithmic Regression curves
Drawing Polynomial Regression lines
Showing a Regression Analysis formula
Finding the Correlation Coefficient



Overview: Data Analysis
The Data Analysis function derives statistical analysis curves for any series of chart risers. 
Use the Data Analysis dialog box to choose options for showing formulas for calculated 
curves such as Scientific Moving Averages and Financial Moving Averages, or to show 
correlation coefficients. Click any of the data analysis categories shown below for 
information about each one:
·    Mean
·    Standard Deviation
·    Connected Line
·    Smooth Curve
·    Moving Average
·    Financial Moving Average
·    Scientific Moving Average
·    Linear Regression
·    Power Law Regression
·    Natural Logarithmic Regression
·    Exponential Regression
·    Polynomial Regression Line
·    Order box
·    Smooth Factor box
·    Show Formula
·    Show Correlation Coefficient



Determining Standard Deviation
To find standard deviation:

1. Select one or more chart risers.
2. Choose Data Analysis from the Chart Menu or the right-mouse-button popup.
3. Choose Standard Deviation from the list of Data Analysis methods and click OK. 

CorelCHART plots the statistical curves requested.



 
Choosing Data Analysis methods

1. Select one or more chart risers.
2. Choose Data Analysis from the Chart Menu or the right-mouse-button popup.
3. Choose from the list of Data Analysis methods as required and click OK. CorelCHART 

plots statistical curves and shows formulas and coefficients as requested.



Finding Linear Regression curves
To create/delete a linear regression curve fit:

1. Select a bar or data point from with the right mouse button. On the pop-up menu, 
choose Data Analysis.

2. In the Data Analysis dialog box, click Linear Regression and click OK.
To remove the line:

In the Data Analysis dialog box, click Linear Regression again and click OK.



Using Power Law Regression
To create/delete a power law regression curve fit:

1. Click a bar or data point from the series with the right mouse button. On the pop-up 
menu, choose Data Analysis.

2. Click Power Law Regression.
To remove the line: 

Click Power Law Regression again and click OK.



Drawing Exponential Regression lines
To create/delete an exponential regression curve fit:

1. Select a bar or data point from a series with the right mouse button. On the pop-up 
menu, choose Data Analysis.

2. In the Data Analysis dialog box, click Exponential Regression and click OK.
To remove the line: 

In the Data Analysis dialog box, click Exponential Regression again.



Plotting Natural Logarithmic Regression curves
To create/delete a natural logarithmic regression curve fit:

1. Select a bar or data point from the series with the right mouse button. On the pop-up 
menu, choose Data Analysis.

3. Click Natural Log Regression and click OK.
To remove the line:

Click Natural Log Regression again.



Drawing Polynomial Regression lines
To create/delete a polynomial regression curve fit:

1. Select a bar or data point from the series with the right mouse button. On the pop-up 
menu, choose Data Analysis.

2. Click Polynomial Fit.
3. In the Order text box, enter the Order value (e.g., 3rd order = 3).

To remove the line:
Click Polynomial Fit again.



Finding the Correlation Coefficient
CorelCHART's Data Analysis feature can calculate how closely a curve fit line intersects with 
the data points it is charting.
To show the correlation coefficient

1. In the Data Analysis dialog box, choose a regression analysis type by clicking its check 
box. 

2. Click Show Correlation Coefficient below the list of regression types and click OK to close
the dialog box and return to your chart. 
You'll see the coefficient inside the charting area. The number will be between zero and 
one; one is a perfect fit and zero is a poor fit. This text can be moved anywhere on the 
chart, but should be placed close to the line it describes. Only one coefficient per series 
can be shown.



Showing a Regression Analysis formula
The Show Formula Option, located in the Data Analysis dialog box, allows you to display the 
formula for the chosen regression type. 
To display a data analysis formula:

1. Click or more bar risers.
2. Choose Data Analysis from the Chart Menu.
3. Choose a regression type.
4. Click Show Formula and click OK to close the dialog box and return to your chart. The 

formula will display inside the charting area. This text can be moved anywhere on the 
chart, but should be placed close to the line it describes. Only one formula can be 
shown per series.



Calculating the mean
The mean is a horizontal or vertical line drawn at the mean of the data points. The "mean" 
equals the sum of the values divided by the number of values (e.g. [P1 + P2 + P3] / 3 ).
To create/delete a mean average line:

1. Select a bar or data point from the series.
2. Click the right mouse button. On the pop-up menu, choose Data Analysis.
3. Click Mean. To remove the line, click Mean again.



Using Moving Average
How a moving average is calculated:

1. Click Moving Average in the Data Analysis dialog box.
2. As an example, if you then enter 3 for number of periods in the Order text box of the 

Data Analysis dialog box. CorelCHART averages the first 3 values (P1, P2, P3). It then 
shifts over one value to take another 3-value average (P2, P3, P4). This continues (in 
groups of 3) until it reaches the final value.

See also Using Financial Moving Average and Using Scientific Moving Average



Using Scientific Moving Average
How a scientific moving average is calculated:

1. Click Moving Average and Scientific in the Data Analysis dialog box.
2. As an example, if you enter 3 for number of periods, the program averages the first 3 

values (P1, P2, P3). It then shifts over one value to take another 3-value average (P2, 
P3, P4). This continues (in groups of 3) until it reaches the final value.

When the program determines the average of each period, it plots the value in the middle of
the period.



Using Financial Moving Average
How a financial moving average is calculated:

1. Click Moving Average and Financial in the Data Analysis dialog box.
2. As an example, if you enter 3 for number of periods in the Order text box of the Data 

Analysis dialog box, CorelCHART averages the first 3 values (P1, P2, P3). It then shifts 
over one value to take another 3-value average (P2, P3, P4). This continues (in groups of
3) until it reaches the final value.

When the program determines the average of each period, it plots the value at the right end
of the period.





Export EPS dialog box
Use this dialog box to specify how you want to export your EPS file.
Note: CorelCHART can import as EPS, however, files should be saved in the CDR format.

Dialog Box Options

Text
Specify how you want text exported.
As Curves Click to export text contained in the CorelDRAW file as curves.
As Text Click to export text contained in the CorelDRAW file as text.
Include Fonts If the font is not resident in the printer, choose Include Fonts to 

download the fonts into the EPS file. 
Because this option includes the font in the EPS file, you shouldn't use it if 
you are sending your work to a service bureau or another publishing 
package that has Adobe versions of the fonts you have used. This option is 
available only when exporting to EPS format.
No fonts will be downloaded if you export text as curves.

Convert Color Bitmaps to Grayscale
Converts colors in the drawing to appropriate shades of gray. Choose this option if your 
drawing contains color bitmaps and you plan to print the exported file on a black and 
white printer.

Fountain Steps
Specify the number of bands, from 2 to 256,    you want CorelDRAW to use to render 
fountain fills in the exported files. Up to a certain point, the higher the number of bands, 
the smoother the fountain will appear when displayed and printed.

Image Header
Includes a bitmap representation of drawings exported in Encapsulated PostScript (EPS) 
format. The bitmap makes positioning, sizing and cropping the drawing in page layout 
programs much easier. It's also used by graphics file managers such as CorelMOSAIC and 
by CorelDRAW when importing EPS.
CorelDRAW supports TIFF 4.2 headers in monochrome and color. Headers may be Black 
and White, 4 bit gray or color, 8 bit gray or color or 24 bit color. You can set a header 
resolution from 1 to 72 dpi. The larger the file size the more detailed the header.



CORELFLT.INI
A text file with information about the import and export filters used by all installed Corel 
applications. This file is in the CORELDRW\CONFIG subdirectory and can be edited by double-
clicking on it in the Windows File Manager. Aside from adding pens and color definitions used
by the HPGL filter, there's little reason to edit this file.





HPGL Options dialog box
Use this dialog box to specify the outline color and image size of files exported and imported
in HPGL format. The Import and Export dialog boxes have identical "pen management" 
options, however, the Export dialog box will add more features than the Import dialog box.

Dialog Box Options

Pen Options
Displays the Pen Selection, Pen Libraries and allows you to modify the pen color assigned 
to each of the plotter's drawing pens, the Pen Width and Pen Velocity. To change a pen's 
color assignment, for example, choose the pen and then change the Pen Color to the 
color you want. 
· Pen export does not support dashed lines or arrowheads.
Pen Selection
The Pen Selection list contains 256 pens, although not all of the pens may be assigned. 
Pen Color
You can change the color assignments by choosing the pen and then choosing a new 
color for that pen from the Pen Color field.
Choosing Custom colors opens a color definition dialog box that allows you to define a 
custom color using the RGB values.
You can also change the default color assignment by editing the [CorelHPGLPens] section 
in your CORELPLT.INI. For information on the INI files, see Technical Support.
Pen Width
You can change the pen width assignments by choosing the pen and then choosing a new
width for that pen from the Pen Width field.
Pen Velocity
You can change the pen velocity by choosing the pen and then choosing a new velocity 
for that pen from the Pen Velocity field.
Pen Unused
Allows you to set a defined pen to (Unused).
Reset
Allows you to reset the current Pen Library pen settings back to the last saved settings.
Pen Libraries
A Pen Library contains the color, width and velocity for each pen. Typically, a library 
contains 8, 16 or 256 pens. Any pen that is not declared will assume default settings.
You can save and delete Pen Libraries to build custom libraries of your own. After 
changing the current library, enter a new name in the Pen Library field and click OK. 
You delete Libraries by choosing the library to be removed and clicking delete.

Page Options
Choose Bottom Left Origin, or Center Origin. Then if you want to give your graphic a 
specific size, enable Scale.
Scaling Options
Enable Scale or Fit to Page. If you choose Scale you can scale your image up or down by 
percentage points in the Scale Percentage field.
Fit to Page Use the Fit to Page command to scale your current page up or down to the destination 



page. This option uses your page frame rather than the objects on the page. This 
maintains the relationship between the page frame and the objects inside the page, 
preserving white space.

Uses the plotter's automatic scaling features. Some plotter's do not support this option, 
particularly when a paper roll is loaded. If you encounter problems with this option, use 
the Scale feature instead.

Scale Choose a scale factor. You cannot define a page larger than 18 x 18.

Page Size
Allows you to define the page size. You can choose a known page size from the Page Size 
field or create a custom page by defining its dimensions in the Width and Height fields.
Orientation
So that the image is properly positioned when plotted, make sure the page orientation of 
your CorelCHART file match the plotter page. If the plotted image appears distorted, try 
changing the orientation of the CorelCHART page then re-export the file.
Plotter Origin
Choose the type of origin for the plotter your are going to output the image to, be it 
"Center" or "Bottom Left". If the option selected does not match your plotter, the image 
will not appear in the correct location on the page, and will likely go "out of bounds".
Plotter Units
Sometimes, a small sizing error occurs due to the plotter using different plotter units than
the standard 1016 units per inch. This can be corrected by modifying    the Plotter Units. 
Allowable plotter unit limits are between 10 and 10,000. Results for extreme values are 
not guaranteed.

Advanced Options
Fills
Allows you to set Line Spacing, Line Angle and for the Crosshatch fill, a Second Line 
Angle.
Line Spacing Sets the spacing between lines for the Parallel Lines and Crosshatch. For a solid fill 

choose a line spacing smaller than your pen width.

Line Angle Allows you to set the line angle of the fills.

Second Line Allows you to set the line angle on 
 Angle the second line used for Crosshatching.

Line Spacing
Represents the space between lines. To get a Solid fill, set this to the width of your pen 
(or, slightly smaller than the pen width, to guarantee results.)
Curve Resolution
Specifying curve resolution is useful when for scaling images to very large sizes. The 
values you can choose represent the number of straight line segments that a Bezier curve
will be turned into. 
· Curve resolution factor can be set to a value between 0.0 and 1.0 inches. The entered 

value can be very accurate; up to eight decimal places are accepted. While a setting of
0.0 will result in the highest resolution, it will also increase file size. A curve resolution 
of 0.004 inches is recommended.



Export Adobe Illustrator (AI) dialog box
Lets you choose the version of Adobe Illustrator you want to export to, and whether text is 
exported as text or curves.

Dialog Box Options

Format
Choose AI 1.1 if you are planning to use the file in Adobe Illustrator version 1.1.
Choose 88 only if you are planning to use the file in an application that does not support 
the V3.0 format.
V3.0 supports more of CorelCHART's drawing effects and is therefore the recommended 
export format.

Exporting Text as Text or Curves
Exporting Text As Text will create smaller files, and the text will be editable in the 
destination application. Fonts and spacing may not be maintained.
· You may also Use Macintosh Characters. This is very useful when exporting text 

using an extended character set, such as foreign language or other special characters.
Exporting Text As Curves will create larger files, and the text is not editable as text in 
the destination application. However, the appearance of the fonts is maintained. Use this 
option if you:
· used fonts in your chart that are not available in the application in which you intend to 

use the exported file.
· are not satisfied with the appearance of the exported text.

See also
See also Technical Support



Export Matrix/Imapro SCODL dialog box
Use this dialog box to specify the background in the exported image.

Dialog Box Options

Exporting Background Color
Choose whether you want a white or black background. If there is a background rectangle
in the CorelCHART image, the color of the rectangle will override the selection you make 
here.
Note: Page frames you draw or add through the Page Setup command in the Layout 
menu may not fit precisely into the SCODL imaging area. Any part of the frame that does 
not fit in the imaging area will be the color chosen in the dialog box.

Use the Entire Page
While you may use the entire page when exporting to SCODL format, this may result in an
overflow error. We recommend using this option with care as results may not be reliable.

Note: As SCODL export is used for slides, to avoid page sizing problems use the "slide" page size.



Export PIF dialog box
Lets you choose how text and curves are exported.

Dialog Box Options

Exporting Text as Text or Curves
Exporting Text As Text will create smaller files, and the text will be editable in the 
destination application. Fonts and spacing may not be maintained.
Exporting Text As Curves will create larger files, and the text is not editable as text in 
the destination application. The appearance of the fonts is maintained. Use this option if 
you:
· used fonts in your chart that are not available in the application in which you intend to 

use the exported file.
· are not satisfied with the appearance of the exported text.

See also
See also Technical Support



Export Adobe Type 1/TrueType Fonts dialog box
Use this dialog box to convert the selected object into an Adobe Type 1 or a TrueType 
compatible typeface character or symbol character.

Dialog Box Options

Fontname
Displays the name of the typeface and style on which the font file selected in the previous
dialog box is based.
If you are creating a typeface from a symbol, "Symbol" appears after the typeface name.

Preview Window
Shows the selected object. The crosshair in the lower left corner represents the 
character's origin, and the vertical line to the right of the character represents its width. If
you have not selected Auto With (described below), you can drag the vertical line to the 
right of the character to change its width.

Design Size
Specifies the point size of the character being exported. Leave the value at 720 points if 
you are creating a new typeface character or symbol as described in "Preparing Your 
Object Character" in Appendix C of your CorelDRAW User's Guide.
If you are modifying a character in an existing typeface, type or select the size you 
specified when you added the character to the page.

Character Width
Displays the width of the character you are exporting. If you are modifying an existing 
typeface and want to maintain the original proportions, leave the value unchanged.
If you are creating a new typeface, either specify the Character Width you want, or select 
Auto Width and let CorelCHART calculate an appropriate width.
Auto
When selected, this option will calculate a width for the character being exported, based 
on its shape and design size.

Character Number/List
Displays the character number from the Windows 3.1 Character Set that corresponds to 
the character you are exporting. You can change the character you are exporting to by 
typing a value in the text box or by selecting it from the character list. The lowest value is
33.
Characters not in the font file are grayed.

Options
Displays another dialog box that lets you change other information in the font file. 
Changes you make in that dialog box will be reflected in this one. See Options dialog box.

OK
Click this button to export the character. If you are changing an existing character 
definition, a message will appear asking whether you want to overwrite this definition.

Cancel



Click this button to cancel the export without changing the font file.



Export Fonts: Options dialog box
Use this dialog box to specify font information for a new typeface or symbol set or to edit the
information of an existing one.

Typeface Information
Family Name Displays the name of the typeface on which the font file selected in the

previous dialog box is based. If you are creating a new typeface, enter the 
name you want.

Style If the typeface already exists, one of the four styles will be selected. If it 
does not exist, select the style you want to assign to the character you are 
exporting.
Select the style before specifying any other options or values. The style 
cannot be changed once saved in the font file.

Symbol Font If you are creating a font based on the Windows 3.1 character set (ASCII 33-
127 and ANSI 128-255) and you want that font to be available in the 
Typeface selection list, leave this option disabled. If you are creating a 
symbol file or non-standard character set that will be available on a 
character-by-character basis through the Symbols dialog box, enable this 
option.

Grid Size Available when creating a new TrueType typeface. While this value can be 
changed from its default of 2048, there is very little reason to do so. Once a
Grid Size has been set for the first character in a new typeface, the option 
becomes available.
You might want to change it if you plan to use your typeface at very large 
point sizes. A larger grid size (4096) will use more points to describe the 
character, yielding better results and more complex character descriptions.
Once set, this number cannot be changed.

Space WidthSpecifies the width of the "space" character. You can experiment with 
different values to get the best results.

Character Information
The following options and controls are available when editing an existing typeface or 
symbol set.
Number Displays the currently selected character number. You can change the number by 

entering a new one or selecting it from the Character list box.

Width Enter a new value in this box to change the selected character's width.

Delete Click here to delete the
    Character selected character from the font file.

Load Font Metrics
Opens a dialog box which lets you apply the width and kerning data from an AFM file to 
the typeface you are modifying.

See also
See also Technical Support



Export WPG dialog box
Lets you specify whether colors in the exported chart use 16 or 256 colors and whether text 
is exported as text or curves.

Dialog Box 
Options

Export Colors
Choosing 256 colors gives good results depending on the screen and printer drivers 
WordPerfect is using. Choosing 16 colors is useful when you only want 16 colors in 
WordPerfect. The 256 color export will provide better results.

Export Text As
Choosing Curves converts text in the exported file to curves, while leaving text in the 
chart as text. Use this option if you:
· used fonts in your chart that are not available in WordPerfect.
· are not satisfied with the appearance of the text in WordPerfect.

See also
See also Technical Support



Export DXF dialog box
Lets you specify the colors and units of measurement in the exported file.

Dialog Box Options

Standard Colors (7), Full Colors (256)
Exports the standard seven colors available in DXF, or the 255 colors available on 
systems that use the IBM Professional Graphics Controller. Choose seven colors if the 
chart contains only a few primary colors, or if the 255 colors don't display the way you 
want. If the chart contains many colors, choose 255 colors, but keep in mind that results 
will vary depending on the type of graphics adapter and monitor you are using.

Inches, Millimeters
Converts the units of measurement in the chart to either inches or millimeters.

Curve Resolution
Being able to specify curve resolution is useful when you need to scale images to very 
large sizes. The values you can select from represent the number of straight line 
segments that a Bezier curve will be turned into. 
· Curve resolution factor can be set to a value between 0.0 and 1.0 inches. The entered 

value can be very accurate, up to eight decimal places are accepted. While a setting of
0.0 will result in the highest resolution it will also greatly increase file size. A curve 
resolution of 0.004 inches is recommended.

See also
See also Technical Support



 Export WMF dialog box
Gives you the option of including a placeable image header with the exported WMF file. 
Adding the header makes it possible to view the contents of the file in programs such as 
Ventura and Word for Windows. However, the presence of this header may also make the 
WMF file impossible to read by applications that don't understand it.



Export JPEG dialog box
Use this dialog box to specify how you want to export files in either of the JPEG or Lead 
bitmap formats. Images compressed using the JPEG export dialog box can be exchanged 
between a wide variety of platforms and applications. The JPEG format provides you with 
superior compression techniques, however, with extra compression comes a loss in file 
information. The JPEG export dialog box appears asking you to set options for the export. 
This dialog box is followed by the Bitmap Export dialog box where you can set other options

Dialog Box Options

JPEG Format
Choose from one of the following JPEG export formats.
JPEG Interchange Although this is not the pure 
Format (JFIF) JPEG format, JFIF is almost identical, and it is the format used most 

widely for interchanging JPEG images. Note that you should create 
your JFIF file using the JFF extension. This format is PC, Macintosh, 
and UNIX compatible.

TIFF JPEG (JTIF) The TIFF JPEG format will create a TIFF 6.0 file using JPEG 
compression. This is the only way a TIFF JPEG file can be created. 
TIFF JPEG files cannot be created from CorelCHART's usual TIFF 
export filter, nor can a TIFF JPEG file be imported through anything 
but the JPEG import filter.

LEAD Format (CMP) This format will provide you with better compression and better 
quality than any other JPEG format, however, this is not a standard 
JPEG format. LEAD CMP files can be read by Corel, Lead applications 
and any other application that provides support for this format.

Subformat
Choose from one of the following JPEG export subformats.
Standard (4:4:4) This subformat will conform to the standards used by other 

applications.
Option One (4:1:1) This subformat will provide additional compression by representing 

four pixels in the original file with a one pixel approximation. 
Although the file is approximately 1/4 the size of (4:4:4) files, this 
subformat will sacrifice quality.

Option Two (4:2:2) Option Two provides additional compression by representing two 
pixels in the original file with a one pixel approximation. This too 
sacrifices quality while the file is approximately 1/2 the size of a 
(4:4:4) file.

NOTE: The LEAD bitmap format does not use a subformat.

Quality Factor (2-255)
Use the slide control to select a quality factor. Click and drag with the mouse to move the 
slide control to the left or right, or use the left and right arrow keys to nudge the slide 
control by increments of one.
The minimum value on the slide control is two, which represents the highest quality file. 
Maximum value 255 which provides the highest compression, but at the same time, the 
lowest quality. Values in between will provide a certain degree of trade off between 
quality and compressed file size.



Use LEAD Quality Factor
When exporting in LEAD format, you can enable the Use Lead Quality check box. Select a 
preset quality factor from the list box below the check box. These presets can be used in 
place of numeric quality factors when exporting the LEAD bitmap format. The presets 
provide the best compromises between image quality and compressed file size.
There is no way of knowing which preset LEAD Quality Factor is the best for exporting a 
specific image. You should experiment with each option until you find one that suits your 
needs. The presets explain themselves by their titles, reflecting the compromises they will
make between file size and file quality.



Export CGM dialog box
Exporting Text as Text

Exporting Text As Text will create smaller files, and the text will be editable in the 
destination application. Fonts and spacing may not be maintained.

Exporting Text as Curves
Exporting Text As Curves will create larger files, and the text is not editable as text in 
the destination application. The appearance of the fonts is maintained. Use this option if 
you:
· used fonts in your chart that are not available in the application in which you intend to 

use the exported file.
· are not satisfied with the appearance of the exported text.



Export GEM dialog box
Exporting Text as Text

Exporting Text As Text will create smaller files, and the text will be editable in the 
destination application. Fonts and spacing may not be maintained.

Exporting Text as Curves
Exporting Text As Curves will create larger files, and the text is not editable as text in 
the destination application. The appearance of the fonts is maintained. Use this option if 
you:
· used fonts in your chart that are not available in the application in which you intend to 

use the exported file.
· are not satisfied with the appearance of the exported text.



TIFF Export dialog box
Export Formats

· TIFF 4.2
· TIFF 5.0
· TIFF 6.0 CMYK Exports CMYK 32-bit TIFF 6.0 images. This type of file is useful for high 

quality color separation. TIFF 6.0 JPEG is also supported. See Export JPEG dialog box.
See also Technical Support



Export Macintosh PICT dialog box
Exporting Text as Text

Exporting Text As Text will create smaller files, and the text will be editable in the 
destination application. Fonts and spacing may not be maintained. 
· You may also Use Macintosh Characters. This is very useful when exporting text 

using an extended character set, such as foreign language or other special characters.
Exporting Text as Curves

Exporting Text As Curves will create larger files, and the text is not editable as text in 
the destination application. The appearance of the fonts is maintained. Use this option if 
you:
· used fonts in your chart that are not available in the application in which you intend to 

use the exported file.
· are not satisfied with the appearance of the exported text.





Overview: Outlining and filling chart objects
There are two types of objects in the CorelCHART's charting mode--
· objects that make up the Chart itself, such as risers, axis, background, title and legend, 

and 
· objects, also called annotations, added to the chart using drawing tools--text, lines, 

curves, polygons, ellipses and rectangles .
Chart Objects are given outline and fill attributes based on the chart template being used. 
Added objects are automatically given a set of default outline and fill attributes. Fill and 
outline attributes can be changed for both kinds of objects using the Outline and Fill tools.
Open paths, such as the axis, are given outline attributes such as thickness and color, line 
style (solid, dashed, etc.) and line-ending shape (round, square, arrowhead, etc.).
Closed paths are given a fill attribute and some of the outline attributes of an open path. The
fill attribute can be a solid color, a fountain fill, a pattern or a texture. You can turn either set
of attributes off and leave the other visible. Turning off a rectangle's fill for example, makes 
it transparent, allowing objects behind it to show through.
Choosing Attributes
For flexibility and ease of use, CorelCHART offers four ways to select fill and outline 
attributes for Chart View objects.

Fly-out menus Provide quick access to pre-defined line thicknesses and colors for 
outlining and filling objects. You display the fly-out menus by clicking 
on the Outline and Fill tools.

Color Palette Lets you select Outline and Fill colors with the click of a mouse button. 
A command in the View menu turns the palette on and off and loads it 
with Spot or Process color.

Roll-Up Window Lets you apply a wide range of attributes with one or two clicks of your 
mouse. You can have the window open as you work or hide the 
controls, leaving just the Title bar visible. You display the roll-up 
windows by clicking on icons in the in the fly-out menus.

Dialog Boxes Give you access to all available attributes plus controls for specifying 
attributes such as line thickness with numeric precision. You display the
dialog boxes by clicking on icons in the fly-out menus and the Edit 
button in the roll-up windows.



Choosing line thicknesses
Choosing a line thickness using the Outline tool
Choosing a line thickness using the Pen Roll-up window
Choosing a line thickness using the Outline Pen dialog box



Choosing a line thickness using the Outline tool flyout
1. Select the object you want to outline.
2. Click the Outline tool. The Outline tool flyout menu appears.
3. Click the line thickness you want. The choice of thicknesses is 1/4 point, 2, 8, 16, and 

24 points.



Choosing a line thickness using the Pen Roll-up window

1. Click  in the Outline tool flyout. The Pen roll-up appears.
2. Select the object you want to outline.
3. Select the line thickness you want by clicking the arrows located to the right of the 
outline width preview. The up arrow increases the current thickness by .01 inches, the down 
arrow reduces it by the same amount. The preview is updated every time you click the 
arrows.
4. Click Apply.



Choosing a line thickness using the Outline Pen dialog box
1. Select the object you want to outline.
2. Click the Outline tool.
3. Click the pen icon.
4. In the Width box, type or select the line thickness you want.

To use a different unit of measurement, choose it from the units box. CorelCHART 
converts it to its equivalent in the new unit 



Choosing outline colors
Choosing an outline color with the Outline tool icons
Choosing an outline color with the Pen Roll-up
Choosing an outline color with the On-screen Color Palette
Choosing an outline color with the Outline Color dialog box



Choosing an outline color with the Outline tool icons
The Outline tool flyout menu includes several icons for applying white, black or shades of 
gray to your outlines. To apply any other color to an outline, please refer to the other outline 
color methods.
To choose a color from the Outline tool menu:

1. Select the object you want to outline.
2. Click the Outline tool.
3. Click black, white or the shade of gray you want. The shades vary in increments of 20%

from 10% to 90%.



Choosing an outline color with the Pen Roll-up

1. Click     in the Outline tool flyout menu. The Pen roll-up appears.
2. Select the object you want to outline.
3. Click the Color Selector bar. The drop-down color palette appears.
4. Click a color.
5. Click Apply.



Choosing an outline color with the On-screen Color Palette
1. If the palette is not displayed, choose Color Palette in the View menu. Then from the 

sub-menu, choose the custom palette,    Spot color palette or one of the Process colors 
palettes.

2. Select the object you want to outline.
3. Select the color you want from the palette by clicking it with the right mouse button.

To scroll the palette one color at a time, click an arrow at either end of the palette with 
the left mouse button. Click with the right mouse button to scroll the width of the 
screen.



Choosing an outline color with the Outline Color dialog box
1. Select the object you want to outline.
2. Do one of the following:

· From the Outline tool menu, click the color wheel icon.
· From the Pen Roll-up window, click the Edit button, then the Color button. From the 

drop-down color palette that appears, click the More button.
3. From the Show list box, choose the color specification method you want to use.
4. Do one of the following:

· To select a color from the TRUMATCH, FOCOLTONE or PANTONE palettes by sight, click 
Show Color Names to clear the check mark, then click the color you want.
If you want a lighter shade of the selected Spot color, type or select a value in the 
%Tint box. 

· To choose a color by name, choose Show Color Names, then click the name of the 
color.
The Search option lets you locate a color by typing part of its name. As you type, 
the list of names scrolls to the color that most closely matches what you type. You 
do not need to type the word TRUMATCH, PANTONE or FOCOLTONE.

· To create a Process color, choose CMYK, RGB or HSB. Create the color you want using 
the numeric controls or the color adjustment markers. 

5. Choose OK, if you are using the Pen Roll-up window, click Apply.



Removing an object's outline
While you can remove an object's outline using the Pen Roll-up window and the Outline Pen 
dialog box, it's quicker to use the Outline Pen menu or the on-screen color palette.
From the Outline tool menu:

1. Select the object with the outline you want to remove.
2. Select the Outline tool.
3. Click the  button.

From the on-screen color palette:
1. If the palette is not displayed, choose Show Color Palette from the Display menu. Then 

from the sub-menu, choose either Spot Colors or Process Colors.
2. Select the object with the outline you want to remove.
3. Click the  button at the left end of the palette with the right mouse button.



Choosing dashed or dotted line styles
You can outline objects with a variety of dashed and dotted line styles. You can even create 
you own line styles and have them added to the existing selection. 

Choosing a dashed or dotted line style from the Pen Roll-up
Choosing a dashed or dotted line style from the Outline Pen dialog box



Choosing a dashed or dotted line style from the Pen Roll-up

1. Click     on the Outline tool flyout menu. The Pen roll-up appears.
2. Select the object you want to outline.
3. Click the Line Style Selector bar to display a list of line styles.
4. Click the style you want.
5. Click Apply.



Choosing a dashed or dotted line style from the Outline Pen dialog 
box

1. Select the object you want to outline.
2. Select the Outline tool.
3. Click the pen icon.
4. Click the Style box to display a list of line styles.
5. Click the style you want.

If you want dash segments with rounded ends, choose the second option under Line 
Caps.
To create a dotted line, apply round caps to a line style with short, widely spaced 
segments.



Choosing default outline attributes
Default outline attributes are automatically applied to annotation objects you add to your 
chart. You can also set new default attributes for outline color, thickness and style or choose 
to give new objects no outline at all.
To choose default outline attributes:

1. Click a white space in the chart window to ensure there is no object selected.
2. Click the Outline tool. The flyout appears.
3. Do one of the following:

· choose the tool that corresponds to the individual outline attribute you want to set.

· click  to set all attributes in the Outline Pen dialog box.

· click  to give all new annotation objects no outline. The Modify Default dialog box
appears.

4. Click Yes to confirm you wish to modify the default fill. The dialog box for the chosen 
outline attribute appears.

5. Set the attributes.



Copying an object's outline
Once you apply an outline to an object, you can quickly apply the same outline to another 
object by using the Pen Roll-up window.
To copy an object's outline:

1. Click     in the Outline tool flyout menu. The Pen roll-up appears.
2. Select the object you want to change.
3. Click the Update From button.

The mouse pointer changes to an arrow with the word "From?"
4. Click the object with the outline you want copied.
5. Click Apply.



Creating calligraphic outlines
Calligraphic outlines vary in thickness giving the object they're applied to a hand-drawn 
appearance. 
To create a calligraphic outline:

1. Select the object with the outline you want to change.
2. Do one of the following:

· From the Outline tool menu, click the pen icon.
· From the Pen Roll-up window, click the Edit button.

3. In the Width box, type the line thickness you want.
To use a different unit of measurement, choose it from the units box. CorelCHART 
automatically converts it to its equivalent in the new unit.

4. Define the Nib Shape of the Outline Pen by choosing a Corners option. The first and 
third options make the nib square; the second makes it round.
You can adjust the shape of the nib even further with the Stretch setting. Lowering the
value makes a square nib rectangular and a round nib oval.

5. Enter a pen angle in the Angle box. The angle controls the orientation of the pen to 
the drawing surface. You can interactively adjust Stretch and Angle by dragging in 
the Nib Shape box.

To change line widths after creating the calligraphic outline, use the Width setting in the 
Outline Pen dialog box. Choosing a line width from the Outline menu will reset the Angle to 
zero degrees and Stretch to 100 percent thus removing the calligraphic effect.



Applying arrowheads and other line-ending shapes
The Pencil tool draws lines and curves. CorelCHART provides an assortment of arrowheads 
and other line-ending shapes that you can apply to the ends of lines and curves with the 
Outline tool. The arrows have the attributes you have given to the line or curve. Use Outline 
tool options to change those attributes.
You can also add arrowheads of your own design to the existing selection using CorelDRAW's
Create Arrow command. Please refer to CorelDRAW Online Help for step by step instructions.
After selecting the arrowhead/line-ending shape, you can resize it and adjust its position 
relative to the end of the path. 
See also Editing an arrowhead or line-ending shape
Arrowheads are applied by using one of the following procedures:
Applying line-ending shapes with the Outline Pen dialog box
Applying line-ending shapes with the Pen Roll-up window



Applying line-ending shapes with the Outline Pen dialog box
1. Select a line or curve.

2. Select the Outline tool. Click .
3. To apply an arrowhead to the start of the line or curve, click the left preview box 
under Arrows, then click the arrowhead you want in the drop-down selection window.
4. To apply an arrowhead to the end of the line or curve, click the right preview box 
under Arrows, then click an arrowhead.

You can swap the arrowheads by choosing either of the Options buttons, followed by 
Swap.
To remove an arrowhead from a path, click the appropriate box under Arrows and 
select the first option in the list.

5. Click the Color selection box to choose a color for the arrowhead. The selected color is 
applied to both the arrowhead(s) and line or curve.

Note: the width of the line or curve must be bigger than a hairline in order for the 
arrowhead to be displayed.



Applying line-ending shapes with the Pen Roll-up 

1. Click     in the Outline tool flyout menu. The Pen roll-up appears.
2. Select the path to which you want to apply the arrowhead/line-ending shape.
3. To apply an arrowhead to the start of the path, click the left arrow preview box, then 
click the arrowhead you want.
4. To apply an arrowhead to the end of the path, click the right arrow preview box, then 
click the arrowhead you want.

To remove an arrowhead from a path, click the appropriate Arrowhead Selector and 
choose the first option in the list.

5. Click Apply.



Editing an arrowhead or line-ending shape
When you apply an arrowhead to a path, its size is determined by the thickness of the path's
outline. If you increase the thickness, the arrowhead size increases proportionately. To get a 
larger arrowhead without changing the outline of the path, use the Arrowhead Editor. You 
can also use the Editor to adjust the arrowhead's position relative to the end of the path.
To edit an arrowhead or line-ending shape:

1. Select the path with the arrowhead/line-ending shape you want to edit.
2. Do one of the following:

· From the Outline tool menu, click the pen icon.
· From the Pen Roll-up window, click the Edit button.

3. Under Arrows, choose the Options button that's beneath the arrowhead you want to 
edit.

4. Choose Edit. The Arrowhead Editor appears.
5. Do one or more of the following:

· To get closer to the arrowhead/shape , check the 4X zoom box.
· To stretch the arrowhead/shape, drag on the solid handles between the corners of its

highlighting box. Drag the corner handles to scale it.
· To move the arrowhead/shape, drag the hollow nodes along its outline. To ensure 

precise alignment as you approach the dashed lines, the node you are using to 
move snaps to the line.

· To move the solid black line representing the line the arrowhead/shape will be 
applied to, drag the node at its end.

· To center the arrowhead/shape on the line, choose the Center buttons.
· To flip the arrowhead horizontally or vertically, choose the Reflect buttons.



Choosing fill colors
Choosing a fill color with the Fill tool flyout menu
Choosing a fill color with the On-screen Color Palette
Choosing a fill color with the Uniform Fill dialog box



Choosing a fill color from the Fill tool flyout menu
From the Fill tool menu, you can fill objects with black, white and five shades of gray. To fill 
objects with a uniform color, you can use the on-screen Color Palette or the Uniform Fill 
dialog box.    
To choose a black, white or a shade of gray from the Fill tool menu:

1. Select the object you want to fill.
2. Click the Fill tool. The flyout menu appears.
3. Click black, white or the shade of gray you want. The shades vary in increments of 20%

from 10% to 90%.



Choosing a fill color from the on-screen Color Palette
1. If the palette is not displayed, choose Color Palette from the View menu. Then choose 

one of the color palettes.
2. Select the object you want to fill.
3. Select the color you want from the palette by clicking it with the left mouse button.

To scroll the palette one color at a time, click an arrow at either end of the palette with 
the left mouse button. Click with the right mouse button to scroll the width of the 
screen.



Choosing a fill color with the Uniform Fill dialog box
1. Select the object you want to fill.
2. From the Fill tool menu, click the color wheel icon.
3. From the Show list box, choose the color specification method you want to use.
4. Do one of the following:

· To select a color from the TRUMATCH, FOCOLTONE or PANTONE palettes by sight, click 
Show Color Names to clear the check mark, then click the color you want.
If you want a lighter shade of the selected Spot color, type or select a value in the 
%Tint box. 

· To choose a color by name, choose Show Color Names, then click the name of the 
color.
The Search option lets you locate a color by typing part of its name. As you type, 
the list of names scrolls to the color that most closely matches what you type. You 
do not need to type the words TRUMATCH, FOCOLTONE or PANTONE.

· To create a Process color, choose CMYK, RGB or HSB. Create the color you want using 
the numeric controls or the color adjustment markers.



Making an object transparent
You may want to remove an object's fill so that objects behind it show through.
You can remove fills using the Fill Roll-up window and the Uniform Fill dialog box, but it's 
quicker to use the Fill tool menu or the on-screen color palette.
From the Fill tool menu:

1. Select the object with the fill you want to remove.
2. Select the Fill tool.
3. Click the  button.

From the on-screen Color Palette:
1. If the palette is not displayed choose Color Palette from the Display menu. Then choose

one of the color palettes.
2. Select the object whose fill you want to remove.
3. Click the  button at the left end of the palette with the left mouse button.



Creating a fountain fill
A fountain fill is one that flows smoothly from one color to another. The fill can flow in a 
straight line across the object (linear), in concentric circles from the center of the object out 
(radial), in concentric rectangle from the center of the object (square) or in rays the from the
center of the object out (conical).
See one of the following topics for step by step instructions:

Using the Fountain Fill dialog box
Using the Fill Roll-up



Creating a fountain fill using the Fountain fill dialog box
1. Select the object you want to fill.
2. Select the Fill tool.
3. Click the Fountain fill icon. The Fountain Fill dialog box appears.
4. Choose the type of fountain you want (Linear, Radial, Conical or Square).
5. In the Color Blend group, click the From color button and then the color you want as 

the start color. Click the To color button and then the color you want as the end color 
of the fountain. 
To create your own colors or select existing ones by name, choose the More button.
Note: If you are using Spot color, and plan to create color separations, use tints of the 
same color to specify the start and end colors.

6. Still in the Color Blend group, click a color blend method
Direct makes a fountain fill that goes from one color to another
Rainbow displays the intermediate colors between the two chosen colors
Custom lets you specify intermediate colors to be applied in the fountain fill
See Specifying the intermediate colors in a fountain.

7. To specify the angle of a Linear or Conical fountain do one of the following:
· Type or select the angle in the Angle box.
· Hold the mouse button down in the Preview box and drag. For Conical fountains use 

the right mouse button. Holding down the CTRL key as you drag constrains the angle
to 15-degree increments.

8. To offset the center of a Radial, Conical or Square fountain do one of the following:
· In the Horizontal and Vertical boxes under Center Offset, type or select the 

amount of offset.
· Hold the mouse button down in the Preview box and drag. Holding down the CTRL 

key as you drag constrains the amount to 10-percent increments.
9. To increase the percentage of start and end color in the fountain, type or select the 

percentage in the Edge Pad box.
You can save the fountain settings you specified so that you can apply them to other objects.
Type a name in the Presets box then click the Plus (+) button. Clicking the Minus (-) button 
removes the selected settings from the Preset list.



Creating a fountain fill using the Fill Roll-up

1. If the window is not displayed, click  in the Fill tool menu.
2. Select the object you want to fill.

3. Click the Fountain fill button.

4. Click  to create a linear fountain, 

 to create a radial fountain,    
 to create a conical fountain or 
 to create a square fountain.

5. Click the left color button, , and then the color you want as the start color.
6. Click the right color button, , and then the color you want as the end color.
7. Do any of the following:

· To change the angle of a Linear fountain, hold the mouse button down in the Preview
box and drag. Use the right mouse button for Conical fountains. Holding down the 
CTRL key as you drag constrains the angle to 15-degree increments.

· To offset the center of a Radial, Conical or Square fountain, hold the mouse button 
down in the    Preview box and drag. Holding down the CTRL key as you drag 
constrains the amount to 10-percent increments.

8. Click Apply.



Specifying the intermediate colors in a fountain fill
Most of the time you'll create fountains by picking a beginning and ending color and letting 
CorelCHART choose the intermediate colors between the two. You can create some 
interesting effects, however, by selecting the intermediate colors yourself.
To specify the intermediate colors in a fountain:

1. In the Fountain Fill dialog box, choose the beginning and ending colors for the fountain 
by clicking the palette that appears when you click the From and To buttons.

2. Do one of the following:
· Click Rainbow to take the intermediate colors from a path around the color wheel. 

You can specify the direction the path takes by clicking the rotation buttons.
· Click Custom to choose the intermediate colors yourself from the palette. You 

specify where you want the color to appear by adding markers above the preview 
box. There are three ways to do that:
1) dragging from the squares at either end of the preview box.
2) double-clicking just above the preview box.
3) specifying a value in the Position box.
After adding a marker choose a color from the palette.
To reposition a color, select its marker and drag it to the desired spot or edit the 
value in the Position box. 
To delete a color, select its marker then press Delete, or double-click the marker.

You can save the fountain settings you specified so that you can apply them to other 
objects. Type a name in the Presets box then click the Plus (+) button.



Choosing a two-color fill pattern
You can fill objects with a pattern composed of repeating bitmap images. CorelCHART 
supplies a collection of black and white bitmap patterns to which you can add color. You can 
also create your own patterns from imported bitmaps or from images drawn in CorelCHART. 
See also Creating a pattern fill
There are two ways to choose a two-color fill pattern:

Choosing a two-color pattern from the dialog box
Choosing a two-color pattern from the Fill Roll-up



Choosing a two-color pattern from the dialog box
1. Select the object you want to fill.
2. Select the Fill tool.
3. Click the two-color pattern icon (checkerboard).
4. Click the arrow in the preview box.
5. Click the pattern you want and choose OK.
6. To color the pattern:

· Click the Back color button and then on the color you want for the background color.
· Click the Front color button and then on the color you want for the foreground color.
To create your own colors or select existing ones by name, click the More button.

7. To specify the pattern size, do one of the following:
· Choose Small, Medium or Large to select a predefined size of 0.25x0.2, 

50.50x0.50 or 1.00x1.00 inches.
· Choose the Tiling button and type or select a custom size (up to 3x3 inches) in the 

Width and Height boxes.
To use a different unit of measure, select it from the units box. CorelCHART will 
automatically convert the displayed value to its equivalent in the unit you select.

8. To offset the pattern tiles:
· Choose the Tiling button.
· To offset the entire pattern horizontally and/or vertically, type or select the amount 

of offset in the X and Y boxes under First Tile Offset.
· To offset alternating row or columns of tiles, choose Row or Column under 

Row/Column Offset, then type or select the amount of offset.



Choosing a two-color pattern from the Fill Roll-up

1. If the window is not displayed, click  in the Fill tool menu.
2. Select the object you want to fill.
3. Click the two-color pattern button (checkerboard).
4. Click the arrow in the preview box.
5. Click the pattern you want and choose OK.
6. To color the pattern:

· Click the left color button, , and then the color you want for the foreground color.
· Click the right color button, , and then the color you want for the background.

7. To scale the pattern tiles:
· Choose the Tile button. A pair of boxes appear inside the object you are filling.
· Drag the small square along the bottom edge of the boxes to scale the pattern.

8. To offset the pattern tiles:
· Choose the Tile button. A pair of boxes appear inside the object you are filling.
· To offset the entire pattern, hold the mouse button down inside the left box and 

drag.
· To offset alternating columns of tiles, hold the mouse button down inside the right 

box and drag down.
· To offset alternating rows of tiles, hold the mouse button down inside the right box 

and drag down and to the left 
9. Click Apply.



Choosing a full-color fill pattern
CorelCHART supplies an extensive selection of Full-Color pattern fills composed of repeating 
vector images. You can also create your own patterns from imported images, or from images
drawn in CorelCHART. See Creating a pattern fill.
There are two ways by which you choose a full-color fill pattern:

Choosing a full-color pattern from the dialog box
Choosing a full-color pattern from the Fill Roll-up



Choosing a full-color pattern from the dialog box
1. Select the object you want to fill and click the Fill tool.
2. Click the Full-Color pattern icon (double-headed arrow).
3. Click the arrow in the preview box.
4. Click the pattern you want and choose OK.
5. To specify the size of the pattern, do one of the following:

· Choose Small, Medium or Large to select a predefined size of 0.25x0.2, 
50.50x0.50 or 1.00x1.00 inches.

· Choose the Tiling button and type or select a custom size (up to 3x3 inches) in the 
Width and Height boxes.

To use a different unit of measure, select it from the units box. CorelCHART will 
automatically convert the displayed value to its equivalent in the unit you select.

6. To offset the pattern tiles:
· Choose the Tiling button.
· To offset the entire pattern horizontally and/or vertically, type or select the amount 

of offset in the X and Y boxes under First Tile Offset.
· To offset alternating row or columns of tiles, choose Row or Column under 

Row/Column Offset, then type or select the amount of offset. 



Choosing a full-color pattern from the Fill Roll-up
1. If the window is not displayed, click the roll-up window icon in the Fill tool menu.
2. Select the object you want to fill.
3. Click the Full-Color pattern button (double-headed arrow).
4. Click the arrow in the preview box.
5. Click the pattern you want and choose OK.
6. To scale the pattern tiles:

· Choose the Tile button. A pair of boxes appear inside the object you are filling.
· Drag the small square along the bottom edge of the boxes to scale the pattern.

7. To offset the pattern tiles:
· Choose the Tile button. A pair of boxes appears inside the object you are filling.
· To offset the entire pattern, hold the mouse button down inside the left box and 

drag.
· To offset alternating columns of tiles, hold the mouse button down inside the right 

box and drag down.
· To offset alternating rows of tiles, hold the mouse button down inside the right box 

and drag down and to the left 
8. Click Apply.



Choosing a Bitmap texture
Bitmap textures are fills that look like clouds, water, gravel, minerals and dozens of other 
natural and man-made substances. Each texture has a set of parameters that you can 
change to create millions of variations.
Bitmap textures display on your screen and print to any printer. There are two procedures 
you can use to apply a bitmap texture to objects:

Choosing a bitmap texture from a dialog box
Choosing a bitmap texture from the Fill Roll-up



Choosing a bitmap texture from a dialog box
1. Select the object you want to fill and click the Fill tool.

2. Click the  button.
3. From the Textures Library list box, choose the library containing the texture you want.
4. From the Textures List, choose the name of the texture you want.
5. Adjust the parameters to customize the texture as required. There are two ways to do
this:

· Click the Preview button to randomly change the unlocked parameters. You lock 
and unlock parameters by clicking the Lock icon next to it.

· Enter a value in the text box next to the parameter name to change the numeric 
parameters. To change a color parameter, click the color button and select a new 
one from the pop-up palette. Click the More button if you want to create a color or 
choose it by name. To see the effect the new parameters have on the texture, click 
the Preview button.



Choosing a bitmap texture from the Fill Roll-up 

1. If the roll-up is not displayed, click  in the Fill tool menu.
2. Select the object you want to fill.
3. Click the  button.
4. From the upper list box, choose the library containing the texture you want.
5. Do one of the following:

· Click the arrow in the bottom-right corner of the preview box to display a list of 
textures. Click the texture you want and choose OK.

· Click the name of the texture in the list below the preview box and click Apply.



Saving a custom Bitmap texture
You can save the bitmap textures you create and apply them to objects later. 
To save a texture:

1. With the texture you want to save displayed in the Bitmap Texture dialog box, do one 
of the following:
· If the texture came from the Styles Library, click Save As.
· If the texture came from the Samples library and you want to overwrite the original, 

choose Save. To keep the original, choose Save As.
2. In the Texture Name box, type a name up to 32 characters (including spaces). Skip this 

step for textures from the Style Library if you want to use the same name.
3. Do one of the following:

· Add the texture to the Samples library by selecting it from the Library list.
· Create a new library by typing a name in the Library Name box.



Deleting a custom Bitmap texture
1. Choose the Bitmap Texture fill icon from the Fill tool flyout menu.
2. In the Texture Fill dialog box, select the texture you want to delete. (You cannot delete 

textures in the Style Library.)
3. Click the Delete button.



Copying an object's fill
Once you apply a fill to an object, you can quickly apply the same fill to another object.
Using the Fill Roll-up window:

1. If the window is not displayed, click  in the Fill tool menu.
2. Select the object you want to change.
3. Click the Update From button.

The mouse pointer becomes an arrow with the word From?
4. Click the object with the fill you want copied.
5. Click Apply.



Choosing the default fill
The default fill is applied automatically to annotation objects when you add them to your 
chart. You can choose a uniform color, two-color pattern, full-color pattern, bitmap texture, 
fountain fill or no fill at all as the default.
To choose the default fill:

1. Click a white space in the chart window to ensure there is no object selected.
2. Click the Fill tool. The flyout appears.
3. Choose the tool that corresponds to the type of fill you want as the default fill. Click

 to give all new annotation objects no fill. The Modify Default dialog box appears.
4. Click Yes to confirm you wish to modify the default fill. The dialog box for the chosen 
fill type appears.
5. Choose the color(s) and set the attributes in the dialog box. See Uniform Fill, Fountain
Fill, two-color Pattern, Full-Color Pattern or Texture Fill dialog boxes.
The attributes set are now applied to annotation objects you create. You may of course 
change the fill of any individual object.



Applying halftone screens 
Filling and outlining objects with Spot color allows you to apply halftone screens to them. You
can apply a single screen to the entire drawing or different screens to individual objects. The
halftone screen's effect on your drawing won't appear on screen. To see it, you must print 
your drawing on a PostScript printer.
If you are printing process color separations you can specify the screen frequencies and 
angles for each of the process colors. You should only do this on the advice of your service 
bureau or commercial printer to avoid moiré patterns.
See the following topics for step by step instructions:
Applying halftone screens to all objects
Applying halftone screens to individual objects



Applying halftone screens to all objects
Screens applied using this procedure affect objects which have not been assigned other 
screens from the PostScript Options dialog box.
To apply halftone screens to all objects:

1. Choose Print from the File menu.
2. Click Options. The Print Options dialog box appears.
3. Choose the Options tab and, type or select the screen frequency you want to use

If you are printing process color separations, you can specify screen frequencies and 
angles for each of the CMYK colors in the Separations tab by checking the Use Custom
Halftone option and clicking the Edit button.
(Spot colors in your drawing will print using the frequency specified for Black.)

4. Select any other options you need.



Applying halftone screens to individual objects
Objects to which you do not apply screens using this procedure, print using the screen 
settings specified in the Print Options dialog box. 
To apply halftone screens to individual objects:

1. Select the object with the screen settings you want to adjust.
2. Select the Fill tool to apply a screen to the object's fill or the Outline tool to apply it to 

object's outline.

3. Click the .
4. Click the PostScript Options button.
5. Choose the screen settings type, frequency and angle you want.



Creating a pattern fill
You can design your own two-color and Full-Color fill patterns to supplement those supplied 
with CorelCHART. Virtually any graphic may be used as the basis for your pattern: a simple 
shape, a piece of text, a color vector illustration, or even an imported bitmap or vector 
image. See the following topics for more information:

· Creating two-color pattern fills
· Creating pattern fills from imported images



Creating two-color pattern fills
CorelCHART's Pattern Editor lets you create your own two-color pattern fills. Patterns you 
create are added to the ones supplied with the program.
To create two-color pattern fills with the Pattern Editor:

1. Select the object you want to fill with the pattern. 
2. Do one of the following

· From the Fill tool menu, click the two-color pattern button (the checkerboard).
· From the Fill Roll-up window click the two-color pattern button then choose the Edit 

button.
· If you are using the Fill Roll-up window and want to modify the pattern in an object, 

click the Update From button. Next, click the object then the Edit button.
4. Choose the Create button.
5. Choose the Bitmap Pattern size you want. The size you choose determines the 

resolution of the pattern.
6. Choose the Pen Size you want. The size you choose determines how many squares in 

the drawing area are filled when you click with the mouse.
7. Click with the left mouse button to fill squares in the drawing area with black.

To erase, click with the right mouse button.
Holding down the mouse button and dragging fills/erases a wide area of squares.
CorelCHART adds the pattern to the end of the list displayed when you click the arrow 
in the pattern preview box.



Creating pattern fills from imported images
CorelCHART allows you to create pattern fills from images in any of the formats the program 
imports. You can use multi-colored images to create Full-Color patterns. But for two-color 
patterns, you should use images with no more than two colors.
You can use a dialog box or the Fill Roll-up window to import the images.
From a dialog box:

1. Select the object you want to fill with the pattern.
2. Select the Fill tool.
3. Click the pattern button that corresponds to the type of pattern you want to create;

 for Two Color pattern, 

 for Full Color pattern.
4. Choose the Import button.
5. From the List Files of Type box, choose the format of the image you want to import.
6. In the File Name box, type or select the name of the file you want to import.

If the file you want is in another drive or directory, select the drive from the Drives box 
and the directory from the Directories box.
CorelCHART adds the pattern to the end of the list displayed when you click the arrow 
in the pattern preview box.

From the Fill Roll-up window:

1. If the window is not displayed, click  in the Fill tool menu.
2. Click the button that corresponds to the type of pattern you want to create.
4. Click the arrow in the pattern preview box.
5. Click File, then choose Import Pattern.
5. From the List Files of Type box, choose the format of the image you want to import.
7. In the File Name box, type or select the name of the file you want to import.

If the file you want is in another drive or directory, select the drive from the Drives box 
and the directory from the Directories box.

8. Choose OK to close the Import dialog box.
The pattern appears in the preview box and is added to the end of the pattern list.

9. To fill an object with the pattern, select the object, then click Apply.
Note: You can store Full-Color patterns you import and use them again to fill other objects.



Saving and deleting a pattern
Saving Full-Color pattern fills you've imported lets you quickly apply them to objects in other
drawings. You can also delete two-color and Full-Color patterns.
To save an imported Full-Color pattern:

1. After importing the graphic, click the arrow in the Fill Roll-up's preview box or the 
preview box in the Full-Color Pattern dialog box.

2. Click File.
3. Choose the Save Current File.

CorelCHART adds the fill to the first empty square.
To delete a pattern fill:

1. Click the arrow in the lower-right corner of the Roll-up's preview box or the preview 
box in the Two- or Full-Color dialog box.

2. Click the pattern you want to delete.
3. Click File, then choose Delete Item.



Editing two-color pattern fills with the Pattern Editor
You can use CorelCHART's Bitmap Editor to modify some of the simpler two-color patterns 
supplied with the program. If the pattern you select for editing is too complex, it does not 
appear in the Editor.
When you modify a pattern, CorelCHART keeps the original and adds the modified version to 
the end of the existing collection.
To edit a two-color pattern fill with the Pattern Editor:

1. Select the object you want to fill with the pattern.
2. Do one of the following

· From the Fill tool menu, click the two-color pattern button (the checkerboard).
· From the Fill Roll-up window, click the two-color pattern button, then click the Edit 

button.
· To edit the pattern in an object, choose the Update From button in the Fill Roll-up 

window, click the object, then the Edit button.
3. Click the arrow in the pattern preview box.
4. Click the pattern you want to edit.
5. Choose the Create button.
6. Click with the left mouse button to fill squares in the drawing area with black.

To erase, click with the right mouse button.
Holding down the mouse button and dragging fills/erases a wide area of squares.
When you open the dialog box again, you will find the modified pattern at the end of 
the pattern list box.



Creating Colors and Managing Color Palettes
With CorelCHART's powerful color-handling capabilities, it's easy to give your work some eye-
catching appeal.
CorelCHART comes with a number of color palettes, One of these palettes contains spot 
colors defined using the PANTONE Matching System--a color specification method used when
exact colors are required. You can choose from over 700 spot colors and create many more 
by adjusting the tint.
The other palettes supplied with the program contain colors defined using the process color 
method. This method of specifying color is based on the principle that virtually any color can
be represented by overlaying cyan, magenta, yellow, and black. The default process color 
palette contains about 100 named colors. For creating your own process colors, CorelCHART 
offers a choice of three color models: CMYK  ,   RGB   and   HSB  .
The TRUMATCH palette lets you specify process colors using the TRUMATCH Swatching System.
By using this palette along with a TRUMATCH color reference book, you can be reasonably 
certain how the colors will look when printed. A similar book is available for specify colors 
with the PANTONE Process palette included with CorelCHART.
You have the option of assigning names to the colors you create and adding them to the 
palette. You can also delete colors and rearrange their order in the palette. And when you're 
finished, you can save the palette under a new name and have CorelCHART load it 
automatically when you start the program.
The ability to customize palettes is especially useful when you're working on a drawing that 
uses many colors. By limiting the palette to the colors you're using, you'll find it easier to 
apply them to other objects in the drawing. Also, if you're working on different drawings that
use the same colors, a custom palette will help you to apply them consistently.



Creating a custom Process color
You can create your own Process colors and use them to fill and outline objects. 
To create a custom Process color:

1. Select the object you want to fill or outline with the color.
2. Do one of the following:

· From the Fill or Outline tool menu, click the color wheel icon.
· From the Pen Roll-up window, choose the Edit button. From the Outline Pen dialog 

box, choose the More button.
3. From the Show box, choose the model--CMYK, RGB, or HSB--you want to use to create 

the color. See Color Models.
5. Define the color by entering exact percentages in the text boxes or use the color-

adjustment markers in Visual Selector boxes.
6. If you want to add the color to the palette:

· Type a name in the Color Name box.

· In the Custom Palette group, click , and then choose Add Color.
7. Choose OK. If you are using the Pen Roll-up, click the Apply button.

The color is added to the end of the Custom Palette. To display this palette, click  
and choose Open.

Note: You can save the revised palette under a new name by clicking  and then Save 
As. 



Adding a Spot color tint to the palette
Instead of adjusting the tint control every time you want to re-use a particular tint of Spot 
color, you can just add the tint to the palette.
To add a tint of Spot color to the palette:

1. Select the object you want to outline or fill with the tint of Spot color.
2. Do one of the following:

· From the Fill or Outline tool menu, click the color wheel icon.
· From the Pen Roll-up window, choose the Edit button. Then, from the Outline Pen 

dialog box, choose the More button.
· From the Fill Roll-up choose the color wheel and click the Edit button.

3. From the Show box, choose PANTONE spot color palette.
4. Click the color whose tint you want to change.
5. Adjust the %tint setting to get the desired tint.

6. In the Custom Palette group, click , and then choose Add Color. The tint is added 
to the end of the palette.

7. Choose OK. If you are using a Roll-up window, click the Apply button.
Note: You can save the revised palette under a new name by choosing the Palette button 
and then Save As. 



Opening and saving a color palette
CorelCHART supplies several different Process color palettes and a single Spot color palette. 
The Process color palettes have different numbers and ranges of color. With some palettes, 
the difference is in whether the colors display on the screen as dithered or pure. 
If you have a TRUMATCH or PANTONE Process color reference book, you can use the 
corresponding palettes to specify process colors.
You can add, delete and rearrange colors in these palettes and then save them under a new 
name. 
To open a color palette:

1. Select an object.
2. From the Outline or Fill tool menu, click the color wheel icon.
3. Do one of the following:

· choose one of the palettes supplied with CorelCHART (TRUMATCH, PANTONE, 
FOCOLTONE) by clicking its name in the SHOW box.

· choose a custom palette by clicking  and choosing Open. Custom palettes have 
a .CPL file extension.

To save a color palette:

1. From the Outline or Uniform Color dialog box, click .
2. Do one of the following:

· To replace the current palette, choose Save.
· To save the palette under a new name or in another drive or directory, choose Save 

As.
In the File Name box, type or select a new name. To save the palette in another 
drive or directory, select the drive from the Drives box, and the directory from the 
Directories box.



Deleting a color from a palette
Colors you do not use can be deleted from custom palettes.
To delete a color from a palette:

1. Select an object.
2. From the Outline or Fill tool menu, click the color wheel icon.

3. In the Custom Palettes group, click  and choose Open.
4. Choose the custom palette with the color(s) to delete. The palette appears.
5. Click the color in the Custom Palette you want to delete.

6. Click  and then choose Delete Color.
7. Repeat steps 5 and 6 to delete other colors.



Rearranging the order of colors in a palette
If you use some colors more often than others, you can make them easier to find by moving 
them to the beginning of the palette.
To rearrange the order of colors in a palette:

1. Select an object.
2. From the Outline or Fill tool menu, click the color wheel icon.

3. In the Custom Palettes group, click , choose Open and choose the palette to 
reorganize.

4. Hold the mouse button down on the color in the Custom Palette you want to move, 
and drag.

As you begin dragging, the mouse pointer becomes a crosshair cursor.
5. Release the mouse button when the cursor is over the square you want the color 

moved to.
The other colors shift to the left.

6. Repeat steps 4 and 5 to move other colors.

You can save the revised palette under a new name by clicking and then Save As.



Creating a new color palette
You can create your own color palettes from scratch and use them to specify colors for 
objects in your drawing.
To create a new color palette:

1. Select an object. From the Outline or Fill tool menu, click the color wheel icon.

2. In the Custom Palettes group, click  followed by New.
3. From the Show list box, choose the color specification method that's appropriate for 
the type of color palette you want to create.
4. Create or select the color you want to add to the palette.
5. If you created the color using the CMYK, RGB or HSB color models, type a name for it 
in the New box.

6. Click  followed by Add Color.
7. Repeat steps 5 to 7 to add additional colors.

8. Save the palette, by clicking  followed by Save.
9. Type a name for the palette in the File Name box, then choose OK. The new palette 
is automatically assigned the .CPL file extension.



Applying colors to your spreadsheet
Use the on-screen color palette to apply colors to your spreadsheet. The palette sets color 
attributes for each cell's background and/or its contents. 
To apply colors to your spreadsheet:

1. Select a cell or a range of cells
2. Click the color to be applied to the contents of the cell(s). The color is applied to the 

text, numbers or formulas contained in the selected cell(s). 
Note: number formats are set using the Numeric Format Interpreter. It supports eight 
colors. A palette color applied to numeric values is converted to the closest match in 
those eight colors. If the Formula command (View menu) is enabled, the color is 
automatically added to that number's numeric format. 

3. With the right mouse button, click the color to be applied to the cell background. 
Note: If you have applied a pattern to the cell's background, your choice of a 
background color described above overrides the pattern selection. The pattern is 
removed and the chosen color applied to the cell background.

4. Repeat steps 2 and 3 as many times as needed.



Font Management
TTF versus PFB
TTF or true type fonts and PFB or Adobe type 1 fonts offer fast screen redraw and easy 
font management. TTFs are managed with Windows Control Panel, PFBs with a font 
manager. You should be able to load more TrueTypes onto your system without crashing 
some software. They're perfect for printing to an office printer or for in-house publishing. If 
you don't have a PostScript printing device, you may prefer using TrueType fonts. PostScript 
fonts offer much better support in the real world of publishing. If you need to print files at a 
service bureau or on in-house PostScript devices, you should use PFB fonts. If you are not an 
expert user and you need to use a service bureau occasionally, you may want to use PFB 
font outlines exclusively.
Controlling PostScript fonts

The primary reasons you use PostScript fonts are:
· better looking printed text
· easier font handling
· easier and more flexible options when printing

How Windows controls PostScript fonts

To understand font management, you need to understand how Windows controls fonts. The 
font listing appears in your WIN.INI file:

Sample:
[PostScript,FILE]
ATM=placeholder
softfonts=31
softfont1=c:\psfonts\pfm\gnbc____.pfm,c:\psfonts\gnbc____.pfb
softfont2=c:\psfonts\pfm\gnc_____.pfm,c:\psfonts\gnc_____.pfb
softfontx...

PostScript printer listings 

The PostScript fonts available on your system are listed in the PostScript printer listings. You 
need two PostScript listings in your WIN.INI in order to print fonts correctly.

[PostScript,FILE] for printing to disk or a service bureau
[PostScript,LPT1] for printing to your office laser printer or proofing device

If you are using PostScript fonts, the following two lines will be in your WIN.INI:
ATM=placeholder This line means that Adobe Type Manager is running. (This line 

appears only if you have Adobe Type Manager installed.)
softfonts=xx This line is a softfonts count. It tells you how many fonts are 

installed on your system. Your softfont number must be the same 
as the number of installed fonts. If you add or subtract from the 
font list manually, update the softfont count.

Font-handling statements

The font-handling statement tracks the fonts installed on your system and indicates whether
they will be downloaded to the print file. Following is a sample font-handling statement as it 
appears in your WIN.INI:



softfont1=c:\psfonts\pfm\gnbc____.pfm,c:\psfonts\gnbc____.pfb
This font statement calls for gnbc____.,pfm, or Gill Sans Bold Condensed. If you are unsure 
whether a font is installed correctly, you can search your WIN.INI for the font ID (gncb_). If 
you know the font name (e.g., Gill Sans) but don't know the ID, search your ATM.INI for Gill 
Sans. If the font has been installed by ATM, the ATM.INI will list the name and the ID. 
The WIN.INI font-handling statement is divided into three sections:

softfont1=
The softfont number; this count number must be consecutive and match the softfonts 
count.
c:\psfonts\pfm\gnbc____.pfm
The font metric name, which contains spacing and kerning information. This listing tells
you that the font is installed on your system.
c:\psfonts\gnbc____.pfb
The font outline name, which contains the description of the font and its fill and outline
properties. This listing indicates that the font will be downloaded into your print file.

A font is correctly installed but will not automatically download into the print file if the listing
reads softfont1=c:\psfonts\pfm\gnbc____.pfm because it does not include a font outline 
statement (pfb). If you print with the PostScript font metric statement (pfm ) alone, your 
service bureau or printer must have the font resident on their system, or your text will print 
as their printer default. 
A font is correctly installed and will download into the print file if the listing reads:

softfont1=c:\psfonts\pfm\gnbc____.pfm,c:\psfonts\gnbc____.pfb
Downloading fonts into your print file creates larger files which slows down printing. 
When to update your font list
Typically, the [PostScript,FILE] listing (for printing to disk or a service bureau) will not have 
pfb listings. You can send your service bureau the font(s) (*.pfb) on disk to download to 
their printing device. This makes it easier to transfer files (since the print files are smaller), 
and it allows your output bureau to impose your print files. Imposing or imposition software 
places the pages of your print file in the order needed to burn plates for the press. Normally 
this process is done in "litho", or in the press stripping room. Stripping a print job is a time-
consuming process, so imposing your print files should save you money. It also saves the 
printer film, as they can put multiple pages together on the same sheet of film.
To ensure that fonts do not download into your print file, remove the pfb listing from the font
list in your WIN.INI.

Your [PostScript,LPT1] list for printing to your office laser printer or proofing device should 
not have pfb listings for the 35 fonts most PostScript devices have resident. The listing 
should have pfb listings for the remaining fonts. If you set up your pfb listing to 
automatically download non-printer-resident fonts, you will achieve the best looking font 
quality with a minimum of trouble.

If you are updating the font list manually, remember that the number of underscore 
characters (_) must remain the same.



Image setter
A generic term for printers capable of printing text and graphics (line art and photographs) 
at resolutions of 1200 dpi or more on film or photographic paper.



DPI
A measure of a printer's resolution in dots per inch. Typical desktop laser printers print at 
300 dpi, while image setters are capable of printing at resolutions of 1270 or 2540 dpi. The 
more dots per inch, the smoother the output.



CORELCHT.INI
A text file with configuration information about CorelCHART. This file is in the COREL suite of 
applications' \CONFIG subdirectory and can be edited by double-clicking on it in the Windows 
File Manager. Changes you can make include the interval between backup file creation and 
the directory in which these backup files are stored.



Filter
A program that translates information from one file format to another. Filters allow files 
created in one application to be inserted or used in another application. CorelCHART includes
many filters enabling you to import data or graphics into CorelCHART and export CorelCHART
files to other applications.



Film Recorder
Device that reproduces images from a computer screen on film. The film can then be 
developed into slides or prints using conventional photographic processes. CorelCHART can 
export files for use by film recorders that accept files in SCODL format.



CorelTRACE
A program supplied with CorelCHART that automatically traces bitmap images. The result is 
a vector graphic that you can import into CorelDRAW for editing.



Scanner
A device that converts images on a page or transparency into digital form. CorelCHART can 
import scanned images (also called "bitmaps") in PCX or TIF format.



ASCII
A standard code for representing characters and non-printable control codes such as 
carriage returns and page breaks.



PostScript
A page description language or protocol by which programs describe text and graphics they 
want the printer to output. Several features in CorelCHART require the use of a PostScript 
printer.



Directory
A directory is part of a structure used to organize files on a disk like a drawer in a filing 
cabinet. Directories have names and can be divided into subdirectories. For example, you 
could create a directory called LOGOS for storing logo designs.



Dithered color
Color simulated by putting dots of another color very close together. Windows uses dithering
to display colors that the graphics adapter is unable to display. See also Pure color.



Image header
An optional bitmap image created when you save a CorelCHART file or export it in .EPS 
format. If you include an image header, you can see a representation of the file contents 
before opening. If you export a file with an image header, you can see a representation in 
programs such as Corel Ventura Publisher and Aldus Pagemaker.





How to...
· Choose a bitmap texture
· Save a custom bitmap texture
· Delete a custom bitmap texture



How to...
· Display legendshow_display_legend>howto
· Modify legend layout



How to...
· Open a KODAK Photo CD image



How to...
· Create a new chart from sample data
· Create a chart from your own data



How to...
· Create 3D text
· Autofit headers in 3D charts



How to...
· Open a CorelCHART file



How to...
· Save a new chart



How to...
· Save an existing chart with a new name / new location



How to...
· Apply templates from other charts
· Changing chart types from the Gallery
· Changing chart types with drag and drop



How to...
· Import graphics



How to...
· Set chart page size and orientation



How to...
· Print a chart
· Set chart page size and orientation
· Print a chart to disk
· Position the printed chart
· Size the printed chart
· Print charts larger than the printer's paper size
· Print text in a chart using your printer's fonts



How to...
· Choose a default printer
· Set up the active printer



How to...
· Work with basic System Profiles
· Use advanced printer calibration features



How to...
· Start and exit CorelCHART



How to...
· Use Paste Inside



How to...
· Delete chart objects



How to...
· Switch to Data Manager



How to...
· Work with the 3D Roll-up



How to...
· Apply pictographs



How to...
· Apply templates from other charts
· Change chart types from the Gallery
· Change chart types with drag and drop



How to...
· Update your chart



How to...
· Use CorelCHART Online Help



How to...
· Link chart objects



How to...
· Export graphics



How to...
· Import spreadsheet data



How to...
· Export spreadsheet data



How to...
· Print a spreadsheet using Print Preview



How to...
· Print a spreadsheet
· Print a range of cells
· Print a range of pages
· Set up a spreadsheet's printable page
· Set page orientation



How to...
· Create headers and footers
· Set the spreadsheet margins
· Print spreadsheet row numbers and column letters
· Print the spreadsheet grid
· Print cell borders and patterns
· Print OLE objects



How to...
· Create headers and footers



How to...
· Change the font, size and style
· Edit text with a pop-up menu
· Create a style
· Delete a style



How to...
· Choose a default printer
· Set up the active printer



How to...
· Link objects from other applications



How to...
· Set up a DDE link with another spreadsheet



How to...
· Insert rows
· Insert columns



How to...
· Delete rows
· Delete columns



How to...
· Embed objects in Data Manager



How to...
· Update linked objects



How to...
· Apply cell borders
· Remove cell borders
· Edit text with a pop-up menu
· Create a style



How to...
· Apply patterns to cells
· Remove cell patterns
· Use the pop-up menu
· Create a style
· Apply colors in Data Manager



How to...
· Set horizontal text alignment
· Set vertical text alignment
· Use the pop-up menu
· Create a style



How to...
· Set horizontal page breaks
· Set vertical page breaks



How to...
· Create a style
· Select a style
· Make a style available to all spreadsheets
· Choose a style sheet



How to...
· Adjust row height using the mouse
· Adjust row height with numeric precision
· Select an entire row or column



How to...
· Adjust column width using the mouse
· Adjust column width with numeric precision
· Select an entire row or column



How to...
· Choose numeric formats
· Create custom numeric formats
· Delete custom numeric formats
· Use the pop-up menu
· Make a custom format available to all documents



How to...
· Find and replace data



How to...
· Move to a specific cell using the cell address



How to...
· Sort data



How to...
· Edit a formula using the formula bar
· Edit a formula directly in a cell
· Enter formulas directly into a cell
· Use alphanumeric date and time values
· Use Context-sensitive Help with Functions
· Use the Enter Formula command
· Use the Formula Bar



How to...
· Turn the grid display on and off



How to...
· Display chart tags



How to...
· Edit a formula in a cell
· Change the attributes of individual characters in a cell



How to...
· Automatically fill series



How to...
· Recalculate the spreadsheet



How to...
· Update your chart



How to...
· Make new data queries
· Open data queries



How to...
· Select objects
· Move objects
· Resize annotation objects
· Resize chart objects



How to...
· Draw straight lines
· Draw curves
· Draw polygons



How to...
· Draw squares and rectangles
· Round the corners or rectangles and squares



How to...
· Draw circles and ellipses



How to...
· Add text to a chart
· Change the font, size and style
· Set text alignment
· Adjust interline spacing
· Adjust inter-character spacing
· Create 3D text
· Autofit headers in 3D charts



How to...
· Choose a line thickness using the outline tool
· Choose an outline color using the Outline tool
· Remove an object's outline
· Copy an object's outline



How to...
· Choose a line thickness using the Outline Pen dialog box
· Choose a line color using the Outline Color dialog box
· Choose a dashed and dotted line style
· Create calligraphic outlines
· Apply arrowheads and other line ending shapes
· Edit an arrowhead or line ending shape



How to...
· Choose a line thickness using the Pen Roll-Up window
· Choose an outline color using the Pen Roll-Up
· Choose a dashed or dotted line style from the Pen Roll-Up
· Apply line-ending shapes using the Pen Roll-Up



How to...
· Choose a fill color with the Fill tool flyout menu
· Make an object transparent
· Create a fountain fill
· Choose a two-color fill pattern
· Choose a full-color fill pattern
· Choose a bitmap texture



How to...
· Create a fountain fill using the Fill Roll-Up
· Choose a two-color pattern from the Fill Roll-Up
· Choose a full-color pattern from the Fill Roll-Up
· Choose a bitmap texture from the Fill Roll-Up



How to...
· Create a fountain fill
· Specify the intermediate colors in a fountain fill





 How to...
Get started with CorelCHART
Use Roll-up windows

Chart View
Change a chart's appearance
Manipulate chart data
Exchange information with other applications
Print your charts

Data Manager
Use Data Manager: An Overview
Enter information in Data Manager
Format your spreadsheets
Exchange data with other applications
Print your spreadsheets



 Basics: Get started with CorelCHART

Creating a chart from sample data
Creating a chart from your own data
Saving a new chart
Opening a CorelCHART file
Saving an existing chart with a new name or new location
Opening Data Manager first
Dragging and dropping files
Using menus
CorelCHART roll-ups
Choosing tools
Ribbon Bars
Text Ribbon Bars
Switching between Chart View and Data Manager
Working with dialog boxes
Starting and exiting CorelCHART
Using Corel Online Help

See also How to..., the CorelDRAW User's Guide (CorelCHART section) and Learning 
CorelDRAW



Change a chart's appearance
Changing chart settings
Formatting text
Outlining and filling chart objects
Displaying legends
Modifying legend layout
Applying pictographs
Using Corel clip art in your charts
Importing graphics

Using drawing tools
Drawing squares and rectangles
Drawing circles and ellipses
Rounding the corners of rectangles and squares
Drawing straight lines
Drawing curves
Drawing polygons

Using the Color Manager
Working with basic System Profiles
Using advanced printer calibration features



Changing chart settings
Setting chart page size and orientation
Choosing chart types
Entering information in Data Manager
Applying templates from other charts
Changing chart types from the Gallery
Changing chart types with drag and drop



Working with chart objects
General

Selecting objects
Moving objects
Resizing annotation objects
Resizing chart objects
Hiding or showing chart objects
Deleting chart objects
Outlining and filling chart objects

Axis lines and Scales
Working with second Y-axis lines
Using Data Axis Major Grid lines
Using Data Axis Minor Grid lines
Adjusting the second Y-axis scale
Showing or hiding the left Z-axis scale
Showing or hiding the right Z-axis scale

Headers and Labels
Making 3D Scatter labels
Working with series headers
Creating column header labels
Creating row header labels
Creating a row header area
Creating a category header

Titles
Working with the second Y-axis title
Working with the left Z-axis title
Creating and editing series titles
Creating or editing a Z-axis title
Showing or hiding titles
Working with X-axis titles
Working with Y-axis titles



Outlining and filling chart objects
Overview
Outlining chart objects
Filling chart objects
Creating colors and managing color palettes
Choosing a bitmap texture fill
Saving and deleting a custom Bitmap texture



Outlining chart objects
Choosing line thicknesses
Choosing outline colors
Removing an object's outline
Choosing dashed or dotted line styles
Copying an object's outline
Creating calligraphic outlines
Applying arrowheads and other line-ending shapes
Choosing default outline attributes
Editing an arrowhead or line-ending shape



Filling chart objects
Choosing a fill color
Making an object transparent
Copying an object's fill
Using Paste Inside
Choosing the default fill
Creating a fountain fill
Specifying the intermediate colors in a fountain fill
Choosing a two-color fill pattern
Choosing a full-color fill pattern
Creating a pattern fill
Saving and deleting a pattern
Editing a two-color pattern with the Pattern Editor
Choosing a bitmap texture
Saving a custom bitmap texture
Deleting a custom bitmap texture
Applying halftone screens



Formatting text
Adding text to a chart
Editing text in Chart View
Changing font, size and style
Setting text alignment in Chart View
Adjusting interline spacing in Chart View
Adjusting inter-character spacing
Creating 3D text
Autofitting headers in 3D charts



Use Roll-up windows

Using the Pictograph Roll-up
Working with the 3D Roll-up
Using the Fill Roll-up
Working with the Pen Roll-up

Use the Mosaic Roll-up
Choosing a collection
Opening a second collection
Resizing the Mosaic roll-up
Importing files using drag and drop
Moving and copying files between collections



Manipulate chart data
Working with chart objects
Using Data Analysis
Making combination charts
Reversing the order within groups and series
Changing the scale range

Numeric formats
Choosing numeric formats
Creating custom numeric formats
Deleting custom numeric formats

See also Built-in numeric formats and User Defined Numeric Formats



Use Data Manager: An overview
Switching to Data Manager
Setting up a spreadsheet's printable page
Entering information in Data Manager
Selecting, inserting and deleting cells
Tagging cells automatically
Tagging cells manually
Automatically filling series
Drag and Drop within Data Manager
Sorting data
Finding and replacing data
Recalculating the spreadsheet
Updating your chart

See also Basics: Get started with CorelCHART and Spreadsheet functions



Enter information in Data Manager
Entering information into a cell
Entering information in a group of cells
Editing cell contents
Using the Formula Bar
Entering formulas directly into a cell
Editing a formula using the formula bar
Editing a formula directly in a cell
Using the Enter Formula dialog box
Using Context-sensitive Help with Functions
Automatically filling series
Entering cell references
Entering dates and times
Using alphanumeric date and time values in formulas

See also Spreadsheet Functions



Format your spreadsheets
Applying colors to your spreadsheet
Adjusting cell borders
Applying patterns to cells
Removing cell patterns
Applying cell borders
Removing cell borders
Working with rows and columns
Using numeric formats
Creating text styles and style sheets



Working with rows and columns
Adjusting row height using the mouse
Adjusting row height with numeric precision
Adjusting column width using the mouse
Adjusting column width with numeric precision
Hiding columns and rows
Unhiding columns and rows
Turning the grid on and off
Selecting, inserting and deleting cells



Using numeric formats
Choosing numeric formats
Creating custom numeric formats
Deleting custom numeric formats
Making custom formats available to all documents



Creating text styles and style sheets (Data Manager)
Changing text attributes: Data Manager
Creating a style
Selecting a style
Deleting a style
Making a style available to all spreadsheets
Choosing a style sheet
Displaying chart tags

See also Built-in Data Formats and User Defined Numeric Formats



Managing files
Creating file icons
Launching files from File Manager
Working with multiple charts



Creating colors and managing color palettes
Creating a custom Process color
Adding a Spot color tint to the palette
Opening and saving a color palette
Deleting a color from a palette
Rearranging the order of colors in a palette
Creating a new color palette



Selecting, inserting and deleting cells
Selecting multiple cells
Selecting an entire row or column
Moving to a specific cell using a cell address
Inserting rows
Inserting columns
Deleting rows
Deleting columns

See also Right mouse button shortcuts ... in a spreadsheet



Changing text attributes: Data Manager
Changing font, size and style in Data Manager
Setting horizontal text alignment in Data Manager
Setting vertical text alignment in Data Manager
Editing individual characters in a cell
Editing text with the pop-up menu



Print your charts
Choosing a default printer
Setting chart page size and orientation
Setting up the active printer
Printing a chart
Printing a chart to disk
Positioning the printed chart
Sizing the printed chart
Printing charts larger than the printer's paper size
Faster printing with printer fonts
Printing charts with complex curves faster
Printing complex charts on a PostScript printer
Using unsupported colors in EPS files

See also Advanced printer calibration features



Color printing
Overview: Color models
Printing fountain fills
Creating color separations
Creating trap
Applying halftone screens
Printing color separations to disk
Printing color separations to an output device



Print your spreadsheets
Printing a spreadsheet
Setting up a spreadsheet's printable page
Setting page orientation
Choosing a default printer
Setting up the active printer
Printing a range of cells
Printing a range of pages
Setting the first page number for a printed spreadsheet
Creating headers and footers
Setting horizontal page breaks
Setting vertical page breaks
Setting the spreadsheet margins
Printing spreadsheet row numbers and column letters
Printing spreadsheet gridlines
Printing cell borders and patterns
Saving printing time by turning off OLE objects
Printing a spreadsheet from Print Preview

See also
Print command
Page Setup
Print Setup
Color Manager



Using the Fill Roll-up
Creating a fountain fill using the Fill Roll-up
Choosing a two-color pattern from the Fill Roll-up
Choosing a full-color pattern from the Fill Roll-up
Choosing a bitmap texture from the Fill Roll-up



Working with the Pen Roll-up
Choosing a line thickness using the Pen Roll-up window
Choosing an outline color using the Pen Roll-up
Choosing a dashed or dotted line style from the Pen Roll-up
Applying line-ending shapes using the Pen Roll-up





Crop Image dialog box
The Crop Image dialog box allows you to crop an image before loading. The cropping is 
permanent and reduces the size of the image.

Dialog Box Options:

Preview Window Displays the entire image with a bounding box. Move the nodes on 
the bounding box to crop the image. Use the Hand cursor to move 
the bounding box to a specific area of the image.

Units Choose the units of measurement.

Max Click to select entire image or to resize the bounding box to cover the
entire area and reselect the cropped area.

Top Enter a number or use the scroll arrows to position the top of the 
cropped area.

Left Enter a number or use the scroll arrows to position the left side of the
cropped area.

Width Enter a number or use the scroll arrows to select the width of the 
cropped area.

Height Enter a number or use the scroll arrows to select the height of the 
cropped area.

New Image Size Displays the size of the cropped image.



Resample dialog box
The Resample dialog box resizes an image and creates a new file. The Resample option on 
the Open Bitmap dialog box only resamples to a smaller size.

Dialog Box Options

Units Choose a unit of measurement from the drop-down list box.

Width Enter a number or use the scroll arrows to choose a number or enter 
a percentage in the % box. If a number is entered in the first box, the
% box reflects the change and vice versa. You can enter either a 
number or percentage but not both.

Height Enter a number or use the scroll arrows to choose a number or enter 
a percentage in the % box. If a number is entered in the first box, the
% box reflects the change and vice versa. You can enter either a 
number or percentage but not both.

Horizontal Enter a resolution. The maximum is 300 dots per inch.

Vertical Enter a resolution. The maximum is 300 dots per inch.

Identical Values When checked, the Horizontal and Vertical resolutions are always 
equal.

Original Image Size Displays the size of the original image.

New Image Size Displays the size of the resampled version.



Import PostScript (Interpreted) (.EPS, .PS, .AI)
Technical Notes

CorelCHART can interpret EPS, PS, and AI files. This filter is primarily for importing print files 
and is available in Chart View only. 

You may import EPS files for use in CorelCHART either as curves or text. 

Importing as text

PostScript files imported as text reduces both the size of the data and the time involved in 
loading information into your chart. However, fonts not installed on your system will be 
converted to the next closest default typeface.

· If text was exported as text it should be importable as editable text. Point size, font 
information should be maintained.

· Imported text will appear as annotations and character length cannot exceed 2,048

Importing as curves

PostScript files imported as curves increases data size and conversion time. Although text 
converted to curves cannot be edited as text, this option permits the display of any typeface
accurately in your chart.
The EPS information that is used when the image is printed to a PostScript printer can be 
imported into CorelCHART.

· Note: This filter is useful for importing any PostScript files that are not in the AI form.
· PostScript (Interpreted) will import the CorelCHART EPS format.
· Due to the way PostScript describes gradient fills if you are importing a file with large 

or complex gradient fills you may generate a very large number of objects. This may 
lead to a very large file, or, if the file grows too large, you may not be able to import 
the file due to memory limitations.

· If the file you are importing is too large or complex you may not be able to import the
file due to memory limitation errors.

· There is an option in CORELFLT.INI to increase the Virtual Memory that the interpreter 
will allocate when it initializes. This may help you import larger or more complex files.
Set VMSize=n (where n is megabytes of allocated memory, 2 is the default) to a 
larger number.

Note: EPS file formats (AI, EPS placeable, PostScript Interpreted) cannot be imported 
properly using the All Files import option. To import PostScript Interpreted files successfully 
choose the PostScript Interpreted import filter.



Import--AutoCAD (DXF)
Technical Notes

Preparing the file in AutoCAD
To create a DXF file from AutoCAD, use the DXFOUT utility while in that program. If the 
image is 3-D, save it with the view that you want to transfer over to CorelCHART. 

Note: DXF v11 and v12 are not fully supported.

DXF File Complexity
If your DXF file is too complex to import into CorelCHART, configure your AutoCAD output 
device as an HP7475 Plotter and perform a Plot-to-File of your drawing. You should then be 
able to import this plot file using CorelCHART's HPGL import filter. 

General notes and limitations on imported DXF files
· CorelCHART tries to center the imported image in an 18x18 inch area of the charting 

window. This size is not guaranteed though, especially with 3-D images. Drawings 
larger than 18x18 inches can be scaled to fit within these dimensions. In most cases, 
an Import DXF dialog box that allows you to enter a scale factor will open, allowing 
you to scale an image up or down as long as it is not larger than 18 x 18 inches. 
However, if you're importing an AutoCAD file from version 11 or 12 of AutoCAD that 
contains extent information which CorelCHART cannot read, (for example, exponential
numbers), this Import DXF dialog box will not open. Instead, CorelCHART estimates 
the best fit and scales the image up or down accordingly.

· Dashed lines in the DXF file will be given a similar dashed line pattern in CorelCHART. 
· If you have a problem with the scattering of dimension entities in your imported file, 

go back to your original drawing in AutoCAD and explode the dimension entity before
creating the DXF file.

· The line width of a polyline is imported as the minimum line width which that polyline
had in AutoCAD. The maximum line width is 4 inches. Variable line width information 
is not retained when the file is imported.

· Curve resolution factor can be set to a value between 0.0 and 1.0 inches. The entered
value can be very accurate, up to eight decimal places are accepted. While a setting 
of 0.0 will result in the highest resolution it will also greatly increase file size. A curve 
resolution of 0.004 inches is recommended.

· Solid and trace entities are filled, provided the view is not    3-D (i.e., they are filled on
x-y axis view only).

· A point is imported as an ellipse of minimum size. An extruded point is imported as a 
line segment with two nodes. PDMODE is not considered.

· Files exported as "Entities only" may come into CorelCHART incorrectly due to lack of 
header information.

AutoCAD features not supported in CorelCHART
The following features in AutoCAD are not supported when importing a DXF file into 
CorelCHART:

· CorelCHART does not support polygon arcs.
· Shape entities--CorelCHART cannot read .SHX files
· Polylines including variable-width polylines, elevation (group 38), mesh M and N 



vertex counts (groups 71 and 72), smooth surface M and N densities (groups 73 and 
74) and smooth surface type (group 75)

· Special 3-D shapes such as cones, spheres and tori
· 3-D extrusion of circles, arcs, and text
· 3-D extrusion of polylines with width and/or dashed patterns
· Invisible lines in 3-D face entities
· Automatic wireframes
· Hidden lines or hidden-line removal
· Extrusion direction assumed to be parallel to the Z-axis
· Binary DXF format
· Paper Space Entities within a Model Space

Text in the DXF File
Text generated in AutoCAD and imported via DXF will show the following differences:

· Various justifications on text entries may not be preserved. Normal text placement 
(no justification) works best.

· CorelCHART has limits on values for text's point size and skew. If the AutoCAD text 
object exceeds these limits, the object is brought within these limits when it is 
imported.

Special characters in text strings:
· Control characters are ignored.
· Overscore and underscore indicators are ignored.
· If a character is referred to by number, the number must be three digits. i.e. 

character 65 is %%065.
· %%010 is considered to be a carriage return and line feed.
· Any non-standard characters become a "?" in CorelCHART, including the degrees 

symbol, the +/- tolerance symbol, and the circle dimensioning symbol.
The typefaces used in AutoCAD are matched by PANOSE font matching with the closest 
available face in CorelCHART. If a font is not found the default font will be used.



Import--HP Plotter (HPGL)
Technical Notes

Formats Supported
CorelCHART can interpret a SUBSET of the HPGL and HPGL/2 command set. A stepping 
factor of 1016 plotter units = 1 inch will be used.

Image Size
The dialog box includes a Scale option for resizing the imported image. Use this option to 
import images larger than CorelCHART's maximum page size. If your image does not fit in 
the CorelCHART page, it will automatically scaled down unless you select a stretch factor 
that will make your image smaller than the CorelCHART page.

· Curve resolution factor can be set to a value between 0.0 and 1.0 inches. The entered
value can be very accurate, up to eight decimal places are accepted. While a setting 
of 0.0 will result in the highest resolution it will also greatly increase file size. A curve 
resolution of 0.004 inches is recommended.

Colors in HPGL Files
The HPGL format does not contain color information. Instead, the various objects in an 
HPGL file have certain pen numbers associated with them. When imported into 
CorelCHART, each pen number is assigned a specific color. You can specify the color 
assigned to a particular pen. This makes it easy to match the original colors of the graphic.

Pen Selection
The Pen Selection list contains 256 pens, although not all of the pens may be assigned.

Pen Color
You can change the color assignments by choosing the pen and then choosing a new color 
for that pen from the Pen Color field.

Choosing Custom colors brings up a color definition dialog box that allows you to define a 
custom color using the RGB values.

Pen Width
You can change the pen width assignments by choosing the pen and then choosing a new 
width for that pen from the Pen Width field.

Pen Velocity
You can change the pen velocity by choosing the pen and then choosing a new velocity for 
that pen from the Pen Velocity field. This is only useful for exporting HPGL files.

Pen Unused
Allows you to set a defined pen to (Unused).

Reset
Allows you to reset the current Pen Library pen settings back to the last saved settings.

Fills



Only certain types of objects in the HPGL file will be filled in CorelCHART.

Line Types
CorelCHART supports numerous HPGL dotted, dashed and solid line types. The pattern 
number of a certain line in an HPGL file will be translated to a CorelCHART line type 
pattern, as shown in the following table:

HPGL line: CorelCHART line type:
#0 Solid
#1 Dotted
#2 Small dash
#3 Large dash
#4,5 Dot-dash
#6 Double dot-dash
#7 and over As per # 2

Text in HPGL files
· Text will only come into CorelCHART (Chart View only) as editable annotations when 

the application that generated the file is capable of exporting text as text.
· Once in CorelCHART, text strings will be assigned the Monospaced font, but can 

subsequently be assigned any typeface and size and may not exceed 2,048 
characters.

· Imported text has no outline color, only a fill color. The fill color is based on its 
associated pen number in the original HPGL file.





Opening a KODAK Photo CD image
You can import images derived from 35mm film negatives or slides which have been 
converted to digital format and stored on a compact disc (CD).
To open a KODAK Photo CD image:

1. Choose Import from the File Menu. The Import dialog box opens.
2. Choose KODAK Photo CD from the List Files of Type drop-down list box.
3. Choose the Drive and Directory.
4. Click a file in the File Name list box. 
5. Click Options to view file information such as date, file size, file format, image size 

and Sort by. The Sort by options are: name and date.
6. Click Preview to view the file.
7. Click OK. The Photo CD options dialog box opens.
8. Choose Colors and  Resolution. 

If you check the Apply Image Enhancement check box, the Photo CD Image 
Enhancement dialog box opens. Choose options in the dialog box.

9. Click OK.



Photo CD dialog box
The Photo CD dialog box allows you to specify resolution, colors and apply image 
enhancement. See also Photo CD Image Enhancement dialog box

Dialog Box Options:

Resolution When you import PCD files, a dialog box will appear prompting 
you to choose the desired file resolution. 
· Wallet (128x192)
· Snapshot (256x384)
· Standard (512x768)
· Large (1024x1536)
· Poster (2048x3072)
Note: High resolutions require large amounts of disk space.

Colors · 16.7 million (24 bit)
· 256 colors (8 bit)
· 16 colors (4 bit)
· 256 grayscale (8 bit)

Image Size The Image Size indicator will update to reflect the choices you 
have made regarding Resolution and Color.

Apply Image Enhancement Corrects the color of the image before you import it into 
CorelCHART.

Preview Click Preview to see a thumbnail of the CD image.



Photo CD Image Enhancement dialog box
This dialog box allows you to correct the color of the image before you import it into 
CorelCHART.
See also Photo CD dialog box

Dialog Box Options:

Color Correction Method

GamutCD (TM)
This color correction method uses gamut mapping to enhance the color fidelity and tonal 
ranges of the CD image.
Set Active Area Use the mouse to specify an active area within the image in the 

view field. This ensures GamutCD will base its color correction 
on the area of the photo that you are going to use and helps cut
out any black borders left over from the original scan.

Set Neutral Colors Define neutral colors by clicking on pure whites, blacks and 
grays within the Active Area.

White in Image Choose this option if you have good white elements in the 
photo. If you do not have a white, disable this option as the 
Gamut mapping will overbrighten your picture as it maps the 
lightest elements of your picture to white.
This option will assist GamutCD in enhancing the tonal range of 
your image and removing color cast. If your white is not pure 
white you may wish to lower the 255 setting in the number box 
to the right. 

Black in Image Choose this option if you have good black elements in the 
photo. If the image does not have blacks, disable this option as 
the Gamut mapping will darken your picture as it maps the 
darkest elements of your picture to black.
This option will assist GamutCD in enhancing the tonal range of 
your image and removing color cast. If your black is not pure 
black you may wish to raise the setting in the number box to 
the right from 0.

Fast Preview Displays the effect the GamutCD settings you have chosen will 
have on the image.

Best Preview Displays the effect the GamutCD settings you have chosen will 
have on the image. This method will be more accurate than fast
preview but take longer to build.

Kodak Color Correction
This color correction method allows you to alter color tints, adjust Brightness and Color 
Saturation, as well as make adjustments to the level of contrast.
Remove Scene Balance Adjustment 
Turns off the Scene Balance Adjustment the photo finisher applied at the time the original 
image was scanned and placed on the Photo CD disk. 
Color Metric
Allows you to adjust contrast by pre-set amounts.
Show Out-Of-Gamut Colors
If the changes you've made are too extreme the preview will display out-of-gamut pixels 



as pure red or pure blue.



Click any menu item below for a description of how each one works.
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Click a chart type below for a description of how it works.
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Exchange information with other applications

Connections to other applications
Object Linking and Embedding
Drag and Drop: From Chart View
Embedding CorelCHART objects
Embedding a new chart object in CorelDRAW
Embedding an existing chart object in CorelDRAW
Linking chart objects
Exporting
Exporting graphics

Connections from other applications
Importing
Importing graphics
Drag and drop graphics



Overview: Object Linking and Embedding
Windows' Object Linking and Embedding (OLE) 2.0 offers two ways to connect files from 
separate programs--linking and embedding. As the name implies, linked objects are data, 
text or graphic objects created in one application, a server application, which remain linked 
to a file created in another program, the client. When you update the original linked file, it 
can be updated in both client and server applications. Chart View acts as an OLE server but 
not a client while Data Manager acts as an OLE client. Double-clicking a linked or embedded 
object switches you back to the original file in a special session of the server application to 
make your changes. Your computer must have enough Random Access Memory and the 
system resources to run CorelCHART and the other applications you are using at the same 
time.
Embedded Objects
Embedded objects place or embed a full-sized picture, called an object, in the file 
you're working on. Double-click the embedded object to edit it; this activates the 
server program from within your file. The difference between embedded and linked 
objects is that for embedded objects, OLE makes a copy of the original file. No link is 
maintained between an embedded object and the original file--the original file does 
not update when you edit the embedded object, nor does the embedded object 
change if the original file is changed.
Embedded objects are more portable than linked objects. If you are moving files 
between systems, the only requirement is that the new system have both the server 
and client programs.
Linked Objects
Linked object files can be updated when the original file changes in the server 
application. Linked objects are not as portable as embedded objects. If you are 
moving files between computer systems, to preserver the link you must copy both 
source and destination files to the new system must have both server and client 
programs installed. 
Drag and Drop
Drag and Drop is a popular new feature of OLE 2.0. Drag and Drop allows you to 
select and drag information from one application and drop it into another. When used 
from an OLE server to an OLE client application, Drag and Drop can be used to create
embedded objects. If the application you are dragging from is not a server, Drag and 
Drop acts like cut and paste, moving the selected data from place to place.
Linking and embedding procedures vary somewhat between applications. Check the 
client application's documentation for additional information.



Drag and Drop: From Chart View
You can drag and drop a whole chart, but not its individual parts, from CorelCHART into other
applications. Drag and drop creates an embedded object in the client application.
To drag an entire chart to another application:

1. Size the Chart View and client application windows so that you can see both 
CorelCHART's charting window and the target area of the client application.

2. Click and hold the mouse button in the charting window above the Printable Page (the 
cursor will not change).

3. Move or "drag" the pointer from the Chart View window to the client application. 
4. When the cursor becomes a blinking white arrow with a small rectangle underneath, 

release the mouse button to "drop" the data into the client program. Note: The cursor 
becomes a black circle with a diagonal line through it when moving over invalid paste 
areas.

OLE procedures vary somewhat between applications. Check the client application's 
documentation for additional information.



Embedding CorelCHART objects
You can embed a whole chart but not its individual objects from CorelCHART into client 
applications.
To embed a CorelCHART object in another application:

1. In the client application, choose Insert Object.
2. Choose the appropriate Object Type from the Insert Object dialog box and click OK.
3. Your system will automatically open or switch to CoreCHART for an embedded session.
4. Create or open the CorelCHART object you want to embed in the client application.
5. When you have completed the chart-building session, choose Exit & Return to 

[client filename].
OLE procedures vary somewhat between applications. Check the client application's 
documentation for additional information.
See also Insert Object command (Edit Menu)



Embedding a new chart object in CorelDRAW
You can embed a CorelCHART file in CorelDRAW by creating a new chart, as described below,
or you can Create from File. See also Embedding an existing chart object in CorelDRAW.
To create a new CorelCHART object:

1. In CorelDRAW, choose Insert Object from the Edit menu. The Insert Object dialog box 
appears.

2. Choose CorelCHART! 5.0 from the Object Type list box and click OK (Create New is the 
default option).

3. Design your chart.
4. While you are building the chart, you have the following file management options:

Save Copy As: Saves the chart as a copy of the embedded object
Update [original filename]: Updates your original file
Close & Return to [original filename]: Closes the current file but leaves CorelCHART open
Exit & Return to [original filename]: CorelCHART will disappear, and the embedded chart
will appear in CorelDRAW with handles. You can move or resize the object, or double-
click it to return to an embedded CorelCHART session to edit it. 

5. When you have finished creating your chart, choose Exit & Return from the CorelCHART 
file menu to return to CorelDRAW.



Embedding an existing chart object in CorelDRAW
You can embed existing CorelCHART objects into CorelDRAW from file as described below or 
Embed a new CorelCHART object in CorelDRAW
To embed an object from file:

1. In CorelDRAW, choose Insert Object from the Edit menu. The Insert Object dialog box 
appears.

2. Click the Create from File radio button. A File list box appears.
3. Click Link if you want the resulting object to be updated whenever the original file is 

updated. 
4. Choose Browse to open a Browse files box if you want to locate an existing CorelCHART 

file (files with the extension .cch) or type in a path and file name and click OK. The 
embedded object will appear in your CorelDRAW file.



Linking chart objects
To create linked CorelCHART objects using OLE, follow the steps below:

1. Choose Copy Chart from the Edit Menu.
2. In the client application, choose Paste Link or Paste Special from the Edit Menu as 

required. (Paste Link is only available if the chart has been saved previously).
3. Make the appropriate selection from the resulting dialog box and click OK.

Double-click the linked CorelCHART object to return to a closed CorelCHART session to 
edit your CorelCHART file.

OLE procedures vary somewhat between applications. Check the client application's 
documentation for additional information.



Importing graphics
Chart View's Import function gives you access to graphics created by other illustration 
programs and presentation packages, as well as clip art and scanned images. 
To import a graphic object, choose the Import command as follows:

1. Click the Import button or choose Import from the File menu. 
2. From the Import dialog box's List Files of Type box, choose the import format you want.
3. The File Name box shows files in the current directory with the chosen format's 

extension. If the file you want is in another directory, choose the drive from the Drives 
box and the directory from the Directories box.

4. In the File Name box, type or select the data you want to import.



Exporting graphics
Exporting saves CorelCHART files in formats used by other programs. 
To export graphics for use by other programs:

1. Open the CorelCHART file you want to export.
2. Click the Export button or choose Export from the File menu.
3. From the List Files of Type box, choose the export format you want.
4. Accept the name displayed in the File Name box for the graphic you are exporting or 

type a new name in the File Name box. CorelCHART automatically adds the extension 
used by the application you selected.
The file will now work as any native file in the target application.

Depending on the format selected, another dialog box may appear. Choose your options as 
required.



Drag and drop graphics
You can drag and drop a bitmap or other supported graphic images directly from other 
applications or from a Windows file manager into Chart View.
To drag and drop a bitmap into Chart View:

1. Size the charting window and the other application's window so that you can see the 
relevant parts of each.

2. Click and hold down the mouse pointer on the bitmap file or image in an application 
window or a Windows file manager.

3. Drag the bitmap file or image into Chart View and release the button when the pointer is
over the location where you want the image to appear.
The bitmap will appear where you have "dropped" it in the charting window.





Exchange data with other applications

Connections to other applications
Drag and Drop
Drag and drop spreadsheet data
Exporting
Exporting spreadsheet data

Connections from other applications
Object Linking and Embedding
Linking objects from other applications
Updating linked objects
Embedding objects in Data Manager
Dynamic Data Exchange
Setting up a DDE link with another spreadsheet
Importing
Importing spreadsheet data
Querying data
Making data queries



Making data queries

Making new data queries
Opening data queries
Adding Data Sources

See also:
· CorelQUERY Online Help
· ODBC Help



Drag and drop spreadsheet data
Drag and drop spreadsheet data from Data Manager to other applications as follows:
1. Make sure both the Data Manager window and the other application's window are

sized so that you can see the relevant parts of each.
2. Select the data to be dragged from Data Manager to the client application.
3. Point with the mouse pointer to a spot just below the top line of the selected 

data. 
The pointer will change from a white cross to a white arrow.

4. Click and hold the mouse button while you drag the data to the client 
application.

See also Drag and drop within Data Manager



Linking objects from other applications
For information about the procedures used by the program from which you want to link data 
to the Data Manager, consult the application's user documentation. See also Paste Special 
command (Edit Menu)
In general, the following procedures apply:
1. Select the information you want to link to CorelCHART in the server application 

and choose Copy from the Edit Menu.
2. Switch to CorelCHART's Data Manager and choose Paste Special. 
3. Choose Paste Link from inside the Paste Special dialog box and click OK. 

Note: To create Linked Objects, you must choose Paste Special, then Paste Link 
from within the Paste Special dialog box. Paste Link chosen directly from the 
Edit menu creates a DDE link.
The information from the server application will flow into the spreadsheet at the 
cursor location.

OLE procedures vary somewhat between applications. Check the client application's 
documentation for additional information.



Updating linked objects
You can also update a linked object that has been modified in the server application from 
within Data Manager.
To update an object linked to the Data Manager:
1. Choose Links in the Data Manager Edit menu.
2. Select the linked object you want to update from the Links list.
3. Click Update Now.
4. If you want the object to update automatically when it is modified, click the 

Automatic option at the bottom of the dialog box.
OLE procedures vary somewhat between applications. Check the client application's 
documentation for additional information.



Embedding objects in Data Manager
You can embed objects in Data Manager by Creating from File, which inserts an existing 
object from a server application immediately, or begin create a new object.
To embed a new OLE object in Data Manager:
1. Place the cursor where you want the object to appear.
2. Choose Insert Object from the Edit Menu.
3. Choose the appropriate Object Type from the Insert Object dialog box and click 

OK.
4. A closed OLE session will begin in the server application. Create the object you 

want to appear in Data Manager. 
Note: If you choose Create from File, the object you want to appear will be 

inserted immediately in Data Manager.
See also Insert Object command (Edit Menu),



Setting up a DDE link with another spreadsheet
Besides using OLE to link spreadsheets, you can set up what is called a Dynamic Data 
Exchange.
To set up a Dynamic Data Exchange link with Windows-compliant 
spreadsheets:
1. Open a Data Manager window and the other application's spreadsheet file.
2. Select the range of cells in the spreadsheet you'd like to link.
3. Choose Edit, Copy.
4. Switch to Data Manager and place the cursor at the cell location where you want 

the linked data to begin.
5. Choose Edit, Paste Link.

Note: Paste Link chosen directly from the Edit menu creates a DDE link. To 
create Linked Objects, you must choose Paste Special, then Paste Link from 
within the Paste Special dialog box. 
The source and target files are now linked. The data will be updated whenever 
the server spreadsheet's data is updated.

DDE procedures vary somewhat between applications. Check the client application's 
documentation for additional information about DDE.



Setting up a DDE link with another spreadsheet
Besides using OLE to link spreadsheets, you can set up what is called a Dynamic Data
Exchange.
To set up a Dynamic Data Exchange link with Windows-compliant 
spreadsheets:
1. Open a Data Manager window and the other application's spreadsheet file.
2. Select the range of cells in the spreadsheet you'd like to link.
3. Choose Edit, Copy.
4. Switch to Data Manager and place the cursor at the cell location where you want 

the linked data to begin.
5. Choose Edit, Paste Link. 

Note: Paste Link, chosen directly from the Edit menu, creates a DDE link. To 
create Linked Objects, you must choose Paste Special, then Paste Link from 
within the Paste Special dialog box. 
The source and target files are now linked. The data will be updated whenever 
the server spreadsheet's data is updated.

DDE procedures vary somewhat between applications. Check the client application's 
documentation for additional information about DDE.



Exporting spreadsheet data
Use the Data Manager's Export command to save your charts or spreadsheet data in formats
used by other popular programs.
To export your data:
1. Open the Data Manager File menu and click Export.
2. The Export Data dialog box will appear, showing a default export file name 

(sheet1, sheet2, and so on) in the File Name text box. Accept the default or key 
in a new filename.

3. Choose the file type used by the program you'll be exporting to from the listing in
the List Files of Type text box.

4. Choose the drive and directory where you want to send the file.
Click Ansi to Oem if you need to save a file using the OEM standard.



Importing spreadsheet data
Data Manager's Import Data function allows you to import data in a range of spreadsheet 
formats for use in CorelCHART.
To import a data file into Data Manager:
1. In Data Manager, choose Import from the File menu or click the Import button 

from the Ribbon Bar.
2. Choose the type of file format you wish to import from the Import Data dialog 

box.
3. Double-click the name of the file you want to import.
4. The data file will flow into your spreadsheet starting at cell A1.

Warning: Any data already in the current spreadsheet window is replaced by the
imported data.



Overview:    Making queries
Using CorelCHART 5's add-on database viewer, CorelQUERY, you have a quick and easy way 
to gather database information and build query tables. CorelQUERY can view files from 
database application files which use Microsoft's Open Database Connectivity, such as 
dBASE, Paradox, FoxPro and SQL Server. 
Because you can query database files directly from CorelCHART, using CorelQUERY to 
process database information can speed your work. Another advantage of CorelQUERY is 
that you need not own a database program to view files--all you require is CorelCHART and a
database file from a third party.
If CorelQUERY is installed on your system, you are ready to make your first database query. 
To install CorelQUERY, you must run Corel Setup from the Windows Program Manager (i.e., 
File, Run b:\setup). Consult the CorelDRAW Installation Guide for further details.
Notes:    CorelQUERY does not create a dynamic link with the source application unless you 
actually open the server database program and choose Paste Link. If the data in the server 
file has been updated, use CorelQUERY to repeat the query.
See also Making new data queries and ODBC Help



Making new data queries
1. Click a CorelCHART cell where you want the data to appear. 
2. From the Data Menu, choose Get Data From Database , then choose New File... 

from the flyout menu.
3. Click a data folder. The Query Builder dialog box appears with the Select feature 

active.
4. Double-click the data table(s) you want to use from the Relations text box. Note: 

Until you are familiar with making complex queries, we recommend that you 
select only one table for each query.

5. In the Fields list box, double-click the data fields you want to include in your 
query.

6. Select Criteria and Order/Group choices as required. For example, if you want to 
change the sort order from Ascending to Descending, click the Order/Group tab, 
select the relevant fields, and click Descending.

7. Click the SQL tab and click Build. 
CorelQUERY automatically writes your query in Structured Query Language.

8. Click OK. CorelQUERY generates a query table based on the information you 
requested in the Query Builder dialog box.

9. If you want to save your query file in CorelQUERY, choose Save Copy As... from 
the CorelQUERY File Menu and give your query table a name. The .dsq extension 
is automatically appended. If you don't want to save the query table, go to step 
6.

10. Choose Exit and Return to [CorelCHART filename]. The data will flow into 
CorelCHART from the active cell downward and left to right. Edit the data as 
required.

See also Opening data queries



Making new data queries
1. Click a CorelCHART cell where you want the data to appear. 
2. From the Data Menu, choose Get Data From Database , then choose New File... 

from the flyout menu.
3. Click a data folder. The Query Builder dialog box appears with the Select feature 

active.
4. Double-click the data table(s) you want to use from the Relations text box. Note: 

Until you are familiar with making complex queries, we recommend that you 
select only one table for each query.

5. In the Fields list box, double-click the data fields you want to include in your 
query.

6. Select Criteria and Order/Group choices as required. For example, if you want to 
change the sort order from Ascending to Descending, click the Order/Group tab, 
select the relevant fields, and click Descending.

7. Click the SQL tab and click Build. 
CorelQUERY automatically writes your query in Structured Query Language.

8. Click OK. CorelQUERY generates a query table based on the information you 
requested in the Query Builder dialog box.

9. If you want to save your query file in CorelQUERY, choose Save Copy As... from 
the CorelQUERY File Menu and give your query table a name. The .dsq extension 
is automatically appended. If you don't want to save the query table, go to step 
6.

10. Choose Exit and Return to [CorelCHART filename]. The data will flow into 
CorelCHART from the active cell downward and left to right. Edit the data as 
required.
See also Opening data queries



Opening data queries
1. Click a CorelCHART cell where you want the data to appear. 
2. Choose Get Data From Database from the Data Menu, then choose Open File... 

from the flyout menu.
3. Choose any .dsq file from the Load Data Query dialog box and click OK. The data 

will flow into the spreadsheet from the active cell downward and left to right.



Opening data queries
1. Click a CorelCHART cell where you want the data to appear. 
2. Choose Get Data From Database from the Data Menu, then choose Open File... 

from the flyout menu.
3. Choose any .dsq file from the Load Data Query dialog box and click OK. The data 

will flow into the spreadsheet from the active cell downward and left to right.



Adding Data Sources
The Add ODBC Data Source dialog box appears when you click the Add button in 
CorelQUERY's Data Source dialog box.
To add an ODBC Data Source:
1. Choose a driver name (e.g., dBase Files (*.dbf)) from the Add ODBC Data Source 

dialog box.
2. Click OK.

When the resulting dialog box appears, key in the required data source 
information, i.e., name, version, number or location.



Adding Data Sources
The Add ODBC Data Source dialog box appears when you click the Add button in 
CorelQUERY's Data Source dialog box.
To add an ODBC Data Source:
1. Choose a driver name (e.g., dBase Files (*.dbf)) from the Add ODBC Data Source 

dialog box.
2. Click OK.

When the resulting dialog box appears, key in the required data source 
information, i.e., name, version, number or location.





Print to File--Print Options dialog box
Use to name a file to print to disk.

Dialog Box Options

File Name
Type a name for the file. To overwrite an existing file, select its name from the list.
The file name precedes the .PRN extension and can contain up to eight characters.

Drives
Choose the drive to which you want the file printed.

Directories
Choose the directory in which you want the file printed.

List Files of Type
Shows Print File as file type being created.

Read Only
Choose this option to prevent the file from being overwritten or altered.

Note: Before you print a final print file, or send a print file to an output bureau for film or 
direct imaging, make sure that you've built your System Color Profile with Color Manager for 
the output device chosen.



Print Options dialog box 
Opens the Print Options dialog box which includes advanced options for controlling the way 
a chart prints.

Dialog Box Options

Page Window
Shows how a chart will look when printed. The bounding box surrounding the preview 
image shows the area within which the selected printer is capable of printing. Resize the 
image by dragging the handles around it. To change its position on the page, click 
anywhere inside the image and drag. For more precision, specify values in the Position and
Size boxes.
Rulers allow to you judge the relative size and placement of the image. Change the rulers' 
units by clicking on the Units box and selecting a new unit from the list.
Note:    Changing the chart's size and position does not affect the chart file, only how it is 
printed.

Options
Click the tabs below for information on the options they include.

References
Located below the Page Window are the references icons. They add standard printers' 
marks and file information to your chart when you check the appropriate options. See 
Printers' References.
Note:    For references to appear, the size of the Printable Page (as set in the Page Setup 
dialog box) must be smaller than the size of the page you are printing on.



Print Options--Layout tab
Position and Size

Lets you adjust the size and position of a chart with numeric precision. Note:  Changing 
the chart's size and position does not affect the chart file, only how it is printed.
Top, Left Adjusts position of chart on page. The value in the Left box 

represents the location of the top left corner of the chart. The Top 
value represents the location of the top of the chart.

Width, Height Adjusts size of the image. When the value in one box is changed, the 
value in the other changes proportionately to maintain the chart's 
aspect ratio.

Center Centers chart on the page.
Fit to Page Reduces or enlarges chart to fit on the size of paper in the printer. 

Use this option to proof large charts that exceed the printer's 
maximum paper size.

Maintain Aspect Resizes chart when it is printed. Values below 100 shrink chart; 
values above 100 enlarge it. Useful for proofing very small or very 
large charts. Use this option with the Tile option to print a single 
page chart as a large poster.

Print Tiled Pages Prints parts of chart outside the Printable Page on additional pages. 
Use this option if you are also using the Maintain Aspect option to 
print your chart at a size larger than the printer's paper size.

Layout Style
Lets you adjust the size and position of a drawing to reflect different printing needs. If you 
are printing a chart that you want to fit to a three column format to which you will later 
add text. You could set up the page so that the chart prints
Rows Sets the number of vertical rows on the page.
Columns Specifies the number of horizontal columns on the page.
Gutter Width Sets the size of the gutter between Columns.
Clone Frame Clones the page frame.

Preview Image:
Displays the current publication in the "page" window.

Printers' References:
Located under the Preview Image area, the Printers' references are represented by a row of
buttons. Use the printers' references to add standard printers' marks and file information 
to your publication.

Note:    For references to appear, the size of the Page (as set in the Chapter Settings, Layout 
dialog box) must be smaller than the size of the page you are printing on. Many 
imagesetters have an "extra" page setting ("letter extra" is 9.5x12, for example) which 
enables for crop marks and file information.



Print Options--Separations tab
Use to prepare a file for color separation. 

Dialog Box Options

Print Separations 
When checked, prints the color information of your slide(s)chart in grayscale separations. 
Usually these are the four process colors (cyan, magenta, yellow and black) and any spot 
colors used in the chart. Click on the colors for which you want to print separations.

In Color
When checked, prints the separations in color rather than grayscale. This option is 
available if you are printing to a color printer or if you are printing to file. Printing on 
transparencies with this option enabled will allow you to check any traps you've applied to 
objects in your chart.

Convert Spot to CMYK
Converts spot colors in the chart to their process color equivalents.
Note:    Converted color appears the same on screen but will not match Spot color exactly 
when printed.

Use Custom Halftone
Select this option to specify halftone screen angles and line frequencies for each of the 
CMYK colors. If left unchecked, your chart prints using the printer's default angle and 
frequency.
Advanced Screening
Clicking the Edit button opens the Advanced Screening dialog box. Control screening 
technology, output resolution, line screen, screen angles and frequencies for the four 
Process colors. Set halftone screen type. The look-up table in CORELPRN.INI defines the 
default screen frequency and angle for different resolution devices.
Unless you specify a different screen angle in the PostScript Options dialog box, objects 
with Spot colors print using the screen angle specified for Black.

Colors
Lists four process colors (cyan, magenta, yellow and black) and any spot colors used in the
chart. Click the colors for which you want to print separations.

Auto Trapping
Adds trap to certain objects in your chart.
Note:    Autotrapping creates spreads, not chokes. 
Always Overprint Black

Adds trap to any object that contains 95 percent black. Change value by editing the 
PSOverprintBlackLimit in the CORELPRN.INI file.

Auto-Spreading
Adds trap to all objects which meet two conditions: they have no outline and they are
filled with a uniform color.
In the Maximum box, specify the maximum amount of trap you want to add. Actual 
amount added depends on the object's color: the lighter the color, the greater the 



percentage of the maximum value CorelCHART adds.
If Always Overprint Black is also checked, black overprinting will occur                even
if the object does not meet the two conditions for auto-trapping.

Unsharp mask
Use the Unsharp Mask filter to accentuate edge detail as well as sharpen smooth 
areas in the image. The higher the percentage, the more defined are the edges.

Preview Image:
Displays the current publication in the "page" window.

Printers' References:
Located under the Preview Image area, the Printers' references are represented by a 
row of buttons. Use the printers' references to add standard printers' marks and file 
information to your publication.

Note:    For references to appear, the size of the Page (as set in the Chapter Settings, Layout 
dialog box) must be smaller than the size of the page you are printing on. Many 
imagesetters have an "extra" page setting ("letter extra" is 9.5x12, for example) which 
enables for crop marks and file information.



Print Options--Options tab
Use to specify additional setting for printed files.

Dialog Box Options

Screen Frequency
Determines the halftone screen frequency used to print your chart. Unless you specify a 
different one in the PostScript Options dialog box, objects with Spot color print using the 
screen frequency selected here.
If printing color separations, adjust the screen frequency of each CMYK color in the 
Separations dialog box in the Use Custom Halftone option. In this case, objects with Spot 
color print using the frequency specified in the Separations dialog box.

Set Flatness to
Determines how many segments PostScript printers use to draw a curve. Reducing the 
number of segments helps overcome PostScript limitcheck errors which can prevent charts
with complex curves from printing. Curves may become noticeably rough if the Flatness 
setting is increased too much.
If you are getting PostScript limit check errors, increase the Flatness setting in increments 
of four or five until the chart prints.

Auto Increase Flatness
Automatically increases flatness setting in increments of one until the chart prints. If the 
limit of 10 is reached and a particular object still will not print, the printer will skip that 
object and print the next.

Fountain Steps
Determines the number of stripes or bands printers use to render a fountain fill. Values 
higher than 40 produce a smooth fountain, but take longer to print. Even higher values 
may be necessary to create large fountain fills. A similar option in the Preferences dialog 
box controls how many stripes CorelCHART uses to display fountain fills on your screen.
Note: The Steps setting in the Fountain Fill dialog box overrides the settings in this dialog 
box and in the Preferences dialog box.

Download Type 1 fonts
Check when using Type 1 fonts that are not resident on your printer. CorelCHART's Type 1 
fonts will be used instead of the printer's default font, most probably Courier. 

Convert True Type to Type 1
Check to convert the True Type fonts used in your chart to their Type 1 equivalents.    Useful
when sending work to a service bureau that has Type 1 versions of the fonts you used.

Preview Image:
Displays the current publication in the "page" window.

Printers' References:
Located under the Preview Image area, the Printers' references are represented by a row of
buttons. Use the printers' references to add standard printers' marks and file information 
to your publication.

Note:    For references to appear, the size of the Page (as set in the Chapter Settings, Layout 



dialog box) must be smaller than the size of the page you are printing on. Many 
imagesetters have an "extra" page setting ("letter extra" is 9.5x12, for example) which 
enables for crop marks and file information.





Choosing a default printer
When you print from CorelCHART your chart is automatically sent to the default printer. If 
you have installed other printers, you can specify which one you want CorelCHART to use. 
The printer you specify remains active until you exit CorelCHART.
Note: Before you print or send a final color print file to an output bureau for film or direct 
imaging, make sure that you've built your System Color Profile with Color Manager for the 
particular output device chosen.
To select a printer:

1. Choose Print Setup from the File menu.
2. From the box under Printer, Name, choose a printer and click OK.

For information on installing printers, see your Microsoft Windows User's Guide.



Setting up the active printer
You can specify the default settings for the active printer from CorelCHART.
To set up the active printer:

1. Choose Print Setup from the File menu.
2. Click Setup and accept or change the paper and orientation settings as required. 

Choose the Help button for information about the options.



Printing a chart
You can print an entire chart or selected objects only. 
To print a chart:

1. Choose Print from the File menu.
2. Choose the printing options you want.

You can choose to print all the pages in the print range, selected objects, the current 
page, set print quality, select a different printer, choose number of copies, collation and 
other options.
See also Print command



Printing a chart to disk
"Printing to disk" creates a special print file which allows you to print your chart from 
computers without CorelCHART installed. You would normally use this feature when you want
to send your chart to a service bureau for high-resolution printing.
When you print to file, use the screen frequency specified in the Options dialog box available
from the Print dialog.
Note: Before you print your final file or send a print file to an output bureau for film or direct
imaging, make sure you've built your System Color Profile with Color Manager for the 
particular output device chosen.
To print a chart to a disk:

1. Choose Print from the File menu.
2. Check the Print To File check box.

If you are sending the chart to a service bureau that uses Macintosh computers, check 
the For Mac check box.

3. Select any other options you want and click OK.
4. The Print to File dialog box appears, prompting for a file name. Accept the name shown 

or type your own and change directories as required in the File Name box and click OK.
The file is saved as a print file with the .PRN file extension.



Positioning the printed chart
Before you print your chart, you can use controls in the Print Options, Layout dialog box to 
change its position on the page. Positioning a chart in the Layout dialog box affects the way 
it prints; the chart remains unchanged.
To position a chart:

1. Choose Print from the File menu and click the Options button. Check the Preview Image 
box if it is not already.
The chart appears in the preview box. Its size and position are proportional to its size 
and position on the printable page.

2. Make sure the Center option isn't checked, otherwise you won't be able to change the 
chart's position. 

3. Enter values in the Left and top boxes; they determine the location of the top left corner
of the chart



Sizing the printed chart
Before you print your chart, you can change its layout and size on the page from the Print 
Options dialog box - Layout tab. Sizing a chart affects the way it prints; the chart remains 
unchanged.
To size a chart:

1. Choose Print from the File menu and click Layout.
The chart appears in the preview box. Its size is proportional to its size on the printable 
page.

2. Do one of the following:
· enter a value in the Width box; if Maintain Aspect is enabled, the value 

in the Height box is proportionally updated to maintain the original 
aspect ratio.

· clear the Maintain Aspect box and type values in both the Width and 
Height boxes; the chart is resized in the preview according to the 
dimensions entered; the aspect ratio may be different

· in the Width and Height percentage boxes,    specify the percentage by 
which you want to enlarge or reduce the chart

After sizing the chart, you can center it on the page by clicking Center. 



Printing charts larger than the printer's paper size
CorelCHART provides three options for printing charts that exceed your printer's paper size. 
They affect the printed size of the chart, not its actual size.
To print charts larger than the printer's paper size:

1. Choose Print from the File menu.
2. Click Layout. Choose one of the following:

Fit To Page:    Reduces the chart to fit on the size of paper the printer is using.
Tile:    Prints parts of the chart over the boundaries of the printable page on additional 
pages. 
Maintain Aspect:Reduces the chart to the percentage you choose of its original size. 
Preview to ensure that the reduced chart size fits onto the page size your printer 
supports.

4. Choose other options as required and click OK.



Faster printing with printer fonts
If you use your printer's factory-installed resident fonts or supplied with a font cartridge, 
your charts print more quickly.
The following procedure can also be used to reduce the size of files created when a chart is 
printed to a disk. You may want to take advantage of this when sending your work to a 
service bureau that has Adobe versions of the fonts you used.
To print text in a chart using your printer's fonts:

· Choose only the type faces available in your printer's Read Only Memory or on its Font 
Cartridge.



Printing fountain fills
To proof charts with fountain fills, you may want to speed up printing by reducing the 
number of stripes used to print the fountains. The fewer the stripes, the coarser the fountain
appears, but the faster the chart prints.
When you are ready to print the final version of your chart, increase the number of stripes to
the default setting or higher (128 for PostScript printers and 64 for non-PostScript printers).
Note: Unless you've specified a different number in the Fountain Fill dialog box, all fountains

print with the number of stripes specified using the following procedure.
To specify the number of stripes used to print fountain fills:

1. Choose Print from the File menu.
2. Choose Print Options and choose Options.
3. In the Fountain Steps box, select the number of stripes you want.



Printing charts with complex curves faster
When proofing charts with complex curves, you may want to speed up printing by increasing
the "flatness" setting. The higher the setting, the rougher the curves appear and the faster 
the chart prints.
When you are ready to print the final version of your chart, reset the flatness to the default 
value (1.00).
Increasing printing speed for PostScript printers:
You can also use this procedure to simplify curves too complex to print. See Printing complex
charts on a PostScript printer.

1. Choose Print from the File menu.
2. Click Options and choose the Options tab.
3. In the Set Flatness To box, type or select the higher flatness setting you want.



Printing complex charts on a PostScript printer
Printing a chart that contains complex curve objects sometimes produces a limitcheck error 
aborts print jobs. When this happens, you can use the Flatness control in the Print Options 
dialog box to simplify your chart. You can adjust the control manually or have CorelCHART 
adjust it in steps until the chart prints.
The flatness value affects the appearance of your chart: If it is set too high, curves may 
become noticeably rough.
To simplify a complex chart:

1. Choose Print from the File menu.
2. Click Options and choose the Options tab.
3. Choose one of the following Flatness options:

Set Flatness To:    Lets you type or select a flatness value. As a general rule, try 
increasing the value in increments of 4 or 5 until the chart prints.
Auto Increase:    Automatically increases the flatness value in increments of two until 
the chart prints. If a limit of 10 plus the current Set Flatness To value is reached and a 
particular object still will not print, the printer will skip that object and print the next.

Other measures you can take to simplify a chart:

· Lower the PSComplexityThreshold setting in your CORELPRN.INI file.

· Remove extraneous objects.

· If you have an older printer, avoid large fountain fills.
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Creating Color Separations
Separating a color chart causes it to print out on several pages, depending on how you 
assigned the colors to your objects. If you used a process color model, then you'll get four 
pages--one for each of the CMYK process colors used. Spot colors are printed on a separate 
page, one page per color. Be careful, if you're printing to a four-color device but you've 
specified some colors as spot, you could end up with four plates of CMYK plus extra plates of
spot color. 
CorelCHART's color separator works very well when used on devices setup with the Color 
Manager. Color Manager sets up prepress controls that prepare the charts for different types
of media. Some prepress tools set by Color Manager include Gray Component Replacement, 
Undercolor Removal and Dot Gain.
CorelCHART provides overprinting features that you can use to create trap. First-time users 
or people with little color separation experience can take advantage of the program's 
autotrapping feature.
There are also color calibration controls that allow you to adjust your monitor so that the 
colors it displays more closely match those in the printed output. See also Using the Color 
Manager in How to... change a chart's appearance 
You can print color separations on any printer, from a 300 dpi desktop laser printer to a high-
resolution PostScript imagesetter.



 
Creating trap
You can use CorelCHART's Auto Trapping feature to create traps when printing a chart as 
color separations.
See Print Options--Separations tab.
To create trap:

1. In Chart View, choose Print from the File menu.
2. In the Print dialog box, click Options.
3. Choose the Separations tab.
4. In the Auto Trapping group, click Always Overprint Black and/or Auto-Spreading. If 

you chose Auto-Spreading, type a value for the maximum point size of the spread in the
Maximum box.



Printing color separations to disk
Provided you have the appropriate printer driver installed and selected, you can print a chart
to disk for a service bureau to output on a PostScript or non-PostScript device. Printing to file
lets you output your work on a remote printer not connected to your system.
Note: Before you proceed, check the Printer settings in the Windows Control Panel to 

ensure that the port connection is not set to "File". If it is your file may not print.
To print a chart to a disk:

1. Choose Print from the File menu.
2. Check the Print To File check box.

If you are sending the chart to a service bureau that uses Macintosh computers, check 
the For Mac check box.

3. Select any other options you want and choose OK.
Another dialog box appears, prompting you to give the file a name. Either accept the 
name shown (the same name as the file you are printing), or type your own in the File 
Name box.
CorelCHART will print the file to the current directory. 

To print the file to another drive or directory:
Type the path name in the File Name box or select a new drive and directory.
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Printing color separations to an output device
You can print both Spot and four-color process separations from CorelCHART. Desktop laser 
printers are suitable for printing proofs of your separations. To create separations that can 
be used for offset printing, you must use a high-resolution PostScript imagesetter.
You don't actually need an imagesetter connected to your system to create the separations, 
provided you have the appropriate printer driver installed and selected. You can print the 
separations to disk and then output them on another computer connected to the 
imagesetter. 
See also Printing color separations to disk
To print color separations:

1. Choose Print from the File menu.
2. Click the Options button.
3. Choose the Separations option.
4. Enable the printer's references as required.

The printer's references only print when the page size of the chart is smaller than the 
paper size you are printing on. If the page size is 8.5x11 inches, choosing File info within
page will print the File information (file name, date, time and color separation 
information) inside the left margin of your chart. To print outside the margin, the page 
size must be smaller than the paper size.

4. Select any other options you want.
5. Click OK.

By default, CorelCHART prints one page for each of the Process and Spot colors listed. To
print selected colors only, click on the colors you want to print.
To avoid printing spot colors when you are preparing a four-color separation choose the 
Convert Spot Colors to CMYK. As a specified Pantone color may not be matchable with a 
CMYK separation it's a good idea to work with a CMYK palette when creating files for 
output to four-color devices.
You can adjust the screen angle and frequency for each of the four process colors. It's 
best not to change these values unless your service bureau or commercial printer 
advises otherwise to avoid moire patterns.



Overview: Color Models
CorelCHART provides three different color models for creating process colors: CMYK (cyan, 
magenta, yellow, black), RGB (red, green, blue) or HSB (hue, saturation, brightness).
You can create colors using the model you are most comfortable with. If you are going to 
produce color separations, CorelCHART will convert any RGB and HSB colors into their CMYK 
equivalents. The conversion will not be exact, however, since the RGB and HSB models 
create color in a fundamentally different way than the CMYK model.
CMYK Model
The CMYK model, as its name suggests, is based on the colors of the inks used in four-color 
printing. By combining percentages of cyan, magenta, yellow and black, you can reproduce 
virtually any color you want.
The advantage of the CMYK model is that you can specify your colors using CMYK color 
reference charts and be reasonably certain of what the colors will look like when printed. No 
such charts exist for specifying colors with the RGB and HSB models.
When you use the Visual Selector to specify colors, CorelCHART automatically adjusts the 
amount of black through a process called Gray Component Replacement (GCR). If you are 
specifying colors numerically, you must do the gray replacement yourself by entering 
appropriate percentages of black.
If your chart contains large areas of black, you will want to override the GCR process and 
increase the percentages of cyan, magenta and yellow. Doing this makes the blacks look 
much darker. Ask your printer or service bureau for advice on the exact percentages you 
should use.
RGB Model
The RGB color model uses percentages of red, green and blue to create colors. Each 
component has 100 levels of intensity, ranging from black to the component's full intensity. 
Thus, to produce pure red for example, set Red to 100 and Green and Blue to 0. Similarly, 
set Green to 100 and the others to 0 to produce pure green. To produce a dark but pure 
shade of one of the three, lower its setting while leaving the others at 0.
White is produced by setting all three components to 100. Setting them all to 0 produces 
black. Equal amounts of each produces varying shades of gray.
HSB Model
The HSB model, creates color by varying three parameters: hue, saturation and brightness. 
Hue refers to the quality which makes a particular color different from another. Blue, red, 
and green, for example, are all hues. Saturation refers to the purity or intensity of a color. By
varying the intensity, you can make the color lighter or darker. Brightness refers to the 
percentage of black in a color, where 0 percent is black and 100 percent is white.



Using unsupported colors in EPS files
To color separate encapsulated PostScript files for PostScript output devices, Corel VENTURA 
parses EPS files for color comments using Adobe Document Structuring Conventions (DSC). 
This process identifies what Spot and Process colors the files use. 
Where EPS files use Spot or user-defined colors that are not supported by Corel applications 
(including abbreviated Pantone color names, e.g., PANTONE Wm Red), the string "unknown 
PANTONE color" appears in the separation colors list of the Print Options--Separations dialog 
box. The separation will fail, and resulting in an empty separation output. 
To eliminate this problem, do one of the following:

· Deselect the unknown color in the list before printing separations, 
or,

· Recreate the EPS file using only colors recognized by Corel applications.





Data Manager Ribbon Bar
The Data Manager's Ribbon Bar includes (from left) New, Open, Save, Print, Cut, Copy and 
Paste, Import and Export, Set Page Break, Number Format, Borders, Patterns, Go to cell, 
Enter Formula Sort, Auto Recalculate, Grid Lines and Mosaic Rollup. Clicking a Text Ribbon 
Bar button activates the command associated with it. Hold the mouse pointer over a Text 
Ribbon button or list box to see its name or right-click for Context-sensitive Help.
See also Chart View Tools and Ribbon Bars and Data Manager Ribbon Bars



Data Manager Text Ribbon Bar
The Data Manager's Text Ribbon Bar--located just below the Data Manager Ribbon Bar--
includes buttons and drop-down list boxes for setting text attributes such as font type and 
size selection, bold, underline, italic, alignment, inter-character and inter-line spacing. 
Clicking a Text Ribbon Bar button activates the command associated with it. Hold the mouse 
pointer over a Text Ribbon button or list box to see its name or right-click for Context-
sensitive Help.
See also Chart View Tools and Ribbon Bars and Data Manager Ribbon Bars





Mosaic Roll-Up
Displays Corel MOSAIC, a file management application, as a roll-up window in CorelCHART.    
The Mosaic roll-up is used to display a collection of thumbnails, each thumbnail representing
a file. You can use drag and drop to open or import files displayed in the roll-up in your chart 
or spreadsheet.
Two Mosaic roll-up windows can be opened at the same time in an application, allowing you 
to move or copy files between collections using drag and drop. 

Control menu box    
Use to roll up, roll down, close the Mosaic roll-up window, arrange all opened roll-up 
windows or close them all.

Directory drop-down list 
Located immediately below the Control menu box, the directory drop-down list allows you 
to select or change the directory, library or catalog displayed in the Mosaic Roll-Up. A file 
folder icon precedes each directory name in the list, a book icon precedes catalog names 
and a book collection precedes library names.    An open collection, of any type, has an 
open file folder preceding its name.

Open collection button     
Use to open a second Mosaic roll-up window.    It displays the Open Collection dialog box 
where you choose the type of collection you wish to open; directory, library (.CLB) or 
catalog (.CLC).    To open a directory, select the file type you want to see, All Image Files 
to see thumbnails of all graphic files or All Files to see thumbnails of all files in the 
directory.
The Options button displays additional options to sort files, see notes associated and 
keywords associated with them and a Find button to find files that have specific keywords.
The keyword options are not available in every Corel application.

Thumbnail size and orientation
The thumbnail size, orientation and other settings used in the collection are the ones 
saved when the standalone mode of Corel MOSAIC was last used.

Drag and Drop to the application
You can import a file into the application by clicking its thumbnail and dragging it to the 
current document in the application. Files of any files formats supported by CorelCHART 
can be imported.

Moving and copying files between collections
You can copy a file to a different collection by clicking its thumbnail and dragging it to the 
collection of your choice. Holding down the Shift key while dragging the file moves it 
instead of copying it.



Catalog
A collection type in which thumbnails of your files, along with keywords and pointers 
indicating the location of your files are stored. A catalog does not contain the actual files. It 
is used to visually group files that are saved in different directories yet are of related subject 
matter. 



Collection
A general term referring to master files which contain thumbnails.    The thumbnails are 
associated with files and are displayed in a single window in the display screen.    A collection
can be a library, a catalog or a directory. 
A library contains the actual files it shows as thumbnails in a compressed format.    A 
directory contains the files in an uncompressed format. A catalog contains only references 
pointing to files located in various directories and keywords associated them. 



Batch Operations
A task performed on several consecutive graphic files.    Batch printing, importing, 
exporting/converting and extract/merge-back text are available in Corel MOSAIC 
(standalone).



Library
A type of collection in which individual graphics files are stored in a compressed format.



Thumbnails
Small bitmapped representations of graphic files created and saved with original drawing 
files. Thumbnails are used within Corel MOSAIC as a way of organizing, displaying, and 
selecting graphics files visually rather than by filename. 



Corel MOSAIC
A versatile file management utility included with CorelDRAW 5. Corel MOSAIC works in one of
two modes; standalone or roll-up.    The standalone mode, accessed by double-clicking the 
Corel MOSAIC icon in the Corel Applications group, provides full functionality.    It allows you 
to create collections, perform batch operations to graphics files, export files, to name just 
few.    
The roll-up mode displays MOSAIC as a roll-up window within another CorelDRAW 
application. It provides basic functionality by giving you quick access to graphic files and 
allows you to use drag and drop to import or open files within the application.



Choosing a collection
The Mosaic Roll-Up command allows you to open collections of thumbnails of graphic files.    
The visual representation of the files makes it easy and fast to select and manage your 
graphic files.
To choose a collection:

1. Choose Mosaic Roll-Up in the File menu.    The Mosaic roll-up window appears and 
displays a the files of a directory. 

2. Click the directory drop-down list located at the top left corner immediately below the 
control menu box.

3. Choose a collection.    Library files have the .CLB extension and catalogs have the .CLC 
extension.

4. The thumbnails of the graphic files included in the collection appear in the roll-up 
window. Files of a    format not supported by Mosaic appear in the roll-up; a large "X" 
appears instead of a thumbnail.



Opening a second collection
You can have two Mosaic roll-up windows displayed in any Corel application.    This is useful 
when you need to import files from several collections or to move/copy files between 
collections.
To open a second collection:

1. Choose Mosaic Roll-Up in the File menu.    

2. In the Mosaic roll up, click .
3. In the Open Collection dialog box, choose a file type in the List Files of Type drop-
down list box from one of the following:

· .CLC to open a catalog file 
· .CLB to open a library file
·    another file format in the list to open a directory; only the files of the chosen 
format appear.
· All Files or All Image files to display files of any format/any graphic format, included 
in the selected directory.



Resizing the Mosaic roll-up
You may want o resize the roll-up in order to see more thumbnails at one time.
To resize the Mosaic roll-up window:

1. Position the cursor over the horizontal or vertical window border of the Mosaic roll-up 
window.    The cursor changes to a double arrow indicating both directions in which you 
can move the border.    

2. Click and drag the window border until the window is of the desired size.    If you drag 
the window border from a corner, the double arrow is diagonal and allows you to resize 
the roll-up window horizontally and vertically at the same time.



Importing files using drag and drop
The Mosaic roll-up makes it very easy to import graphic files in CorelCHART with the use of 
drag and drop.
To import files in a Corel application using the Mosaic roll-up:

1. In a Corel application, open the document in which you want to import graphics.
2. Choose Mosaic Roll-Up in the File menu.
3. If needed, change the current collection by choosing one in the directory drop-down 

list.
4. Click the thumbnail of the file you want to import. The thumbnail is highlighted.
5. Press and hold down the mouse button, drag the cursor to the application document 

and drop it by releasing the mouse button.
6. The file associated with the thumbnail is imported in CorelCHART.



Moving and copying files using drag and drop
You can open two Mosaic roll-up windows in a given Corel application.    Using drag and drop ,
you can copy or move files between collections displayed in the roll-up windows.
To copy or move files using drag and drop:

1. In a Corel application, choose Mosaic Roll-Up in the File menu.
2. Choose a collection.

3. Open a second collection by clicking the .
4. Click the thumbnail of the file you want to move or copy. The thumbnail is 
highlighted. Press the Ctrl key and click to select multiple thumbnails.
5. Press and hold down the mouse button, drag the cursor to the other Mosaic roll-up 
and drop it by releasing the mouse button to copy the file.    Press the Shift key before 
releasing the mouse button to move the file.
6. A dialog box appears asking you to confirm the move or copy operation.



Open Collection (File menu)
Opens an existing collection (catalog, library or directory) containing graphic files for viewing in the roll-
up window.

The command displays thumbnails of the graphics files included in the collection in the file 
display screen. If a file is not a graphic file, but is a file type recognized by Corel MOSAIC, the
icon representing the program it was created in is displayed.

indicates that the file is in a format that Corel MOSAIC does not recognize. If 
CorelCHART supports the format, you can still import, export and print the file.
You can search for specific files by keywords and choose the order (by name or date) the images will be 
displayed in.

Several collections can be opened at the same time in Corel MOSAIC, allowing you to move or copy files 
between them using drag and drop.

Dialog Box Options
File Name

Displays the files of the selected file type contained in the current directory.    It also lists all catalogs or 
libraries in the current directory. Double-click a collection name and all thumbnails for the files within the
collection display in the display screen.

Directories
Displays a list of directories for selecting catalogs, libraries and directories. Double-click on a directory 
to display the related sub directories and to list all file names of a given format in the File Name box. 

List Files of Type
Displays the file formats available for selection, which include Catalog File(.CLC), Library 
File(.CLB),and supported file formats for all the CorelDRAW applications. When opening a directory, 
choose a specific file type to have only files of that type display in the display screen.    All Files 
displays all files included in a directory and All Image Files displays only files of a graphic nature.

Drives
Lists the drives available for selection.

Preview
When enabled, shows a thumbnail image of the graphics file highlighted in the File Name 
box.

Options >>
Displays additional options for searching and sorting files.

Tip
When viewing a collection containing many files, clicking the window as the files are being 
loaded halts the display. When ready to continue, pressing the ESC key resumes the 
display.



Open Collection Options (File menu)
The following options appear when the Options >> button is clicked in the Open Collection 
dialog box.    Their purpose is to search a collection for files that contain specific keywords 
and display their thumbnail images in the display screen. The keywords are saved with the 
original file, in the application used to create it. Not all Corel applications support the use of keywords.

Dialog Box Options
Sort by Options for sorting files by their file name or date. Both the files listed in the dialog 

box and the thumbnails in the display screen are sorted according to the chosen 
Sort by option.

Subdirectories When selected, Corel MOSAIC searches the current directory and all subdirectories 
below it for graphics files of a specified file format. 

Keywords Displays the indexing terms associated with the selected file. Keywords can be 
associated with CorelDRAW and CorelSHOW files only.

Notes Displays the annotations associated with the selected CorelDRAW file.
Fonts Displays the names of the fonts used in a selected CorelDRAW file.
Find Searches a directory for CorelDRAW files that contain specific keywords and 

displays their thumbnail images in the roll-up window.

Tip
When viewing a collection containing many files, clicking the window as the files are being 
loaded halts the display. When ready to continue, pressing the ESC key resumes the 
display.





Overview: Using CorelCHART Roll-ups
Unlike dialog boxes or drop-down menus, CorelCHART roll-ups remain on screen until 
you close them or exit CorelCHART. And, because they literally roll up and tuck away 
until you need them again, they never get in the way. 
To accept and apply your selections:

· Click Apply
To roll a window up and down:

· Click the arrow in the top right corner, or
· Click the Control button and choose Roll up or Roll down, or
· Double-click the roll-up's Title bar.

To close a Roll-up window:
· Click the Control button and choose Close, or 
· Click the Roll-up window and press the ESC key.

To move a Roll-up window:
· Point to the Title bar, hold the left mouse button down and drag to the new 

location.
To arrange open Roll-up windows:

1. Click the Control button.
2. Choose arrange to roll up the active window and then move it to the top right 

corner of the drawing window, or
3. Choose Arrange All to roll up all open windows and move to the top corners of 

the drawing window.
For Help about Roll-up windows:

· Press Shift+F1 and click the Roll-up, or
· Click the Control button and choose Help.

Like conventional windows, CorelCHART roll-ups include a Control menu button at the 
top left. Click the Control button to choose from the following options:

 Menu item Function
Roll-up/Roll Down A toggle command, the command shown depends on whether 

the menu is currently up or down
Arrange Arranges a single open Roll-ups at the top left of the Drawing 

window
Arrange All Arranges two or more Roll-ups at the top left and or right of 

the Drawing window
Help Opens CorelCHART Online Help
Close Closes a single active Roll-up
Close All Closes all active Roll-ups
Roll-ups also include Maximize and Minimize buttons.



Working with the 3D Roll-up
The 3D Roll-up is enabled, i.e., shown in black on the View menu, when you are 
working with a 3D riser or 3D scatter chart. The 3D Roll-up is used to: 

· alter size, scale and perspective 
· modify length of axes and thickness of walls
· rotate a chart

To execute any of the above 3D Roll-up commands:
1. Click a red arrow on any of the tool buttons (described below) at the top of the 

Roll-up. Deselect Show Graph for a wireframe outline of your chart which reflects 
the changes as you make them.

moves the chart vertically or horizontally diagonally

enlarges or reduces the chart

changes axis lengths

tilts the chart in three dimensions
2. Hold the mouse button down until you achieve the desired result. The longer you hold
down the mouse button, the more of the effect you'll get.
3. Click Redraw if you are satisfied with your results or Undo if you want to try again.
See also 3D Roll-up Command (View Menu)



Choosing chart types
When choosing chart types, you must determine which one best emphasizes the 
point you want to make. Click the categories below for information about each chart 
type and what types of presentations they are suited for.
Bar, Line, Area and Pie charts

Vertical bar chart
Vertical line chart
Vertical area chart
Horizontal bar chart
Horizontal line chart
Horizontal area chart
Pie chart

3D charts
3D Riser chart
3D Floating chart
3D Connect Series chart
3D Connect Group chart
3D Surface chart
3D Scatter chart

Other chart types
Scatter chart
Polar chart
Radar chart
Bubble chart
High-Low-Open-Close chart
Spectrally-mapped chart
Gantt chart
Histogram
Table chart



Vertical bar chart
A chart that uses bars to show the magnitudes of several categories. Bars run 
vertically, while the numeric scale travels in the same direction as the bars.
Vertical Bar chars show how values change over time. In contrast to line charts, 
vertical bar charts are best for a limited time series--just a few years, quarters, 
months, or whatever time period you're working with. Vertical bar charts are good for 
handling multiple series for comparison purposes. 
Subtypes: Side-by-Side, Stacked, Dual Axis Side-by-Side, Dual Axis Stacked, Bipolar 
Side-by-Side, Bipolar Stacked, Percent



Vertical line chart
A chart that uses lines to show the magnitudes of several categories. The numeric 
scale is perpendicular to the lines.
Vertical Line charts are best for showing changes in a group of values over longer 
periods of time. If you're trying to plot three or four series of values on a line chart, 
and they intersect so often you lose track of which is which, consider a vertical bar or
vertical area chart. 
Subtypes: Absolute, Stacked, Bipolar Absolute, Bipolar Stacked, Dual Axis Absolute, 
Dual Axis Stacked and Percent



Vertical area chart
A chart that uses area risers to show the magnitudes of several categories. The 
numeric scale is perpendicular to the areas.
Shows continuous proportions and totals. Like line charts, vertical area charts don't 
handle multiple series well; the areas representing larger quantities tend to obscure 
those representing smaller quantities. If this is the problem with your vertical area 
chart, consider a stacked vertical bar chart. 
Subtypes: Absolute, Stacked, Bipolar Absolute, Bipolar Stacked, Dual Axis Absolute, 
Dual Axis Stacked and Percent



Horizontal bar chart
A chart that uses bars to show the magnitudes of several categories. Bars run 
horizontally, while the numeric scale travels in the same direction as the bars.
Horizontal Bar charts are best for simple comparisons of different individual values at 
one time. If you want to express change in a value or values over time, switch to a 
line, area or 3D riser chart. 
Subtypes: Side-by-side, Stacked, Dual Axis Side-by-Side, Dual Axis Stacked, Bipolar 
Side-by-Side, Bipolar Stacked, Percent



Horizontal line chart
Best for showing changes in a group of values over longer periods of time. If you're 
trying to plot three or four series of values on a line chart, and they intersect so often
you lose track of which is which, consider a horizontal bar or horizontal area chart.
Subtypes: Absolute, Stacked, Bipolar Absolute, Bipolar Stacked, Dual Axis Absolute, 
Dual Axis Stacked, Percent



Horizontal area chart
Useful for graphing data that frequently intersects, making visual tracking easier.
Subtypes: Absolute, Stacked, Bipolar Absolute, Bipolar Stacked, Dual Axis Absolute, 
Dual Axis Stacked, Percent



Pie chart
Shows the relative sizes of data points, compared to their sums. The slices show 
proportions, not absolute values. Slice labels name the slice and can include the 
slice's percentage or its absolute value. 
For multiple pie charts, if you assign each pie to represent a time period, each 
conveys the contribution of parts to a whole and how the whole itself can grow or 
shrink over time.
Subtypes: Pie, Ring Pie, Multiple Pie, Multiple Ring Pie, Multiple Proportional Pie, 
Multiple Proportional Ring Pie



3D Riser chart
Three-dimensional (3D) charts suggest a connection between three groups of data. 
3D Riser charts represent data using three-dimensional bars or other riser shapes 
that rise from the floor of the chart. 
Subtypes: Bar, Pyramid, Octagon and Cut-Corner Bar



3D Floating chart
Three-dimensional (3D) charts suggest a connection between three groups of data. 
3D Floating charts represent data with three-dimensional cubes or spheres in three 
dimensions. 
Subtypes: Cube and Sphere



3D Connect Series chart
Three-dimensional (3D) charts suggest a connection between three groups of data. In
3d Connect Series charts, markers or data points in a series are connected to form 
three-dimensional floating lines or areas, usually representing year-over-year 
economic performance. Ribbon and step lines let you see below them, while areas 
rise from the floor. 
Subtypes: Area, Ribbon and Step



3D Connect Group chart
Three-dimensional (3D) charts suggest a connection between three groups of data. 
Markers or data points in a group are connected to form three-dimensional floating 
"lines" or areas. Ribbon and step lines let you see below them, while areas rise from 
the floor. 
Subtypes: Area, Ribbon and Step



3D Surface chart
Three-dimensional (3D) charts suggest a connection between three groups of data. 
Data points are connected to form a net. The areas between the points are planes 
that can be colored to make the net look like a solid surface rather than a wireframe. 
For large amounts of data, surface charts help show hot spots both high and low 
areas in the data.
A 3D surface with contour lines can be made by activating grid lines for the riser and 
making the edges of the riser surface transparent. 
Subtypes: Surface, Surface with Sides and Honeycomb Surface



3D Scatter chart
Three-dimensional (3D) charts suggest a connection between three groups of data. 
3D scatter chart data is random along all three axes. Unlike the other 3D charts, the 
data is not spaced evenly along the floor (X and Y axes).
Since the data points are floating in space, there are several visual methods to help 
gauge their values: 
· Color by distance from floor, left wall, or right wall
· Tie lines to the floor, left wall, right wall, or neighbor.
Subtypes:  XYZ Scatter and XYX Scatter with Labels



Scatter chart
Show the correlation of two sets of numbers by plotting where the variables intersect.
Scatter charts are useful when the co-ordinates on the horizontal scale--often time 
intervals--are irregular.
Subtypes: X-Y Scatter, X-Y Dual Axes, X-Y with Labels, X-Y Dual Axes with Labels



Polar chart
This chart type is based on an X-Y plane in which each data point represents the 
distance (or radius) and angle from the X axis, i.e., distance, angle.
Subtypes: Single and Dual Axis



Radar chart
Used to display the occurrence of data or the variation of data in relation to each 
other. Several series of data can be represented on a single radar chart. The different 
data points in a series are connected by lines.
Subtypes: Regular, Stacked Radar and Dual Axis Radar



Bubble chart
Similar to a scatter chart, a bubble chart represents three-variable (also known as 
trivariate) data:    the standard X and Y axis and the Z variable, represented by the 
size of the data point or bubble as it is called in this chart type.
Subtypes: Bubble, Dual Axis Bubble, Bubble with Labels and Dual Axis Bubble with 
Labels



High-Low-Open-Close chart
This is a traditional stock-market chart type. Vertical lines indicate the highest and 
lowest values, while horizontal bars indicate the opening and closing values. 
Subtypes: HiLo, HiLo Dual Axes, HiLoOpen, HiLoOpen Dual Axes, HiLoOpenClose, 
HiLoOpenClose Dual Axes



Spectrally-mapped chart
Spectral maps are specialized charts used with data that carries some kind of spatial 
relationship, such as geographical data. Showing a population density across a group 
of contiguous areas of a city would be one application for a spectrally-mapped chart.



Gantt chart
This chart type is used to represent the duration and start and end times of particular
events.



Histogram
Displays the distribution of data. The difference between the largest and smallest 
data values is broken into equally-spaced intervals. The histogram displays a count of
the number of data points in each interval. The shape of the chart is often the 
traditional Gaussian or bell-shaped normal distribution curve.
Subtypes: Vertical Histogram and Horizontal Histogram



Table
Displays data in columns and rows. This format is often used for data that is difficult 
to chart in any other way, or in scientific and technical settings where a graph's data 
is shown next to it in a table.





Maximize button
Clicking on the Maximize button expands the active window to fill the entire screen. After 
you expand a window, the button changes to the Restore button . Use the Restore button 
to return the window to its former size.

· You can also maximize a window by choosing the Control Maximize command.
· You can also restore a maximized window to its former size by choosing the Control 

Restore command.



Minimize button
Clicking on the Minimize button shrinks the window to an icon at the bottom of the screen.

· As an icon, CorelCHART stays in memory, but its window does not take up space on 
your screen.

· To restore the window, double-click on its icon or click once on the icon and choose 
Control Restore.



Restore button 
Restores a window enlarged with the Maximize button or the Control Maximize command to 
its previous size and location.

· You can also restore a window by choosing the Control Restore command.
· Does not affect a window moved or resized with the Control Move or Control Size 

commands.



On Screen Color Palette

The On Screen Color Palette is used in to select outline and fill colors for chart elements and 
spreadsheet data cells. 
To fill an object or data cell, select the object and then click the color you want in the color 
palette with the left mouse button. The object or cell will be filled with the desired color.
To fill an object or data cell's outline, select the object, then click the color you want in the 
color palette. The object or cell's outline will fill with the chosen color.

 Applies a transparent fill or outline
 Scrolls through the color palette
 Displays the palette on several lines to show more colors at once



Title Bar
The CorelCHART title bar shows the name of the program plus the name and location of files 
in fully-expanded presentation windows. For new charts you have not yet saved, the title bar
shows the word "Untitled-1," "Untitled-2," and so forth. If a window is not maximized, 
dragging the title bar moves the window.
The Title Bar may contain the following buttons for controlling the window:

 Maximize button

 Minimize button

 Restore button

 Control Menu button



Toolbox
Includes the eight tools available in Chart View. The toolbox is inoperative in Data Manager. 
The tools perform various functions such as object selection, zoom, text and drawing 
operations. Each tool is described in Chart View Tools and Ribbon Bar.



Menu Bar
CorelCHART's drop-down commands lists. There are two Menu bars, one for Chart View and 
one for Data Manager. For details about the menus and the commands they include see 
Chart View menus and/or Data Manager menus.



Data Manager button 
Use this button to toggle from Chart View to Data Manager. The Data Manager button allows
you to switch from a view of the chart itself to the spreadsheet containing that chart's data.



Printable Page (Chart View)
Only objects within this rectangular area will print. You can adjust the size of the printable 
page in the Page Setup dialog box, opened by choosing File, Page Setup in either Chart view 
or the Data Manager.
Note that the printable page corresponds to the paper size you've specified in the Page 
Setup dialog box, not the printer's "image area," which includes margins. Margin width are 
determined by your printer.



Charting window
Includes everything contained in the large white area of the Chart View window. In 
CorelCHART, you cannot draw or place objects outside the printable page. Click at the top of 
the current charting window during drag and drop operations.



Text Ribbon Bar--Chart View
Gives you quick access to several text formatting options, such as font, size and other text 
attributes in your chart. See also Chart View Tools and Ribbon Bars



Text Ribbon Bar--Data Manager
The Text Ribbon gives you quick access to several text formatting options such as font, size 
and    the user-defined formatting styles to be applied to your spreadsheet text. See also 
Data Manager Ribbon Bars



Control Menu Box 
The Control Menu box displays commands for sizing and positioning the CorelCHART window.
Control Menu boxes are located at the top left of the CorelCHART Title Bar and, for individual 
chart and data files, at the left side of the Menu Bar.



Row buttons
Every row in the Data Manager spreadsheet is numbered. The row button can be used to set 
row height or select an entire row. Data Manager spreadsheets contain 16,384 rows. See 
also Column buttons



Column buttons
All columns in Data Manager spreadsheets are identified by a letter or pair of letters on the 
button at the top of each column. Clicking a column button selects all cells in that column. 
Data Manager spreadsheets have 256 columns. The columns are labeled from A to Z, then 
from AA to AZ and so on up to IF. See also Row buttons



Chart Preview

This section of the Data Manager screen gives you a visual representation of the currently 
selected chart type. When you click the various types of data (e.g., Title or Column header) 
in a spreadsheet, Chart Preview highlights its location in Chart View and its tag appears in 
the Tag List. Clicking a cell in the data range, changes your Chart Preview to a graphic 
representation of a spreadsheet. 



Chart View button 
This button allows you to switch the current window from Data Manager to Chart View. In 
other words, it allows you to switch from the spreadsheet containing the chart data to the 
chart itself. In Chart View, click the Data Manager button to toggle back to your spreadsheet.



Tag list
Contains the names of the "tags" or "labels" you must assign to spreadsheet cells after 
entering data. Tags ensure that the correct cells are used to represent the different chart 
elements--title, axis title, data range and so on. See also How to... Use Data Manager



Formula bar    
Data entered in the Data Manager appears in both the Formula bar and the current cell. The 
cell's address is displayed in the Current Cell Address box to the left of the formula bar. 
Formulas may contain text, numbers or functions. See also Spreadsheet functions



Formula bar    
Data entered in the Data Manager appears in both the Formula bar and the current cell. The 
cell's address is displayed in the Current Cell Address box to the left of the formula bar. 
Formulas may contain text, numbers or functions. Use the following buttons when editing 
formulas:

 Enter button: Enters a completed formula
 Cancel button: Clears a formula

 Current Cell Address box: Identifies the currently active cell
See also Spreadsheet functions



Current Cell Address box 
As its name suggests, this area displays the selected cell's address. The address is made up 
of the column heading and the row number, such as A3 or AB5. If multiple cells are selected,
only the address of the first cell in the range of cells is displayed.



Cancel button 
This button, available only when the cursor is in the Formula bar, abandons changes made 
to a cell's contents when clicked before the current changes are entered. You must click the 
Cancel button or press the Esc key to exit a cell if you enter an invalid formula.



Enter button 
Click this button, available only when the cursor is in the Formula bar, when you have 
finished editing a cell's contents to make your changes take effect. 



Autoscan
Autoscan tags spreadsheet cells automatically for display in your charts by looking for your 
chart elements--title, data range, footnote and so on--in particular places. When placing your
data, you must place the data in the same configurations as the sample data used for the 
sample chart for the chart type you want to create. See also Tagging cells manually and 
Tagging cells automatically



Scroll Bars
Use the scroll bars--located at the bottom and right side of the CorelCHART screen--to move 
through large spreadsheets or zoomed areas of the charting window. See also Scrolling and 
selecting cells

Click To
An arrow move the current view 10% in selected direction
An elevator move the view by one window at a time
A thumb and drag move the view an arbitrary amount in any direction (most useful for 

moving over long distances within a chart or data window)



Data cells
The CorelCHART spreadsheet is made up of data cells. A cell is the white rectangular area 
formed at the intersection of a row and column. Cells contain data in the form of text, 
numbers, values or functions. 
Note:    Text that is wider than the current cell is visible unless the adjacent cell also 
contains data. To display any text hidden in this way, widen its column. Where a number 
contains more digits than can be displayed in the current column width, number signs 
appear in the cell. To display the number correctly, widen its column.
See also Row buttons and Column buttons



Refresh button
Use the refresh button, located at the intersection of the column and row buttons under the 
Chart Preview area, to redraw the active spreadsheet window. Just as when you press 
Ctrl+Home, after a Data Manager refresh the active cell is A1, located at the top left-hand 
corner of the spreadsheet.



Status Line
Displays information about the tools and menu items as you navigate through CorelCHART.



Ribbon Bar--Chart View
The Chart View ribbon bar gives quick access to commands such as cut, copy, paste, data 
analysis, alignment and much more. See also the Tools section



Ribbon Bar--Data Manager
The Data Manager ribbon bar gives quick access to commands such as cut, copy, paste, 
enter formula, sort and much more. See also the Tools section



System Info dialog box
Use System Info to display information about your system, display, network, printing, Corel 
EXEs and dlls and system DLLs.

Dialog Box Options

Choose a category Choose a category from the drop-down list box. The categories are: 
System, Display, network, printing, Corel EXEs and DLLs and 
system DLLs.

List box Displays the system information for the chosen category.
System: information about your computer. For example, Windows 
version, DOS version, processor, and so on.
Display: information about your monitor. For example, driver, driver
version, etcetera.
Network: information about the network. For example, drivers, 
whether a network is installed, etcetera.
Printing: information about installed printers.
Corel EXEs and DLLs: lists all of the Corel EXEs and DLLs.
System DLLs: lists all of the system DLLs.

Save Saves all of the selected category's details to a predefined file.



 Chart View Tools and Ribbon Bars
Click the tools or buttons below for information on how they work. See also Data Manager 
Ribbon Bars

The View menu for 3D charts contains a special 3D Roll-up used to edit three-dimensional 
charts. 
The On-screen Color Palette appears across the bottom of the Chart View window. Most 
elements can be colored by selecting the element with the Pick tool, then clicking a color in 
the color palette.



 Data Manager Ribbon Bars
Click the tools or buttons below for information on how they work.

See also Chart View Tools and Ribbon Bars



Data Manager button 
Click this button to switch to the Data Manager window to enter data for the current chart.

In Data Manager, click the Chart View button to return to Chart View .



Pick tool 
In Chart View, used to select, move or alter objects.
Use the Pick tool to interactively move, stretch and scale objects as well as select text for 
modification. After you select an object, you can use commands in the menus or toolbox to 
alter the object.



Zoom tool 
In Chart View, changes the size of the viewing window. 
Click the Zoom tool icon, move the cursor along the flyout menu to select the required view, 
then release the mouse button. The flyouts are described below, from left to right:

· Zoom In Tool
· Zoom Out Tool
· Zoom To Actual Size Tool--displays objects at the size they will print (the default)
· Zoom To Page Tool--brings all objects into view



Pencil tool 
In Chart View, draws lines, polygons, curves, and arrows.
Click the Pencil tool to open a flyout menu used to choose the desired drawing option.

To draw a straight line, click the option, 
move to where you want to start the line 
and click the mouse button. Hold the 
button and drag the mouse to where you
want the line to end. Release the button.
To draw a polygon, click the option, move
to where you want to start the polygon 
and click the mouse button. Release the 
mouse button and move to another 
location and click again. Repeat this 
process until you have the desired 
shape, then double-click to close the 
polygon.
Used for freehand drawing. Click the 
option, move to where you want to start 
the line and click the mouse button. Hold
the mouse button down while drawing.

Note: Lines and curves drawn with the Pencil tool are automatically assigned the current 
default outline color and thickness attributes. Use the Outline tool to modify these attributes.



Rectangle tool 
In Chart View, draws rectangles and squares. Objects drawn with the Rectangle tool are 
automatically assigned the current default fill and outline attributes. 



Ellipse tool 
In Chart View, draws ellipses and circles. Objects drawn with the Ellipse tool are 
automatically assigned the current default fill and outline attributes.



Text tool 
In Chart View, adds and edits text for annotations of up to 2,048 characters. Text can be 
formatted using the options available in the text ribbon. Click How to... for a list of step-by-
step instructions.



Outline tool 
In Chart View, opens a flyout menu from which you can select outline thickness and color. 
(You can also choose outline colors from the On Screen Color Palette.)

Menu Icons

Outline Pen 
Opens the Outline Pen dialog box where you can enter a custom value for the outline 
thickness, choose an outline color, a dashed or dotted line style, arrowheads and other 
special effects.

Pen Roll-up 
Opens the Pen Roll-up, for quick access to various outline attributes. See Pen Roll-up 
window

None    
Removes outlines from the selected object(s). 

You can also remove outlines by clicking with the right mouse button on the  button 
at the left end of the color palette.

Line Widths 
Selects line thicknesses ranging from 1/4 (hairline), 3, 5, 7, and 9 points.

Outline Color dialog box    
Opens the Outline Color dialog box to choose or create colors to be applied to the outline.

White, Black, Gray    
Offers white, black and successive shades of gray for the outline color.



Outline Pen dialog box
Controls the color, width, shape of the pen used to outline objects. It also allows you to apply
arrowheads, dashed and dotted line styles and calligraphic effects.

Dialog Box Options

Color
Displays the object's current outline color. Clicking the color button displays a drop-down 
palette with other colors you can choose.
Use the scroll bars to see other colors in the list. Clicking More Displays the Outline Color 
dialog box for creating custom colors and selecting them by name.

Width
Varies the thickness of the outline.
A value of 0.00 prints a line one pixel wide at the printer's current resolution. If you 
change to a higher resolution printer, be aware that the line will print much thinner.
If you want to use a different unit of measurement, select it from the units box. 
CorelCHART will automatically convert the displayed value to its equivalent in the unit you
select.

Corners
Controls how outlines are drawn on objects with sharp corners.

Draws mitered corners. You may need to adjust the Miter Limit setting in the 
Preferences dialog box to prevent corner points from extending too far.

Draws rounded corners
Draws blunted corners

Line Caps
Controls how the ends of lines and open curves are drawn.

Squares the line off at each end
Draws round caps extending beyond the ends of the line
Draws square caps extending beyond the ends of the line

Behind Fill
Specifies whether the outline is placed behind, or in front of the object's fill.
When placed behind, only half the outline's thickness will be visible.

Scale With Image
Specifies whether the thickness of the object's outline remains the same or changes in 
proportion to the object's size. If selected, the outline thickness increases when the object
is enlarged (either by scaling or stretching) and decreases when reduced.
Also causes the Pen Shape Angle to rotate along with the object.

Arrows
Displays a selection of arrowheads and symbols you can apply to the ends of lines. The 
left button selects an arrowhead for the beginning of the line, the right button for the end 
of the line. 



Click one of the preview boxes to see the drop-down list of existing arrowheads. Use the 
scroll bars to see other colors in the list. When you find the one you want, click on it. To 
close the box without making a selection, press the ESC key.

Options...
Displays a menu with the following commands.
None Removes the displayed arrowhead.
Swap Puts the arrowhead at the other end of the line.
Edit Displays the Arrowhead Editor which let you change the size and placement 

of the arrowhead.
Delete Deletes the displayed
    From List arrowhead from the list.

Style
Displays a box with a selection of dashed and dotted line styles. Use the scroll bars to see
other colors in the list. When you find the one you want, click on it. To close the box 
without making a selection, press the ESC key.
Dotted lines are created by applying round Line Caps to a line style with short, widely 
spaced segments.

Calligraphy
Controls the shape and orientation of the Outline Pen. Used to create calligraphic pen 
effects.
Nib ShapeShows the effects of varying Angle and Stretch. You can vary Angle and 

Stretch by dragging in this box.
Angle Varies the angle of the pen.
Stretch Changes the Pen Shape from square to rectangular or from round to 

elliptical.
Default Resets Angle to 0.0 degrees and Stretch to 100%.



Pen Roll-up window
The Pen Roll-up window gives you quick access to a variety of outline attributes.
If you choose an attribute with no object selected and then Click the Apply button, a dialog 
box appears allowing you to assign that attribute as the default for a particular type of new 
object. 

Roll-up Controls

Roll window icon 
Hides the controls leaving just the title bar visible.

Thickness Selector 
Selects a line thickness from .001 to 0.5 inches. Each click on the scroll arrows changes 
the thickness by .01 inches. Scroll down repeatedly for the hairline or no outline options.

Arrowhead Selectors 
Displays a box with a selection of arrowheads you can apply to the ends of open paths. 
The left and right selectors let you choose different arrowheads for both ends of the path.
Use the scroll bars to see other arrowheads in the list. When you find the one you want, 
click on it. To close the box without making a selection, press the ESC key.

Line Style Selector 
Displays a selection of dashed and dotted line styles.
Use the scroll bars to see other styles in the list. When you find the one you want, click on
it. To close the box without making a selection, press the ESC key.

Color Selector 
Displays a palette of outline colors. Use the scroll bars to see other colors in the list. 
When you find the one you want, click on it. To close the box without making a selection, 
press the ESC key.
You can rearrange colors in the list by dragging them to different spots.

Update From...
After making changes choose the Apply button.
You can also use Update From to copy another object's outline to the selected object. 
Click the object with the outline you want to copy, Click the Update From... button, then
on the Apply button.

Edit
Displays the Outline Pen dialog box where you can access all of the available Outline Pen 
controls.

Apply
Applies your choices to the selected object.





Outline Color, Uniform Fill and Select Color dialog boxes
Use this dialog box to specify the selected object's outline or uniform fill color using various 
models and custom palettes. As well, you can select colors from existing files in the Mixing 
area.
If you are using a color monitor, remember that the colors you see will not match the printed
colors exactly. To accurately specify Process colors, use the CorelDRAW Process Color Chart. 
If you are choosing colors from the TRUMATCH or FOCOLTONE palettes or either of the 
PANTONE palettes, use the corresponding Color Reference.

Dialog Options

Show
Selects the color model. The options are: CMYK, RGB, HSB, Grayscale, Standard Colors, 
FOCOLTONE, PANTONE Spot colors, PANTONE Process colors, TRUMATCH, Custom Palette.

Preview
The color model selected determines the display of the colors in the Preview box.
CMYK Shows CMYK model and list boxes for each of the components.
RGB Shows RGB model and list boxes for each of the components.
HSB Shows HSB model and list boxes for each of the components.
Grayscale Shows grayscale model and Gray Level list box.
Standard Colors Shows Standard Colors model.
FOCOLTONE Shows FOCOLTONE model, Show Color Names check box and a 

Search for: box.
PANTONE Spot Shows spot colors, Show Color Names check box, Tint and Search 

for: boxes.
PANTONE Process Shows process colors, Show Color Names check box, Tint and 

Search for: boxes.
TRUMATCH Shows TRUMATCH colors, Show Color Names check box, Tint and 

Search for: boxes.
Current/New color Displays the current color in the top half and the new selected color 

in the bottom half. 
New

Field used for the entry of a new color name.
PostScript Options...

Displays the PostScript Options dialog box. Only available when working with Spot colors. 
Used to specify halftone screens for Spot colors. See the Postscript Options dialog box.

Custom Palettes
Click the arrow button to display the following menu choices:    
· Add Color, Delete Color and New palette commands
· Open Palette dialog box
· Save Palette As dialog box 
· Set As default command, used to set the current palette as the default. The Preview

box displays the colors in the selected custom palette.
Mixing Area



Used to choose colors from existing files, the Show Preview box, the Custom Palette 
Preview box or any combination of the three. Click the arrow button to display the 
following menu choices: 
· Load Paint Area File dialog box
· Save Paint Area File As     dialog box  
· Clear paint area command. 

The Paintbrush button paints the selected color in the Paint Area and can mix that color
with colors already in the paint area. The Eyedropper button selects a color from the 
paint area which is then displayed in the Current/New preview box.



Load Paint Area File dialog box
Loads previously mixed paint colors into the Mixing Area.

Dialog Box Options
The File Name, List Files of Type, Directories and Drives lists and boxes allow you to
choose bitmap (.BMP) files from the drives and directories on your computer system. 



Save Paint Area File As dialog box
Saves newly mixed colors in the Mixing Area as bitmaps.

Dialog Box Options
The File Name, List Files of Type, Directories and Drives lists and boxes allow you to
choose bitmap (.BMP) files from the drives and directories on your computer system. 



More Color dialog box
Use this dialog box to specify the selected object's outline or uniform fill color using various 
models and custom palettes. As well, you can select colors from existing files in the Mixing 
area.
If you are using a color monitor, remember that the colors you see will not match the printed
colors exactly. To accurately specify Process colors, use the CorelDRAW Process Color Chart. 
If you are choosing colors from the TRUMATCH or FOCOLTONE palettes or either of the 
PANTONE palettes, then use the corresponding Color Reference.

Dialog Options

Show
Selects the color model. The options are: CMYK, RGB, HSB, Grayscale, Standard Colors, 
FOCOLTONE, PANTONE Spot colors, PANTONE Process colors, TRUMATCH, Custom Palette.

Preview
The color model selected determines the display of the colors in the Preview box.
CMYK Shows CMYK model and list boxes for each of the components.
RGB Shows RGB model and list boxes for each of the components.
HSB Shows HSB model and list boxes for each of the components.
Grayscale Shows grayscale model and Gray Level list box.
Standard Colors Shows Standard Colors model.
FOCOLTONE Shows FOCOLTONE model, Show Color Names check box and a 

Search for: box.
PANTONE Spot Shows spot colors, Show Color Names check box, Tint and Search 

for: boxes.
PANTONE Process Shows process colors, Show Color Names check box, Tint and 

Search for: boxes.
TRUMATCH Shows TRUMATCH colors, Show Color Names check box, Tint and 

Search for: boxes.
Current/New color Displays the current color in the top half and the new selected color 

in the bottom half. 
New

Field used for the entry of a new color name.
PostScript Options...

Displays the PostScript Options dialog box. Only available when working with Spot colors. 
Used to specify halftone screens for Spot colors. See the Postscript Options dialog box.

Custom Palettes 
Click the arrow button to display the following menu choices:    
· Add Color, Delete Color and New palette commands
· Open Palette dialog box
· Save Palette As dialog box 
· Set As default command, used to set the current palette as the default. The Preview

box displays the colors in the selected custom palette.
Mixing Area



Used to choose colors from existing files, the Show Preview box, the Custom Palette 
Preview box or any combination of the three. Click the arrow button to display the 
following menu choices: 
· Load Paint Area File dialog box
· Save Paint Area File As     dialog box  
· Clear paint area command. 

The Paintbrush button paints the selected color in the Paint Area and can mix that color
with colors already in the paint area. The Eyedropper button selects a color from the 
paint area which is then displayed in the Current/New preview box.



#Color Models
CorelCHART provides three different color models for creating process colors: CMYK (cyan, 
magenta, yellow, black), RGB (red, green, blue) or HSB (hue, saturation, brightness).
You can create colors using the model you are most comfortable with. If you are going to 
produce color separations, CorelCHART will convert any RGB and HSB colors into their CMYK 
equivalents. The conversion will not be exact, however, since the RGB and HSB models 
create color in a fundamentally different way than the CMYK model.
CMYK Model
The CMYK model, as its name suggests, is based on the colors of the inks used in four-color 
printing. By combining percentages of cyan, magenta, yellow and black, you can reproduce 
virtually any color you want.
The advantage of the CMYK model is that you can specify your colors using CMYK color 
reference charts and be reasonably certain of what the colors will look like when printed. No 
such charts exist for specifying colors with the RGB and HSB models.
When you use the Visual Selector to specify colors, CorelCHART automatically adjusts the 
amount of black through a process called Gray Component Replacement (GCR). If you are 
specifying colors numerically, you must do the gray replacement yourself by entering 
appropriate percentages of black. 
If your drawing contains large areas of black, you will want to override the GCR process and 
increase the percentages of cyan, magenta and yellow. Doing this makes the blacks look 
much darker. Ask your printer or service bureau for advice on the exact percentages you 
should use.
RGB Model
The RGB color model uses percentages of red, green and blue to create colors. Each 
component has 100 levels of intensity, ranging from black to the component's full intensity. 
Thus, to produce pure red for example, set Red to 100 and Green and Blue to 0. Similarly, 
set Green to 100 and the others to 0 to produce pure green. To produce a dark but pure 
shade of one of the three, lower its setting while leaving the others at zero.
White is produced by setting all three components to 100. Setting them all to 0 produces 
black. Equal amounts of each produces varying shades of gray.
HSB Model
The HSB model, creates color by varying three parameters: hue, saturation and brightness. 
Hue refers to the quality which makes a particular color different from another. Blue, red, 
and green, for example, are all hues. Saturation refers to the purity or intensity of a color. By
varying the intensity, you can make the color lighter or darker. Brightness refers to the 
percentage of black in a color, where 0 percent is black and 100 percent is white.



PostScript Options dialog box
Controls halftone screens used to print the selected object's fill or outline.

· Screens are available only when printing Spot colors to a PostScript printer.
· The effect of varying the halftone screen parameters will not appear on screen, but 

they will show up when printed.
· All other objects except those whose screen settings you specify in this dialog box print

using the screen settings specified in the Print Options dialog box.

Dialog Box Options

PostScript Halftone Screen
Type Lists the types of screens by the shape of the halftone dots.

The Default type uses the printer's default screen parameters unless 
overridden in the Print dialog box. A dot screen with 60 lines per inch at 45 
degrees has typical screen parameters for a 300 dot per inch laser printer.

Frequency Controls the resolution of the screen. The lower the frequency, the more 
apparent the screen will appear when printed.
Choosing an appropriate frequency depends on the resolution of your printer
and the results you want to achieve. For example, settings of 100 or more 
are appropriate when printing on a high-resolution image setter. When 
printing on a 300 dpi laser printer, use a value from 60 to 80. Values below 
40 are useful for creating special effects.
Frequency also affects the number of gray levels in the printed output: the 
higher the frequency, the fewer the number of gray levels.

Angle Controls the angle of the screen.
Screen angle does not change when you rotate or skew an object. These, 
along with other transformations such as stretching and scaling, can 
significantly change the appearance of coarse line screens.



Open Palette dialog box
Use this dialog box to load different Process color palettes supplied with CorelCHART and any
you have modified and saved with the Save Palette As command.

· The default process color palette, loaded when you first installed CorelCHART, is the 
CORELDRW.PAL palette. Another palette with the same colors, PURE99.PAL, is provided as
a backup to the default one.

· The TRUMATCH palette is used to specify Process colors using the TRUMATCH Swatching 
System. By using this palette along with a TRUMATCH color reference book, you can be 
reasonably certain how the colors will look when printed. A similar book is available for 
use with the PANTONE Process palette included with CorelCHART.

· The other Process color palettes differ in the number and range of colors they contain. 
They also differ in the way in which their colors are displayed on the screen: one uses 
dithered color while the others use pure color.

· There is only one Spot color palette, CORELDRW.IPL.

Dialog Box Options

File Name
Select the palette you want to open. Either type the name of the file or select it from the 
list.

Directories
Select the directory in which the palette you want to open is stored.

Drives
Select the drive in containing the file you want to open.

List Files of Type
Select the type of palette--Process or Spot--you want to open.



Save Palette As dialog box
Allows you to save a palette that you have modified by adding, deleting or rearranging 
colors. Creating custom palettes makes it easier to apply colors to complex drawings that 
uses many colors. They also save time when working on different drawings that use the 
same colors.
You can create as many custom palettes you want and load them when required with the 
Load New Palette command.

Dialog Box Options

File Name
Type a name for the new palette. If you want or overwrite an existing palette, select its 
name from the list.

Directories
Select the directory in which you want the palette file stored.

Drives
Select the drive in which you want the palette file stored.

List Files of Type
Shows the type of palette--Process or Spot--being saved.



Fill tool 
In Chart View, displays a menu with a variety of icons used to specify an object's fill. 

Menu Icons

Uniform Fill Color 
Displays the Uniform Fill dialog box for selecting or creating a uniform color fill.

Fill Roll-up Window 
Displays the Fill Roll-up window for quick access to various fills.

None 
Makes the object transparent, allowing objects behind it to show through.

Fountain Fill 
Displays the Fountain Fill dialog box, used to set fountain fills.

Two-Color Pattern 
Displays the Two-Color Pattern dialog box from which you can choose a two-color pattern 
fill.

Full-Color pattern 
Displays the Full-Color pattern dialog box from which you can choose a full-color pattern 
fill.

Bitmap Textures 
Displays the Texture Fill dialog box from which you can choose a Bitmap texture fill.

Pictograph Roll-up 
Displays the Pictograph Roll-up from which you can choose a CorelDRAW (.CDR) picture as
a fill for an object.

Patterns and Solid 
Selects white or black solid fills and various patterns.



Fill Roll-up
The Fill Roll-up window gives you access to color, texture and pattern fills.

Roll-up Controls

Roll window icon 
Hides the roll-up, leaving just the title bar visible.

Uniform Fill 
Displays the current color palette for choosing uniform color fill. When the Uniform Fill 
button is enabled, clicking the Edit button displays the Uniform Fill dialog box for 
choosing a color model and palette.

Fountain Fill 
Displays controls for creating fountain fills.

Clicking the button selects a linear, radial, conical or square fountain.
You can change the angle of a linear fountain and the center of a radial, square or 

conical fountain by dragging the control in the preview box. 
Holding down the CTRL key while dragging, constrains the angle of a linear fountain 

to multiples of 15 degrees and the amount of offset for a radial or conical fountain to 10 
percent increments.

 Colors Displays a palette for choosing the start and end colors. Click the left 
button to specify the start color, the right button to specify the end color. 

Clicking the fountain fill button with no object selected displays a dialog box for 
assigning the currently displayed fountain as the default fill for a particular type of new 
object.

Two-Color pattern Fills 
Displays controls for selecting and coloring two-color pattern fills.

 Colors Displays a palette used in choosing foreground and background colors. 
Click the left button to specify a foreground color, the right button to specify a background 
color. 

          Pattern List Clicking the white preview box displays a list of patterns. Click 
the pattern you want and choose OK. Choosing Cancel ignores your selection and closes the
list.

Choosing File displays a menu for saving, deleting, and importing patterns
Delete Item: Deletes the selected pattern from the list.
Import Pattern: Displays another dialog box used to create a pattern from an 

imported graphic.
Note: For best results, limit the use to no more than two-colors in the graphic you 

import.
Tile Displays two squares in the selected object. Dragging the control point in the squares
stretches or scales sets the tile size to use to apply the pattern. A small tile size results in a 



smaller size pattern; a bigger tile size makes the pattern bigger, therefore more visible.

Bitmap Textures 
Displays controls for selecting and editing bitmap texture fills.

 Texture List Clicking the white preview box displays a list of textures. Click the 
texture you want and choose OK. Choosing Cancel ignores your selection and closes the 
list.
          Select the Texture Library containing the texture you want.

Click the name of the texture you want.
Edit 

Displays a different dialog box depending on the type of fill. See, Fountain Fill, Two-Color 
Fill Pattern, Full-Color Fill Pattern or Bitmap Texture  dialog box.

Full-Color pattern Fills 
Displays controls for selecting two-color pattern fills.

 Pattern List Clicking the white preview box displays a list of patterns. Click the 
pattern you want and choose OK. Choosing Cancel ignores your selection and closes the list.

Choosing File displays a menu for saving, deleting and importing patterns.
Delete Item: Deletes the selected pattern from the list.
Import Pattern: Displays another dialog box used to create a pattern from an 

imported graphic.
Tile Displays two squares in the selected object. Dragging the control point in the squares
stretches or scales sets the tile size to use to apply the pattern. A small tile size results in a 
smaller size pattern; a bigger tile size makes the pattern bigger, therefore more visible.
Apply

Applies your choices to the selected object.



Fountain Fill dialog box
Displays controls for creating fountain fills.

Dialog Box Options

Preview Box Shows you how the fountain fill will look with the colors you have chosen.
Type Select the type of fountain you want to create.

Linear Selects a fountain fill that changes color in one direction.
Radial Selects a fountain fill that changes color in concentric circles from

the center of the object outwards.
Conical Selects a fountain fill that radiates from the center of the object 

like rays of light.
Square Selects a fountain fill that changes color in concentric squares 

from the center of the object outwards.
Palette Contains colors you can select to create a custom fountain.
Center Offset Repositions the center of a radial, conical, or square fountain fill so that

it no longer coincides with the center of the object. Negative values shift the 
center down and to the left; positive values shift the center up and to the 
right.
You can also move the center by dragging the crosshairs that appear when 
you click anywhere in the Preview box. For Conical fountains, you must hold 
down the SHIFT key will dragging.
Holding down the CTRL key while dragging, constrains the amount of offset to 
10 percent increments.

Options Adjust any of these settings to customize the appearance of the fountain.
Angle
Determines the angle of gradation in a linear, conical, or square fountain fill. 
The Preview box shows the effect of changing the angle.
If you rotate the object, the fountain angle adjusts automatically.
You can also change the angle by dragging the line that appears when you 
click anywhere in the Preview box. Use the right mouse button (or the left 
mouse button and SHIFT) to change the angle for conical and square 
fountains.
Holding down the CTRL key while dragging, constrains the angle to multiples of
15 degrees.
Steps
Displays the number of bands used to display and print the fountain. You can 
change these settings for the selected object by clicking the Lock button and 
entering a value in the text box.
Edge Pad
Increases the amount of start and end color in the fountain fill. Used primarily 
with circles and irregularly shaped objects in which the first and/or last few 



bands of color lie between the object and its highlighting box. This option is 
not available for conical fountain fills, and therefore, is greyed out.

Color Blend Indicate the colors you want to use.
Direct
Takes the intermediate colors along a straight line beginning at the From color
and continuing across the color wheel to the To color.
Rainbow
Takes the intermediate colors from a path around the color wheel. You can 
specify the direction the path takes by clicking the rotation buttons. The From
and To colors coincide with endpoints of the path.
Custom
You can select up to 99 intermediate colors from the palette at the right of the
dialog box. Specify where you want the color to appear by adding markers 
above the preview box. There are two ways to do that:
· double-clicking just above the preview box.
· select the "to" or "from" color squares at either end of the preview ribbon 

and specify a new value in the Position box.
After adding a marker choose a color from the palette.
To reposition a color, select its marker and drag it to the desired spot or edit 
the value in the Position box.
To delete a color, double-Click the marker.
Note: More than one color marker can be selected at a time be holding down 
the SHIFT key when selecting or deselecting.

Presets You can save the fountain settings you specified so that you can apply them to
other objects. Type a name in the Presets box then click the plus sign. 
Clicking the minus sign removes the selected settings from the Preset list.



Two-Color Pattern dialog box
Use this dialog box to select, edit, create and import Two-Color patterns.

Dialog Box Options

Preview Box
Displays the pattern, if any, in the selected object. The display changes as you choose 
patterns from the Selection Box and adjust the Tile Size and Tile Offset settings.

Pattern List    
Clicking the arrow in the top right corner of the preview box displays a list of patterns. 
Click the pattern you want and choose OK. Choosing Cancel ignores your selection and 
closes the list.
Choosing File displays a menu for deleting, and importing patterns.
Delete Item Deletes the selected pattern from the list.
Import Pattern Displays another dialog box used to create a pattern from an 

imported graphic.
Note:    Graphics you import should use no more than two colors for best 
results.

Create
Displays the Two-Color pattern Editor which you can use to create your own patterns and 
edit certain existing ones.

Import
Displays another dialog box used to create patterns from imported images in any of the 
formats CorelCHART supports.

Back/Front Color
Clicking the color boxes displays a list of colors you can apply to the background and 
foreground of the pattern.
Use the scroll bars to see other colors in the list. Clicking the More button displays the 
Uniform Fill dialog box which you can use to create custom colors and select colors by 
name.

Small, Medium, Large
Selects a pattern tile size of 0.25x0.2, 50.50x0.50, or 1.00x1.00 inches.

PostScript Options
Displays the PostScript Options dialog box. If you are producing spot color separations, 
you can use this dialog box to specify halftone screens.

Tiling
Displays additional controls for sizing and offsetting the tiles that make up the pattern.
Width/Height Specifies a custom pattern tile size up to 3x3 inches.

If you want to use a different unit of measurement, open the units 
list then choose the unit you want.

First Tile Offset Specifies the placement of the first tile relative to the upper left 



corner of the object's highlighting box.
Row/Column Offset Shifts alternating rows or columns by the amount specified.
Scale Pattern If checked, the pattern will be scaled as you scale the object.
with Object Otherwise, the pattern keeps its size when you scale the object; it is

repeated more times if the object is enlarged, fewer if it is reduced.



Two-Color Pattern Editor
Used to create your own Two-Color patterns. You can also edit existing patterns provided 
their resolution is no more than 64x64 pixels. If the selected pattern's resolution is too high, 
it will not appear in the editor's charting area when you choose the Create button in the 
previous dialog box.

Dialog Box Options

Drawing Area
You create patterns by clicking with the left mouse button to fill a square with black, or 
the right mouse button to fill it with white. Holding down the mouse button as you draw 
enables you to fill a wide area of pixels.
Each square represents a pixel. The Bitmap Size options specify the number of pixels 
which in turn determines the resolution of the pattern.

Bitmap Size
Determines the resolution of the pattern. Choose the smallest size (16x16) to create 
simple patterns consisting of rectangular shapes and horizontal or vertical lines. For more 
intricate patterns with curves and diagonal lines, use one of the other two sizes.
Note: If you choose a Bitmap Size option, whatever you have drawn up to that point will 
be erased. Also, if you Click OK without drawing anything, an empty pattern is created. 

Pen Size
Determines how many pixels are filled when you click in the charting area. For example, 
2x2 fills four pixels at a time.



Full-Color Pattern dialog box
Used to choose a full color fill pattern and specify the size of the tiles that make up the 
pattern. Also used to shift the entire pattern inside the object you are filling and stagger the 
individual pattern tiles.

Dialog Box Options

Preview Box
Displays a tile of the selected pattern.

Pattern List     
Clicking the arrow in the top right corner of the preview box displays a list of patterns. 
Click the pattern you want and choose OK. Choosing Cancel ignores your selection and 
closes the list.
Choosing File displays a menu for deleting, and importing patterns.
Delete Item Deletes the selected pattern from the list.
Import Pattern Displays another dialog box used to create a pattern from an imported 

graphic.
Load

Displays a dialog box for you to load full-color patterns saved in other directories.
Import

Displays another dialog box used to create a pattern from an imported graphic.
Tiling

Displays additional controls for sizing and offsetting the tiles that make up the pattern.
Small, Medium Selects a pattern tile size of 0.25x0.2, 50.50x0.50 or 1.00x1.00 

inches.
Large
Width/Height Specifies a custom pattern tile size up to 3x3 inches. 

If you want to use a different unit of measurement, open the units 
list then choose the unit you want.

First Tile Offset Specifies the placement of the first tile relative to the upper left 
corner of the object's highlighting box.

Row/Column Offset Shifts alternating rows or columns by the amount specified.
Scale Pattern with Object

If checked, the pattern will be scaled as you scale the object. Otherwise, the pattern 
keeps its size when you scale the object; it is repeated more times if the object is 
enlarged, fewer if it is reduced..



Texture Fill dialog box
Use this dialog box to select one of the 100-plus bitmap texture fills included in CorelCHART. 
Each texture has a set of parameters that you can change to create millions of variations.

· Bitmap textures add significantly to the size of your file and the time it takes to print. 
As such, you should avoid filling numerous and/or large objects with them.

· The textures look best on color monitors. If you are using a monochrome monitor, you 
may not get a very good representation of the texture's appearance.

· When you rotate an object with a texture fill, the fill does not rotate.
· Resizing an object with a texture fill can distort the texture. To restore its appearance, 

open the Bitmap Texture dialog box and choose OK.

Dialog Box Options

Texture Library
Select the library that contains the texture you want. The Samples and Textures libraries 
contain textures which you can alter and save for later use. When you save them, 
however, you must store them in another library. You cannot save modified textures to 
the Styles Library.

Texture List
Displays textures in the selected library. Click the one you want.

Preview
Varies the appearance of the selected texture by randomly changing all unlocked 
parameters. Lock and unlock parameters by clicking the Lock icon next to it.
You must use the Preview button to update a texture after changing the parameters 
manually.

Save
After changing the parameters of a texture in a library choose save to overwrite the 
original. Textures from the styles library cannot be overwritten but can be saved to 
another library.

Save As
Opens the Save Texture As dialog box for naming (or renaming) a texture you've created.

Delete
Deletes the selected texture. You can only delete textures from any library but the Styles 
Library. When you click the Delete texture button, a dialog box appears asking for 
confirmation before the style is deleted.

Style Name <texture name>
Lists parameters for the selected texture. Changing one or more of these parameters 
alters the appearance of the texture. 
Note:    Available parameters change depending on the type of texture selected. Some of 
the bitmap textures available in the three categories include: aerial photography, biology,
blend corners, blend edges, bubble mania, clouds, cosmic, cotton, drapes, eclipse, fiber, 
flames, hypnotic, leather, mandel, mineral, noise, patches, pizzazz, pottery wheel, putty, 



raindrops, recycled paper, rings, ripples, rock and water colors.
The left side of the Style Name field lists up to six numeric parameters. All textures have 
a Texture Number parameter which ranges from 0 to 32,768. The names of the other 
parameters vary with the texture and have a range from 0 to 100 or -100 to 100.
To change a numeric parameter, enter a value in the text box and click the Preview 
button.
The right side of the field lists up to six color parameters. To change a color, click the 
color button (e.g., Shade, Mid-Shade, Light) and choose a new color from the pop-up 
palette. Click the More button if you want to create a color or choose one by name from 
the More Color dialog box. To see the effect a new color has on the texture, click the 
Preview button.



Save Texture As dialog box
Use this dialog box to save a modified texture under its own name. Saving a texture makes it
easier to apply to other objects later on. You can also create and rename libraries in this 
dialog box.

Dialog Box Options

Texture Name
Type a name up to 32 characters (including spaces).

Library Name
Type a name in this box if you want to create a new library in which to store the textures 
you create. You can type up to 32 characters (including spaces).

Library List
Select the library you want to store the modified texture in.
Note: You must save modified Style textures in a new library.





Text Ribbon
The Text Ribbon appears across the top of the main screen and gives you quick access to 
several text formatting options.



Font Name list box    
Type or select the typeface you want to apply.    CorelCHART includes over 825 fonts 
available in both True Type or Type 1 formats.    See also Font Management



Font Size list box      
Type or select the point size you want to apply.



Bold button    
Applies or clears bold formatting.



Italic button    
Applies or clears italic formatting.



Underline button    
Applies or removes underlining from selected text or cell contents.



Left Alignment button    
Aligns text with the left side of its bounding box.



Center Alignment button    
Centers text in its bounding box.



Right Alignment button    
Aligns text with the right side of its bounding box.



Justify button    
Increases spacing between characters to align the text with the left and right sides of its 
bounding box.



Wide Spacing button 
Increases spacing between characters.



Single Spacing button 
Decreases spacing between lines.



Double Spacing button 
Increases spacing between lines.



Narrow Spacing button 
Decreases spacing between characters.



Display Status button 
Gives you quick access to the Display Status dialog box to choose hidden or displayed chart 
elements.



Legend button 
Gives quick access to the Legend dialog box for controlling how the chart legend will look on 
screen.



Number format button 
Use this button to change the formatting of numeric values displayed on your chart.



Data Analysis button 
Gives quick access to the Data Analysis dialog box.



Align objects button 
Aligns objects on the chart page horizontally or vertically. See also Align command



3D Roll-up button 
Displays the 3D Roll-up window for controlling the orientation, perspective, elements size 
and proportions and other attributes specific to 3D charts. The button is only available when 
the current chart is a 3D chart. Otherwise it is dimmed. See also 3D Roll-Up



Copy Chart button 
Copies the current chart to the clipboard.



Show as Pictograph button 
This button is available for bar charts and histograms. It divides the bar risers in equal 
sections allowing you to select images, symbols or clipart with which to fill the bars to create
a pictograph.



Wireframe button 
Displays the chart in wireframe mode. Only the chart's outline and other objects' outlines 
appear on screen. This increases the speed at which you work as the redraw is much faster.



Numeric format button      
Displays the numeric dialog box where you can modify the format of one or several cells and
create custom formats. See also Numeric dialog box



Border button      
Displays the Borders dialog box, used to emphasize selected cells by adding ruling lines or 
borders. See also Borders command



Display Grid button      
Press this button to display or turn off the grid.



Auto Recalc button      
Press this button to activate, or deactivate the Auto Recalc feature which automatically 
recalculates dependent formulas every time you make a change to a value or formula.



Chart View button 
Click this button to switch to Chart View.



Style list box
Drop-down list of available styles for the current spreadsheet. The styles are used to format 
cells. You can create and save styles. See Styles command.



Auto alignment button 
Auto alignment gives numeric entries a right alignment and a left alignment to text entries.



Center Across Selection button 
Centers one or several cells' contents across a range of several cells.



Open file button 
Opens chart and corresponding spreadsheet files. See also Open command



Save file button 
Saves your chart or spreadsheet.    See also Save command



Print button 
Prints your chart or spreadsheet. See also Print command (Chart View) or Print command 
(Data Manager)



New file button 
Opens the New Chart dialog box. See also New command



Cut button 
Cuts selected annotations from the current chart and places them onto the clipboard



Copy button 
Places a copy of the selected annotations to the clipboard.



Paste button 
Pastes a cut or copied annotation from the clipboard onto the current chart.



Import button 
Imports graphics in your chart or data for your spreadsheet. See also Import command 
(Chart View) or Import command (Data Manager)



Export button 
Exports your chart or data for use in other applications. See also Export command (Chart 
View) or Export command (Data Manager)



Page break button 
Inserts a manual page break in your spreadsheet. See also Set Page Break command



Center alignment button    
Centers text and numerical values in cells.



Pattern button 
Applies a pattern to the selected cell(s). See also Patterns command



Go To button 
Moves to a specific cell using that cell's address. 



Enter Formula button 
Opens the Enter Formula dialog box.



Sort button 
Sorts the selected data according to the criteria and order you select.



Mosaic Roll-up button 
Displays the Mosaic file management utility as a Roll-up window. The Mosaic Roll-up allows 
you to drag and drop files in your current CorelCHART document.



Screen/menu Help button 
Displays a question mark pointer.    Click a screen item or an available menu command    to 
get information about the item chosen.



3D Tool Roll-up
Open the 3D Roll-up by choosing 3D Roll-up from the View menu when the current chart is a 
3D riser or 3D scatter. You can use the 3D Roll-up to: 

· alter size, scale and perspective 
· modify the length of axes and thickness of walls
· rotate charts

Click a red arrow and hold the mouse button down until you achieve the desired result. The 
longer you hold down the mouse button, the more of the effect you'll get. Caution:    You 
cannot undo a movement after you select the redraw button.
Button/
Check box Action

Moves the chart vertically or diagonally forward and backward.

Makes the chart larger or smaller without changing its position on the page.
2D Pan moves the chart vertically or diagonally anywhere on the page without 

changing the size of the chart.
3D Perspective controls the chart's perspective by making part of the chart appear 

closer and larger and part of the chart appear further away and smaller. The less parallel the
lines of the chart are, the more distorted the chart is. The chart can become very distorted 
as though seen through a fisheye lens or have very little distortion as seen through a 
telephoto lens. Increasing distortion can give the chart a dramatic look and emphasize data 
by placing it closer to the viewer.

Changes the length of any of the axes.

Tilts the chart in three dimensions.
Show Graph Clearing the box leaves a wire-frame outline reflecting changes in the 

original chart.

Undo Undoes the changes you have made and returns you to the chart 
window.

Redraw Redraws the chart to show changes.



Pictograph Roll-up
Used to fill an object with an imported graphic. Clicking an object and then selecting the 
picture will fill the entire object with that picture.
Choose Show as Pictograph from the Chart menu. Select any bar in a series and select a 
picture from the Pictograph Roll-up. Multiple copies of the picture will form each bar. The size
of each picture is set by the width of the bars and the frequency of the major grid lines on 
the data axis.

Roll-up Controls

Roll-up window icon 
Hides the controls leaving just the title bar visible.

Pattern List 
Clicking in the preview box displays a list of patterns. Click the pattern you want and 
choose OK. Choosing Cancel ignores your selection and closes the list.

Choosing File displays a menu for saving, deleting and importing patterns.

Delete Item Deletes the selected pattern from the list.
Import Pattern Displays another dialog box that lets you create a pattern from an 

imported    graphic.
Import

Displays another dialog box that lets you create a pattern from an imported graphic.

Apply
Applies your choices to the selected object.



The topics below are duplicates of some topics located above in the file.    They 
were duplicated (and adapted a bit)so that they could be included in the browse 
sequence for Data Manager as well as Chart View tools.    The characters _DUP 
were added to each context string. They have no keywords so will only be 
accessed with the Browse buttons.



Open file button 
Opens a chart and its corresponding spreadsheet files. See also Open command



Save file button 
Saves your chart or spreadsheet.    See also Save command



Print button 
Prints your chart or spreadsheet. See also Print command (Chart View) or Print command 
(Data Manager)



New file button 
Creates a new file. See also New command



Cut button 
Cuts selected data from the current spreadsheet and places it on the clipboard



Copy button 
Places a copy of the selected cells in the Clipboard.



Paste button 
Pastes cut or copied data onto the current spreadsheet.



Import button 
Imports graphics in your chart or data for your spreadsheet. See also Import command 
(Chart View) or Import command (Data Manager)



Export button 
Exports your chart or data for use in other applications. See also Export command (Chart 
View) or Export command (Data Manager)



Mosaic Roll-up button 
Displays the Mosaic file management utility as a Roll-up window. The Mosaic Roll-up allows 
you to drag and drop files in your current CorelCHART document.



Screen/menu Help button 
Displays a question mark pointer.    Click a screen item or an available menu command    to 
get information about the item chosen.



Font Name list box    
Type or select the typeface you want to apply



Font Size list box    
Type or select the point size you want to apply.



Bold button    
Applies or clears bold formatting.



Italic button    
Applies or clears italic formatting.



Underline button    
Applies or removes underlining from selected cell contents. 



Left alignment button    
Aligns text and numbers with the left side of the current cell.



Right alignment button    
Aligns text and numbers with the right side of the current cell.



Technical Support
The Technical Support Help file contains information pertaining to:

· New features
· Corel Support Services
· Common Error Messages
· Printing Information
· Import and Export File Filter information
· INI files
· and other technical information

Please click the highlighted text below to open the Technical Support Help file. 
Technical Support



Spreadsheet Functions: An Alphabetical Listing
ABS() Calculates the absolute value of a number
ACCRINTM() Calculates interest accrued on a security returning interest upon 

maturation
ACOS() Calculates the inverse cosine of the expression
ACOSH() Calculates the inverse hyperbolic cosine of the expression
AND() Result is 1 if all arguments in the list are TRUE and 0 if only one is 

FALSE
ANGSTROMS Converts linear measures into angstroms
ASIN() Calculates the inverse sine of the expression
ASINH() Calculates the inverse hyperbolic sine of a value
ATAN() Calculates the inverse tangent of the expression
ATANH()                        Calculates the inverse hyperbolic tangent of a number
ATOMMAS Converts mass measures into atom mass units (u)
AVEDEV() Calculates the average of absolute deviations of values in a data list 

from the mean
AVG() Calculates the average of the range or list of arguments
BESSELI() Calculates the modified Bessel function In(x)
BESSELJ() Calculates the Bessel function Jn(x)
BESSELK() Calculates the modified Bessel function Kn(x)
BESSELY() Calculates the Bessel function Yn(x)
BETADIST()                    Calculates the cumulative beta probability density distribution, widely 

used in the statistical testing of production quality
BETAINV()                     Calculates the inverse value of the cumulative beta probability density 

function
BINOMDIST() Calculates the magnitude of the individual term binomial probability 

distribution
CEILING()                      Calculates the number rounded to the nearest multiple of significance
CELSIUS Converts temperature values into Celsius
CHAR() Returns the number of the Windows font character from 1 to 255 

referenced by your computer
CHIDIST()                      Calculates the one-tailed probability of the chi-squared ( ) distribution
CHIINV()             Calculates the inverse of the chi-squared ( ) distribution
CHITEST()          Calculates the result of the test of independence
CHOOSE() Chooses the specified number from a list based on the index number 

given
CLEAN() Deletes non-printable Windows font characters from 1 to 255 

referenced by your computer from the text string
CNT() Calculates the number of cells in a range containing only numbers and 

formulas
CNTA() Calculates the number of cells in the range containing data
CODE() Result is a numeric code matching the code used in the Windows 

character set for the first character in the given string
COLUMNS() Calculates the number of columns in a list
COMBIN()                      Calculates the number of combinations of a given size from a given 

population without regard to order.
CONFIDENCE()              Calculates the confidence interval, in accordance with known 



probability, for a population mean
CORREL() Calculates the correlation coefficient between two ranges of data
COS()                            Calculates the cosine of an angle
COSH()                          Calculates the hyperbolic cosine of a number
COUPDAYBS() Calculates the duration of the coupon period in days from the 

beginning to date of settlement
COUPDAYS() Calculates the duration of the coupon period (in days) when the 

settlement occurs
COUPDAYSNC() Calculates number of days between date of settlement and the next 

coupon issue date
COUPNCD() Calculates the next coupon date following date of settlement
COUPNUM() Calculates coupons payable between the date of settlement and date 

of maturation
COUPPCD() Calculates coupon date prior to the date of settlement
COVAR() Calculates covariance, the average of the products of paired 

deviations, of two ranges of data.
CRITBINOM() Calculates the smallest value for which the accumulated binomial 

distribution is greater than or equal to a criterion value
CUMIPMT() Calculates cumulative interest paid from the first to last periods 

specified
CUMPRINC() Calculates cumulative principal paid against a loan from first to last 

periods specified
CUPS Converts volume measures into cups
DATE() Calculates the serial value of a specified date
DATEVALUE() Converts date values to serial values for use in formulas
DAY() Calculates the day of the month for the given serial value, returning an

integer from 1 to 31 inclusive
DAYS360() Calculates a value for the number of days between two dates based on

a 360-day year
DAYS Converts time measures into days
DB() Uses the fixed-declining balance method to calculate real depreciation 

of assets over a given period
DDB() Uses the double-declining balance method to calculate asset 

depreciation 
DDE/External Creates a Dynamic Data Exchange with a DDE server application. Use 

DDE/External to link data directly to Data Manager from DDE-compliant
spreadsheets.

DEGREES Converts radian angular measures into degrees
DELTA() Tests whether two numbers are equal
DEVSQ() Calculates the sum of the squared deviations of data points from their 

sample mean
DISC() Calculates securities' discount rates
DOLLAR() Rounds a numeric value to a given number of decimals using financial 

format and returns the result as text
DOLLARDE() Converts dollar prices from fractions to decimals
DOLLARFR() Converts dollar prices from decimals to fractions
DYNES Converts mass measures into dynes
EFFECT() Calculates effective annual interest rate



ERF() Calculates the error function
ERFC() Calculates the value of the complementary error function integrated 

between x and infinity
EVEN()                          Rounds the expression up to the nearest even integer
EXP()                             Raises e to a given exponent
EXPONDIST() Calculates the magnitude of the exponential distribution probability
Exponential Functions              Used in the multiplication of metric measures
FACT()                           Calculates the factorial of the expression
FACTDOUBLE()              Calculates the double factorial of the expression
FAHRENH Converts temperature values into Fahrenheit
FALSE() Result is the logical value 0
FDIST()                          Calculates the F probability distribution
FEET Converts linear measures into feet
FIND() Finds the substring txt in the text string intxt beginning with the 

specified position st. Result is the number of position in intxt where 
the substring is situated.

FINV()                            Calculates the inverse of the F probability distribution
FISHER() Calculates the Fisher transformation
FISHERINV() Calculates the inverse of the Fisher transformation
FIXED() Rounds a numeric value to a given number of decimals and converts 

the result to text 
FLOOR()                        Rounds a real number to the nearest multiple at the given significance
FORECAST()                  Calculates predicated values along a linear regression
FTEST()                         Calculates the result of the F-test, which checks the variance of two 

samples to determine whether they are significantly different
FV() Calculates future value of investments where interest rates and 

periodic payments are constant
FVAL() Calculates future value of investments where payments and interest 

rates are constant in each period
FVSCHEDULE() Applies compound interest rates and computes projected value of the 

initial principal
GALLONS Converts volume measures into gallons
GAMMADIST() Calculates the magnitude of the gamma distribution
GAMMA Calculates the Gamma function, G(x)
GAMMAINV()                 Calculates the inverse of the gamma cumulative distribution
GAMMALN() Calculates a value for the natural logarithm of the gamma function, 

G(x)
GCD()                            Calculates the greatest common divisor--the largest integer that 

divides each number in the list without leaving a remainder--of a series
of numbers. 

GEOMEAN() Calculates the geometric mean of a data range containing only positive
values

GESTEP() Compares two values; result is 1 if num is  step and 0 if not
GRAMS Converts mass measures into grams
HARMEAN() Calculates the harmonic mean of a data range
HLOOKUP() Scans through the top row of the table or range from left to right (a) searching
for the first instance of the value x, and (b) selecting the value a given number of rows down
HORSEPOWS Converts power measures into horsepower
HOUR() Converts the serial value for a given time value to an integer representing 



hours from 0 to 23 inclusive
HOURS Converts time measures into hours
HYPGDIST() Calculates the hypergeometric distribution probability
IF() Result is one of the specified values depending on the logical condition
INCHES Converts linear measures into inches
INT()                              Calculates the integer value of the expression
INTERCEPT()                  Calculates the intercept of the linear regression
INTRATE() Calculates fully invested securities' interest rates
IPMT() Calculates interest payments for investments for a set period based on 

a constant interest rate
IRR() Calculates an internal rate of return for a range of cash flows
ISBLANK() Result is 1 if the argument refers to a blank cell and 0 otherwise
ISERROR() Result is 1 if the argument refers a cell containing an error value and 0 

otherwise
ISEVEN() Result is 1 if the argument is an even number and 0 otherwise
ISNONTEXT() Result is 1 if the argument refers to non-text data
ISNUMBER() Result is 1 if the argument refers to a cell containing a number and 0 

otherwise
ISODD() Result is 1 if the argument is an odd number and 0 otherwise
ISTEXT() Result is 1 if the argument refers to a cell containing text and 0 

otherwise
KELVIN Converts temperature values into Kelvin
KURT() Calculates the kurtosis coefficient of a data range
LARGE()                        Calculates the specified largest value in a data range
LCM()                            Calculates the least common multiple of two or more integers
LEFT() Finds the specified number of initial characters in the text string and 

returns the characters as a text string
LEN() Result is the number of characters in the text string
LITERS Converts volume measures into liters
LN()                               Calculates the natural log of the expression
LOG()                            Calculates the log of an expression to a given base
LOG10()                        Calculates the log base 10 of the expression
LOGINV()                       Calculates the inverse magnitude of the lognormal distribution
LOGNORDIST()              Calculates the magnitude of the lognormal distribution probability
LOWER() Converts any uppercase letters in a text string to lower case
MAX() Returns the highest number in the data range
MDETERM()                   Calculates the matrix determinant of an array
MEDIAN()                      Returns the median value in the data range
METERS Converts linear measures into meters
MID() Returns the number of characters in a text string, beginning at a given 

position
MIN() Returns the lowest number in the data range
MINUTE() Calculates a minute value from 0 to 59 inclusive for a serial value
MINUTES Converts time measures into minutes
MIRR() Calculates a modified internal rate of return for a list of values
MOD()                           Calculates the modulus (remainder) of expression 1 divided by 

expression 2
MODE()                         Calculates the value of the most frequently repeated data points in the 



data range
MONTH() Converts a serial value for a month to an integer from 1 to 12 inclusive
MROUND()                    Rounds a number to a specified multiple
MULTINOM()                  Calculates the multinomial of a list of expressions, a ratio of the 

factorial of the sum of the list to the product of factorials
nCOLUMN() Calculates the number of the column for the cell    where nCOLUMN is 

executed
NEGBINDIST() Calculates negative binomial distribution
NEWTONS Converts mass measures into Newtons
NMILES Converts linear measures into natural miles
NOMINAL() Calculates an annual nominal interest rate
NORMDIST()                  Calculates the magnitude of the normal distribution for the specified 

mean and standard deviation
NORMINV()                    Calculates inverse magnitude of the normal distribution
NORMSDIST()                Calculates the standard normal distribution function
NORMSINV()                  Calculates inverse magnitude of the standard normal distribution
NOT() Result is the reverse of the logical expression
NOW Calculates the serial value for the current date and time held in your 

computer's operating system
NPER() Calculates the number of periods, or payments, needed to repay a loan

based on the given payment, interest rate per period and amount of 
principal 

NPV() Calculates the net present value of a loan for the given interest rate 
and list of payments. Use this function when payments will not be 
constant.

nROW() Calculates the number of the row for the cell containing nROW
ODD()                           Rounds up an expression to the nearest odd integer
OR() Result is 1 if any argument in the list is TRUE and 0 if all arguments are

FALSE
OUNCES Converts mass measures into ounces
PAYMT() Calculates the periodic payment for annuities where payments and 

interest rates are constant
PCT                               Divides the number given as an argument by 100
PEARSON()                    Calculates the Pearson product moment correlation coefficient
PERCENTILE()                Calculates the k-th percentile of the values contained in a data range
PERCRANK()                  Calculates the percentage rank of a value contained in a data range 

compared with the other values
PERMUT() Calculates how many permutations may result from a defined number 

of objects
PI()                                Calculates the value of p
PINTS Converts volume measures into pints
PMT() Calculates the periodic payment for the given principal amount, 

interest rate per period and number of regular payment periods. PMT 
assumes that interest is paid at the end of each period.

POISSON()                     Calculates the Poisson probability distribution
POODS Converts mass measures into poods
POUNDS Converts mass measures into pounds
PPMT() Calculates payment against principal for investments for given periods.



Payments and interest rates are constant.
PRICE() For securities returning periodic interest, PRICE calculates price for 

each $100 face value
PRICEDISC() For each $100 face value of discounted securities, PRICEDISC 

calculates sale price
PRICEMAT() For securities paying interest upon maturation, PRICEMAT calculates 

price per $100 face value 
PROB()                          Calculates the probability that the values belong to the specified 

interval
PRODUCT()                   Calculates the product of a list of expressions
PROPER() Converts the first letter in each word of the given text string to upper 

case
PV() Calculates an investment's present value, the total present worth of a 

series of future payments
QUARTILE()                   Calculates the representation of placement and dispersion of a random

variable value
QUARTS Converts volume measures into quarts
QUOTIENT()                  Calculates the integer portion of x/y
RADIANS Converts angular measures expressed in degrees to radians
RAND()                          Calculates a random number between zero and one
RANK()                          Calculates the rank of a number in an array of values
RATE() Calculates annuity interest rates per period
RECEIVED() For fully invested securities, RECEIVED calculates amount paid upon 

maturation
REPLACE() Replaces specified number of characters of the text string from the 

start position with the new string
RIGHT() Computes the number of end characters in the text string, returning 

the result as text 
RNDBETW()                   Calculates a random number between two specified numbers
ROMAN() Rounds the value to an integer and converts it to a Roman numeral
ROUND()                       Rounds an expression to a specified number of decimal places
ROWS() Calculates the number of rows referenced in a list
RSQ()                            Calculates the square of the Pearson product moment correlation 

coefficient
SEARCH() Result is the position of the substring text1 in the text string text2
SECOND() Calculates seconds given as a serial value to an integer from 0 to 59 

inclusive
SECONDS Converts time measures into seconds
SERIESSUM()                 Calculates the sum of a power series
SGN()                            Determines the sign of a number
SIN()                             Calculates the sine of an angle
SINH()                           Calculates the hyperbolic sine of an expression
SKEW() Calculates the skewness of a distribution
SLN() Calculates depreciation for an asset for a single period using the 

straight-line method of depreciation
SLOPE()                         Calculates the linear regression slope
SLUGS Converts mass measures into slugs
SMALL()                        Calculates the specified smallest value in a data range



SMILES Converts linear measures into sea miles
SQRT()                          Calculates the positive square root of the expression
SQRTPI()                        Calculates the positive square root of the expression multiplied by p

STANDDIZE()      Calculates a standardized value for a variable
STD() Calculates an estimate of standard deviation of the numbers in the range
STDP() Calculates the standard deviation for a population based on the numbers in the range
STEYX()                         Calculates the standard error of the forecast y-value for the x-values of 

a regression
SUBST() Searches for the given substring in the text string and replaces it with 

a new one
SUM()                            Adds the values in a list of arguments
SUMPROD()                   Calculates the sum of the products of corresponding arrays
SUMSQ()                       Calculates the sum of the squares of all the parameters in a list
SUMX2MY2()                 Calculates the sum of the difference of squares of corresponding values

in two ranges
SUMX2PY2()                  Calculates the sum of the sum of squares of corresponding values in 

two ranges
SUMXMY2()                   Calculates the sum of squares of differences of corresponding values in

two ranges
SYD() Calculates depreciation for an asset for given periods using the 

straight-line method of depreciation
TABLESPS Converts volume measures into tablespoons
TAN()                             Calculates the tangent of an angle
TANH()                          Calculates the hyperbolic tangent of the expression
TBILLPRICE() Calculates Treasury bill price per $100 face value
TBILLYIELD() Calculates Treasury bill yields
TDIST()                          Calculates a student's T-distribution with df (degrees of freedom)
TEASPS Converts volume measures into teaspoons
TIME() Calculates a serial value for a specified time. The returning value is a 

decimal fraction from 0 to 0.9999999999 inclusive
TIMEVALUE() Converts the current time from text to a serial value
TINV()                           Calculates the inverse of a student's T-distribution with df (degrees of 

freedom)
TODAY() Calculates the serial value corresponding to the current date held in 

your computer's operating system
TONS Converts mass measures into tons
TRIM() Deletes spaces in text strings, leaving only single spaces between 

words
TRIMEAN()                     Calculates the mean of a range within a data range
TRUE() Result is the logical value 1
TRUNC()                        Truncates an expression to an integer with a specified number of digits
TTEST()                         Calculates the probability involved with a student's T-test
TYPE() Result is a number indicating the data type in a specified cell
UPPER() Converts lower-case letters in a text string to upper case
VALUE() Converts a text argument to a number
VAR() Estimates the variance of the numbers in a data range
VARP() Calculates the variance of a population for the numbers in the range



VDB() Calculates depreciation of assets for specified periods using the double
declining balance or other specified methods

VLOOKUP() Scans down the lefthand column of the table or range, searching for 
the first occasion of the value x, then selecting the value a given 
number of columns to the right

WATTS Converts power measures into watts
WEEKDAY() Calculates a day of the week for a given serial value. The value 

returned is a positive integer between one and seven, where one is 
equal to Sunday, two is equal to Monday, and so on.

WEIBULL() Calculates the magnitude of the Weibull probability distribution
XIRR() Calculates internal rate of return for regular or irregular cash flow 

schedules
XNPV() Calculates net present value for regular or irregular cash flow 

schedules
YARDS Converts linear measures into yards
YEAR() Calculates a year between 1900 and 2077 for a given serial value
YEARS Converts time measures into hours
YIELD() Calculates yield on securities returning periodic interest
YIELDDISC() Calculates discounted securities' annual yield
YIELDMAT() For securities paying interest upon maturation, YIELDMAT calculates 

annual yield
ZTEST()                         Calculates the two-tailed probability for the standard normal 

distribution and a standard score for x relative to the data range



Exponential Functions
The exponential functions below can be used in conversion formulas involving metric 
measures:

    Exponential Exponential
    Function Value Function Value

exa deci

peta centi

tera milli

giga micro

mega nano

kilo pico

hecto femto

deka atto

Syntax

exponential function(value, "current units")

    Arguments Definitions
value any value you want to convert
current units the current unit of measure

Example
To convert 2 centimeters into feet, write the following formula:
= feet(2, "centimeters")
= 6.5616798E-2



ATOMMAS
Description

Converts mass measures into atom mass units (u)
Syntax

ATOMMAS(exp, unit)

    Arguments Definitions
exp a real value representing a mass measure (in units specified by the 

second argument) to be converted into atom units
unit a text string representing any mass unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

ATOMMAS returns the #BAD DATA! error value if the second argument is an unrecognized 
mass unit.

Example
ATOMMAS(1,"grams")      = 6.02217E+23 u



GRAMS
Description

Converts mass measures into grams
Syntax

GRAMS(exp, unit)

    Arguments Definitions
exp a real value representing a mass measure (in units specified by the 

second argument) to be converted into grams
unit a text string representing any mass unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized mass unit GRAMS returns the #BAD DATA! error
value.

Example
GRAMS(1000,"milligrams")      = 1 gram



DYNES
Description

Converts mass measures into dynes
Syntax

DYNES(exp, unit)

    Arguments Definitions
exp a real value representing a mass measure (in units specified by the 

second argument) to be converted into dynes
unit a text string representing any mass unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized mass unit DYNES returns the #BAD DATA! error 
value.

Example
DYNES(1,"newtons")      = 1000 dynes



NEWTONS
Description

Converts mass measures into Newtons
Syntax

NEWTONS(exp, unit)

    Arguments Definitions
exp a real value representing a mass measure (in units specified by the 

second argument) to be converted into Newtons
unit a text string representing any mass unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized mass unit NEWTONS returns the #BAD DATA! 
error value.

Example
NEWTONS(1,"kilograms")      = 9.81 Newtons



OUNCES
Description

Converts mass measures into ounces
Syntax

OUNCES(exp, unit)

    Arguments Definitions
exp a real value representing a mass measure (in units specified by the 

second argument) to be converted into ounces
unit a text string representing any mass unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized mass unit OUNCES returns the #BAD DATA! 
error value.

Example
OUNCES(1,"kilograms")      = 35.27397 ounces



POODS
Description

Converts mass measures into poods
Syntax

POODS(exp, unit)

    Arguments Definitions
exp a real value representing a mass measure (in units specified by the 

second argument) to be converted into poods
unit a text string representing any mass unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized mass unit POODS returns the #BAD DATA! error
value.

Example
POODS(16.033,"kilograms")      = 1.00000474 poods



POUNDS
Description

Converts mass measures into pounds
Syntax

POUNDS(exp, unit)

    Arguments Definitions
exp a real value representing a mass measure (in units specified by the 

second argument) to be converted into pounds
unit a text string representing any mass unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized mass unit POUNDS returns the #BAD DATA! 
error value.

Example
POUNDS(454,"grams")      = 1.000898803 pounds



SLUGS
Description

Converts mass measures into slugs
Syntax

SLUGS(exp, unit)

    Arguments Definitions
exp a real value representing a mass measure (in units specified by the 

second argument) to be converted into slugs
unit a text string representing any mass unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized mass unit SLUGS returns the #BAD DATA! error 
value.

Example
SLUGS(1,"tons")      = 69.6184 slugs



TONS
Description

Converts mass measures into tons
Syntax

TONS(exp, unit)

    Arguments Definitions
exp a real value representing a mass measure (in units specified by the 

second argument) to be converted into slugs
unit a text string representing any mass unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized mass unit TONS returns the #BAD DATA! error 
value.

Example
TONS(1016,"kilograms")      = 1 ton



ANGSTROMS
Description

Converts linear measures into angstroms
Syntax

ANGSTROMS(exp, unit)

    Arguments Definitions
exp a real value representing a linear measurement (in units specified by the

second argument) to be converted into angstroms
unit a text string representing any length unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized length unit ANGSTROMS returns the #BAD 
DATA! error value.

Example 
ANGSTROMS(1,"micrometers")      = 10,000 angstroms



FEET
Description

Converts linear measures into feet
Syntax

FEET(exp, unit)

    Arguments Definitions
exp a real value representing a linear measurement (in units specified by the

second argument) to be converted into feet
unit a text string representing any length unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized length unit FEET returns the #BAD DATA! error 
value.

Example
FEET(1,"yards")      = 3 feet



INCHES
Description

Converts linear measures into inches
Syntax

INCHES(exp, unit)

    Arguments Definitions
exp a real value representing a linear measurement (in units specified by the

second argument) to be converted into inches
unit a text string representing any length unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized length unit INCHES returns the #BAD DATA! 
error value.

Example
INCHES(1,"yards")      = 36 inches



METERS
Description

Converts linear measures into meters
Syntax

METERS(exp, unit)

    Arguments Definitions
exp a real value representing a linear measurement (in units specified by the

second argument) to be converted into meters
unit a text string representing any length unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized length unit METERS returns the #BAD DATA! 
error value.

Example
METERS(1,"nmiles")      = 1852 meters



NMILES
Description

Converts linear measures into natural miles
Syntax

NMILES(exp, unit)

    Arguments Definitions
exp a real value representing a linear measurement (in units specified by the

second argument) to be converted into natural miles
unit a text string representing any length unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized length unit NMILES returns the #BAD DATA! 
error value.

Example
NMILES(1,"smiles")      = 0.868976242 natural miles



SMILES
Description

Converts linear measures into sea miles
Syntax

SMILES(exp, unit)

    Arguments Definitions
exp a real value representing a linear measurement (in units specified by the

second argument) to be converted into sea miles
unit a text string representing any length unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized length unit SMILES returns the #BAD DATA! 
error value.

Example
SMILES(1,"nmiles")      = 1.150779448 sea miles



YARDS
Description

Converts linear measures into yards
Syntax

YARDS(exp, unit)

    Arguments Definitions
exp a real value representing a linear measurement (in units specified by the

second argument) to be converted into yards
unit a text string representing any type of length unit included in 

CorelCHART's Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized length unit YARDS returns the #BAD DATA! 
error value.

Example
YARDS(1,"nmiles")      = 2025.371829 yards



DAYS
Description

Converts time units into days
Syntax

DAYS(exp, unit)

    Arguments Definitions
exp a real value representing a time period (in units specified by the second 

argument) to be converted into days
unit a text string representing any time unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized time unit DAYS returns the #BAD DATA! error 
value.

Example
DAYS(1,"years")      = 365.2422 days



HOURS
Description

Converts time units into hours
Syntax

HOURS(exp, unit)

    Arguments Definitions
exp a real value representing a period of time (in units specified by the 

second argument) to be converted into hours
unit a text string representing any time unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized time unit HOURS returns the #BAD DATA! error 
value.

Example
HOURS(1,"years")      = 8765.8128 hours



MINUTES
Description

Converts time units into minutes
Syntax

MINUTES(exp, unit)

    Arguments Definitions
exp a real value representing a period of time (in units specified by the 

second argument) to be converted into minutes
unit a text string representing any time units included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized time unit MINUTES returns the #BAD DATA! 
error value.

Example
MINUTES(1,"years")      = 525948.768 minutes



SECONDS
Description

Converts time units into seconds
Syntax

SECONDS(exp, unit)

    Arguments Definitions
exp a real value representing a period of time (in units specified by the 

second argument) to be converted into seconds
unit a text string representing any type of the available time units

Notes and Error Messages
If the second argument is an unrecognized time unit SECONDS returns the #BAD DATA! 
error value.

Example
SECONDS(1,"years")      = 31556926.08 seconds



YEARS
Description

Converts time units into hours
Syntax

YEARS(exp, unit)

    Arguments Definitions
exp is a real value representing a period of time (in units specified by the 

second argument) to be converted into years
unit is a string representing any time unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized time unit YEARS returns the #BAD DATA! error 
value.

Example
YEARS(1,"gigaseconds")      = 31.68876454 years



DEGREES
Description

Converts radian angular measures into degrees
Syntax

DEGREES(angle_in_rad)

    Arguments Definitions
angle_in_rad is a real value in radians to be converted into degrees

Example
DEGREES(pi)      = 180 degrees



RADIANS
Description

Converts angular measures expressed in degrees to radians
Syntax

RADIANS(angle_in_degr)

    Arguments Definitions
angle_in_degr a real value in degrees to be converted into radians

Example
RADIANS(180)      = 3.141592654 radians



TEASPS
Description

Converts volume measures into teaspoons
Syntax

TEASPS(exp,unit)

    Arguments Definitions
exp a real value representing a volume measure (in units specified by the 

second argument) to be converted into teaspoons
unit a text string representing any volume unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized volume unit TEASPS returns the #BAD DATA! 
error value

Example
TEASPS(1,"tablesps")      = 3 teaspoons



TABLESPS
Description

Converts volume measures into tablespoons
Syntax

TABLESPS(exp,unit)

    Arguments Definitions
exp a real value representing a volume measure (in units specified by the 

second argument) to be converted into tablespoons
unit a text string representing any volume unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized volume unit TABLESPS returns the #BAD DATA! 
error value.

Example
TABLESPS(3,"teasps")      = 1 tablespoon



CUPS
Description

Converts volume measures into cups
Syntax

CUPS(exp,unit)

    Arguments Definitions
exp a real value representing a volume measure (in units specified by the 

second argument) to be converted into cups
unit a text string representing any volume unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized volume unit CUPS returns the #BAD DATA! 
error value

Example
CUPS(1,"liters")      = 4.225833333 cups



PINTS
Description

Converts volume measures into pints
Syntax

PINTS(exp,unit)

    Arguments Definitions
exp a real value representing a volume measure (in units specified by the 

second argument) to be converted into pints
unit a text string representing any volume unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized volume unit PINTS returns the #BAD DATA! 
error value.

Example
PINTS(1,"pints")      = 1 pint



QUARTS
Description

Converts volume measures into quarts
Syntax

QUARTS(exp,unit)

    Arguments Definitions
exp a real value representing a volume measure (in units specified by the 

second argument) to be converted into quarts
unit a text string representing any volume unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized volume unit QUARTS returns the #BAD DATA! 
error value.

Example
QUARTS(1,"pints")      = 0.5 of a quart



GALLONS
Description

Converts volume measures into gallons
Syntax

GALLONS(exp,unit)

    Arguments Definitions
exp a real value representing a volume measure (in units specified by the 

second argument) to be converted into gallons
unit a text string representing any volume unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized volume unit GALLONS returns the #BAD DATA! 
error value.

Example
GALLONS(1,"pints")      = 0.125 of a gallon



LITERS
Description

Converts volume measures into liters
Syntax

LITERS(exp,unit)

    Arguments Definitions
exp a real value representing a volume measure (in units specified by the 

second argument) to be converted into liters
unit a text string representing any volume unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized volume unit LITERS returns the #BAD DATA! 
error value.

Example
LITERS(1,"gallons")      = 3.786235457 liters



CELSIUS
Description

Converts temperature values into Celsius
Syntax

CELSIUS(exp,unit)

    Arguments
exp a real value representing a temperature measure (in units specified by 

the second argument) to be converted into Celsius
unit a text string representing any type of the temperature units included in 

CorelCHART's Conversion Functions
Notes and Error Messages

If the first argument is an invalid value of temperature in the scale given by the second 
parameter or the second argument is an unrecognized temperature unit CELSIUS returns 
the #BAD DATA! error value.

Example
CELSIUS(273.15,"kelvin")      = 0 Celsius



FAHRENH
Description

Converts temperature values into Fahrenheit
Syntax

FAHRENH(exp,unit)

    Arguments Definitions
exp a real value representing a temperature measure (in units specified by 

the second argument) to be converted into Fahrenheit
unit a text string representing any temperature unit included in CorelCHART's

Conversion Functions
Notes and Error Messages

If the first argument is an invalid value of temperature in the scale given by the second 
parameter or the second argument is an unrecognized temperature unit FAHRENH returns 
the #BAD DATA! error value.

Example
FAHRENH(100,"celsius")      = 212 degrees Fahrenheit



KELVIN
Description

Converts temperature values into Kelvin
Syntax

KELVIN(exp,unit)

    Arguments Definitions
exp a real value representing a temperature measure (in units specified by 

the second argument) to be converted into Kelvin
unit a text string representing any temperature unit included in CorelCHART's

Conversion Functions
Notes and Error Messages

If the first argument is an invalid value of temperature within the scale given by the 
second parameter or the second argument is an unrecognized temperature unit KELVIN 
returns the #BAD DATA! error value.

Example
KELVIN(-273.15,"celsius")      = 0 degrees Kelvin



HORSEPOWS
Description

Converts power measures into horsepower
Syntax

HORSEPOWS(exp,unit)

    Arguments Definitions
exp a real value representing a power measure (in units specified by the 

second argument) to be converted into horsepower
unit a text string representing any power unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized power unit HORSEPOWS returns the #BAD 
DATA! error value.

Example
HORSEPOWS(1,"kilowatts")      = 1.34102



WATTS
Description

Converts power measures into watts
Syntax

WATTS(exp,unit)

    Arguments Definitions
exp a real value representing a power measure (in units specified by the 

second argument) to be converted into watts
unit a text string representing any power unit included in CorelCHART's 

Conversion Functions
Notes and Error Messages

If the second argument is an unrecognized power unit WATTS returns the #BAD DATA! 
error value.

Example
WATTS(1,"horsepows")      = 745.7010335 watts





Conversion Functions
CorelCHART 5 provides the following conversion functions used for interchanging a wide 
array of units of measure:    

Function                      Description
Exponential Functions       Used in the multiplication of metric measures
Linear measures
ANGSTROMS Converts linear measures into angstroms
FEET Converts linear measures into feet
INCHES Converts linear measures into inches
METERS Converts linear measures into meters
NMILES Converts linear measures into natural miles
SMILES Converts linear measures into sea miles
YARDS Converts linear measures into yards
Mass
ATOMMAS Converts mass measures into atom mass units (u)
GRAMS Converts mass measures into grams
DYNES Converts mass measures into dynes
NEWTONS Converts mass measures into Newtons
OUNCES Converts mass measures into ounces
POODS Converts mass measures into poods
POUNDS Converts mass measures into pounds
SLUGS Converts mass measures into slugs
TONS Converts mass measures into tons
Time
DAYS Converts time measures into days
HOURS Converts time measures into hours
MINUTES Converts time measures into minutes
SECONDS Converts time measures into seconds
YEARS Converts time measures into hours
Angles
DEGREES Converts radian angular measures into degrees
RADIANS Converts angular measures expressed in degrees to radians
Volumes
TEASPS Converts volume measures into teaspoons
TABLESPS Converts volume measures into tablespoons
CUPS Converts volume measures into cups
PINTS Converts volume measures into pints



QUARTS Converts volume measures into quarts
GALLONS Converts volume measures into gallons
LITERS Converts volume measures into liters
Power
HORSEPOWS Converts power measures into horsepower
WATTS Converts power measures into watts
Temperature
CELSIUS Converts temperature values into Celsius
FAHRENH Converts temperature values into Fahrenheit
KELVIN Converts temperature values into Kelvin





Date and Time Functions
Date and Time Functions are multipliers that help you compute serial values for dates and 
times for use in a wide range of mathematical calculations. Click any of the Date and Time 
Functions shown at left below for more details on how they work. Note: DATEVALUE, 
DAYS360 and TIMEVALUE are the only Date and Time Functions which normally recognize 
alphanumeric values. 
See also Entering dates and times and Using alphanumeric date and time values
Date Functions
Function Description
DATE() Calculates the serial value of a specified date
DATEVALUE() Converts date values to serial values for use in formulas
DAY() Calculates the day of the month for the given serial value, returning an 

integer from 1 to 31 inclusive
DAYS360() Calculates a value for the number of days between two dates based on a

360-day year
MONTH() Converts a serial value for a month to an integer from 1 to 12 inclusive
WEEKDAY() Calculates a day of the week for a given serial value. The value returned 

is a positive integer between one and seven, where one is equal to 
Sunday, two is equal to Monday, and so on.

YEAR() Calculates a year between 1900 and 2077 for a given serial value
Time Functions
HOUR() Converts the serial value for a given time value to an integer 

representing hours from 0 to 23 inclusive
MINUTE() Calculates a minute value from 0 to 59 inclusive for a serial value
NOW Calculates the serial value for the current date and time held in your 

computer's operating system
SECOND() Calculates seconds given as a serial value to an integer from 0 to 59 

inclusive
TIME() Calculates a serial value for a specified time. The returning value is a 

decimal fraction from 0 to 0.9999999999 inclusive
TIMEVALUE() Converts the current time from text to a serial value
TODAY() Calculates the serial value corresponding to the current date held in your

computer's operating system



DAYS360
Definition

Calculates a value for the number of days between two dates based on a 360-day year
Syntax

DAYS360(sdate, edate)
 Arguments Description
sdate start date: integers expressed in date and time formats recognized by the 

Data Manager
edate end date: integers expressed in date and time formats recognized by the 

Data Manager
Notes:

The argument can be given as text, such as "15-Jan", or numerically.
If sdate occurs after edate, the function returns a negative value.
Day, month and year must be separated by hyphens "-" or obliques "/", and hours, minutes
and seconds by obliques.

Examples
DAYS360("2.9.53","2.9.53") = 
DAYS360((DATEVALUE("14-Feb"),(DATEVALUE("12-Dec")) = 301
DAYS360(33660,33690) = 30

Associated Function
DAY



DATE
Definition

Calculates the serial value of a specified date
Syntax

DATE(day, month, year)
 Arguments Description

day integers from 1 to 31 inclusive
month integers from 1 to 12 inclusive
year integers from 1, the serial value for Dec. 31, 1899, to -1, the serial value 

for June 4, 2079 inclusive
Notes and Error Messages

The day value must be valid for the month, i.e., if month is 6 (June) then day cannot be 
greater than 30, because June has only 30 days.
To convert the serial value, display the result of the DATE function as a date, apply a Date 
Format to the cell using the Numeric Format Interpreter.
Use alphanumeric dates with this function or convert them using DATEVALUE; otherwise 
DATE returns a syntax error message.
Use commas or semicolons as separators; using hyphens will return a list separator error 
message.

Example
DATE(25,2,94) = 34390, the serial value for February 25, 1994

Associated Functions
DATEVALUE and NOW



DATEVALUE
Definition

Converts date values to serial values for use in formulas
Syntax

DATEVALUE("text")
 Argument Description

"text" any alphanumeric date enclosed in quotation marks and corresponding to 
any Data Manager date format

Note:
If you use alphanumeric dates, separate them by obliques or hyphens. Periods are not 
recognized.

Examples
DATEVALUE("7.1.92") = #BAD DATA!
DATEVALUE("7/1/92") = 33786, the serial value for July 1, 1992
DATEVALUE("Jan-12-1994") = 34346

Associated Functions
DATE and TIMEVALUE



NOW
Definition

Calculates the serial value for the current date and time held in your computer's operating 
system

Syntax
NOW

Notes:
The whole number portion of the real number produced represents today's date; the 
decimal portion represents the current time.
To display the result of NOW in a specific date format, apply a Data Manager date format to
the cell.
If you omit a serial value, Data Manager will automatically compute the current date and 
time.
Be sure column-width settings are wide enough to permit full display of the number. See 
also Adjusting column width using the mouse

Example
If today's date is February 24, 1994, and the time 4:00:53 PM, the NOW function produces 
34389.66573.
To turn the above date and time serial value (34389.66573) into a date and time, click the 
right mouse button on its Data Manager cell, select Numeric and choose a date and time 
format. The date and time will then display in a conventional format.

Associated Functions
DATE, YEAR, MONTH, DAY, HOUR and MINUTE



TIME
Definition

Calculates the serial value for a specified time. The returning value is a decimal fraction 
from 0 to 0.9999999999 inclusive.

Syntax
TIME(hh, mm, ss)

 Arguments Description
hh hours:    integers from 0 (representing midnight) to 23 inclusive
mm minutes:    integers from 0 to 59 inclusive
ss seconds:    integers from 0 to 59 inclusive

Note: To display the result of TIME as a conventional time, apply a Data Manager time 
format to the cell.

Example
TIME(16,15,50) computes the serial value for 4:15:50 PM, which is 0.67766.

Associated Functions
TIMEVALUE



TIMEVALUE
Definition

Converts the current time from text to a serial value
Syntax

TIMEVALUE(text)
 Argument Description

text any textual time format recognized by the Data Manager enclosed in 
double quotation marks

Notes and Error Messages:
If the argument is mistaken, the function returns the #BAD DATA! error value.
Use TIMEVALUE to convert time entered as text to its serial value for use in calculations.

Example
TIMEVALUE("1:45 PM") produces the serial value 0.572916667

Associated Functions
TIME



TODAY
Description

Calculates the serial value corresponding to the current date held in your computer's 
operating system

Syntax
TODAY

Note: To display the result of the TODAY function as a date, apply a Data Manager date 
format to the cell.

Example
TODAY(any date value) produces a serial value corresponding to the current date.

Associated Functions
NOW and DAY



DAY
Description

Calculates the day of the month for the given serial value, returning an integer from 1 to 
31 inclusive

Syntax
DAY(serial value)

 Argument Description
serial value any real number which can be derived from a date and/or time code

the whole number portion of the serial value represents the number of 
days since December 31, 1899
numbers shown to the right of the decimal point represent the number of 
seconds since midnight for the day entered

Note:
Convert alphanumeric dates to serial values before using day, or, if you use text and 
numbers, separate them by obliques or hyphens and nest the DATEVALUE function in the 
formula, e.g., July-16-1994.

Examples
DAY(DATEVALUE("July-16-1994")) = 16
DAY(DATEVALUE("7/16/1994")) = 16
DAY(34531) = 16

Associated Functions
DATE, YEAR, SECOND, HOUR and MINUTE



HOUR
Description

Converts the serial value for a given time value to an integer representing hours from 0 to 
23 inclusive

Syntax
HOUR(serial value)

 Arguments Description
serial value any real number which can be derived from a date and/or time code

numbers shown to the right of the decimal point represent seconds from 
midnight for the day entered

Example
HOUR(0.4999) = 11

Associated Functions
DATE, YEAR, SECOND, DAY and MINUTE



MINUTE
Description

Calculates a minute value from 0 to 59 inclusive for a serial value
Syntax

MINUTE(serial value)
 Arguments Description

serial value any real number which can be derived from a date and/or time code
numbers to the right of the decimal point represent seconds from midnight
for the day entered

Notes and Error Messages:
If the argument is negative, the function returns the #BAD DATA! error value.
The argument can be given as text, such as "1:15:00 PM" or as a number.

Examples
MINUTE((TIMEVALUE("1:15:00 PM")) = 15
MINUTE(9.48) = 31

Associated Functions
DATE, YEAR, SECOND, DAY and HOUR



MONTH
Description

Converts a serial date value for a month to an integer from 1 to 12 inclusive
Syntax

MONTH(serial value)
 Argument Description

serial value any real number which can be derived from a date and/or time code
the whole number portion of the serial value represents the number of 
days since December 31, 1899
numbers shown to the right of the decimal point represent seconds from 
midnight for the day entered

Notes and Error Messages:
Convert alphanumeric dates to serial values before using MONTH, or, if you use text and 
numbers, separate them by obliques or hyphens and nest the DATEVALUE function in the 
formula, e.g., MONTH(DATEVALUE(July-16-1994).
If the argument is negative, the function returns the #BAD DATA! error value.
The argument can be given as text, such as "July 12, 1994" or as a number.

Examples
MONTH(15666) = 11
MONTH(345) = 12
MONTH(202) = 7
MONTH(A1) = 3, if A1 contains 3/12/96
MONTH(A1) = 4, if A1 contains Thursday April-14-1994
MONTH(DATEVALUE("July-12-1994")) = 7

Associated Functions
DATE, YEAR, SECOND, DAY, HOUR and MINUTE



SECOND
Description

Calculates seconds given as a serial value to an integer from 0 to 59 inclusive
Syntax

SECOND(serial value)
 Argument Description

serial value any real number which can be derived from a date and/or time code
numbers shown to the right of the decimal point are measured in seconds, 
beginning with 0 at midnight for the day entered

Note:    If the argument is negative, the function returns the #BAD DATA! error value.
Examples

SECOND(0.4999) = 51
SECOND(555.4999) = 51
SECOND(TODAY()) = 0, because the TODAY function returns only the whole number 

portion of a real number
Associated Functions

DATE, YEAR, MONTH, DAY, HOUR and MINUTE



WEEKDAY
Description

Calculates a day of the week for a serial date value. The value returned is a positive 
integer between one and seven, where one is equal to Sunday, two is equal to Monday, 
and so on.

Syntax
WEEKDAY(serial value)

 Arguments
serial value A date/time code or any real number which can be derived from a date 

and/or time code. The whole number portion of the serial value represents 
the number of days since December 31, 1899.
numbers shown to the right of the decimal point are measured in seconds, 
beginning with 0 at midnight for the day entered

Note:    If the serial value is less than one, the function returns the #BAD DATA! error 
value.

Example
WEEKDAY(TODAY())    = 3, if today is Tuesday

Associated Functions
MONTH and YEAR



YEAR
Description

Calculates a year between 1900 and 2077 for a given serial date value. 
Syntax

YEAR(serial value)
 Argument Description

serial value any real number from 1 to 65,000 which is a recognized date-time code.

Note:    If an argument is non-numeric or out of the range, the function returns the 
#BAD DATA! error value.
Example
YEAR(NOW()) = 1994
Associated Functions

MONTH and WEEKDAY



DDE/External
Description

Creates a Dynamic Data Exchange with a DDE server application. Use DDE/External to link 
data directly to Data Manager from DDE-compliant spreadsheets.

Syntax
|app|filename|range

 Arguments Definitions
app the DDE server application name
filename the path and name of the file you want to bring into the Data Manager
range the cell range you want to bring in from the server application's file

Notes and Error Messages
You must use the keyboard symbol "|" as a separator, otherwise DDE returns the #N/A! 
error value.
DDE automatically appends the parameter [1][1].

Example
If you were to use the following formula on a computer system equipped with Microsoft 
Excel, keying the formula would load Excel and the specified file. The DDE formula will 
appear in your Data Manager cell as indicated below: 
|Excel|path\filename.xls|R1C1:R5C5|[1][1] 
[1][1] refers to the co-ordinates of a specific cell in the specific range R1C1:R5C5. 
You may also specify a one-cell range when entering the formula as follows:
|Excel|path\filename.xls|R1C1:R5C5|
R1C1:R5C5 specifies a range from cell(Row1,Col 1) to cell (Row 5,Col 5)

Associated Functions
Setting up a DDE link with another spreadsheet
See also How to... Exchange data with other applications



Engineering Functions
Function            Description
BESSELI() Calculates the modified Bessel function In(x)
BESSELJ() Calculates the Bessel function Jn(x)
BESSELK() Calculates the modified Bessel function Kn(x)
BESSELY() Calculates the Bessel function Yn(x)
DELTA() Tests whether two numbers are equal
ERF() Calculates the error function
ERFC() Calculates the value of the complementary error function integrated 

between x and infinity
GAMMA Calculates the Gamma function, G(x)
GAMMALN() Calculates a value for the natural logarithm of the gamma function, G(x)
GESTEP() Compares two values; result is 1 if num is  step and 0 if not



BESSELI
Description

Calculates the modified Bessel function In(x). The Besseli function is the Bessel function 
Jn(x) using purely imaginary arguments.

Syntax
BESSELI(x, n)

 Arguments Definitions
x any real number; specifies the value at which to evaluate the function
n an integer; specifies the order of the Bessel function

Notes and Error Messages
If n is not an integer, it is trucated.
BESSELI returns the #BAD DATA! error value for non-numeric arguments.
The following is an example of the simplest of the BESSEL functions, the Bessel function 
of the first kind of order zero:*

Example
BESSELI(1.2, 2)    = 0.202595682

Associated Functions
BESSELJ, BESSELK and BESSELY
* Source:    The HarperCollins Dictionary of Mathematics, 1991



BESSELJ
Description

Calculates the Bessel function 
Syntax

BESSELJ(x, n)
 Arguments Definitions

x any real number; specifies the value to be used in evaluating BESSELJ
n an integer; specifies the order of the Bessel function

Notes and Error Messages
BESSELJ truncates n if it is not an integer.
BESSELJ returns the #BAD DATA! error value for non-numeric arguments or if n is less than
0.
The following is an example of the simplest of the BESSEL functions, the Bessel function 
of the first kind of order zero:*

Example
BESSELJ(1.2, 2)    = 0.159349018

Associated Functions
BESSELI, BESSELK and BESSELY
* Source:    The HarperCollins Dictionary of Mathematics, 1991



BESSELK
Description

Calculates the modified Bessel function Kn(x). BESSELK equates to the Bessel functions Jn 
and Yn evaluated for purely imaginary arguments.

Syntax
BESSELK(x, n)

 Arguments Definitions
x any real number; specifies the value to be used to evaluate BESSELK.
n an integer number; specifies the order of the Bessel function.

Notes and Error Messages
BESSELK truncates n if it is a non-integer.
For non-numeric arguments or if n < 0, BESSELK returns the #BAD DATA! error value.
The following is an example of the simplest of the BESSEL functions, the Bessel function 
of the first kind of order zero:*

Example
BESSELK(1.7,1) = 0.209362488

Associated Functions
BESSELI, BESSELJ and BESSELY
* Source:    The HarperCollins Dictionary of Mathematics, 1991



BESSELY
Description

Calculates the Bessel function Yn(x). The BESSELY function is also referred to as the 
Neumann or Weber function.

Syntax
BESSELY(x, n)

 Argument Definitions
x any real number; specifies the value to use in evaluating BESSELY
n an integer number; specifies the order of the Bessel function

Notes and Error Messages
If n is not an integer, it is trucated.
BESSELY returns the #BAD DATA! error value for non-numeric arguments or if n < 0.
The following is an example of the simplest of the BESSEL functions, the Bessel function 
of the first kind of order zero:*

Example
BESSELY(1.2, 2)    = -1.263310803

Associated Functions
BESSELI, BESSELJ and BESSELK
* Source:    The HarperCollins Dictionary of Mathematics, 1991



DELTA
Description

Compares two values and returns 1 if num1 is strictly equal to num2; returns 0 otherwise.
Syntax

DELTA(num1, num2)
 Arguments Definitions

num1 any real number
num2 any real number

Notes and Error Messages
If the second argument is omitted, it is assumed to be equal to 0.
DELTA returns the #BAD DATA! error value for non-numeric arguments.

Examples
DELTA(11.23654, 12.253) = 0
DELTA(12.735, 12.735) = 1

Associated Functions
GESTEP



ERF
Description

Calculates the value of the error function integrated between low_lim and up_lim.
Syntax

ERF(low_lim, up_lim)
 Arguments Definitions

low_lim any real number; specifies the lower bound for integration
up_lim any real number; specifies the upper bound for integration

Notes and Error Messages
ERF calculates the integral from 0 to low_lim if the second argument is omitted.
ERF returns the #BAD DATA! error value for non-numeric or negative arguments, or if 
up_lim is less than low_lim.

Example
ERF(1.2, 2) = 0.085008287

Associated Functions
ERFC



ERFC
Description

Calculates the value of the complementary error function integrated from x to infinity
Syntax

ERFC(x)
 Argument

x any real number; specifies the lower limit of integration
Notes and Error Messages

ERFC returns the #BAD DATA! error value if the argument is non-numeric or negative. 
Example

ERFC(1) = 0.157299207
Associated Functions

ERF



GAMMA
Description

Calculates the value of the Gamma function, G(x)
Syntax

GAMMA(num)
 Arguments Definitions

num any positive real number; specifies the value at which to evaluate the 
function

Notes and Error Messages
GAMMA returns returns the #BAD DATA! error value if the argument is non-numeric or 
negative.

The formula for the GAMMA function is:

Example
GAMMA(12.85) = 39,916,800.00

Associated Functions
BESSELJ and GAMMALN



GAMMALN
Description

Calculates the value of the natural logarithm applied to the Gamma function, (x).
Syntax

GAMMALN(num)
 Argument

num any positive real number; specifies the value at which to evaluate the 
function

Notes and Error Messages
GAMMALN returns the #BAD DATA! error value for non-numeric or negative arguments.

Example
GAMMALN(7.2) = 6.579251212

Associated Functions
FACT



GESTEP
Description

Compares two values; result is 1 if num is  step and 0 if not
Syntax

GESTEP(num, step)
 Arguments Definitions

num any real number to be compared to step
step any real number

Notes and Error Messages
If the second argument is omitted, it is assumed to equal 0.
GESTEP returns the #BAD DATA! error value for non-numeric arguments.

Examples
GESTEP( 5, 2) = 1
GESTEP( -5, 2) = 0
GESTEP( 2.5, 2.5) = 1

Associated Functions
DELTA



ACCRINTM
Description

Accrued Interest at Maturity: Calculates interest accrued on a security returning 
interest upon maturation

Syntax
ACCRINTM(iss, mat, coup, par, b)

 Arguments Definitions

iss the serial date value for issue date of the security
mat the serial date value for the date of maturation of the security
coup the annual coupon rate for the security
par the par value. If no par value is entered, $1,000 is used as a default
b the day-count basis used

Notes and Error Messages:
Iss, mat, and b are rounded to integers.
ACCRINTM returns the #BAD DATA! error value if:
· iss or mat is not a valid serial date value
· coup < 0 or if par < 0
· b is not 0, 1, 2 or 3

Example
ACCRINTM(DATE(1;6;1990);DATE(1;1;1991);0.1;100;1)    = 5.8333333

Associated Functions
DATE()



COUPDAYBS
Description

Coupon Days (beginning to date of settlement): Calculates the duration of the coupon 
period in days from the beginning to date of settlement

Syntax
COUPDAYBS(set, mat, fr, b)

 Arguments Definitions

set the serial date value for the date of settlement of the security
mat the serial date value for the date of maturation of the security
fr the number of annual coupon payments. Frequency = 1 for annual, 2 for 

semiannual, and 4 for quarterly payments
b the day-count basis used

Notes and Error Messages:
The arguments are rounded to integers.
COUPDAYBS returns the #BAD DATA! error value if:
· set or mat is not a valid serial date value
· fr is not 1, 2, or 4
· b is not 0, 1, 2, or 3
· set > mat

Example
COUPDAYBS(date(1;1;1993);date(1;6;1994);2;0) = 30

Associated Functions
COUPDAYS(), COUPDAYSNC(), COUPNCD(), COUPNUM() and COUPPCD()



COUPDAYS
Description

Coupon Days: Calculates the duration of the coupon period (in days) when the settlement
occurs

Syntax
COUPDAYS(set, mat, fr, b)

 Arguments Definitions

set the serial date value for the date of settlement of the security
mat the serial date value for the date of maturation of the security
fr the number of annual coupon payments. Frequency = 1 for annual, 2 for 

semiannual, and 4 for quarterly payments
b the day-count basis used

Notes and Error Messages:
COUPDAYS returns the #BAD DATA! error value if:
· set or mat is not a valid serial date value
· fr is not 1, 2, or 4
· b is not 0, 1, 2, or 3
· set > mat
The arguments are rounded to integers.

Example
COUPDAYS(date(1;1;1993);date(3;6;1994);2;1) = 182

Associated Functions
COUPDAYBS(), COUPDAYSNC(), COUPNCD(), COUPNUM() and COUPPCD()



COUPDAYSNC
Description

Coupon Days (date of settlement to next coupon date): Calculates number of days 
between date of settlement and the next coupon issue date

Syntax
COUPDAYSNC(set, mat, fr, b)

 Arguments Definitions

set the serial date value for the date of settlement of the security
mat the serial date value for the date of maturation of the security
fr the number of annual coupon payments. Frequency = 1 for annual, 2 for 

semiannual, and 4 for quarterly payments
b the day-count basis used

Notes and Error Messages:
The arguments are rounded to integers.
COUPDAYSNC returns the #BAD DATA! error value if:
· fr is not 1, 2, or 4
· b is not 0, 1, 2, or 3
· set or mat is not a valid serial date value
· set > mat

Example
COUPDAYSNC(date(27,1,1994), date(1,3,1994),2,1) = 33

Associated Functions
COUPDAYBS(), COUPDAYS() COUPNCD() COUPNUM() and COUPPCD()



COUPNCD
Description

Next Coupon Date after Settlement: Calculates the next coupon date following date of 
settlement

Syntax
COUPNCD(set, mat, fr, b)

 Arguments Definitions

set the serial date value for the date of settlement of the security
mat the serial date value for the date of maturation of the security
fr the number of annual coupon payments. Frequency = 1 for annual, 2 for 

semiannual, and 4 for quarterly payments
b the day-count basis used

Notes and Error Messages:
The arguments are rounded to integers.
COUPNCD returns the #BAD DATA! error value if:
· set or mat is not a valid serial date value
· fr is not 1, 2, or 4
· b is not 0, 1, 2, or 3
· set > mat

Example
COUPNCD(date(27;1;1993);date(1;3;1994);2;1) = 1 Mar 1993

Associated Functions
COUPDAYBS(), COUPDAYS(), COUPDAYSNC(), COUPNUM() and COUPPCD()



COUPNUM
Description

Coupons, Number Payable: Calculates coupons payable between the date of settlement
and date of maturation

Syntax
COUPNUM(set, mat, fr, b)

 Arguments Definitions

set the serial date value for the date of settlement of the security
mat the serial date value for the date of maturation of the security
fr the number of annual coupon payments. Frequency = 1 for annual, 2 for 

semiannual, and 4 for quarterly payments
b the day-count basis used

Notes and Error Messages:
The arguments are rounded to integers.
COUPNUM returns the #BAD DATA! error value if:
· set or mat is not a valid serial date value
· fr is not 1, 2, or 4
· b is not 0, 1, 2, or 3
· set > mat

Example
COUPNUM(date(27;1;1994);date(1;3;1995);2;1) = 3

Associated Functions
COUPDAYBS(), COUPDAYS(), COUPDAYSNC(), COUPNCD() and COUPPCD()



COUPPCD
Description

Coupon Date (prior to date of settlement): Calculates coupon date prior to the date of 
settlement

Syntax
COUPPCD(set, mat, fr, b)

 Arguments Definitions

set the serial date value for the date of settlement of the security
mat the serial date value for the date of maturation of the security
fr the number of annual coupon payments. Frequency = 1 for annual, 2 for 

semiannual, and 4 for quarterly payments
b the day-count basis used

Notes and Error Messages:
The arguments are rounded to integers.
COUPPCD returns the #BAD DATA! error value if:
· set or mat is not a valid serial date value
· fr is not 1, 2, or 4
· b is not 0, 1, 2, or 3
· set > mat

Example
COUPPCD(date(27;1;1994);date(1;3;1994);2;1) = 1 Sep 1993

Associated Functions
COUPDAYBS(), COUPDAYS(), COUPDAYSNC(), COUPNCD() and COUPNUM() 



CUMIPMT
Description

Cumulative Interest Payments: Calculates cumulative interest paid from the first to last
periods specified

Syntax
CUMIPMT(rate, nper, pv, st, end, t)

 Arguments Definitions

rate interest rate
nper total payment periods
pv present value
st start period in the calculation
end final period in the calculation. Period numbers begin at 1
t Time of payment:

0--payment takes place at the end of the period
1--payment takes place at the beginning of the period

Notes and Error Messages:
Nper, st and end are rounded to integers.
CUMIPMT returns the #BAD DATA! error value if:
· the arguments are non-numeric
· rate is less than or equal to 0, or nper is less than or equal to 0, or pv is less than or 

equal to 0
· st < 1, end < 1, or st > end
· t  0 or 1

Example
Let rate be 3% annual (rate = 0.03 / 12 = 0.0025 ).
Term, 1 year (nper = 1*12 = 12 )
Present value $10,000.
The total interest paid in the first half-year (periods 1 through 6) is:
CUMIPMT(0.0025,12,10000,1,6,0)    = -119

Associated Functions
CUMPRINC()



CUMPRINC
Description

Cumulative Principal: Calculates cumulative principal paid against a loan from first to 
last periods specified

Syntax
CUMPRINC(rate, nper, pv, st, end, t)

 Arguments Definitions

rate interest rate
nper total payment periods
pv present value
st start period in the calculation
end final period in the calculation. Period numbers begin at 1
t Time of payment:

0--payment takes place at the end of the period
1--payment takes place at the beginning of the period

Notes and Error Messages:
Nper, st and end are rounded to integers.
CUMPRINC returns the #BAD DATA! error value if:
· the arguments are non-numeric
· rate    0, nper    0, or pv    0
· st < 1, end < 1, or st > end
· t 0 or 1

Example
Let annual interest rate be 3% (rate = 0.03 / 12 = 0.0025 )
Term, 1 year (nper = 1*12 = 12 )
Present value $10,000
The cumulative principal paid in the first half-year (periods 1 through 6) is:
CUMPRINC(0.0025,12,10000,1,6,0) = -4962.5475

Associated Function
CUMIPMT()



DB
Description

Declining Balance: Uses the fixed-declining balance method to calculate real 
depreciation of assets over a given period

Syntax
DB(cost, sal, lif, per, mon)

 Arguments Definitions

cost original asset cost
sal salvage value after depreciation
lif a real number specifying the number of periods, or lifetime, over which 

you want to determine asset deprecation
per periods for which depreciation is calculated 
mon the number of months in the first year. If omitted, assumed to be 12. 

Inclusion of the Mon argument is mandatory.
Notes and Error Messages:

DB returns the #BAD DATA! error value if:
· the arguments are non-numeric 
· sal > cost, or per > lif, or mon > 12

Examples
If an equipment purchase costs $20,000,000 and is used for two years, its salvage value is 
$20,000. The following example shows depreciation over its lifetime:
DB(20000000,20000,2,1) = 19,368,000
DB(20000000,20000,2,2) = 612,028

Associated Functions
DDB(), SLN(), SYD() and VDB()



DDB
Description

Double-Declining Balance: Uses the double-declining balance method to calculate asset
depreciation 

Syntax
DDB(cost, sal, lif, per)

 Arguments Definitions

cost original asset cost
sal salvage value after depreciation
lif a real number specifying the number of periods, or lifetime, over which 

you want to determine asset deprecation
per periods for which depreciation is calculated 

Notes and Error Messages:
DDB returns the #BAD DATA! error value if:
· the arguments are non-numeric 
· sal > cost, or per > lif

Examples
A tool costs $20,000,000 and requires replacement every two years. The salvage value of 
the tool is $20,000. The following example shows depreciation according to the double-
declining balance method over the life of the tool.
DDB(20000000,20000,2,1) = $19,980,000
DDB(20000000,20000,2,2)    = $0

Associated Functions
DB(), SLN(), SYD() and VDB()



DISC
Description

Discount: Calculates securities' discount rates
Syntax

DISC(set, mat, pr, redempt, b)
 Arguments Definitions

set the serial date value for the date of settlement of the security
mat the serial date value for the date of maturation of the security
pr the price for each $100 face value of the security
redempt the redemption value for each $100 face value of the security
b the day-count basis used

Notes and Error Messages:
Set, mat and b are rounded to integers.
DISC returns the #BAD DATA! error value if:
· set or mat is not a valid serial date value
· b is not 0, 1, 2, or 3
· set > mat

Example
DISC(date(1;1;94);date(1;6;94);90;100) = 0.24 

Associated Functions
PRICEDISC() and YIELDDISC()



DOLLARDE
Description

Dollars to decimals: Converts dollar prices from fractions to decimals
Syntax

DOLLARDE(fr_num, fr)
 Arguments Definitions

fr_num a fractional number
fr the fraction's denominator

Notes and Error Messages:
DOLLARDE returns the #BAD DATA! error value if:
· either argument is non-numeric
· fr is negative
Fr is truncated if it is not an integer.

Example
In the following example, the number 1.04 represents the fractional number 1 and 4/40. 
DOLLARDE multiplies expression one by expression two, returning a decimal as shown.
DOLLARDE(1.04;40) = 1.1

Associated Function
DOLLARFR()



DOLLARFR
Description

Dollars to fractions: Converts dollar prices from decimals to fractions. 
Syntax

DOLLARFR(dec_num, fract)
 Arguments Definitions

dec_num a decimal number
fr the fraction's denominator

Notes and Error Messages:
DOLLARFR returns the #BAD DATA! error value if:
· either argument is non-numeric
· fr is negative
Fr is truncated if it is not an integer.

Example
In the following example, the expression 1.1 is a decimal number. DOLLARFR multiplies 
expression one by expression two, returning a fraction as shown. The number 1.04 = 1 and
4/40.
DOLLARFR(1.1;40) = 1.04

Associated Functions
DOLLARDE()



EFFECT
Description

Calculates effective annual interest rate
Syntax

EFFECT(nom_rate, npery)
 Arguments Definitions

nom_rate nominal interest rate
npery the number of annual compounding periods

Notes and Error Messages:
Npery is rounded to an integer
EFFECT returns the #BAD DATA! error value if:
· the arguments are non-numeric
· nom_rate is less than or equal to 0 or npery < 1

Example
EFFECT(0.1, 4) = 0.103812

Associated Function
NOMINAL()



FV
Description

Future Value: Calculates future value of investments where interest rates and periodic 
payments are constant

Syntax
FV(pmt, int, nper)

 Arguments Definitions

pmt the payment you make each period
int the interest rate for each period
nper the total payment periods

Notes and Error Messages:
FV returns the #BAD DATA! error value if the arguments are non-numeric.
FV function is analogous to the FVAL, but it is retained for compatibility with CorelCHART 4.

Example
If you make a $100 payment each month (pmt = 100) to an bank account in the bank 
which pays 2% annual interest (int = 0.02/12 = 0.001667). The future value of your 
investment is:
FV(100,0.001667,12) = $1,211

Associated Functions
FVAL(), FVSCHEDULE(), IPMT() and PV()



FVAL
Description

Future Value: Calculates future value of investments where payments and interest rates 
are constant in each period

Syntax
FVAL(rate, nper, pmt, pv, t )

 Arguments Definitions

rate interest rate
nper the total payment periods
pmt the fixed, equal payment you make each pay period
pv present value of future payments or initial lump sum payment
t Type:    

0--at the end of period payment (default)
1--at the beginning of the period payment

Notes and Error Messages:
FVAL calculates the future value of an investment making fixed payments and returning a 
constant interest rate in each period.
Cash debits are to be represented as negative values; cash revenues are to be represented
by positive values.

Example
Suppose you have $500 in an account initially (pv=-500) and make a $100 payment each 
month (pmt = -100). The bank pays 2% annual interest (int = .02/12 = 0.001667) and 
returns in 12 months:
FVAL(0.001667;12;-100;-500) = $1,721.16

Associated Functions
FV(), FVSCHEDULE(), IPMT() and PV()



FVSCHEDULE
Description

Future Value Schedule: Applies compound interest rates and Calculates projected value 
of the initial principal

Syntax
FVSCHEDULE(princ, sched)

 Arguments Definitions

princ the initial sum
sched a series of interest rates charged

Notes and Error Messages:
FVSCHEDULE returns the #BAD DATA! error value if princ is non-numeric.

Example
An account with an opening balance of $100 which grows 10% each period will have the 
balance shown below at the end of 12th period.
FVSCHEDULE(100;{0.1;0.1;0.1;0.1;0.1;0.1;0.1;0.1;0.1;0.1;0.1;0.1}) = $313.8428377

Associated Functions
FV(), FVAL(), IPMT() and PV()



INTRATE
Description

Interest Rates: Calculates fully invested securities' interest rates
Syntax

INTRATE(set, mat, inv, red, b)
 Arguments Definitions

set the serial date value for the date of settlement of the security
mat the serial date value for the date of maturation of the security
inv sum invested in the security
red amount redeemed at maturity
b the day-count basis used

Notes and Error Messages:
Set, mat, and b are rounded to integers.
INTRATE returns the #BAD DATA! error value if:
· set or mat is not a valid serial date value
· b is not 0, 1, 2, or 3
· set > mat

Example
INTRATE(date(1;3;94);date(1;5;94);500;550) = 0.6, i.e., 60% annually

Associated Functions
RECEIVED()



IPMT
Description

Interest Payments: Calculates interest payments for investments for a set period based 
on a constant interest rate

Syntax
IPMT(rate, per, nper, pv)

 Arguments Definitions

rate rate of interest 
per the period for which interest must be found
nper the total payment periods
pv present value of future payments

Notes and Error Messages:
IPMT returns the #BAD DATA! error value if the arguments are non-numeric.
Per must be in the range 1 to nper inclusive.
Cash debits are to be represented as negative values; cash revenues are to be represented
by positive values.

Example
To calculate the interest due after one year for a two-year $1,000 loan at 12% annual 
interest:
IPMT(0.12/12,12,24,1000)= -$6

Associated Functions
ACCRINTM(), CUMIPMT(), INTRATE(), PMT(), PPMT(), PV() and RATE()



IRR
Description

Internal Rate of Return: Calculates an internal rate of return for a range of cash flows
Syntax

IRR(vals, guess)
 Arguments Definitions

vals the range containing values whose internal rate of return you wish to 
calculate

guess optional argument--your estimate of the result of the function
Notes and Error Messages:

Arrays should be represented as a range of cells, for example B1:B6.
At least one of the vals at the beginning of a list must be negative and at least one 
positive.

Example
Suppose you invest $1,000 and expect $200, $300, $400, $500 incomes within the next 
periods respectively. Let cells B1-B5 contain: -1000, 200, 300, 400, 500. Your internal rate 
will amount to:
IRR(b1:b6) = 0.128, i.e., 12.8%

Associated Functions
MIRR(), NPV(), RATE(), XIRR() and XNPV()



MIRR
Description

Modified Internal Rate of Return: Calculates a modified internal rate of return for a list 
of values, taking into account both the cost of the initial investment and the interest on 
reinvestment of incomes.

Syntax
MIRR(vals, frate, rrate)

 Arguments Definitions

vals the array that contains payment values (negative values) and income 
(positive values) in each period

frate the interest rate paid on funds borrowed for investment
rrate the interest rate you receive on reinvested funds

Notes and Error Messages:
The array used in vals should be represented as a range of cells; for example B1:B6.
At least one of the vals must be negative, and at least one positive. Otherwise, the 
function returns #DIV/0! error value.

Example
If cells B1 to B5 contain -1,000, 200, 300, 400, 500 respectively,
MIRR(B1:B5, 0.08, 0.009) = .0906, i.e., 9%

Associated Functions
IRR(), RATE(), XIRR() and XNPV()



NOMINAL
Description

Nominal Interest Rate: Calculates an annual nominal interest rate
Syntax

NOMINAL(e_rate, npery)
 Arguments Definitions

e_rate the effective rate of interest
npery the number of annual compounding periods

Notes and Error Messages:
Npery is rounded to an integer.
NOMINAL returns the #BAD DATA! error value if the arguments are non-numeric.

Example
NOMINAL(1;12) = 0.7135

Associated Functions
EFFECT()



NPER
Description

Number of Repayment Periods: Calculates the number of periods, or payments, 
needed to repay a loan based on the given payment, interest rate for each period and 
amount of principal 

Syntax
NPER(pmt, int, per)

 Arguments Definitions

pmt the payment you make each period
int the rate of interest for each period
per the present value

Notes and Error Messages:
NPER returns the #BAD DATA! error value for non-numeric arguments.

Example
This example assumes payment is made at the end of the period.
NPER(100, 0.3/12, 1000) = 11.65

Associated Functions
FV(), IPMT(), PMT(), PPMT(), PV() and RATE()



NPV
Description

Calculates the net present value of a loan for the given interest rate and list of payments. 
Use this function when payments will not be constant.

Syntax
NPV(int, list)

 Arguments Definitions

int the rate of discount
list the array representing the payments and incomes in each period

Notes and Error Messages:
NPV returns the #BAD DATA! error value for non-numeric arguments.
Funds paid out are to be written as negative values, funds you receive are positive.

Examples
NPV(0.1;{-1000;100;1000}) = $75.13 (assuming payment of $1,000 is made at the end

of the first period)
Associated Functions

FV(), IRR(), PV() and XNPV()





PAYMT
Description

Payment: Calculates the periodic payment for annuities where payments and interest 
rates are constant

Syntax
PAYMT(rate, nper, pv, fv, t)

 Arguments Definitions
rate a real number specifying interest rate
nper the total payment periods
pv a real number specifying present value
fv a real number specifying the future value that should be attained after the 

last payment. If omitted, 0 is assumed.
t Time of payment:

0 - payment takes place at the end of the period
1 - payment takes place at the beginning of the period

Notes and Error Messages
PAYMT returns the #BAD DATA! error value for non-numeric arguments.
Cash debits are represented by negative values, while cash revenues are represented by 
positive values.

Examples
To compare your monthly payments at the start or end of the month for a 10-month 
$2,000 mortgage with a 9% annual interest rate, enter the following:
PAYMT(0.09/12, 10, 2000) = -$208.34
PAYMT(0.09/12, 10, 2000, 0, 1) = -$206.79

Associated Functions
FV(), IPMT(), NPER(), PMT(), PPMT(), PV() and RATE()



PMT
Description

Payment:    Calculates the periodic payment for the given principal amount, interest rate 
for each period and number of regular payment periods. PMT assumes that interest is paid 
at the end of each period.

Syntax
PMT(pv, int, nper)

 Arguments Definitions
pv a real number specifying the present value
int a real number specifying the interest rate
nper the total payment periods

Notes and Error Messages
PMT returns the #BAD DATA! error value for non-numeric arguments.
Cash debits are represented by negative values; cash revenues are represented by 
positive values.

Example
To calculate a monthly payment for a 5-year loan of $20,000 at an annual 12% interest 
rate, enter the following:
PMT(20000, 0.12/12, 5*12) = $444.89

Associated Functions
FV(), IPMT(), NPER(), PAYMT(), PPMT(), PV() and RATE()



PPMT
Description

Payment Against Principal: Calculates payment against principal for investments for 
given periods, such as the last year of a loan. Payments and interest rates are constant.

Syntax
PPMT(rate, per, nper, pv)

 Arguments Definitions
rate a real number specifying the interest rate
per a real number specifying the period; must be from 1 to nper
nper number of payment periods
pv a real number specifying present value

Notes and Error Messages
PPMT returns the #BAD DATA! error value if:
· any argument is non-numeric
· per is out of range

Example
The following function returns the principal payment for the last year of an 11-year, $2,500
loan at 7% annual interest:
PPMT(0.07, 11, 11, 2500)    = -$311.58

Associated Functions
FV(), IPMT(), NPER(), PAYMT(), PMT(), PV() and RATE()



PRICE
Description

Securities Price: For securities returning periodic interest, PRICE calculates price for each
$100 face value

Syntax
PRICE(set, mat, rate, yld, red, fr, b)

 Arguments Definitions
set a serial date value specifying the security's date of settlement
mat a serial date value specifying the security's date of maturation
rate a real number specifying the interest rate
yld a real number specifying the security's annual yield
red a real number for the security's redemption value for each $100 face value
fr an integer specifying the number of annual coupon payments.

 For annual payments, fr = 1;
 for semiannual, fr = 2;
 for quarterly, fr = 4.

b an integer from 0 to 4, specifying the type of day-count basis to use. If 
omitted, 0 is supposed.

Notes and Error Messages
PRICE returns the #BAD DATA! error value if:
· the arguments are non-numeric
· set or mat is not a valid serial date value
· rate or yld is negative
· b or fr is out of range
· set is greater than or equal to mat
If set, mat, fr and b are non-integers they are truncated.

Example
PRICE could be used for a bond with the terms shown below:
The date of settlement is February 10, 1991
The date of maturation is November 15, 1991
The semiannual coupon is 5.89% 
The yield is 7.12% 
The redemption value is $80
The frequency is semiannual and based on 30/360
The bond price (in the 1900 Date System) is:
PRICE(33279, 33557, 0.0589, 0.0712, 80, 2, 0)    = 80.12896169

Associated Functions
DATE and YIELD



PRICEDISC
Description

Securities Discount Price: For each $100 face value of discounted securities, PRICEDISC
calculates sale price

Syntax
PRICEDISC(set, mat, disc, red, b)

 Arguments Definitions
set a serial date value specifying the security's date of settlement
mat a serial date value specifying the security's date of maturation
disc a real number specifying the security's discount rate
red a real number for the security's redemption value for each $100 face value
b an integer from 0 to 4 specifying the type of day-count basis to use. If 

omitted, 0 is assumed.
Notes and Error Messages

PRICEDISC returns the #BAD DATA! error value if:
· set or mat is not a valid serial date value
· disc or red is negative
· b is out of the range
· set is greater than or equal to mat
If set, mat and b are non-integers they are truncated.

Example
PRICEDISC works as shown in the bond calculation below:
The date of settlement is February 10, 1991
The date of maturation is November 15, 1991
The discount rate is 5.89% 
The redemption value is $80 and based on 30/360 
The bond price (in the 1900 Date System) is:
PRICEDISC(33279, 33557, 0.0589, 80, 0)    = 76.40055556

Associated Functions
DATE(), DISC() and YIELDDISC()



PRICEMAT
Description

Securities Price at Maturity: For securities paying interest upon maturation, PRICEMAT 
calculates price for each $100 face value 

Syntax
PRICEMAT(set, mat, iss, rate, yld, b)

 Arguments Definitions
set a serial date value specifying the security's date of settlement
mat a serial date value specifying the security's date of maturation
iss a serial date value specifying the security's date of issue
rate a real number specifying the interest rate
yld a real number specifying the security's annual yield
b an integer from 0 to 4 specifying the type of day-count basis to use. If 

omitted, 0 is assumed.
Notes and Error Messages

If set, mat, iss and b are non-integers they are truncated.
PRICEMAT returns the #BAD DATA! error value if:
· the arguments are non-numeric
· set, iss or mat is not a valid serial date value
· rate or yld is negative
· b is out of the range
· set is greater than or equal to mat

Example
PRICEMAT could be used for a bond with the terms shown below:
The date of settlement is February 10, 1991
The date of maturation is November 15, 1991
The date of issue is September 12, 1990
The semiannual coupon is 5.75% 
The yield is 5.77% and based on 30/360 
The price (in the 1900 Date System) is:
PRICEMAT(33279, 33557, 33128, 0.0575, 0.0577, 0) = 136.8498472

Associated Functions
DATE() and YIELDMAT()



PV
Description

Present Value: Calculates an investment's present value, the total present worth of a 
series of future payments

Syntax
PV(rate, nper, pmt)

 Arguments Definitions
rate a real number specifying interest rate
nper a real number specifying total payment periods
pmt a real number specifying the payment made each period; cannot change 

over the life of the annuity
Notes and Error Messages

PV returns the #BAD DATA! error value for non-numeric arguments.
Cash debits are represented by negative values; cash revenues are represented by 
positive values.

Example
PV is useful in the following types of analysis. Which is better, to pay $25,000 up front, or 
$450 per month for the next 10 years at 7.5% interest?
PV(0.075/12, 12*10, 450)    = $37,910.13
This tells you that the loan's present value is $12,910.13 more than the initial $25,000 
payment.

Associated Functions
FV(), IPMT(), NPER(), PMT(), PPMT() and RATE



RATE
Description

Rate: Calculates annuity interest rates per period
Syntax

RATE(nper, pmt, pv, type, g)

 Arguments Definitions
nper a real number specifying total payment periods
pmt real number specifying the payment made each period; fixed for the life of 

the annuity
pv a real number specifying the present value
type type is an optional argument
g Guess, your estimate of the result, is an optional argument

Notes and Error Messages
RATE returns the #BAD DATA! error value for non-numeric arguments.

Example
The following example shows how to calculate the rate of a three-year, $5,000 loan with 
monthly payments of $120:
RATE(3*12, -120, 5000)    = 0.0077

Associated Functions
FV(), IPMT(), NPER(), PMT(), PPMT() and PV()



RECEIVED
Description

Amount Received on Maturity: For fully invested securities, RECEIVED calculates 
amount paid upon maturation

Syntax
RECEIVED(set, mat, inv, disc, b)

 Arguments Definitions
set a serial date value specifying the security's date of settlement
mat a serial date value specifying the security's date of maturation
inv security investment amount 
disc a real number specifying the security's discount rate
b an integer from 0 to 4 specifying the type of day-count basis to use. If 

omitted, 0 is supposed
Notes and Error Messages

RECEIVED returns the #BAD DATA! error value for non-numeric arguments or if:
· set or mat is not a valid serial date value
· b is out of the range
· set is greater than or equal to mat
If set, mat and b are non-integers they are truncated.

Example
RECEIVED could be used for a bond with the terms shown below:
The date of settlement is February 10, 1990
The date of maturation is November 15, 1993
The discount rate is 5.75% 
Amount invested in the security
and based on 30/360 
The total to be received upon maturation (in the 1900 Date System) is:
RECEIVED(32914, 34288, 0.0575, 100000,0)    = -0.000000153

Associated Functions
DATE() and INTRATE()



SLN
Description

Straight-line Depreciation: Calculates depreciation for an asset for a single period using
the straight-line method of depreciation

Syntax
SLN(cost, sal, lif)

 Arguments Definitions
cost a real number specifying the original asset cost
sal a real number specifying the asset's salvage value after depreciation
lif a real number specifying the number of periods, or lifetime, over which 

you want to determine asset deprecation
Notes and Error Messages

SLN returns the #BAD DATA! error value for non-numeric arguments.
Example

If the original purchase price of a given piece of equipment is $15,000, useful lifetime is 15
years and salvage value $2,300, the annual depreciation allowance would be:
SLN(15000, 2300, 15) = $846.67

Associated Functions
DDB(), SYD() and VDB()



SYD
Description

Sum of Years' Depreciation: Calculates depreciation for an asset for given periods using
the straight-line method of depreciation

Syntax
SYD(cost, sal, lif, per)

 Arguments Definitions
cost a real number specifying the original asset cost
sal a real number specifying the salvage value after depreciation
lif a real number specifying the number of periods, or lifetime, over which 

you want to determine asset deprecation
per a real number specifying the period; must use the same units as lif

Notes and Error Messages
SYD returns the #BAD DATA! error value for non-numeric arguments.

Examples
If the original purchase price of a given piece of equipment is $15,000, useful lifetime is 15
years and salvage value $2,300, the first-year's depreciation allowance would be:
SYD(15000, 2300, 15, 1) = $1,587.50
The yearly depreciation allowance for the 12th year would be:
SYD(15000, 2300, 15, 12) = $423.33

Associated Functions
DDB(), SLN() and VDB



TBILLPRICE
Description

T-Bill Price: Calculates Treasury bill price per $100 face value
Syntax

TBILLPRICE(set, mat, disc)

 Arguments Definitions
set a serial date value specifying the security's date of settlement
mat a serial date value specifying the security's date of maturation
disc a real number specifying the security's discount rate

Notes and Error Messages
TBILLPRICE returns the #BAD DATA! error value for non-numeric arguments or if:
· set or mat is not a valid serial date value
· disc is non-positive
If set and mat are non-integers they are truncated.

Example
TBILLPRICE could be used for a Treasury bill with the terms shown below:
The date of settlement is February 10, 1990
The date of maturation is November 15, 1993
The discount rate is equal to 7%
The Treasury bill price (in the 1900 Date System) is:
TBILLPRICE(32914, 34288, 0.07) = 73.28333333

Associated Functions
DATE() and TBILLYIELD



TBILLYIELD
Description

T-Bill Yield: Calculates Treasury bill yields
Syntax

TBILLYIELD(set, mat, disc)

 Arguments Definitions
set a serial date value specifying the security's date of settlement
mat a serial date value specifying the security's date of maturation
pr a real number specifying the Treasury bill's price for each $100 face value.

Notes and Error Messages
TBILLYIELD returns the #BAD DATA! error value for non-numeric arguments or if:
· set or mat is not a valid serial date value
· pr is non-positive
If set and mat are non-integers they are truncated.

Example
TBILLYIELD could be used for a Treasury bill with the terms shown below:
The date of settlement is February 10, 1990
The date of maturation is November 15, 1993
The price for each $100 face value is equal to 72.22
The Treasury bill yield (in the 1900 Date System) is:
TBILLYIELD(32914, 34288, 72.22) = 10.08%

Associated Functions
DATE() and TBILLPRICE



VDB
Description

Variable Declining Balance: Calculates depreciation of assets for specified periods using
the double declining balance or other specified methods

Syntax
VDB(cost, sal, lif, sper, eper)

 Arguments Definitions
cost the initial asset cost
sal the salvage value after depreciation
lif a real number specifying the number of periods, or lifetime, over which 

you want to determine asset deprecation
sper an integer specifying the starting period for which depreciation is to be 

calculated
eper an integer specifying the ending period for which depreciation is to be 

calculated
Notes and Error Messages

VDB returns the #BAD DATA! error value for non-numeric or negative arguments.
Examples

The following examples show depreciation for a pair of new microcomputers purchased for 
$4,000 with lifetimes of five years and salvage value of $490. 
VDB(4000, 490, 5*365, 0, 1) = $4.38, the first day's depreciation
VDB(4000, 490, 5*12, 0, 1) = $133.33, the first month's depreciation
VDB(4000, 490, 5, 0, 1) = $1,600.00, the first year's depreciation
VDB(4000, 490, 5*12, 4, 15) = $1,087.21, the depreciation calculated between 

the 4th and 15th months
Associated Functions

DDB(), SLN() and SYD()



XIRR
Description

Cash Internal Rate of Return: Calculates internal rate of return for regular or irregular 
cash flow schedules

Syntax
XIRR(values, dates, g)

 Arguments Definitions
values an array of cash flows matched to a series of payments and dates
dates an array of payment dates matched with cash flow payments
g a guess; your speculated result of XIRR 

Notes and Error Messages
Numbers in dates are truncated to integers.
XIRR returns the #BAD DATA! error value for non-numeric arguments or if:
· arrays have a different number of values
· value doesn't contain at least one positive cash flow and one negative cash flow
· dates contains invalid serial date value(s)
· any serial date value is earlier than the serial date value of the starting date

Examples
If you invested $5,000 on January 1, 1994, and the return was $1,000 on the first of each 
month for the next 6 months, you would compute Cash Internal Rate of Return as follows:
XIRR({-5000,1000,1000,1000,1000,1000,1000}, 
{34335,34366,34394,34425,34455,34486,34516}) = .908230878
Suppose that you invested $24,000 into an enterprise on December 15, 1992 and the 
payment returned $3,500 on March 15, 1993, $2,835 on June 15, 1993, $4,750 on 
September 15, 1993, and $6,000 on December 15, 1993. Compute Cash Internal Rate of 
Return as follows:
XIRR({-14000,3500,2835,4750,6000},A1:A5,0.1) = 0.33958219 or - 33.958219%, if range 
A1:A5 contains DATE(15,12,92), DATE(15,3,93), DATE(15,6,93) DATE(15,9,93) and 
DATE(15,12,93)

Associated Functions
IRR(), MIRR(), NPV(), RATE() and XNPV



XNPV
Description

Cash Net Present Value: Calculates net present value for regular or irregular cash flow 
schedules

Syntax
XNPV(rate, values, dates)

 Arguments Definitions
rate a real number specifying the discount rate to apply to cash flows
values an array containing a series of cash flows matched with a schedule of 

payments and dates
dates an array containing payment dates that match the cash flow payments

Notes and Error Messages
Numbers in dates are truncated to integers.
XNPV returns the #BAD DATA! error value for non-numeric arguments or if:
· arrays have a different number of values
· dates contains invalid serial value(s)
· any serial date value is less than the serial date value of the starting date

Examples
If you invested $5,000 on January 1, 1994, the investment returned $1,000 on the first of 
each month for the next six months and you wanted to discount the cash flow at 10%, you 
would compute Cash Net Present Value as follows:
XNPV(0.1,{-5000,1000,1000,1000,1000,1000,1000}, 
{34335,34366,34394,34425,34455,34486,34516}) = 837.7471231
Suppose you invested $24,000 into an enterprise on December 15, 1992, and the payment
returned $3,500 on March 15, 1993, $2,835 on June 15, 1993, $4,750 on September 15, 
1993, and $6,000 on December 15, 1993, based on a 5% interest rate. You would compute
Cash Net Present Value as follows:
XNPV(0.05,{-14000,3500,2835,4750,6000},A1:A5,0.1) = 2967.637955 if range A1:A5 
contains DATE(15,12,92), DATE(15,3,93), DATE(15,6,93) DATE(15,9,93) and 
DATE(15,12,93)

Associated Functions
IRR(), MIRR(), NPV(), RATE() andXIRR



YIELD
Description

Yield on Securities: Calculates yield on securities returning periodic interest
Syntax

YIELD(set, mat, rate, pr, red, fr, b)

 Arguments Definitions
set a serial date value specifying the security's date of settlement
mat a serial date value specifying the security's date of maturation
rate a real number specifying the security's annual coupon rate
pr a real number specifying the security's price for each $100 face value
red a real number representing the security's redemption value for each $100 

face value
fr an integer specifying the number, or frequency, of annual coupon 

payments.
 for annual payments, fr = 1
 for semiannual, fr = 2
 for quarterly, fr = 4

b an integer from 0 to 4 specifying the type of day-count basis is to use. If 
omitted, 0 is supposed.

Notes and Error Messages
Convert dates to serial values before proceeding or type them into another cell and 
reference them in the formula. 
YIELD returns the #BAD DATA! error value for non-numeric arguments or if:
· set or mat is an invalid serial date value
· rate or pr is negative
· b is out of range
YIELD truncates set, mat and b to integers.

Example
YIELD works as shown in the bond calculation below:
The date of settlement is February 10, 1991
The date of maturation is November 15, 1991
The coupon rate is 5.75% 
The price is equal to 120.2222
The redemption value is $80
The frequency is semiannual and based on 1
The bond yield (in the 1900 Date System) is:
YIELD(33279,33557,5.75/100,120.2222,80,1) = -0.385791894

Associated Functions
NOW() and PRICE()



YIELDDISC
Description

Yield on Discounted Securities: Calculates discounted securities' annual yield
Syntax

YIELDDISC(set, mat, pr, red, b)

 Arguments Definitions
set a serial date value specifying the security's date of settlement
mat a serial date value specifying the security's date of maturation
pr a real number specifying the security's price for each $100 face value
red a real number for the security's redemption value for each $100 face value
b an integer from 0 to 4 specifying the type of day-count basis to use. If 

omitted, 0 is supposed.
Notes and Error Messages

Convert dates to serial values before proceeding or type them into another cell and 
reference them in the formula. 
YIELDDISC returns the #BAD DATA! error value for non-numeric arguments or if:
· set, iss or mat is an invalid serial date value
· red or pr is negative
· b is out of range
· set is greater than or equal to mat
If set, mat, iss and b are non-integers they are truncated.

Example
YIELDDISC works as shown in the bond calculation below:
The date of settlement is February 10, 1991
The date of maturation is November 15, 1991
The price is equal to 120.2222 
The redemption value is $80
and based on 30/360
The bond yield (in the 1900 Date System) is:
YIELDDISC(33279,33557,120.2222,80,30/360) = -0.43797665

Associated Functions
DISC(), NOW() and PRICEDISC



YIELDMAT
Description

Yield on Securities at Maturity: For securities paying interest upon maturation, 
YIELDMAT calculates annual yield

Syntax
YIELDMAT(set, mat, iss, rate, pr, b)

 Arguments Definitions
set a serial date value specifying the security's date of settlement
mat a serial date value specifying the security's date of maturation
iss a serial date value specifying the security's date of issue 
rate a real number specifying the security's interest rate at date of issue
pr a real number specifying the security's price for each $100 face value
b an integer from 0 to 4 specifying the type of day-count basis to use. If 

omitted, 0 is supposed.
Notes and Error Messages

Convert dates to serial values before proceeding or type them into another cell and 
reference them in the formula. 
YIELDMAT returns the #BAD DATA! error value for non-numeric arguments or if:
· set, iss or mat is an invalid serial date value
· rate or pr is negative
· b is out of range
· set is greater than or equal to mat
If set, mat, iss and b are non-integers they are truncated.

Example
YIELDMAT could be used for a bond with the terms shown below:
The date of settlement is February 10, 1991
The date of maturation is November 15, 1991
The date of issue is September 12, 1990
The semiannual coupon rate is 5.75% 
The price is equal to 120.2222 and based on 30/360
The yield (in the 1900 Date System) is:
YIELDMAT(33279,33557,33128,5.75,120.2222,30/360)    = 1.5381667

Associated Functions
DATE() and PRICEMAT()





Financial Functions
Function Description
ACCRINTM() Accrued Interest at Maturity: Calculates interest accrued on a 

security returning interest upon maturation
COUPDAYBS() Coupon Days (beginning to date of settlement): Calculates the duration 

of the coupon period in days from the beginning to date of settlement
COUPDAYS() Coupon Days: Calculates the duration of the coupon period (in days) 

when the settlement occurs
COUPDAYSNC() Coupon Days (date of settlement to next coupon date): Calculates 

number of days between date of settlement and the next coupon issue 
date

COUPNCD() Next Coupon Date after Settlement: Calculates the next coupon date
following date of settlement

COUPNUM() Coupons, Number Payable: Calculates coupons payable between the 
date of settlement and date of maturation

COUPPCD() Coupon Date (prior to date of settlement): Calculates coupon date prior 
to the date of settlement

CUMIPMT() Cumulative Interest Payments: Calculates cumulative interest paid 
from the first to last periods specified

CUMPRINC() Cumulative Principal: Calculates cumulative principal paid against a 
loan from first to last periods specified

DB() Declining Balance: Uses the fixed-declining balance method to 
calculate real depreciation of assets over a given period

DDB() Double-Declining Balance: Uses the double-declining balance method 
to calculate asset depreciation 

DISC() Discount: Calculates securities' discount rates
DOLLARDE() Dollars to decimals: Converts dollar prices from fractions to decimals
DOLLARFR() Dollars to fractions: Converts dollar prices from decimals to fractions
EFFECT() Calculates effective annual interest rate
FV() Future Value: Calculates future value of investments where interest 

rates and periodic payments are constant
FVAL() Future Value: Calculates future value of investments where payments 

and interest rates are constant in each period
FVSCHEDULE() Future Value Schedule: Applies compound interest rates and 

computes projected value of the initial principal
INTRATE() Interest Rates: Calculates fully invested securities' interest rates
IPMT() Interest Payments: Calculates interest payments for investments for a 

set period based on a constant interest rate
IRR() Internal Rate of Return: Calculates an internal rate of return for a 

range of cash flows
MIRR() Modified Internal Rate of Return: Calculates a modified internal rate 

of return for a list of values
NOMINAL() Nominal Interest Rate: Calculates an annual nominal interest rate



NPER() Number of Repayment Periods: Calculates the number of periods, or 
payments, needed to repay a loan based on the given payment, interest 
rate per period and amount of principal 

NPV() Net Present Value: Calculates the net present value of a loan for the 
given interest rate and list of payments. Use this function when 
payments will not be constant.

PAYMT() Payment: Calculates the periodic payment for annuities where 
payments and interest rates are constant

PMT() Payment:    Calculates the periodic payment for the given principal 
amount, interest rate per period and number of regular payment periods.
PMT assumes that interest is paid at the end of each period.

PPMT() Payment Against Principal: Calculates payment against principal for 
investments for given periods. Payments and interest rates are constant.

PRICE() Securities Price: For securities returning periodic interest, PRICE 
calculates price for each $100 face value

PRICEDISC() Securities Discount Price: For each $100 face value of discounted 
securities, PRICEDISC calculates sale price

PRICEMAT() Securities Price at Maturity: For securities paying interest upon 
maturation, PRICEMAT calculates price per $100 face value 

PV() Present Value: Calculates an investment's present value, the total 
present worth of a series of future payments

RATE() Rate: Calculates annuity interest rates per period
RECEIVED() Amount Received on Maturity: For fully invested securities, RECEIVED

calculates amount paid upon maturation
SLN() Straight-line Depreciation: Calculates depreciation for an asset for a 

single period using the straight-line method of depreciation
SYD() Sum of Years' Depreciation: Calculates depreciation for an asset for 

given periods using the straight-line method of depreciation
TBILLPRICE() T-Bill Price: Calculates Treasury bill price per $100 face value
TBILLYIELD() T-Bill Yield: Calculates Treasury bill yields
VDB() Variable Declining Balance: Calculates depreciation of assets for 

specified periods using the double declining balance or other specified 
methods

XIRR() Cash Internal Rate of Return: Calculates internal rate of return for 
regular or irregular cash flow schedules

XNPV() Cash Net Present Value: Calculates net present value for regular or 
irregular cash flow schedules

YIELD() Yield on Securities: Calculates yield on securities returning periodic 
interest

YIELDDISC() Yield on Discounted Securities: Calculates discounted securities' 
annual yield

YIELDMAT() Yield on Securities at Maturity: For securities paying interest upon 
maturation, YIELDMAT calculates annual yield





Spreadsheet Functions
Function categories

Conversion
Date and Time
DDE/External
Engineering
Financial
Information
Logical
Lookup and Reference
Math and Trig
Statistical
Text

Related Help topics
Procedures
Editing a formula using the formula bar
Editing a formula directly in a cell
Entering formulas directly into a cell
Using alphanumeric date and time values
Using Context-sensitive Help with Functions
Using the Enter Formula command
Using the Formula Bar
The Enter Formula dialog box
Enter Formula dialog box (Data menu)
Reference
List of Operators
Reference materials
Spreadsheet error values
Spreadsheet Functions: An Alphabetical Listing



Reference materials
The books listed below provide useful information in the subject areas covered by the 
spreadsheet functions. See also Spreadsheet Functions 

Engineering
Reich, Jens G. C Curve Fitting and Modeling for Scientists and Engineers. New York: McGraw-

Hill, Inc., 1992.
Reid, David M. Reed's Mathematical Tables and Engineering Formulae. London: Thomas Reed

Publications Limited, 1974.
Vetterling, William T. et al. Numerical Recipes Example Book (C), Second Edition. Cambridge:

The Press Syndicate of the University of Cambridge, 1992.
Finance
Bodie, Zvi et al. Investments. Homewood, Il.: Richard D. Irwin, Inc., 1989.
Davidson, Sidney et al. Financial Accounting: An Introduction to Concepts, Methods, and 

Uses, Third Canadian Edition. Toronto: Holt, Rinehart and Winston of Canada, Limited, 
1986.

Gujarati, Damodar, N. Basic Econometrics, Second Edition. New York: McGraw-Hill Publishing 
Company, 1988.

Hewlett-Packard. HP-17B Business Calculator Owner's Manual. Corvallis, Oregon: Hewlett-
Packard, 1988.

Lutzig, Peter and Schwab, Bernhard. Managerial Finance in a Canadian Setting, Third Edition.
Toronto: Butterworth and Co. (Canada) Ltd., 1983.

Zima, Petr and Brown, Robert L. Mathematics of Finance, Second Edition. Toronto: McGraw-
Hill Ryerson Limited, 1983.

Mathematics
Allendoerfer, C.B., and Oakley, C.O. Fundamentals of Freshman Mathematics. New York: 

McGraw-Hill Book Company, Inc., 1959.
Borowski, E.J., and Borwein, J.M. The HarperCollins Dictionary of Mathematics. New York: 

Harper Perennial, 1991.
Clapham, Christopher. The Concise Oxford Dictionary of Mathematics. New York: Oxford 

University Press, 1990.
Del Grande, J.J. and Egsgard, J.C. Relations: Elements of Modern Mathematics. Toronto: Gage 

Educational Publishing Limited, 1972.
Kramer, Arthur D. Fundamentals of Technical Mathematics. New York: Gregg Division, 

McGraw-Hill Book Company, 1982.
Salem, Lionel, Testard, Frédéric and Salem, Coralie. The Most Beautiful Mathematical 

Formulas. Translated by James D. West. New York: John Wiley and Sons, Inc., 1992.
Statistics
Albright, S. Christian. Statistics for Business and Economics. New York: Macmillan Publishing 

Company, 1987.
Harnett, Donald L. Statistical Methods, Third Edition. Reading, Mass.: Addison-Wesley 

Publications Company, 1982.
Mansfield, Edwin. Statistics for Business and Economics: Methods and Applications, Third 

Edition. New York: W.W. Norton and Company, 1987.
Porkess, Roger. The HarperCollins Dictionary of Statistics. New York: Harper Perennial, 1991.



List of Operators
You can use the following operators to build your formulas.

 Operator Action

+ Addition. If both arguments are text strings enclosed in double quotation marks, 
the plus sign links the two strings.

- Subtraction

* Multiplication. If the first operand is a number and the second is a string of 
characters enclosed in quotation marks, this operation repeats the text string the
number of times given in the first operand.

/ Division

^ Raise to a power

( ) Group parts of a formula or function

{ } Group constant arrays of 10 values or fewer



Spreadsheet error values
The Data Manager displays the following spreadsheet error values.    NB: To edit a formula 
after you receive an error value, use the Home, End, Backspace or Delete keys. You cannot 
use the arrow keys unless you press F2 first. 

    Error Value Explanation

Expecting a comma You have omitted a comma between arguments.
Expecting a list separator List separators such as commas, semicolons, or double 

periods must be used to separate values in Data Manager 
formulas.

Illegal value for location You have used the wrong data type for one or more of the 
arguments.

Syntax error Operators, variables or arguments incorrectly positioned.
Unbalanced parenthesis Parenthesis missing or included out of place
Formula too complex Data Manager formulas must not exceed 255 characters in 

length.
#ARG CNT! Incorrect number of arguments. Verify the number of arguments

in the formula.
#BAD DATA! The data are not of the type implied by the argument..
#CALC ERR! Error during calculation. Verify that values used as arguments 

are of the proper type.
#CELL! The values of cells used as arguments are not of appropriate 

type expected by a function.
#DIV/0! The formula attempts to divide by zero. Examine cell reference 

for blanks or zeros. Formula may be written incorrectly so that it
attempts to divide by zero.

#FATAL ERR! Internal error of the command interpreter. Verify all formulas in 
your spreadsheet.

#NUM! The formula has a problem with a number. The numeric 
argument is out of acceptable range of inputs, or the function 
calculates the result given the arguments you have entered.

#REF! Illegal function reference
#N/A! Data not available
#RECURSIVE! The formula contains a recursive reference. Check the chain of 

references for circular arguments.
########### Where a number contains more digits than can be displayed in 

the current column width, number signs appear in the cell. 





Information Functions
Function            Description
ISBLANK() Result is 1 if the argument refers to a blank cell and 0 otherwise
ISERROR() Result is 1 if the argument refers a cell containing an error value and 0 

otherwise
ISEVEN() Result is 1 if the argument is an even number and 0 otherwise
ISNONTEXT() Result is 1 if the argument refers to non-text data
ISNUMBER() Result is 1 if the argument refers to a cell containing a number and 0 

otherwise
ISODD() Result is 1 if the argument is an odd number and 0 otherwise
ISTEXT() Result is 1 if the argument refers to a cell containing text and 0 otherwise
TYPE() Result is a number indicating the data type in a specified cell





ISBLANK
Description

Result is 1 if the argument refers to a blank cell and 0 otherwise
Syntax

ISBLANK(val)
 Argument

val contents of the cell referenced
Notes and Error Messages

If the argument is not a reference to the cell, the function returns 0.
Examples

ISBLANK(12) = 0
ISBLANK(A1) = 1 , if A1 is an empty cell

Associated Functions
ISERROR, ISEVEN, ISNONTEXT, ISNUMBER, ISODD and ISTEXT



ISERROR
Description

Result is 1 if the argument refers a cell containing an error value and 0 otherwise
Syntax

ISERROR(val)
 Argument

val a reference to the investigated cell
Example

ISERROR(A1)    = 1, if A1 contains any error value
Associated Functions

ISBLANK, ISEVEN, ISNONTEXT, ISNUMBER, ISODD and ISTEXT



ISEVEN
Description

Result is 1 if the argument is an even number and 0 otherwise
Syntax

ISEVEN(val)
 Argument

val any integer
Notes and Error Messages

If the argument is non-numeric, the funtion returns the #BAD DATA! error value.
If the argument is a non-integer, it is truncated.

Examples
ISEVEN(-1) = 0
ISEVEN(7.23) = 0
ISEVEN(4.216) = 1

Associated Functions
ISODD



ISNONTEXT
Description

Result is 1 if the argument refers to non-text data
Syntax

ISNONTEXT(val)
 Argument

val any kind of data to be investigated
Notes and Error Messages

The argument can be a reference to the cell containing the value to test.
If the argument refers to a blank cell, the function returns 1.

Examples
ISNONTEXT(12) = 1
ISNONTEXT("12") = 0

Associated Functions
ISTEXT



ISNUMBER
Description

Result is 1 if the argument refers to a cell containing a number and 0 otherwise
Syntax

ISNUMBER(val)
 Argument

val a number to be tested
Notes and Error Messages

The argument can be a reference to the cell containing the value to test.
Examples

ISNUMBER(12) = 1
ISNUMBER("12") = 0

Associated Functions
ISERROR, ISEVEN, ISNONTEXT, ISNUMBER, ISODD and ISTEXT



ISODD
Description

Result is 1 if the argument is an odd number and 0 otherwise
Syntax

ISODD(val)
 Argument

val any integer number
Notes and Error Messages

If argument is non-numeric, the funtion returns the #BAD DATA! rerror value.
If the argument is a non-integer, it is truncated.

Examples
ISODD(-1) = 1
ISODD(7.253) = 1
ISODD(4.235) = 0

Associated Functions
ISEVEN



ISTEXT
Description

Result is 1 if the argument refers to a cell containing text and 0 otherwise
Syntax

ISTEXT(val)
 Argument

val refers to text
Notes and Error Messages

The argument can be a reference to the cell containing the value to test.
Examples

ISTEXT("12") = 1
ISTEXT(A1) = 1 if A1 contents the text value.

Associated Functions
ISNONTEXT()



TYPE
Description

Result is a number indicating the data type in a specified cell
Syntax

TYPE(cell)
 Argument

cell the address of a cell containing a value to be tested
    Values Returning type

Blank 0
Number 1
Text 2

    Error Values 16-24:
"#CALC ERR!" 16
"#CELL!" 17
"#DIV/0!" 18
"#BAD DATA!" 19
"#ARG CNT!" 20
"#NUM!" 21
"#FATAL ERR!" 22
"N/A!" 23
"RECURSIVE!" 24

Notes and Error Messages
The TYPE function is useful in finding out what type of data was returned by other 
functions.
TYPE returns 0, if there is no data in the addressed cell.

Example
If A1 contains the value 12
TYPE(A1) = 1



Logical Functions
Function            Description
AND() Result is 1 if all arguments in the list are TRUE and 0 if only one is FALSE
FALSE() Result is the logical value 0
IF() Result is one of the specified values depending on the logical condition
NOT() Result is the reverse of the logical expression
OR() Result is 1 if any argument in the list is TRUE and 0 if all arguments are 

FALSE
TRUE() Result is the logical value 1



AND
Description

Result is 1 if all arguments in the list are TRUE and 0 if only one is FALSE
Syntax

AND(list)
 Argument

List represents any combination of numbers, expressions, cell references separated by 
commas; or an array of values.

Notes and Error Messages
AND returns the #BAD DATA! errror value if arguments are not logical values or arrays 
whose references contain logical values.

Examples
AND(1+2=4, 3+4=7, 4+4=8) = 0
AND(TRUE, TRUE, TRUE) = 1
AND(TRUE, FALSE, TRUE) = 0
Enter the value 12 in cell B1, then:
AND(3<B1, B1<20) = 1

Associated Functions
NOT and OR



FALSE
Description

Result is the logical value 0
Syntax

FALSE()
Notes and Error Messages

Many types of spreadsheets and formulas interpret FALSE as the logical value 0.
Example

AND(TRUE, FALSE, TRUE) = 0 (FALSE)
Associated Functions

TRUE



IF
Description

Result is one of the specified values depending on the logical condition. IF returns the 
value contained in t if the condition exp is true, otherwise it returns the value contained in
f.

Syntax
IF(exp, t, f)

 Arguments Definitions
exp any logical expression
t any numeric value or text enclosed in double quotation marks
f any numeric value or text enclosed in double quotation marks
Notes and Error Messages

Nesting of the IF statement is limited by the number of characters permitted in the 
Formula bar (255).

Example
IF( [cell reference]>= 1000, "Small Cash")

Associated Functions
AND, FALSE, NOT, OR and TRUE



NOT
Description

Result is the reverse of the logical expression
Syntax

NOT(exp)
 Argument
exp any logical value
Examples

NOT(TRUE) = 0 (FALSE)
AND(NOT(2+1=5), TRUE) = 1 (TRUE)

Associated Functions
AND and OR



OR
Description

Result is 1 if any argument in the list is TRUE and 0 if all arguments are FALSE
Syntax

OR()
 Argument

List represents any combination of numbers, expressions, cell references separated by 
commas; or an array of values.

Notes and Error Messages
OR returns the #BAD DATA! errror value if the arguments are not logical values or arrays of
references containing logical values.

Examples
OR(1+2=4, 3+4=7, 4+4=8) = 1
OR(TRUE, TRUE, TRUE) = 1
OR(FALSE, FALSE, FALSE) = 0
If cell B1 contains the value 2, then:
OR(3<B1, B1<20) = 1

Associated Functions
AND and NOT



TRUE
Description

Result is the logical value 1
Syntax

TRUE()
Notes and Error Messages

TRUE is interpreted as the logical value 0 in many types of spreadsheets and formulas.
Example

OR(1+2=4, 3+4=7, 4+4=8) = 1 (TRUE)
Associated Functions

FALSE



CHOOSE
Description

Chooses the specified number from a list based on the index number given. The first 
argument is the argument counter, which specifies the numbered argument to select. If 
the argument counter is zero, the first case will be selected, if the argument counter is 
one, the second case will be selected, and so on.

Syntax

CHOOSE(n, c1, c2, ...)

 Arguments Definitions
n any non-negative integer; indicates the location of the returning value in 

the list of arguments to select
c1, c2, ... a list of any kind of data (from one to 37 arguments) separated by 

commas
Notes and Error Messages

CHOOSE truncates n if it is not an integer.
CHOOSE returns the #ARG CNT! error value if the argument counter n is negative or if its 
value is greater than the number of the selected arguments minus one.
You must reference the place of each case with a comma even if you do not have a case 
for each test value.

Examples
CHOOSE(2, "CASE1", "CASE2", "CASE3", "CASE4") = "CASE3"
CHOOSE(4, "CASE1", "CASE2", "CASE3", "CASE4") = #ARG CNT!



COLUMNS
Description

Calculates the number of columns in a list. If there are several references in the list to one 
column, the column will be counted the given number of times.

Syntax

COLUMNS(list)

 Arguments Definitions
list any combination of references to a range of cells separated by commas

Notes and Error Messages
If there are several references to one column in the list, the column will be counted the 
given number of times.

Examples
COLUMNS(A1:C3, H5:M18) = 9
COLUMNS(D1:D3) = 1

Associated Functions
ROWS



HLOOKUP
Description

Scans through the top row of the table or range from left to right (a) searching for the first 
instance of the value x, and (b) selecting the value a given number of rows down. If the 
particular value is found, the search stops at that column and HLOOKUP returns the value 
contained in the row index (r_index) of the column.

Syntax

HLOOKUP(x, list, y)

 Arguments Definitions
x any numeric or character string; specifies the value being looked up in the 

top row of the data table
range a reference to a range or an array name; specifies the data table
r_index any integer; indicates how many rows down in the column the returning 

value is located; can be any number from one to the number of rows in the
data table

Notes and Error Messages
HLOOKUP returns the #BAD DATA! error value if the search for the value x in the top row of
the data table fails, or y is non-positive or greater than the number of rows in the data 
table.
HLOOKUP truncates y if it is not an integer.
HLOOKUP is not case-sensitive or sensitive to diacritical marks used in languages other 
than English.

Examples
A B C

1. First Name Last Name Salary
2. Tyler Bennett $32,000
3. John Rappl $47,000
4. George Woltman $53,500
5. Adam Smith $18,000

HLOOKUP("FIRST NAME", A1:C5, 3) = "John"
HLOOKUP("FIRST", A1:C5, 3) = #BAD DATA!
HLOOKUP("SALARY", A1:C5, 4) = 53,500

Associated Functions
VLOOKUP



nCOLUMN
Description

Calculates the number of the column for the cell where nCOLUMN is executed. The 
columns are numbered in ascending alphabetical order. nCOLUMN is widely used in Fill 
Series.

Syntax

nCOLUMN

Notes and Error Messages
nCOLUMN returns the same values for all cells in the column.

Examples
nCOLUMN = 3, if nCOLUMN is contained in cell C4 
TAN(PI/nCOLUMN) = 1, if nCOLUMN is contained in cell D7 

Associated Functions
nROW



nROW
Description

Calculates the number of the row for the cell containing nROW. The function is widely used
in Fill Series.

Syntax

nROW(list_of_ranges)

List of ranges refers to the cells to be included in nROW.
Notes and Error Messages

nROW returns the same values for all cells in the row.
Examples

nROW = 7, if nROW is contained in cell C7
TAN(PI/nROW) = 1, if nROW is contained in cell D4 

Associated Functions
nCOLUMN



ROWS
Description

Calculates the number of rows referenced in a list. If there are several references to one 
row in the list, this row will be counted the given number of times.

Syntax

ROWS(list_of_ranges)

List of ranges refers to the cells to be included in the function.
 Arguments Definitions

list any combination of references to the range of cells; separated by commas
Notes and Error Messages

If there are several references to one row in the list, this row will be counted the given 
number of times.

Examples
ROWS(A1:C3, H5:M18) = 17
ROWS(D1:D3) = 3

Associated Functions
COLUMNS



VLOOKUP
Description

Scans down the lefthand column of the table or range, searching for the first occasion of 
the value x, then selecting the value a given number of columns to the right. If the 
particular value is found, the search stops at that row and the function returns the value 
contained in the column index (c_index) of that row.

Syntax

VLOOKUP(x, range, c_index)

 Arguments Definitions
x any numeric or character string; specifies the value to be looked up in the 

lefthand column of the data table
range a reference to a data table--a range or an array name
c_index column index: any integer; c_index indicates how many columns to the 

right in the row the returning value is located; c_index may be any value 
from one to the number of columns in the data table

Notes and Error Messages
VLOOKUP truncates y if it is a non-integer.
VLOOKUP is not case-sensitive or sensitive to diacritical marks used in languages other 
than English.
VLOOKUP returns the #BAD DATA! error value if:

· the search of the x value in the lefthand column of the data table fails.
· y is non-positive or greater than the number of columns in the data table.

Examples
A B C

1. FIRST NAME LAST NAME SALARY
2. Tyler Bennett $32,000
3. John Rappl $47,000
4. George Woltman $53,500
5. Adam Smith $18,000
VLOOKUP("FIRST NAME", A1:C5, 3) = "SALARY"
VLOOKUP("Bennett", A1:C5, 1) = #BAD DATA!
VLOOKUP("Adam", A1:C5, 2) = "Smith"

Associated Functions
HLOOKUP





Lookup and Reference Functions
Function            Description
CHOOSE() Chooses the specified number from a list based on the index number given
COLUMNS() Calculates the number of columns in a list
HLOOKUP() Scans through the top row of the table or range from left to right (a) 

searching for the first instance of the value x, and (b) selecting the value a
given number of rows down

nCOLUMN() Calculates the number of the column for the cell    where nCOLUMN is 
executed

nROW() Calculates the number of the row for the cell containing nROW
ROWS() Calculates the number of rows referenced in a list
VLOOKUP() Scans down the lefthand column of the table or range, searching for the 

first occasion of the value x, then selecting the value a given number of 
columns to the right





Math and Trig Functions
Function Description
ABS() Calculates the absolute value of a number
ACOS() Calculates the inverse cosine of the expression
ACOSH() Calculates the inverse hyperbolic cosine of the expression
ASIN() Calculates the inverse sine of the expression
ASINH() Calculates the inverse hyperbolic sine of a value
ATAN() Calculates the inverse tangent of the expression
ATANH()                   Calculates the inverse hyperbolic tangent of a number
CEILING()                 Calculates the number rounded to the nearest multiple of significance
COMBIN()                Calculates the number of combinations of a given size from a given 

population without regard to order.
COS()                      Calculates the cosine of an angle
COSH()                    Calculates the hyperbolic cosine of a number
EVEN()                     Rounds the expression up to the nearest even integer
EXP()                       Raises e to a given exponent
FACT()                     Calculates the factorial of the expression
FACTDOUBLE()        Calculates the double factorial of the expression
FLOOR()                   Rounds a real number to the nearest multiple at the given significance
GCD()                      Calculates the greatest common divisor--the largest integer that divides 

each number in the list without leaving a remainder--of a series of 
numbers. 

INT()                        Calculates the integer value of the expression
LCM()                      Calculates the least common multiple of two or more integers
LN()                         Calculates the natural log of the expression
LOG()                       Calculates the log of an expression to a given base
LOG10()                   Calculates the log base 10 of the expression
MDETERM()             Calculates the matrix determinant of an array
MOD()                      Calculates the modulus (remainder) of expression 1 divided by expression 

2
MROUND()               Rounds a number to a specified multiple
MULTINOM()            Calculates the multinomial of a list of expressions, a ratio of the factorial of

the sum of the list to the product of factorials
ODD()                      Rounds up an expression to the nearest odd integer
PCT                          Divides the number given as an argument by 100
PI()                          Calculates the value of p
PRODUCT()              Calculates the product of a list of expressions
QUOTIENT()             Calculates the integer portion of x/y
RAND()                    Calculates a random number between zero and one



RNDBETW()             Calculates a random number between two specified numbers
ROUND()                 Rounds an expression to a specified number of decimal places
SERIESSUM()           Calculates the sum of a power series
SGN()                      Determines the sign of a number
SIN()                        Calculates the sine of an angle
SINH()                      Calculates the hyperbolic sine of an expression
SQRT()                     Calculates the positive square root of the expression
SQRTPI()                  Calculates the positive square root of the expression multiplied by p

SUM()     Adds the values in a list of arguments
SUMPROD()        Calculates the sum of the products of corresponding arrays
SUMSQ()            Calculates the sum of the squares of all the parameters in a list
SUMX2MY2()      Calculates the sum of the difference of squares of corresponding values in two
ranges
SUMX2PY2()       Calculates the sum of the sum of squares of corresponding values in two 
ranges
SUMXMY2()        Calculates the sum of squares of differences of corresponding values in two 
ranges
TAN()      Calculates the tangent of an angle
TANH()  Calculates the hyperbolic tangent of the expression
TRUNC()             Truncates an expression to an integer with a specified number of digits





ABS
Description

Calculates the absolute value of a number. Absolute value is expressed as a positive value,
and works as follows: if the expression is positive, the sign is positive; if the expression is 
negative, the absolute value is the inverse of the number.

Syntax
ABS(exp)

 Argument Description
exp any real number

Examples
ABS(-3) = 3
ABS( 3) = 3
ABS( 0) = 0

Associated Functions
SGN



ACOS
Description

Calculates the inverse cosine of the expression. Example:    If ACOS(COS(exp)) equals exp,
the result is an angle bounded below by 0 (0 degrees) and above by  (180 degrees).

Syntax
ACOS(exp)

 Argument Definition
exp any real number from -1 to 1, inclusive; specifies the cosine of the angle

Notes and Error Messages
To convert the result from radians to degrees, use the Conversion function DEGREES or 
multiply it by 180/PI().
If the argument is greater than 1 or less than -1.

Examples
ACOS(-0.75) = 2.418858406
DEGREES(ACOS(-0.75)) = 138.5903779 (degrees)

Associated Functions
SGN, ACOSH and PI



ACOSH
Description

Calculates the inverse hyperbolic cosine of the expression and operates as the inverse 
function to COSH(), so ACOSH(COSH(exp)) equals exp.

Syntax
ACOSH(exp)

 Argument
exp the hyperbolic cosine of an angle; must be greater than or equal to 1

Examples
ACOSH(1) = 0
ACOSH(12) = 3.17631318

Associated Functions
ACOS and COSH



ASIN
Description

Calculates the inverse sine of the expression. The result is an angle bounded below by - /2
(-90 degrees) and bounded above by 
/2 (90 degrees).

Syntax
ASIN(exp)

 Argument
exp any real number from -1 to 1 inclusive; specifies the sine of an angle

Note
To convert the result of ASIN from radians to degrees, use the Conversion function 
DEGREES or multiply it by 180/PI().

Examples
ASIN(1) = 1.570796327
ASIN(0.25) = 0.2526802551
DEGREES(ASIN(-0.75)) = -48.59037789(degrees)
DEGREES(ASIN(0.5)) = 30(degrees)

Associated Functions
SGN, ASINH and PI



ASINH
Description

Calculates the inverse hyperbolic sine of an expression
Syntax

ASINH(exp)
 Argument

exp any real number; specifies the hyperbolic sine of an angle
Notes and Error Messages

ASINH operates as the inverse function to SINH(), such that ASINH(SINH(exp)) equals exp.
ASINH returns the #BAD DATA! error value if the argument is non-numeric.

Examples
ASINH(1.5) = 1.818446459
ASINH(-0.75) = -0.6931471806.

Associated Functions
ACOSH, SINH and ATANH



ATAN
Description

Calculates the inverse tangent of the expression. The result is an angle bounded below by 
-/2 (-90 degrees) and above by /2 (90 degrees).

Syntax
ATAN(exp)

 Argument
exp any real number; specifies the tangent of an angle

Note
To convert the of ATAN result from radians to degrees, use Conversion function DEGREES 
or multiply it by 180/PI().

Examples
ATAN(-0.75) = -0.6435011088
DEGREES(ATAN(-0.75)) = -36.86989765(degrees)

Associated Functions
ATANH, PI and TANH



ATANH
Description

Calculates the inverse hyperbolic tangent of the expression and determines the inverse of 
TANH(), so ATANH(TANH(exp)) equals exp.

Syntax
ATANH(exp)

 Argument
exp any real number from -1 to 1, exclusive; specifies the hyperbolic tangent of

an angle.
Notes and Error Messages

ATANH returns the #BAD DATA! error value if the argument is non-numeric.
Examples

ATANH(-0.75) = -0.9729550745
ATANH(0.9) = 1.472219469

Associated Functions
ACOSH, ASINH and TANH



CEILING
Description

Calculates a number rounded to the nearest multiple of significance. The result is the 
nearest multiple of the second number.

Syntax
CEILING(exp, sign)

 Arguments Definitions
exp any real number
sign any integer; specifies the multiple expression you want to round to

Notes and Error Messages
CEILING returns the #BAD DATA! error value if:
· either argument is non-numeric.
· the signs for exp and sign are different.
Whatever of the sign of exp, numbers are rounded upward for calculations away from 
zero. The value is not rounded if num is an exact multiple of significance.
If sign is a non-integer, CEILING truncates it.

Examples
CEILING(7.5, 1) = 8
CEILING(-3.5, -4) =-8
CEILING(-6.5, 5) = #BAD DATA!
CEILING(3.6, 0.1) = 3.6
CEILING(0.587, 0.01) = 0.59

Associated Functions
EVEN, FLOOR, INT, ODD, ROUND and TRUNC



COMBIN
Description

Calculates the number of combinations of a given size from a given population without 
regard to order. Determines the binomial coefficient for num and num_c. The binomial 
coefficient is the coefficient by degrees in decomposition of the binomial formula and 
determines the total possible number of groups for a given number of objects.

Syntax
COMBIN(num, num_c)

 Arguments Definitions
num any positive integer
num_c any positive integer less than or equal to num

Notes and Error Messages
The arguments are non-integers, they are truncated.
COMBIN returns the #BAD DATA! error value if:
· either argument is non-numeric.
· num <0, num_c < 0, or num < num_c.
The formula of the coefficient is:

Example
In how many ways can you choose 2 balls from a basket containing 7 differently colored 
balls.
COMBIN(7, 2) = 21

Associated Functions
FACT



COS
Description

Calculates the cosine of an angle. The result of COS is a number from -1 to 1 inclusive.
Syntax

COS(exp)
 Argument Definition

exp any real number corresponding to the angle measured in radians
Note

Use the Conversion function RADIANS or multiply the angle by PI()/180 if the angle is 
expressed in degrees.

Examples
COS(30) = 0.15425145 (degrees)
COS(RADIANS(0.5)) = 0.7071067812 (radians)

Associated Functions
ACOSH, COSH and PI



COSH
Description

Calculates the hyperbolic cosine of an expression. The value of the result is greater than or
equal to 1.

Syntax
COSH(exp)

 Argument Definition
exp any real number

Note
The hyperbolic cosine formula is:

Examples
COSH(0.75) = 1.294683285
COSH(-5) = 74.20994852

Associated Functions
ACOSH, SINH and TANH



EVEN
Description

Rounds up the expression to the nearest even integer
Syntax

EVEN(exp)
 Argument Definition

exp any real number
Notes and Error Messages

EVEN returns the #BAD DATA! value for non-numeric expressions.
Positive and negative numbers are rounded away from zero. Even integers are not 
rounded.

Examples
EVEN(-2) = -2
EVEN(5.69) = 6

Associated Functions
CEILING, FLOOR, INT, ODD, ROUND and TRUNC



EXP
Description

Raises e to a given exponent--e equals 2.71828182845904, the base of the natural 
logarithm. The value of the expression is always positive.

Syntax
EXP(exp)

 Argument Definition
exp any real number

Notes and Error Messages
EXP returns the #BAD DATA! error value if exp is greater than 599--the result is too large.
EXP is the inverse of the natural logarithm of number (LN).

Examples
EXP(-3.25) = 0.038774208
EXP( 7.89) = 2670.44392

Associated Functions
LN and LOG



FACT
Description

Calculates the factorial of an num. The factorial of an num equals the product of all the 
integers greater than 1 and equal to num.

Syntax
FACT(num)

 Argument Definition
num any non-negative number

Notes and Error Messages
If num is a non-integer, it is truncated.
FACT returns the #BAD DATA! error value if num is non-numeric or negative.
If num is greater than or equal to 171, FACT returns 0.

Examples
FACT(5) = 120
FACT( 21.56) = 5.109094E+19

Associated Functions
FACTDOUBLE and PRODUCT



FACTDOUBLE
Description

Calculates the double factorial of num
Syntax

FACTDOUBLE(num)
 Argument Definition

num any non-negative number
Notes and Error Messages

If num is a non-integer, it is truncated.
FACTDOUBLE returns the #BAD DATA! error value for non-numeric or negative arguments.
If num is greater than or equal to 171, FACTDOUBLE returns 0.
If num is even:

If number is odd:

Examples
FACTDOUBLE(4) = 8
FACTDOUBLE(5) = 15

Associated Functions
FACT



FLOOR
Description

Rounds a real number to the nearest multiple at the given significance.
Syntax

FLOOR(exp, sign)
 Arguments Definitions

exp any real number
sign any integer; specifies the multiple of the expression must be round

Notes and Error Messages
FLOOR returns the #BAD DATA! error value if either argument is non-numeric or num and 
sign have different signs.
Positive and negative numbers are rounded away from zero. The value is not rounded if 
num is an exact multiple of significance.

Examples
FLOOR(4.5, 1) =    4
FLOOR(-3.5, -3) = -3
FLOOR(1.5, 0.1) =    1.5
FLOOR(0.234, 0.01) =    0.23
FLOOR(-5.5, 4) = #BAD DATA!

Associated Functions
CEILING, EVEN, INT, ODD, ROUND, and TRUNC



GCD
Description

Calculates the greatest common divisor--the largest integer that divides each number in 
the list without leaving a remainder--of a series of numbers. 

Syntax
GCD(list)

 Argument
List represents any combination of integers, cell references separated by commas, or an 
array of values.

Notes and Error Messages
GCD truncates non-integers.
GCD returns the #BAD DATA! error value if any argument is non-numeric or less then zero.

Examples
GCD(2, 4) = 2
GCD(14,56,77) = 7

Associated Functions
LCM



INT
Description

Calculates the integer value of the expression
Syntax

INT(exp)
 Arguments

exp any real number
Note

Do not use INT function for displaying values as integers, but calculating the values to their
full precision.

Examples
INT(33.27) = 33
INT(33.95) = 33

Associated Functions
CEILING, FLOOR, MOD, MROUND, ROUND and TRUNC



LCM
Description

Calculates the least common multiple of two or more integers. Use LCM--the smallest 
positive multiple integer of all arguments--to add fractions with different denominators.

Syntax
LCM(list)

 Argument
List represents any combination of integers, cell references separated by commas, or an 
array of values.

Notes and Error Messages
LCM returns the #BAD DATA! error value if:
· any argument is non-numeric or a non-integer.
· the arguments are greater than 1.

Examples
LCM(4, 8, 6) = 24
LCM(3, 5, 2) = 30

Associated Functions
GCD



LN
Description

Calculates the natural logarithm, based on the constant e (2.71828182845904), of an 
expression. 

Syntax
LN(exp)

 Arguments
exp any positive real number

Notes and Error Messages
LN is the inverse of the EXP() function, so LN(EXP(exp)) equals exp.
LN returns the #BAD DATA! error value if exp is negative or 0.

Examples
LN(1.2) = 0.1823215568
LN(30) = 3.401197382

Associated Functions
EXP, LOG and LOG10



LOG
Description

Calculates the logarithm of the expression to a given base.
Syntax

LOG(exp, b)
 Arguments Definitions

exp any positive real number
b any positive real number; specifies the base of the logarithm

Note
If base is omitted, LOG assumes 10.

Example
LOG(3, 2) = 1.5849625

Associated Functions
EXP, LN, and LOG10



LOG10
Description

Calculates the log base 10 of the expression.
Syntax

LOG10(exp)
 Argument

exp any positive real number
Example

LOG10(3) = 0.4771212547
Associated Functions

EXP, LN and LOG



MDETERM
Description

Calculates the matrix determinant of an array. Matrix determinants are generally used for 
solving systems of mathematical equations that involve several variables.

Syntax
MDETERM(array)

 Argument
array a numeric array comprised of an equal number of rows and columns

Notes and Error Messages
MDETERM returns the #BAD DATA! error value if array does not have an equal number of 
rows and columns.

Example
Let A be the following 2 x 2 matrix:

 
The expression  would be the determinant of A and would be written as follows:

Source: Allendoerfer and Oakley, "Simultaneous Equations and Matrices," Fundamentals of 
Freshman Mathematics, New York: McGraw-Hill, p. 140.
See also Reference materials



MOD
Description

Calculates the modulus (remainder) of expression 1 divided by expression 2. The result has
the same sign as expression 2.

Syntax
MOD(e1, e2)

 Arguments Definitions
e1 any integer; specifies divisor
e2 any integer by which you want to divide e1

Notes and Error Messages
MOD returns the #DIV/0! error value if divisor is 0.
MOD can be expressed in relation to the INT function:
MOD(e1, e2) = e1 - e2*INT(e1/e2)

Examples
MOD(-14, 3) = -2
MOD(4, 3) = 1

Associated Functions
INT, ROUND and TRUNC



MROUND
Description

Rounds a number to the specified multiple
Syntax

MROUND(exp, mult)
 Arguments Definitions

exp any integer; specifies the value to be rounded
mult any integer; specifies the multiple to which you want to round exp

Notes and Error Messages
MROUND returns the #BAD DATA! error value if the arguments have different signs.
If the remainder of the dividing number by multiple is    half the value of the multiple, 
MROUND rounds away from zero.

Examples
MROUND(15, 31) = 0
MROUND(-15, -25) = -25
MROUND(6.7, 0.5) = 6.5

Associated Functions
CEILING, EVEN, FLOOR, ODD ROUND and TRUNC



MULTINOM
Description

Calculates the multinomial of a list of expressions, a ratio of the factorial of the sum of the 
list to the product of factorials

Syntax
MULTINOM(list)

 Argument
List represents any combination of integers, cell references separated by commas, or an 
array of values.

Notes and Error Messages
MULTINOM returns the #BAD DATA! error value for non-numeric arguments.
The formula of the multinom is:

Example
MULTINOM(5,6,7) = 14,702,688

Associated Functions
FACT and FACTDOUBLE



ODD
Description

Rounds up an expression to the nearest odd integer
Syntax

ODD(exp)
 Arguments

exp any real number
Notes and Error Messages

ODD returns the #BAD DATA! error value if exp is non-numeric.
Positive and negative numbers are rounded away from zero. Exp is not rounded if it is an 
odd integer.

Examples
ODD(5.5) =    5
ODD(7) =    7
ODD(6) =    7
ODD(-5) = -5
ODD(-4) = -5

Associated Functions
CEILING, EVEN, FLOOR, INT, ROUND and TRUNC



PCT
Description

Divides the expression or number value given as an argument by 100
Syntax

PCT(exp)
 Arguments
Exp is any real number
Notes and Error Messages

PCT returns the #BAD DATA! error value for non-numeric arguments.
Examples

PCT(50) = 0.5
PCT(50/9) = 0.056
PCT(56) = 0.56
PCT(20 = 0.2



PI
Description

Calculates the value of the mathematical constant  (3.141592654), the ratio of a 
circumference of a circle to its diameter.

Syntax
PI()

Examples
TAN(PI()/2) = 1.632455E+16
PI()/2 = 1.570796327

Associated Functions
COS, SIN and TAN



PRODUCT
Description

Calculates the product of a list of expressions
Syntax

PRODUCT(list)
 Arguments

List represents any combination of integers, cell references separated by commas, or an 
array of values.

Examples
PRODUCT(2, 4, 76) = 608
PRODUCT(3, 65.3, 12.4) = 2429.16

Associated Functions
FACT, SUM and SUMPROD



QUOTIENT
Description

Calculates the integer portion of x/y.
Syntax

QUONTIENT(numer, denom)
 Arguments Definitions

numer any real number; specifies the dividend
denom any real number (except 0); specifies the divisor

Notes and Error Messages
QUOTIENT returns the #BAD DATA! error value for non-numeric arguments.

Examples
QUOTIENT(7, 7) =    1
QUOTIENT(33.5, 3.1) = 10
QUOTIENT(-11, 5.35) = -2

Associated Functions
MOD



RAND
Description

Calculates a random number between 0 and 1. A new random number is calculated 
whenever the formula is moved or the spreadsheet recalculates.

Syntax
RAND()

Notes
If you wish to compute random a real number between other numbers, use:    RAND()*(y-x)
+x
To generate a random real number within the range, use the RNDBETW function.

Example
To compute a random number greater than or equal to 10 but less than 60:    RAND()*(60-
10)+10

Associated Functions
RNDBETW



RNDBETW
Description

Calculates a random number between two specified numbers. A new random number is 
calculated whenever the formula is moved or the spreadsheet recalculates.

Syntax
RNDBETW(bottom, top)

 Arguments Definitions
bottom any real number; specifies the smallest random value
top any real number; specifies the largest random value

Example
To compute a random number from 12.5 and 12.6 inclusive:    RNDBETW(12.5, 12.6)

Associated Functions
RAND



ROUND
Description

Rounds an expression to a specified number of decimal places
Syntax

ROUND(exp, dec)
 Arguments Definitions

exp any real number
dec the number of decimal places to you wish to round the number to

Notes
Exp is rounded to the left of the decimal point if dec is less than 0.
Exp is rounded to the indicated number of decimal places if dec is greater than 0.
ROUND rounds the number to the nearest integer if dec is 0.

Examples
ROUND(3.55, 1) = 3.6
ROUND(3.1499, 1) = 3.1
ROUND(-115.33,-1) = -120
ROUND(221.5, -1) = 221

Associated Functions
CEILING, FLOOR, INT, MOD, MROUND and TRUNC



SERIESSUM
Description

Calculates the sum of a power series. The following formula serves as the basis for 
SERIESSUM:

Syntax
SERIESSUM(x, n, m, coeff)

 Arguments Definitions
x any real number; specifies the input value to the power series
n any real number; specifies the initial degree to raise x
m any real number; specifies the amount to increase or decrease n for each 

term in the series
coeff any real number or an array of real numbers; specifies the coefficients by 

which successive powers of x are multiplied
Notes and Error Messages

The quantity of values in coeff dictates number of terms in the power series.
SERIESSUM returns the #BAD DATA! error value if any argument is non-numeric.

Examples
SERIESSUM(2,-1.5,0.05,2, 5.6, 3) = 3.89361418
SERIESSUM(2,-1.5,0.05,2) = 0.7071067812



SGN
Description

Determines the sign of an expression. Returns -1 if the number is negative, 0 if the number
is 0, and 1 if the sign of the number is positive.

Syntax
SGN(exp)

 Argument Definition
exp any real number

Examples
SGN(5) = 1
SGN(0) = 0
SGN(-0.021)=-1

Associated Functions
ABS



SIN
Description

Calculates the sine of an angle. The result of SIN is the expression from -1 to 1, inclusive.
Syntax

SIN(exp)
 Argument Definition

exp any real number corresponding to the angle measured in radians
Note

Use the Conversion function RADIANS or multiply the angle by PI()/180 to convert to 
radians if the angle is expressed in degrees.

Examples
SIN(PI()/4) = 0.7071067812
SIN(RADIANS(45)) = 0.7071067812

Associated Functions
ASINH, SINH and PI



SINH
Description

Calculates the hyperbolic sine of the expression
Syntax

SINH(exp)
 Argument Definition

exp any real number between -710 and 710
Note

The formula for the hyperbolic sine is:

Examples
SINH(0.523599)=0.5478537298
SINH(-0.25) =-0.2526123168

Associated Functions
ASINH, COSH and TANH



SQRT
Description

Calculates the positive square root of the expression
Syntax

SQRT(exp)
 Argument Definition

exp any non-negative real number
Notes and Error Messages

SQRT returns the #BAD DATA! error value if exp is a negative number.
Example

SQRT(0.175)= 0.4183300133
Associated Functions

SQRTPI



SQRTPI
Description

Calculates the positive square root of the exp multiplied by 
Syntax

SQRTPI(exp)
 Argument Definition

exp any real number
Notes and Error Messages

SQRTPI returns the #BAD DATA! error value if exp is negative.
Example

SQRTPI(0.175) = 0.7414706429
Associated Functions

SQRT and PI



SUM
Description

Adds the values in a list of arguments.
Syntax

SUM(list)
 Argument

List represents any combination of integers, cell references separated by commas, or an 
array of values.

Notes and Error Messages
Numbers, logical values and text strings are included. 
Error values or text that cannot be translated into numbers are excluded.

Examples
SUM(12, 156, 0.87) = 168.87
SUM("text",{12, 15, TRUE}) = 28
SUM(5, TRUE, 3) =9, because the logical value TRUE is translated into the number 

1
If cells A3:C3 contain 25, 35 and 50
SUM(A3:C3) = 110
SUM(A3:C3, 200) = 310

Associated Functions
PRODUCT and SUMPROD



SUMPROD
Description

Calculates the sum of the products of corresponding arrays
Syntax

SUMPROD(arr1, arr2, ...)
 Argument Definition

arr1, arr2, ... are 2 to n arrays of the real numbers.
Notes and Error Messages

Array arguments must have equal dimensions. If not, SUMPROD returns the #BAD DATA! 
error value.
Non-numeric array entries are read as zeros.

Examples
SUMPROD({3,4;8,6;1,9}, {2,7;6,7;5,3}) = 156
The formula works as follows: 
3*2 + 4*7 + 8*6 + 6*7 + 1*5 + 9*3 = 156

Associated Functions
PRODUCT and SUM



SUMSQ
Description

Calculates the sum of the squares of all the parameters in a list
Syntax

SUMSQ(list)
 Arguments

List represents any combination of integers, cell references separated by commas, or an 
array of values.

Note
You can also use a sequence of arrays and numbers separated by commas.

Examples
SUMSQ(12, 3) = 153
SUMSQ({12, 3}, 3)= 162

Associated Functions
SUM and SUMPROD



SUMX2MY2
Description

Calculates the sum of the difference of squares of corresponding values in two ranges
Syntax

SUMX2MY2(arr_x, arr_y)
 Arguments Definitions

arr_x a range or array of values; can be any of the real numbers
arr_y a second range or array of values; can be any of the real numbers

Notes
Arrays or arguments containing text, logical values, or empty cells are excluded; however, 
cells with the value zero are included.
SUMX2MY2 returns the #BAD DATA! error value if arr_x and arr_y do not contain the same
number of values.
The expression for the sum of the difference of squares is:

Example
SUMX2MY2({2, 3, 5}, {6, 12, 4}) = -158

Associated Functions
SUMPROD, SUMX2PY2 and SUMXMY2



SUMX2PY2
Description

Calculates the sum of the sum of squares of corresponding values in two ranges
Syntax

SUMX2PY2(arr_x, arr_y)
 Arguments Definitions

arr_x a range or array of values; can be any of the real numbers
arr_y a second range or array of values; can be any of the real numbers

Notes and Error Messages
All arguments must be numeric, but may include arrays or references containing numbers.
SUMX2PY2 returns the #BAD DATA! error value if arr_x and arr_y do not contain the same 
number of values.
The expression for the sum of the sum of squares is:

Example
SUMX2PY2({2, 3, 5}, {6, 12, 4}) = 234

Associated Functions
SUMPROD SUMX2MY2 and SUMXMY2



SUMXMY2
Description

Calculates the sum of squares of differences of corresponding values in two ranges
Syntax

SUMXMY2(arr_x, arr_y)
 Arguments Definitions

arr_x the first array or range of values, can be any real number.
arr_y the second array or range of values, can be any real number.

Notes and Error Messages
All arguments must be numeric, but may include arrays or references containing numbers.
SUMXMY2 returns the #BAD DATA! error value if arr_x and arr_y have a different number 
of values.
The expression for the sum of squared differences is:

Example
SUMXMY2({2, 3, 5}, {6, 12, 4}) = 98

Associated Functions
SUMPROD, SUMX2MY2 and SUMX2PY2



TAN
Description

Calculates the tangent of an angle
Syntax

TAN(exp)
 Argument Definition

exp any real number corresponding to the angle measured in radians
Note

Use the Conversion function RADIANS or multiply the angle by PI()/180 if the angle is 
expressed in degrees.

Examples
TAN(0.5) = 0.5463024898
TAN(RADIANS(60)) = 1.732050808

Associated Functions
ATAN and PI



TANH
Description

Calculates the hyperbolic tangent of the expression
Syntax

TANH(exp)
 Argument Definition

exp any real number
Note

The formula for the hyperbolic tangent is:

Example
TANH(0.75) = 0.6435011099

Associated Functions
ATANH, COSH and SINH



TRUNC
Description

Truncates an expression to an integer with a specified number of digits
Syntax

TRUNC(exp, n_dig)
 Arguments Definitions

exp any real number you want to truncate
n_dig a number which determines the precision of the truncation

Notes
The difference between TRUNC and INT is that TRUNC removes the fractional part of the 
number, but INT rounds numbers down to the nearest integer based on the value of the 
fractional part of the number. They are different only when using negative numbers:
TRUNC(-5.4) returns -5, but INT(-5.4) returns -6, because -6 is the lower number.

Examples
TRUNC(14.9) = 14
TRUNC(-14.9) = -14
TRUNC(PI()) = 3

Associated Functions
CEILING, FLOOR, INT and ROUND



AVEDEV
Description

Calculates the average of absolute deviations of values in a data list from the mean. 
AVEDEV measures variability in data sets.

Syntax
AVEDEV(list)

 Argument
List represents any combination of numbers, expressions, cell references separated by 
commas; or an array of values.

Note
AVEDEV does not process empty cells and cells containing text; however, cells containing 
values equal to 0 are included.

Example
AVEDEV(1, A1:A2, {3, 5, -6}) = 3.144444444, if A1 = 0.5, A2 = -3.4

Associated Functions
MEDIAN and MODE



AVG
Description

Calculates the average of the range or list of arguments
Syntax

AVG(list)
 Argument

List represents any combination of numbers, expressions, cell references separated by 
commas, or an array of values.

Note
The AVG function does not include empty cells and cells containing text in its calculations; 
however, the cells with values equal to 0 are included.

Examples
AVG( 5, 10, 25, 30 ) = 17.5
AVG( 5, 10, 25, B1..B3 ) = 12.16666667, if B1=32, B2=0, B3=1
AVG(1, A1:A2, {3, 5, -6}) = 0.016666667, if A1 = 0.5, A2 = -3.4

Associated Functions
STD



BETADIST
Description

Calculates the cumulative beta probability density distribution, widely used in the 
statistical testing of production quality. Many methods of a production quality estimation 
are based on the assumption that a group of non-high-quality products have the beta 
distribution. 

Syntax
BETADIST(x, alpha, beta, A, B)

 Arguments Definitions
x any real number from A to B inclusive
alpha any positive real number specifying the distribution parameter
beta any positive real number specifying the distribution parameter
A any real number specifying the lower limit of x
B any real number specifying the upper limit of x

Notes and Error Messages
If values A and B are omitted the function returns the standard cumulative beta 
distribution, assuming A = 0 and B = 1.
BETADIST returns the #BAD DATA! error value if:
· any argument is out of range or non-numeric.
· x is less than A, x is greater than B or A = B.

Example
BETADIST(3, 2.3, 3.5, 1, 8) = 0.3125812752



BETAINV
Description

Calculates the inverse value of the cumulative beta probability density function such that if
p=BETADIST(x, alpha, beta ,A, B), then x=BETAINV(p, alpha, beta ,A, B).

Syntax
BETAINV(prob, alpha, beta, A, B)

 Arguments Definitions
prob any non-negative real number to be used with the beta distribution
alpha any positive real number which is a parameter to the distribution
beta any positive real number which is a parameter to the distribution
A any real number; specifies a lower limit of x
B any real number; specifies an upper limit of x

Notes and Error Messages
BETAINV returns the #BAD DATA! error value if:
· prob is negative or greater than 1.
· any argument is out of the range or non-numeric.
If values A and B are omitted, BETAINV returns the inverse standard cumulative beta 
distribution, that A = 0 and B = 1.

Example
BETAINV(0.3125812752, 2.3, 3.5, 1, 8) = 3

Associated Function
BETADIST



BINOMDIST
Description

Calculates the magnitude of the individual term binomial probability distribution
Syntax

BINOMDIST(num_s, num_t, prob, cum)
 Arguments Definitions

num_s any integer; specifies the number of successes in trials
num_t any integer; specifies the number of independent trials
prob any non-negative real number; specifies the probability of success of each 

trial
cum a logical value (TRUE or FALSE); specifies the form of the function

Notes and Error Messages
If num_s or num_t is real, BINOMDIST rounds it to an integer.
BINOMDIST returns the #BAD DATA! error value if prob is negative or greater than 1.
If cum is FALSE, BINOMDIST returns the value of the distribution density function; if TRUE, 
BINOMDIST returns the probability of obtaining exactly num_s successes in the num_t 
independent trials.
The BINOMDIST formula is:

where s is the number of successes in trials, t is the number of independent trials, p is the
probability of success on each trial.

Examples
Suppose, that 500 students studied in a given faculty. Find the probability that September 
1, is the birthday of k students, simultaneously. Where k can be 0,1,2,...
If A1=1/365, then
BINOMDIST(0, 500, A1, false) = 0.253664444
BINOMDIST(1, 500, A1, false) = 0.34844017
BINOMDIST(2, 500, A1, false) = 0.238834677
BINOMDIST(3, 500, A1, false) = 0.108919111

Associated Functions
CRITBINOM, FACT, HYPGDIST, NEGBINDIST and PERMUT



CHIDIST
Description

Calculates the one-tailed probability of the chi-squared ( ) distribution
Syntax

CHIDIST(x, df)
 Arguments Definitions

x any non-negative real number
df any positive integer; specifies the number of degrees of freedom

Notes and Error Values
CHIDIST returns the #BAD DATA! error value if x is < 0 or if df is    0.
The formula of the distribution density function is:

where G(x) is the gamma function.
Example

CHIDIST(1.345, 9) = 0.9963973196
Associated Functions

CHIINV and CHITEST



CHIINV
Description

Calculates the inverse of the chi-squared ( ) distribution, such that if p=CHIDIST(x, df), 
then x=CHIINV(p, df)

Syntax
CHIINV(prob, df)

 Arguments Definitions
prob any non-negative real number; specifies the probability to be used with 

the chi-squared distribution
df any positive integer; specifies the number of degrees of freedom

Error Message
CHIINV returns the #BAD DATA! error value if prob is negative or greater than 1, or if df is 
less than 1 or equal to 0.

Example
CHIINV(A1, 9) = 1.34500122, if A1 contains formula CHIDIST(1.345, 9)

Associated Functions
CHIDIST and CHITEST



CHITEST
Description

Calculates the result of the test of independence. The chi-squared test can be used to 
verify hypothesized results.

Syntax
CHITEST(act_range, expect_range)

 Arguments Definitions
act_range any references to the cells or expressions of returned values, separated by

commas; or an array of values; specifies the observations to test
expect_range any references to the cells or expressions of returned values, separated by

commas; or an array of values; specifies the expected data
Notes and Error Messages

CHITEST returns the #BAD DATA! error value if the arrays have a different number of 
references.
CHITEST does not include empty cells and cells containing text in its calculations; however,
cells with values equal to 0 are included.

Example
The formula for the test statistic for goodness of fit is: 

The hypothetical example below shows the data for expected and actual results for 100 
students and 100 employees taking the same training course. In this case, the expectation
is that the students will retain more or less of the training information than the employees.

Students Employees
Actual
Improved 60 40
Worse 5 20
Unchanged 35 40
Expected
Improved 70 60
Worse 5 10
Unchanged 25 30
The result of the chi-squared test of independence computes as follows:
= CHITEST(B3:C5,B9:C11) = 3.007848E-6
Therefore, the return probability is low.

Associated Functions
CHIDIST and CHIINV



CNT
Description

Calculates the number of cells in a range containing only numbers and formulas
Syntax

CNT(list)
 Argument

List represents any combination of numbers, expressions, cell references separated by 
commas; or an array of values.

Note
CNT does not include empty cells and cells containing text in its calculations; however, 
cells with values equal to 0 are included.

Examples
CNT(2, 3.4, 5, Hello) = 3
CNT(A1, A2, A3, A4) = 2, if A1=Hello, A2 is empty, A3=2, A4=34

Associated Functions
CNTA



CNTA
Description

Calculates the number of cells in the range containing data
Syntax

CNTA(list)
 Argument

List represents any combination of numbers, expressions, cell references separated by 
commas; or an array of values.

Note
CNTA includes cells with values equal to 0 in its calculations.

Examples
CNTA(2, 3.4, 5, Hello) = 4
CNT(A1, A2, A3, A4) = 3, if A1=Hello, A2 is empty, A3=2, A4=34

Associated Function
CNT



CONFIDENCE
Description

Calculates the confidence interval, in accordance with known probability, for a population 
mean. The confidence interval for any value Q is an interval (Q1, Q2) covering the value 
with known probability equals 1-alpha.

Syntax
CONFIDENCE(alph, dev, size)

 Argument Definitions
alpha any positive real number which is a parameter to the distribution
dev any positive real number; specifies the standard deviation for the data
size variable integer greater than 1, representing sample size

Notes and Error Messages
CONFIDENCE returns the #BAD DATA! error value for any non-numeric argument.
The CONFIDENCE probability equals 1 - alpha
Dev is assumed to be known.
If size is a real number, it is rounded down to the nearest integer.

Example
Suppose, that 16 apples have an average weight equal to 120 grams with the standard 
mean square deviation of 15. With 90 percent of confidence, the population mean is within
intervals from 113.8317985 to 126.1682015, because 
90% = 100(1-alpha)%, therefore alpha = 0.1
CONFIDENCE(0.1, 15, 16) = 6.168201506
113.8317985 = 120 - 6.168201506
126.1682015 = 120 - 6.168201506

Associated Functions
ZTEST



CORREL
Description

Calculates the correlation coefficient between two ranges of data. The correlation 
coefficient is a standardized covariance and determines the degree of linear relationship of
two random variables. The function returns the value from -1 to 1, inclusive. Two random 
variables are called non-correlated variables, if their correlation coefficient equals 0. Two 
random variables have a function dependence if the correlation coefficient equals 1 or -1.

Syntax
CORREL(arr1, arr2)

 Arguments Definitions
arr1 an array of real numbers or a data range of values
arr2 an array of real numbers or a data range of values

Notes and Error Messages
CORREL returns the #BAD DATA! error value if:
· the arrays have a different number of references.
· the standard deviation of any random variable equals 0.
CORREL does not include empty cells and cells containing text in its calculations; however,
the cells with values equal to 0 are included.
The correlation coefficient is expressed in the following formula:

where Cov(X,Y) is covariance (see COVAR) and sx, sy are standard deviations.
Example

Suppose, that the first array contains the height of a number of trees and the second one 
contains their mean diameters.
CORREL({17, 18, 19, 20, 21, 22, 23, 24, 25}, {19, 19, 18, 20, 23, 25, 27, 30, 32}) = 
0.957591, which means those two random events are interdependent

Associated Functions
COVAR, FISHER and FISHERINV



COVAR
Description

Calculates covariance, the average of the products of paired deviations, of two ranges of 
data. The function reflects the relationship of two random variables. The positive value of 
the function means that two events have common dependencies, otherwise the events are
not interdependent.

Syntax
COVAR(arr1, arr2)

 Arguments Definitions
arr1 an array of real numbers or a range of data values
arr2 an array of real numbers or a range of data values

Notes and Error Messages
COVAR returns the #BAD DATA! error value if the arrays have a different number of 
references.
COVAR does not include empty cells and cells containing text in its calculations; however, 
cells with values equal to 0 are included.
The formula for covariance is:

where mx, my are the mean values of the arrays
Example

COVAR({17, 18, 19, 20, 21, 22, 23, 24, 25}, {19, 19, 18, 20, 23, 25, 27, 30, 32}) = -
0.2177777778, if A1=3.4, A2=2, A3=2

Associated Functions
CORREL, FISHER and FISHERINV



CRITBINOM
Description

Calculates the smallest value for which the cumulative binomial distribution is greater than
or equal to a criterion value

Syntax
CRITBINOM(trials, prob, alpha)

 Arguments Definitions
trials any integer; specifies the number of Bernoulli trials
prob any non-negative real number; specifies the probability of success for each

trial
alpha any positive real number which is a parameter to the distribution

Notes and Error Messages
If trials is real, CRITBINOM truncates it to integer.
CRITBINOM returns the #BAD DATA! error value if prob is greater than 1.

Example
CRITBINOM(12, 0.9, BINOMDIST(4, 12, 0.9, TRUE)) = 4

Associated Functions
BINOMDIST, FACT, HYPGDIST, PERMUT and PROB



DEVSQ
Description

Calculates the sum of the squared deviations of data points from their sample mean. The 
returning value is always positive.

Syntax
DEVSQ(list)

 Argument
List represents any combination of numbers, expressions, cell references separated by 
commas; or an array of values.

Notes and Error Messages
The formula for DEVSQ is:

where N is the number of values in the list.
Example

DEVSQ(3, -4.5, 75, 22) = 3858.1875
Associated Functions

AVEDEV, STD, VAR and VARP



EXPONDIST
Description

Calculates the magnitude of the exponential distribution probability. The exponential 
distribution is often used to model processes in the theory of reliability and queuing.

Syntax
EXPONDIST(x, lambda, cum)

 Arguments Definitions
x any non-negative real number
lambda any positive real number; specifies the function's parameter 
cum a logical value (TRUE or FALSE); specifies the form of the function

Notes and Error Messages
EXPONDIST returns the #BAD DATA! error value if any argument is out of the range or non-
numeric.
If cum is FALSE, EXPONDIST returns the value of the distribution density function; if TRUE, 
EXPONDIST returns the cumulative distribution function.
The formula of the distribution density function is:

The cumulative distribution function equals:

Examples
EXPONDIST(2.76, 3.2, TRUE) = 0.999854014
EXPONDIST(2.76, 3.2, FALSE) = 0.0004672

Associated Functions
GAMMADIST and POISSON



FDIST
Description

Calculates the F probability distribution. The function is useful in determining degrees of 
diversity between data ranges.

Syntax
FDIST(x, df1, df2)

 Arguments
x any non-negative real number
df1 any positive integer; specifies the number of degrees freedom
df2 any positive integer; specifies the number of degrees freedom

Notes and Error Messages
FDIST returns the #BAD DATA! error value if:
· x is negative, or if any value of the degrees freedom    or equal to 0.
· df1 or df2 is less than 1.
If df1 or df2 is a real number, the function truncates it to an integer.

Examples
FDIST(7.146381829;5;50)= .025
FDIST(3.251,2,8) = 0.092607966

Associated Functions
FINV and FTEST



FINV
Description

Calculates the inverse of the F probability distribution, such that if p=FDIST(x, df1, df2), 
then x=FINV(p, df1, df2).

Syntax
FINV(prob, df1,df2)

 Arguments Definitions
prob any non-negative real number; specifies the probability of success on each

trial used with the F distribution
df1 any positive integer; specifies the numerator degrees of freedom
df2 any positive integer; specifies the denominator degrees of freedom

Notes and Error Messages
FINV returns the #BAD DATA! error value if:
· prob is negative or greater than 1, or if any value of the degrees of freedom is    0.
· df1 or df2 is less than 1.
If df1or df2 is a non-integer, FINV truncates it.

Examples
FINV(0.25,5,5) = 7.146381829
FINV(0.092607966,2,8) = 3.251

Associated Functions
FDIST



FISHER
Description

Calculates the Fisher transformation. The transformation produces a normally distributed 
function.

Syntax
FISHER(x)

 Argument Definition
x any real number from -1 to 1, exclusive

Notes and Error Messages
FISHER returns the #BAD DATA! error value if x is out of the range or a non-numeric value.
The formula of the Fisher transformation is:

Example
FISHER(0.832) = 1.194599783

Associated Functions
CORREL, COVAR and FISHERINV



FISHERINV
Description

Calculates the inverse of the Fisher transformation. If FISHER(x)=y, then FISHERINV(y)=x
Syntax

FISHERINV(y)
 Arguments Definition

y any real number
Notes and Error Messages

FISHERINV returns the #BAD DATA! error value if y is non-numeric.
The formula for the inverse of the Fisher transformation is:

Example
FISHERINV(1.194599783) = 0.832

Associated Functions
CORREL, COVAR and FISHER



FORECAST
Description

Calculates a predicted value of the dependent variable for the independent variable x 
based on a linear regression. Independent variable x has a random range because of 
observing, measuring and other errors. Values in arry depend on values contained in arrx,
the range of independent variables.

Syntax
FORECAST(x, arry, arrx)

 Arguments Definitions
x any real number 
arry the dependent array; a range of data values
arrx the independent array; a range of regression variables

Notes and Error Messages
FORECAST returns the #BAD DATA! error value if:
· x is non-numeric.
· the arrays have a different number of references.
FORECAST does not include empty cells and cells containing text in its calculations; 
however, cells with values equal to 0 are included.

Example
Suppose that in a laboratory experiment the outcome of product Y (kg per hour) depends 
on the reaction temperature x (C). The following table shows dependence of outcome from
the reaction temperature:
x: 51, 32, 80, 73, 64, 45, 83, 44, 93, 28, 35, 40, 29, 53, 58, 65
y: 52.7, 15.2, 89.5, 94.8, 76, 39.3, 114.8, 36.5, 137.4, 5.3, 20.7, 21.7, 9.19, 55.4, 64.3, 

79.1
Predict the outcome of the product when the reaction temperature equals 75 (C).
FORECAST(75, B1:B16, A1:A16) = 96.31364489, if A1:A16 contains independent variables,
B1:B16 contains dependent variables.

Associated Functions
CORREL and SLOPE



FTEST
Description

Calculates the result of the F-test, which checks the variance of two samples to determine 
whether they are significantly different. 

Syntax
FTEST(arr1, arr2)

 Arguments Definition
arr1 an array or range of real numbers
arr2 another array or range of real numbers

Notes and Error Messages
FTEST returns the #BAD DATA! error value if the arrays have a different number of 
references.
FTEST does not include empty cells and cells containing text in its calculations; however, 
cells with 0 values are included.

Examples
FTEST({5,4,7,8,12,11},{14,23,21,16,19,25}) = 0.567008623
FTEST({12,14,12.5},{17,18,16}) = 0.96

Associated Functions
FDIST and FINV



GAMMADIST
Description

Calculates the magnitude of the gamma distribution. 
Syntax

GAMMADIST(x, alpha, beta, cum)
 Arguments Definitions

x any non-negative real number; specifies the value at which the distribution
must be evaluated

alpha any positive real number; specifies the parameter of the distribution
beta any positive real number; specifies the parameter of the distribution
cum a logical value (TRUE or FALSE); specifies the form of the function

Notes and Error Messages
GAMMADIST returns the standard Gamma distribution if beta equals 1.
GAMMADIST returns the #BAD DATA! error value if any argument is out of the range or 
non-numeric.
If cum is FALSE, GAMMADIST returns the value of the distribution density function; if TRUE,
GAMMADIST returns the cumulative distribution function.
The formula of the distribution density function is:

where G(a) is the gamma function.
Examples

GAMMADIST(7, 4.67, 3.44, FALSE)= 0.034859326
GAMMADIST(7, 4.67, 3.44, TRUE) = 0.078691295

Associated Functions
CHIDIST, EXPONDIST, GAMMA and GAMMAINV



GAMMAINV
Description

Calculates the inverse of the gamma cumulative distribution. If p=GAMMADIST(x, alpha, 
beta, TRUE), then x=GAMMAINV(p, alpha, beta)

Syntax
GAMMAINV(prob, alpha, beta)

 Arguments Definitions
prob any non-negative real number; specifies the probability to be used with 

the gamma distribution
alpha any positive real number; specifies the parameter of the distribution
beta any positive real number; specifies the parameter of the distribution

Notes and Error Messages
GAMMAINV returns the #BAD DATA! error value if:
· any argument value is non-numeric.
· prob is negative or greater than 1.

Example
GAMMAINV(0.078691295, 4.67, 3.44) = 7

Associated Functions
CHIINV, EXPONDIST, GAMMA and GAMMADIST



GEOMEAN
Description

Calculates the geometric mean of the data range containing only positive values
Syntax

GEOMEAN(list)
 Arguments
List represents any combination of numbers, expressions, cell references separated by 
commas, or an array of values.
Notes and Error Messages

GEOMEAN returns the #BAD DATA! error value if any value in list is negative.
The formula of the geometric mean is:

Examples
GEOMEAN( 2, {1, 2}) = 1.587401052
GEOMEAN( A1, {1, 2}) = 1.587401052, if A1 contains 2

Associated Functions
AVG, HARMEAN, MEDIAN, MODE and TRIMEAN



HARMEAN
Description

Calculates the harmonic mean of a data range. The harmonic mean is the ratio of the 
number of data points in the list to the sum of the reciprocals.

Syntax
HARMEAN(list)

 Argument
List represents any combination of numbers, expressions, cell references separated by 
commas, or an array of values.
Notes and Error Messages

HARMEAN returns the #BAD DATA! error value if any value in list is negative.
The formula of the harmonic mean is:

Examples
HARMEAN( 2, {1, 2}) = 1.5
HARMEAN( A1, {1, 2}) = 1.5, if A1 contains 2

Associated Functions
AVG, GEOMEAN, MEDIAN, MODE and TRIMEAN



HYPGDIST
Description

Calculates the hypergeometric distribution probability
Syntax

HYPGDIST(succ, num_c, pop, num_p)
 Arguments Definitions

succ any positive integer; specifies the number of successes in the sample
num_s any positive integer; specifies the size of the sample
pop any positive integer; specifies the number of successes in the population
num_p any positive integer; specifies the population size

Notes and Error Messages
The function rounds non-integers to the next lowest integer.
The use of negative arguments returns the #BAD DATA! error value.
HYPGDIST returns the #BAD DATA! error value if:
· succ is greater than the lesser value of num_s or pop, or is less than the greater value 

of 0 or num_s+pop+num_p.
· num_s is greater than num_p.
· pop is greater than num_p.
The hypergeometric distribution is calculated as follows:

where:
C is the number of combinations for a given number of objects
x is the number of successes in the sample
n is the size of the sample
M is the number of successes in the population
N is the population size

Examples
Suppose you have 25 golf balls, 6 of which are fluorescent yellow and you randomly select 
12. Find the probability that only two will turn out to be fluorescent yellow.
HYPGDIST(2,12,6,24) = 0.242726381
Suppose you have 14 coins in your pocket. Ten of them are nickels and the others are 
quarters. Find the probability that if you randomly take three coins from your pocket that 
two will be nickels.
HYPGDIST(2,3,10,14) = 0.494505495

Associated Functions
BINOMDIST, FACT, NEGBINDIST and PERMUT



INTERCEPT
Description

Calculates the intercept of the linear regression. Calculations are based on the dependent 
and independent arrays of data points. The intercept value indicates the point of 
intersection between the linear regression and the y-axis.

Syntax
INTERCEPT(arry, arrx)

 Arguments Definitions
arry the dependent array or data range of values
arrx the independent array or range of regression variables

Notes and Error Messages
INTERCEPT returns the #BAD DATA! error if the arrays have a different number of 
references.
INTERCEPT does not include empty cells and cells containing text in its calculations; 
however, zero values are included.
The intercept of the linear regression has the following equation:

where

and the slope is calculated as:

Example
Evaluate the intercept of the linear regression for the following data:
x: 51, 32, 80, 73, 64, 45, 83, 44, 93, 28, 35, 40, 29, 53, 58, 65
y: 52.7, 15.2, 89.5, 94.8, 76, 39.3, 114.8, 36.5, 137.4, 5.3, 20.7, 21.7, 9.19, 55.4, 64.3, 
79.1
INTERCEPT(B1:B16, A1:A16) = -47.9824     If A1:A16 contains independent variables, 
B1:B16 contains dependent variables.

Associated Functions
FORECAST, PEARSON, RSQ, SLOPE and STEYX



KURT
Description

Calculates the kurtosis coefficient of a data range. The kurtosis coefficient reflects the 
relative peakedness or flatness of a distribution relative to the normal distribution. A 
positive result indicates a relatively peaked distribution. A negative value of the coefficient
indicates a relatively flat distribution.

Syntax
KURT(list)

 Argument
List represents any combination of numbers, expressions, cell references separated by 
commas, or an array of values.

Notes and Error Messages
KURT does not include empty cells and cells containing text in its calculations; however, 
zero values are included.
KURT returns the #BAD DATA! error value if list contains less than four numeric values.

Example
KURT( 3, -4, 5, {6, 7.77}) = 2.432420372

Associated Functions
SKEW, STD, STDP, VAR and VARP



LARGE
Description

Calculates the specified largest value in a data range. The second argument determines 
what largest value to return in their ascending order.

Syntax
LARGE(arr, k)

 Arguments Definitions
arr an array or range reference of real numbers
k any positive integer less than the number of values in arr

Notes and Error Messages
LARGE returns the #BAD DATA! error value if arr is empty or k is greater than the number 
of values in arr.
If k = 1, LARGE returns the largest value in arr.
If k = N, LARGE returns the smallest value in arr; where N is the number of data values in 
the arr.

Example
If A1:A16 contains the following data:
52.7, 15.2, 89.5, 94.8, 76, 39.3, 114.8, 36.5, 137.4, 5.3, 20.7, 21.7, 9.19, 55.4, 64.3, 79.1
LARGE(A1:A16, 2) = 114.8

Associated Functions
PERCENTILE, PERCRANK, QUARTILE and SMALL



LOGINV
Description

Calculates the inverse magnitude of the lognormal distribution. 
Syntax

LOGINV(prob, mean, dev)
 Arguments Definitions

prob any positive real number; specifies the probability to be used with the 
lognormal distribution

mean any real number; specifies the mean value of the random variable
dev any positive real number; specifies the deviation of the random variable.

Notes and Error Messages
LOGINV returns the #BAD DATA! error value if:
· any argument is out of the range or non-numeric.
· prob is negative or greater than 1.

Example
LOGINV(0.118678153, 3, 1.75) = 2.5400000

Associated Functions
EXP, LN, LOG, LOG10 and LOGNORDIST



LOGNORDIST
Description

Calculates the magnitude of the lognormal distribution probability of x, where random 
variable y=ln(x) is normally distributed with parameters mean and dev. 

Syntax
LOGNORDIST(x, mean, dev)

 Arguments Definitions
x any positive real number; specifies the value at which the distribution 

must be evaluated
mean any real number; specifies the mean value of the random variable
dev any positive real number; specifies the deviation of the random variable

Notes and Error Messages
LOGNORDIST returns the #BAD DATA! error value if any argument is out of the range or 
non-numeric.
The formula of the distribution density function is:

where  is the mean value and 
 is the deviation of the random variable.

Example
LOGNORDIST(2.54, 3, 1.75) = 0.118678153

Associated Functions
EXP, LN, LOG, LOG10 and LOGINV





MAX
Description

Returns the highest number in the data range

Syntax

MAX(list)

 Argument
List represents any combination of numbers, expressions, cell references separated by 
commas, or an array of values.

Notes and Error Messages
MAX does not include empty cells and cells containing text in its calculations; however, 
cells with zero values are included.
If all arguments in the list are non-numeric, MAX returns 0.

Example
MAX(3, -4, 2.999, {5, 4.32}) = 5

Associated Functions
MIN



MEDIAN
Description

Returns the median value in the data range. The median is a value at the mid-point of a 
list of data points; half the values in the list are greater than the median and half are 
smaller.

Syntax

MEDIAN(list)

 Argument
List represents any combination of numbers, expressions, cell references separated by 
commas, or an array of values.

Notes and Error Messages
MEDIAN does not include empty cells and cells containing text in its calculations; however,
zero values are included.

Example
MEDIAN(3, 9, 7.6, 4.5, 7.6, 3, 3) = 4.5

Associated Functions
AVG, CNT, CNTA, MODE and SUM



MIN
Description

Returns the lowest number in the data range

Syntax

MIN(list)

 Argument
List represents any combination of numbers, expressions, cell references separated by 
commas, or an array of values.

Notes and Error Messages
MIN does not include empty cells and cells containing text in its calculations; however, the 
cells with zero values are included.
If all arguments in the list are non-numeric, MIN returns 0.

Example
MIN((3, -4, 2.999, {5, 4.32}) = -4

Associated Functions
MAX



MODE
Description

Calculates the value of the most frequently repeated data points in the data range

Syntax

MODE(list)

 Argument
List represents any combination of numbers, expressions, cell references separated by 
commas, or an array of values.

Notes and Error Messages
MODE returns the #BAD DATA! error value if list does not contain duplicated data points.
MODE does not include empty cells and cells containing text in its calculations; however, 
zero values are included.

Example
MODE(3, 9, 7.6, 4.5, 7.6, 3, 3) = 3

Associated Functions
AVG, GEOMEAN, HARMEAN, MEDIAN and TRIMEAN



NEGBINDIST
Description

Calculates the negative binomial distribution. The returning value specifies the probability 
that f number of failures will occur before s number of successes, where the probability of 
success in each trial equals prob.

Syntax

NEGBINDIST(f, s, prob)

 Arguments Definitions
f any non-negative integer; specifies the number of failures on each trial
s any non-negative integer; specifies the threshold number of successes on 

each trial
prob any non-negative real number; specifies the probability of success on each

trial
Notes and Error Messages

NEGBINDIST returns the #BAD DATA! error value if:
· any argument is negative.
· prob is greater than 1.
If f or s is real, NEGBINDIST truncates it to an integer.

Example
NEGBINDIST(1, 5, 0.9) = 0.295245

Associated Functions
BINOMDIST, FACT, HYPGDIST and PERMUT



NORMDIST
Description

Calculates the magnitude of the normal distribution for the specified mean and standard 
deviation. The function is widely used in mathematical statistics and especially in 
hypothesis testing.

Syntax

NORMDIST(x, mean, dev, cum)

 Arguments Definitions
B any real number specifying the upper limit of x
x any real number to be measured for its distribution
mean any real number; specifies the mean value of the random variable
dev any positive real number; specifies the deviation of the random variable
cum a logical value (TRUE or FALSE); specifies the form of the function

Notes and Error Messages
NORMDIST returns the #BAD DATA! error value if any argument is out of range or non-
numeric.
If cum is FALSE, NORMDIST returns the value of the distribution density function; if TRUE, 
it returns the cumulative distribution function.
The formula of the distribution density function is:

where  is the mean value and 
 is the deviation of the random variable.

Example
NORMDIST(12, 11, 1.75, TRUE) = 0.7161454169

Associated Functions
NORMINV and ZTEST



NORMINV
Description

Calculates inverse magnitude of the normal distribution

Syntax

NORMINV(prob, mean, dev)

 Arguments Definitions
prob any positive real number; specifies the probability to be used with the 

standard normal distribution
mean any real number; specifies the mean value of the random variable
dev any positive real number; specifies the deviation of the random variable

Notes and Error Messages
NORMINV returns the #BAD DATA! error value if:
· prob is negative or greater than 1.
· any argument is out of the range or non-numeric.

Example
NORMINV(0.7161454169, 11, 1.75) = 12

Associated Functions
NORMDIST and ZTEST



NORMSDIST
Description

Calculates the standard normal distribution function. The distribution is the special case of 
the normal distribution, which has a mean value equal to zero and a standard deviation 
equal to one.

Syntax

NORMSDIST(z)

 Argument
z any real number; specifies the value at which the standard distribution is 

to be evaluated
Notes and Error Messages

NORMSDIST returns the #BAD DATA! error value if the argument is non-numeric.
Example

NORMSDIST(2.3454) = 0.9904966618
Associated Functions

NORMDIST, NORMINV, NORMSINV and ZTEST



NORMSINV
Description

Calculates inverse magnitude of the standard normal distribution

Syntax

NORMSINV(prob)

 Argument
prob any non-negative real number; specifies the probability to be used with 

the standard normal distribution
Notes and Error Messages

NORMSINV returns the #BAD DATA! error value if prob is negative or greater than 1.
Example

NORMSINV(0.9904966618) = 2.345399857
Associated Functions

NORMDIST, NORMINV and ZTEST



PEARSON
Description

Calculates the Pearson product moment correlation coefficient, R., reflecting the extent of 
a linear relationship between two data sets. The returning value is in the range from -1.0 
to 1.0 inclusive.

Syntax

PEARSON(arr1, arr2)

 Arguments Definitions
arr1 the dependent array or a data range of values
arr2 the independent array or range of regression variables

Notes and Error Messages
PEARSON returns the #BAD DATA! error value if the arrays have a different number of 
references.
PEARSON does not include empty cells and cells containing text in its calculations; 
however, cells zero values are included.
The formula for the R value of the regression is:

Example
PEARSON({2, 4, 5, 2, 1, 2}, {4, 2, 6, 3, 7, 1}) = 0.019114485

Associated Functions
CORREL, COVAR, INTERCEPT, RSQ, SLOPE and STEYX 



PERCENTILE
Description

Calculates the k-th percentile of the values contained in a data range.

Syntax

PERCENTILE(arr, k)

 Arguments Definitions
arr an array or range reference of real numbers
k any real number from 0 to 1 inclusive

Notes and Error Messages
PERCENTILE returns the #BAD DATA! error value if:
· k is non-numeric or out of range.
· arr contains non-numeric data or is empty.

Example
A 10-cell range (C11 to C20) containing the values 1 to 10, returns the following 
PERCENTILE result:
PERCENTILE(C11..C20,0.5) = 5.5

Associated Functions
LARGE, MAX, MEDIAN, MIN, PERCRANK, QUARTILE and SMALL



PERCRANK
Description

Calculates the percentage rank of a value contained in a data range compared with the 
other values

Syntax

PERCRANK(arr, x, s)

 Arguments Definitions
arr an array or range reference of real numbers
x any number from arr; the value whose percentage rank you want to 

establish
s an integer value; specifies the number of significant digits for the 

percentage value returned
Notes and Error Messages

PERCRANK returns the #BAD DATA! error value if:
· arr contains non-numeric data or is empty.
· s is less than 1.

Examples
PERCRANK returns the following for the 10-cell range (C11 to C20) containing the values 1 
to 10:
PERCRANK(c11..c20,c16,3) = 0.555

Associated Functions
LARGE, MAX, MEDIAN, MIN, PERCENTILE, QUARTILE and SMALL,



PERMUT
Description

Calculates how many permutations may result from a defined number of objects. The 
internal order of objects is significant for the permutation.

Syntax

PERMUT(num, num_c)

 Arguments Definitions
num any non-negative integer; specifies the number of objects
num_c any non-negative integer; specifies the number of objects in each 

permutation
Notes and Error Messages

PERMUT returns the #BAD DATA! error value if:
· any argument is negative.
· num_c is greater than num.
The number of permutations is determined by the following formula:

Example
PERMUT(15, 4) = 32760

Associated Functions
BINOMDIST, CRITBINOM, FACT, HYPGDIST and NEGBINDIST



POISSON
Description

Calculates the Poisson probability distribution. The Poisson distribution can be obtained 
from the binomial distribution when the number of trials is very large and the probability of
success is small, provided that their product is constant.

Syntax

POISSON(x, mean, cum)

 Arguments
a any positive real number; specifies the value at which the distribution 

must be evaluated
mean any positive real number; specifies the mean value of the random variable
cum a logical value (TRUE or FALSE); specifies the form of the function

Notes and Error Messages
POISSON returns the #BAD DATA! error value if any argument is out of the range or non-
numeric.
If cum is FALSE, POISSON returns the value of the probability mass function; if TRUE, it 
returns the cumulative distribution function.
The formula of the probability mass function is:

The formula of the cumulative Poisson probability is:

Examples
Suppose, that 500 students studied at a faculty. Find the probability that September 1, is 
the birthday of k students simultaneously where k can be 0,1,2,...
Let A1 equal 500/365, then
POISSON(0, A1, FALSE) = 0.2541417711
POISSON(1, A1, FALSE) = 0.3481394125
POISSON(2, A1, FALSE) = 0.2384516524

Associated Functions
BINOMDIST and EXPONDIST



PROB
Description

Calculates the probability that the values in xrange belong to the interval bounded by 
lim1 and lim2. 

Syntax

PROB(xrange, probrange, lim1, lim2)

 Arguments Definitions
xrange the array for which you wish to associate probabilities
probrange probabilities to be used with values in the xrange
lim1 any real number; specifies the lower limit of the interval
lim2 any real number; specifies the upper limit of the interval

Notes and Error Messages
PROB returns the #BAD DATA! error value if:
· the arrays have a different number of references.
· any probability value is negative or greater than 1, or the sum of values in the 

probrange is not equal to 1.
Examples

PROB({20.33, 25.87, 26, 23,57}, {0.6, 0.1, 0.16, 0.14}, 23, 34) = 0.4
PROB({20.33, 25.87, 26, 23,57}, {0.6, 0.1, 0.16, 0.14}, 12, 19) = 0

Associated Functions
BINOMDIST and CRITBINOM



QUARTILE
Description

Calculates the representation of placement and dispersion of a random variable value

Syntax

QUARTILE(arr, q)

 Arguments Definitions
arr an array or range reference of real numbers
q an integer number from 0 to 4; specifies which value is to be returned

Notes and Error Messages
If q = 0, the function returns the minimum value in the array.
If q = 1, the function returns the first quartile of the array.
If q = 2, the function returns the median value in the array.
If q = 3, the function returns the third quartile of the array.
If q = 4, the function returns the maximum value in the array.
QUARTILE returns the #BAD DATA! error value if:
· q is out of range or non-numeric.
· arr contains non-numeric values.

Examples
QUARTILE({2,3,5,2.1,-3.4}) = 2
QUARTILE({2,3,5,2.1,-3.4},2) = 2.05

Associated Functions
LARGE, MAX, MEDIAN, MIN, PERCENTILE, PERCRANK and SMALL



RANK
Description

Calculates the rank of a number in an array of values. Numbers are ranked by position in 
the array of values.

Syntax

RANK(num, ref, ord)

 Arguments Definitions
num any real number
ref an array or range of reference of real numbers
ord any number specifying the type of ranking, the num

Notes and Error Messages
RANK does not include empty cells and cells containing text in its calculations; however, 
cells with zero values are included.
If ord is omitted or equals zero, RANK returns the rank of the num as if the ref is sorted by
descending order; otherwise RANK returns the rank of the num as if the ref is sorted by 
ascending order.
RANK returns the #BAD DATA! error value if num value is absent in the ref.
The duplicated numbers num have the same rank.

Examples
RANK(2, {3,5,6,1,2}, 1) = 2
RANK(2, {3,5,6,1,2}) = 4



RSQ
Description

Calculates the square of the Pearson product moment correlation coefficient, R, based on 
two known arrays of data. The interpretation of the r-squared value reflects the proportion 
of the variance in arry attributable to the variance in arrx.

Syntax

RSQ(arry, arrx)

 Arguments Definitions
arry the dependent array or data range of values
arrx the independent array or range of regression variables

Notes and Error Messages
RSQ returns the #BAD DATA! error value if the arrays have a different number of 

references.
RSQ does not include empty cells and cells containing text in its calculations; however, 
cells with zero values are included.
The formula for the R value of the regression is:

Example
RSQ({2, 4, 5, 2, 1, 2}, {4, 2, 6, 3, 7, 1}) = 0.000365364

Associated Functions
CORREL, COVAR, INTERCEPT, PEARSON, SLOPE and STEYX 



SKEW
Description

Calculates the skewness of a distribution. The concept of skewness specifies the degree of 
a distribution around its mean. Skewness can be positive, negative and zero. If the function
returns a positive value, it means that a distribution has an asymmetric tail extended 
toward positive values; if the function returns negative value, a distribution has 
asymmetric tail extended toward negative values. A distribution has symmetric tails if the 
function returns zero.

Syntax

SKEW(list)

 Argument
List represents any combination of numbers, expressions, cell references separated by 
commas, or an array of values.

Notes and Error Messages
SKEW returns the #BAD DATA! error value if there are fewer than three data points, or 
sample standard deviation is zero.
SKEW does not include empty cells and cells containing text in its calculations; however, 
cells with zero values are included.
The formula for skewness is:

where  is the mean value of the data contained in the list and 
 is the standard deviation.

Example
SKEW({4, -3.22, 2}, -12.345) = -1.098255616

Associated Functions
KURT, STD, STDP, VAR and VARP



SLOPE
Description

Calculates the slope of the linear regression. Calculations are based on the dependent and 
independent arrays of data points.

Syntax

SLOPE(arry, arrx)

 Arguments Definitions
arry the dependent array or data range of values
arrx the independent array or range of regression variables

Notes and Error Messages
SLOPE returns the #BAD DATA! error value if the arrays have a different number of 
references.
SLOPE does not include empty cells and cells containing text in its calculations; however, 
cells with zero values are included.
The formula of the linear regression slope is:

where

The intercept of the linear regression has the following equation:

Example
Evaluate the slope of the linear regression for the following data:
x: 51, 32, 80, 73, 64, 45, 83, 44, 93, 28, 35, 40, 29, 53, 58, 65
Y: 52.7, 15.2, 89.5, 94.8, 76, 39.3, 114.8, 36.5, 137.4, 5.3, 20.7, 21.7, 9.19, 55.4, 64.3, 

79.1
SLOPE(B1:B16, A1:A16) =1.923950701. If A1:A16 contains independent variables, B1:B16

contains dependent variables.
Associated Functions

FORECAST



SMALL
Description

Calculates the specified smallest value in a data range. The second argument determines 
what smallest value to return in their ascending order.

Syntax

SMALL(arr, k)

 Arguments Definitions
arr an array or range reference of real numbers
k any positive integer less than the number of values in arr

Notes and Error Messages
SMALL returns the #BAD DATA! error value if:
· arr is empty or k is greater than the number of values in arr.
· k = 1, the function returns the smallest value in arr.
If k = N, SMALL returns the largest value in arr; where N is the number of data values in 
the arr.

Example
Let A1:A16 contain the following data:
52.7, 15.2, 89.5, 94.8, 76, 39.3, 114.8, 36.5, 137.4, 5.3, 20.7, 21.7, 9.19, 55.4, 64.3, 79.1
SMALL(A1:A16, 2) = 9.19

Associated Functions
LARGE, MAX, MEDIAN, MIN and PERCENTILE



STANDDIZE
Description

Calculates standardized value of the variable x from a distribution characterized by the 
mean value (mean) and standard deviation (dev).

Syntax

STANDDIZE(x, mean, dev)

 Arguments Definitions
x any real number
mean any real number; specifies the mean value of the distribution
dev any positive real number; specifies the standard deviation of the 

distribution
Notes and Error Messages

STANDDIZE returns the #BAD DATA! error value if:
· any argument is non-numeric 
· dev is negative or zero.
The formula of standardization is:

where  is the mean value of the distribution and 
 is the standard deviation.

Example
STANDDIZE(24, 20, 1.75) = 2.285714286

Associated Functions
NORMDIST, NORMINV, NORMSDIST, NORMSINV and ZTEST



STD
Description

Calculates the estimate of standard deviation of the numbers in the range. The standard 
deviation is a measure of data dispersion from the mean.

Syntax

STD(list)

 Argument
List represents any combination of numbers, expressions, cell references separated by 
commas, or an array of values.

Notes and Error Messages
STD does not include empty cells and cells containing text in its calculations; however, 
cells with zero values are included.
The formula of the estimate of standard deviation is as follows:

Example
Let A1:A16 contain the following sample data:
52.7, 15.2, 89.5, 94.8, 76, 39.3, 114.8, 36.5, 137.4, 5.3, 20.7, 21.7, 9.19, 55.4, 64.3, 79.1
STD(A1:A16) = 39.34216173

Associated Functions
STDP, VAR and VARP



STDP
Description

Calculates the standard deviation for a population based on the numbers in the range. The
standard deviation is a measure of data dispersion from the mean.

Syntax

STDP(list)

 Argument
List represents any combination of numbers, expressions, cell references separated by 
commas, or an array of values.

Notes and Error Messages
STDP does not include empty cells and cells containing text in its calculations; however, 
cells with zero values are included.
The formula of the standard deviation is as follows:

Example
Let A1:A16 contain the following data:
52.7, 15.2, 89.5, 94.8, 76, 39.3, 114.8, 36.5, 137.4, 5.3, 20.7, 21.7, 9.19, 55.4, 64.3, 79.1
STDP(A1:A16) = 38.0928843

Associated Functions
STD, VAR and VARP



STEYX
Description

Calculates the standard error of the forecast y-value for the x-values of a regression. The 
standard error is a measure of the quality of approximation x by y.

Syntax

STEYX(arry, arrx)

 Arguments Definitions
arry the dependent array or a data range of values
arrx the independent array or range of regression variables

Notes and Error Messages
STEYX returns the #BAD DATA! error value if the arrays have a different number of 
references.
STEYX does not include empty cells and cells containing text in its calculations; however, 
cells with zero values are included.
The formula of the standard error of the linear regression is:

Example
x: 51, 32, 80, 73, 64, 45, 83, 44, 93, 28, 35, 40, 29, 53, 58, 65
y: 52.7, 15.2, 89.5, 94.8, 76, 39.3, 114.8, 36.5, 137.4, 5.3, 20.7, 21.7, 9.19, 55.4, 64.3, 

79.1
STEYX(B1:B16, A1:A16) =5.350158454, if A1:A16 contains independent variables, B1:B16

contains dependent variables
Associated Functions

INTERCEPT, PEARSON, RSQ and SLOPE



TDIST
Description

Calculates the student's T-distribution with df (degrees of freedom). The T-distribution is 
widely used in the hypothesis testing and finding a confidence interval for a unknown 
value.

Syntax

TDIST(x, df, tails)

 Arguments Definitions
x any real number
df any positive integer number; specifies the degrees of freedom of the 

distribution
tails can be 1 or 2; specifies the number of distribution tails to be returned

Notes and Error Messages
TDIST returns the #BAD DATA! error value if any argument is non-numeric or out of range.
The formula of the student's T-distribution density function is:

where G(z) is the gamma function, k is the degrees of freedom of the distribution.
Example

TDIST(1.4, 34, 1) = 0.085286294
Associated Functions

TINV and TTEST



TINV
Description

Calculates the inverse of the student's T-distribution with df (degrees of freedom)

Syntax

TINV(prob, df)

 Arguments Definitions
prob any non-negative real number; specifies the probability to be used with 

the student's T-distribution
df any positive integer; specifies the degrees of freedom of the distribution

Notes and Error Messages
TINV returns the #BAD DATA! error value if prob is negative or greater than 1.

Examples
TINV(0.054587,60) = 1.960484194
TINV(0.100032988,3) = 2.3530000004

Associated Functions
TDIST and TTEST



TRIMEAN
Description

Calculates the mean of a range within a data range

Syntax

TRIMEAN(arr, percent)

 Arguments Definitions
arr an array or range reference of real numbers
percent any real number from 0 to 1 exclusive; specifies the fractional number of 

values to be excluded from the calculation
Notes and Error Messages

TRIMEAN does not include empty cells and cells containing text in its calculations; 
however, cells with zero values are included.

Examples
If the range C11 to C20 contains the values 1 to 10, 
TRIMEAN(c11..c20,0.33) = 5.5
TRIMEAN({2,3,5,2.1,-3.4},0.25) = 1.74

Associated Functions
AVG, HARMEAN, GEOMEAN, MEDIAN and MODE



TTEST
Description

Calculates the probability associated with a student's T-test. The TTEST determines the 
homogeneity or similarity of two normal samples. 

Syntax

TTEST(arr1, arr2, tails, t)

 Arguments Definitions
arr1 an array or range reference of real numbers
arr2 an array or range reference of real numbers
tails can be 1 or 2; specifies the number of distribution tails to return
t can be 1, 2 or 3; specifies the type of the test to perform

Notes and Error Messages
TTEST returns the #BAD DATA! error value if the arrays have a different number of 
references.
The function does not include empty cells and cells containing text in its calculations; 
however, cells with zero values are included.
If t equals 1, the function performs the paired test.
If t equals 2, the function performs the homoscedastic test.
If t equals 3, the function performs the heteroscedastic test.

Examples
TTEST({2;3;4;5};{4.5;6.7;7.8901;10};2;2) = 0.028688116
TTEST({5;6;7;4;6;7;7;8;6;5};{8;6;7;7;9;8;7;5;7;9};2;1) = 0.103888131

Associated Functions
TDIST and TINV



VAR
Description

Estimates the variance of the numbers in a data range

Syntax

VAR(list)

 Argument
List represents any combination of numbers, expressions, cell references separated by 
commas, or an array of values.

Notes and Error Messages
VAR does not include empty cells and cells containing text in its calculations; however, 
cells with zero values are included.
The formula of an estimate for the variance of the numbers is:

Example
VAR(12, 14, 14.74, 11.24, 10.5, 16.8, 10.8) = 5.727714286

Associated Functions
STD, STDP and VARP



VARP
Description

Calculates the variance of a population for the numbers in the range

Syntax

VARP(list)

 Argument
List represents any combination of numbers, expressions, cell references separated by 
commas, or an array of values.

Notes and Error Messages
VARP does not include empty cells and cells containing text in its calculations; however, 
cells with zero values are included.
The formula of the variance of a population is:

Example
VARP(12, 14, 14.74, 11.24, 10.5, 16.8, 10.8) = 4.909469388

Associated Functions
STD, STDP and VAR



WEIBULL
Description

Calculates the magnitude of the Weibull probability distribution. The Weibull distribution is 
used to estimate the probable life of electronic equipment and approximate different non-
symmetrical distributions in mathematical statistics.

Syntax

WEIBULL(x, alpha, beta, cum)

 Arguments Definitions
x any real number; specifies the value at which the distribution has to be 

evaluated
alpha any real number; specifies the parameter of the distribution
beta any real number; specifies the parameter of the distribution
cum a logical value (TRUE or FALSE); specifies the form of the WEIBULL function

Notes and Error Messages
WEIBULL returns the #BAD DATA! error value if any argument is out of the range or non-
numeric.
If cum is FALSE, WEIBULL returns the value of the distribution density function; if TRUE, 
WEIBULL returns the cumulative distribution function.
The formula of the cumulative distribution function is:

The formula of the distribution density function is:

Examples
WEIBULL(75, 43, 81, FALSE) = 0.020198365
WEIBULL(75, 43, 81, TRUE) = 0.03588128

Associated Functions
EXPONDIST



ZTEST
Description

Calculates the two-tailed probability for the standard normal distribution and a standard 
score for x relative to the data range

Syntax

ZTEST(arr, x)

 Arguments Definitions
arr an array or range reference of real numbers
x any real number; specifies the value to be tested

Notes and Error Messages
ZTEST returns the #BAD DATA! error value if arr contains no data or x is non-numeric.
The formula of the z-test is as follows:

where  is the mean value of the distribution, 
 is the standard deviation and n is the number of values in the arr.

Examples
ZTEST({80,76,70,60,90,87,67,89,77,76,56,60,95,66,57},75,) = 0.649761781
ZTEST((1;2;3;4;5;6};3) = 0.2563458

Associated Functions
CONFIDENCE, NORMDIST, NORMINV, NORMSDIST, NORMSINV and STANDDIZE



Statistical Functions
Function Description
AVEDEV() Calculates the average of absolute deviations of values in a data list 

from the mean
AVG() Calculates the average of the range or list of arguments
BETADIST()                 Calculates the cumulative beta probability density distribution, widely 

used in the statistical testing of production quality
BETAINV()                   Calculates the inverse value of the cumulative beta probability density 

function
BINOMDIST() Calculates the magnitude of the individual term binomial probability 

distribution
CHIDIST()                   Calculates the one-tailed probability of the chi-squared ( ) distribution
CHIINV()             Calculates the inverse of the chi-squared ( ) distribution
CHITEST()          Calculates the result of the test of independence
CNT() Calculates the number of cells in a range containing only numbers and formulas
CNTA() Calculates the number of cells in the range containing data
CONFIDENCE()              Calculates the confidence interval, in accordance with known 
probability, for a population mean
CORREL() Calculates the correlation coefficient between two ranges of data
COVAR() Calculates covariance, the average of the products of paired deviations, of two
ranges of data.
CRITBINOM() Calculates the smallest value for which the accumulated binomial 

distribution is greater than or equal to a criterion value
DEVSQ() Calculates the sum of the squared deviations of data points from their 

sample mean
EXPONDIST() Calculates the magnitude of the exponential distribution probability
FDIST()                       Calculates the F probability distribution
FINV()                         Calculates the inverse of the F probability distribution
FISHER() Calculates the Fisher transformation
FISHERINV() Calculates the inverse of the Fisher transformation
FORECAST()               Calculates predicated values along a linear regression
FTEST()                      Calculates the result of the F-test, which checks the variance of two 

samples to determine whether they are significantly different
GAMMADIST() Calculates the magnitude of the gamma distribution
GAMMAINV()              Calculates the inverse of the gamma cumulative distribution
GEOMEAN() Calculates the geometric mean of a data range containing only positive 

values
HARMEAN() Calculates the harmonic mean of a data range
HYPGDIST() Calculates the hypergeometric distribution probability
INTERCEPT()               Calculates the intercept of the linear regression
KURT() Calculates the kurtosis coefficient of a data range
LARGE()                     Calculates the specified largest value in a data range



LOGINV()                    Calculates the inverse magnitude of the lognormal distribution
LOGNORDIST()           Calculates the magnitude of the lognormal distribution probability
MAX() Returns the highest number in the data range
MEDIAN()                   Returns the median value in the data range
MIN() Returns the lowest number in the data range
MODE()                      Calculates the value of the most frequently repeated data points in the 

data range
NEGBINDIST() Calculates negative binomial distribution
NORMDIST()               Calculates the magnitude of the normal distribution for the specified 

mean and standard deviation
NORMINV()                 Calculates inverse magnitude of the normal distribution
NORMSDIST()             Calculates the standard normal distribution function
NORMSINV()               Calculates inverse magnitude of the standard normal distribution
PEARSON()                 Calculates the Pearson product moment correlation coefficient
PERCENTILE()             Calculates the k-th percentile of the values contained in a data range
PERCRANK()               Calculates the percentage rank of a value contained in a data range 

compared with the other values
PERMUT() Calculates how many permutations may result from a defined number of 

objects
POISSON()                  Calculates the Poisson probability distribution
PROB()                       Calculates the probability that the values belong to the specified interval
QUARTILE()                 Calculates the representation of placement and dispersion of a random 

variable value
RANK()                       Calculates the rank of a number in an array of values
RSQ()                         Calculates the square of the Pearson product moment correlation 

coefficient
SKEW() Calculates the skewness of a distribution
SLOPE()                      Calculates the linear regression slope
SMALL()                      Calculates the specified smallest value in a data range
STANDDIZE()              Calculates a standardized value for a variable
STD() Calculates an estimate of standard deviation of the numbers in the range
STDP() Calculates the standard deviation for a population based on the numbers

in the range
STEYX()                      Calculates the standard error of the forecast y-value for the x-values of a 

regression
TDIST()                       Calculates a student's T-distribution with df (degrees of freedom)
TINV()                         Calculates the inverse of a student's T-distribution with df (degrees of 

freedom)
TRIMEAN()                  Calculates the mean of a range within a data range
TTEST()                      Calculates the probability involved with a student's T-test



VAR() Estimates the variance of the numbers in a data range
VARP() Calculates the variance of a population for the numbers in the range
WEIBULL() Calculates the magnitude of the Weibull probability distribution
ZTEST()                      Calculates the two-tailed probability for the standard normal distribution 

and a standard score for x relative to the data range





Text Functions
Function            Description
CHAR() Returns the number of the Windows font character from 1 to 255 

referenced by your computer
CLEAN() Deletes non-printable Windows font characters from 1 to 255 referenced 

by your computer from the text string
CODE() Result is a numeric code matching the code used in the Windows 

character set for the first character in the given string
DOLLAR() Rounds a numeric value to a given number of decimals using financial 

format and returns the result as text
FIND() Finds the substring txt in the text string intxt beginning with the 

specified position st. Result is the number of position in intxt where the 
substring is situated.

FIXED() Rounds a numeric value to a given number of decimals and converts the 
result to text 

LEFT() Finds the specified number of initial characters in the text string and 
returns the characters as a text string

LEN() Result is the number of characters in the text string
LOWER() Converts any uppercase letters in a text string to lower case
MID() Returns the number of characters in a text string, beginning at a given 

position
PROPER() Converts the first letter in each word of the given text string to upper case
REPLACE() Replaces specified number of characters of the text string from the start 

position with the new string
RIGHT() Computes the number of end characters in the text string, returning the 

result as text 
ROMAN() Rounds the value to an integer and converts it to a Roman numeral
SEARCH() Result is the position of the substring text1 in the text string text2
SUBST() Searches for the given substring in the text string and replaces it with a 

new one
TRIM() Deletes spaces in text strings, leaving only single spaces between words
UPPER() Converts lower-case letters in a text string to upper case
VALUE() Converts a text argument to a number



CHAR
Description

Returns the number of the Windows font character from 1 to 255 referenced by your 
computer

Syntax
CHAR(exp)

 Argument
exp any integer number from 1 to 255 inclusive

Examples
CHAR(67) = C
CHAR(72) = H
CHAR(65) = A
CHAR(82) = R
CHAR(84) = T

Associated Functions
CODE



CLEAN
Description

Deletes non-printable Windows font character from 1 to 255 referenced by your computer 
from the text string

Syntax
CLEAN(text)

 Argument
text any text string

Examples
Since character 9 is nonprintable, you could eliminate it as follows.
CLEAN(CHAR(9)+"Sample Text") = Sample Text
CLEAN(A1) = "Test of CLEAN func", if A1 contains the text string "Test 

of"+CHAR(12)+"CLEAN func"+CHAR(7)
Associated Functions

CHAR and TRIM



CODE
Description

Result is a numeric code matching the code used in the Windows character set for the first
character in the given string

Syntax
CODE(text)

 Argument
text  any text string

Examples
CODE("C") = 67
CODE("Corel") = 67

Associated Functions
CHAR



DOLLAR
Description

Rounds a numeric value to a given number of decimals using financial format and returns 
the result as text.

Syntax
DOLLAR(num, dec)

 Arguments Definitions
num any real number
dec an integer--specifies the number of digits to round to

Notes and Error Messages
DOLLAR returns the #BAD DATA! error value for non-numeric arguments.
The first argument can be a reference to a cell which contains a numeric value or a 
reference to a formula which returns a numeric value.
If dec is negative, the number is rounded to the left of the decimal point, and if dec is not 
included, it is assumed to be 2.

Examples
DOLLAR(72.989, 3) = "$72,989"
DOLLAR(72.989, -1) = "$70"
DOLLAR(-72.989, 2) = "$72.989999999"
DOLLAR(72.989) = "$72.989999999"

Associated Functions
FIXED and VALUE



FIND
Description

Finds text string txt in the string intxt starting from the position st. Result is the position 
of txt in intx1.

Syntax
FIND(txt, intxt, st)

 Arguments Definitions
txt any text string specifying the sample to be found
intxt any text string specifying the lookup string to be found
st any positive integer

Notes
FIND returns 0 if:
· it does not find txt in intxt.
· st is greater than the number of characters in the intxt.
· st is negative.
The function is case-sensitive and sensitive to diacritical marks used in non-English 
languages.

Examples
FIND("mem", "Commemorate", 1)= 4, because mem (sample to find) is at position 4
FIND(B1, B2,1) = 2 (if B1 contains election and B2 contains selection)
FIND("d", "end", 4) = #BAD DATA!, because the last argument is greater than 

the number of characters in the lookup string
Associated Functions

LEN and SEARCH



FIXED
Description

Rounds a numeric value to a given number of decimals and converts the result to text 
Syntax

FIXED(num, dec)
 Arguments Definitions

num any real number
dec an integer--specifies the number of digits to round

Notes
If dec argument is omitted, it is assumed to be 2.
If dec is negative, num is rounded to the left of the decimal point.
FIXED converts    the result to text.

Examples
FIXED(45287, 3) = "45,287.28"
TYPE(FIXED(45287.28, 3)) = ""
FIXED(45287.2834, -2) = "45300"

Associated Functions
DOLLAR, ROUND and VALUE



LEFT
Description

Finds the specified number of initial characters in the text string and returns the characters
as a text string

Syntax
LEFT(text, exp)

 Arguments Definitions
text any text string; must be enclosed in a quotation marks
exp any non-negative integer--specifies the number of initial characters to 

return
Notes and Error Messages

If exp is greater than the length of text tested, the function returns all of text.
The number of characters returned is never greater than the length of the text.
If the first argument is not a text string, LEFT returns the #BAD DATA! error value.

Examples
LEFT("Olympiad", 7) = "Olympia"
LEFT("Olympiad", 15) = "Olympiad"

Associated Functions
MID and RIGHT



LEN
Description

Result is the number of characters in the text string
Syntax

LEN(text)
 Argument

text any text string; must be enclosed in quotation marks
Examples

LEN("Example") = 7
LEN("") = 0

Associated Functions
SEARCH



LOWER
Description

Converts any uppercase letters in a text string to lower case
Syntax

LOWER(text)
 Argument

text any text string; must be enclosed in quotation marks
Notes and Error Messages

If the argument is not a text string, LOWER returns the #BAD DATA! error value.
The argument can be a reference to a which cell contains the corresponding value.

Example
LOWER("We All Live In ...") = "we all live in ..."

Associated Functions
UPPER and PROPER



MID
Description

Returns the number of characters in a text string, beginning at a given position
Syntax

MID(text, st, exp)
 Arguments Definitions

text any text string; must be enclosed in quotation marks
st any positive integer
exp any positive integer--specifies the number of leftmost characters to return

Notes
If one or both of the numeric arguments equals 0, they are assumed to be 1.
If st is greater than the length of text, MID returns 0.
Any argument can be a reference to a cell which contains corresponding values.

Examples
MID("Rolling Stones", 9, 6) = "Stones"
MID("Rolling Stones", 9, 5) = "Stone"
MID("Rolling Stones", 1, 25) = "Rolling Stones"
MID(A3, A4, A5) = "Rolling", if A3 contains "Rolling Stones"
A4 contains 1, A5 contains 7

Associated Functions
CODE, FIND, LEFT RIGHT and SEARCH



PROPER
Description

Converts the first letter in each word of the given text string to upper case
Syntax

PROPER(text)
 Argument

text any text string; must be enclosed in quotation marks
Notes

The argument can be a reference to a cell which contains the referenced text.
Examples

PROPER("aBrAcAdAbRa") = "Abracadabra"
PROPER("WHEN the sUN is BRIGHT...") = "When The Sun Is Bright..."

Associated Functions
LOWER and UPPER



REPLACE
Description

Replaces the specified number of characters of the text string from the start position with 
the new string

Syntax
REPLACE(text, st, num, n_text)

 Arguments Definitions
text any text string; must be enclosed in quotation marks
st any positive integer--specifies the start position for n_text (the new text)
num any positive integer--specifies the number of characters to replace
n_text any text string; must be enclosed in quotation marks--specifies the new 

text to insert
Notes and Error Messages

If st is larger than the length of the text, REPLACE appends n_text to text.
If num is 0, REPLACE inserts n_text into text at the place specified by st.
Any argument can be a reference to a cell which contains corresponding values.
If any argument does not conform to its type, REPLACE returns the #BAD DATA! error 
value.

Examples
REPLACE("Corelchart",6,9,"CHART 5.0" = "CorelCHART 5.0"
REPLACE("Coca Cola",1,4,"Hershi") = "Hershi Cola"

Associated Functions
FIND, MID and SEARCH



RIGHT
Description

Computes the number of end characters in a text string, returning the result as text 
Syntax

RIGHT(text, exp)
 Arguments Definitions

text any text string; must be enclosed in quotation marks
exp any non-negative integer--specifies the number of end characters to return

Notes and Error Messages
If exp is greater than the length of text, RIGHT returns all text.
The number of characters returned is never greater than the length of text.
If the first argument is not a text string, RIGHT returns the #BAD DATA! error value.
Any argument can be a reference to a cell containing corresponding values.

Examples
RIGHT("You can do it all with CorelCHART 5.0",9) = "CHART 5.0"
RIGHT(A1, A2) = "PEACE", if A1 contains "GREENPEACE", A2 contains 5
RIGHT("WEATHER",3) = "HER"

Associated Functions
MID and LEFT



ROMAN
Description

Rounds the value to an integer and converts it to a Roman numeral
Syntax

ROMAN(exp)
 Argument

exp any positive real number
Notes and Error Messages

If the argument is negative or non numeric, ROMAN returns the #BAD DATA! error value.
The argument can be a reference to a cell which contains a corresponding value.
The result is returned as text.

Example
ROMAN(12.789) = "XIII"

Associated Functions
FIXED



SEARCH
Description

Result is the position of the substring text1 in the text string text2
Syntax

SEARCH(text1, text2, st)
 Arguments Definitions

text1 any text string; must be enclosed in quotation marks--specifies the text to 
search

text2 any text string; must be enclosed in quotation marks--specifies the text 
string to search

st any positive integer--specifies the start position from the left of search 
within the text

Notes and Error Messages
SEARCH returns 0 if the search is unsuccessful.
If st is greater than the length of the text2, SEARCH returns the #BAD DATA! error value.
SEARCH is neither case-sensitive nor sensitive to diacritical marks used in non-English 
languages.
Any argument can be a reference to a cell which contains corresponding values.

Examples
SEARCH("DRAW 5.0!", "You can do it all with CorelDRAW 5.0!",1) = 29
SEARCH("n","animations",3) = 9
SEARCH("member", "remember",1) = 3
SEARCH("em", "remember",3) = 4

Associated Functions
FIND, MID and REPLACE



SUBST
Description

Searches for the given substring in the text string and replaces it with a new one
Syntax

SUBST(text, old , new)
 Arguments Definitions

text any text string; must be enclosed in quotation marks--specifies the text to 
be searched through

old any text string; must be enclosed in quotation marks--specifies the text to 
replace

new any text string; must be enclosed in quotation marks--specifies the text to 
replace old 

Notes and Error Messages
Any argument can be a reference to a cell which contains corresponding values.
If any argument does not conform to its type, SUBST returns the #BAD DATA! error value.

Examples
SUBST("You can do it all with CorelCHART 4.0!","chart 4.0!","CHART 5.0!") = You can do it 
all with CorelCHART 5.0!
SUBST("Revollution", "voll", "vol") = Revolution

Associated Functions
REPLACE



UPPER
Description

Converts lower-case letters in a text string to upper case
Syntax

UPPER(text)
 Argument

text any text string; must be enclosed in quotation marks
Notes and Error Messages

If the argument is not a text string, UPPER returns the #BAD DATA! error value.
The argument can be a reference to a cell which contains corresponding value.

Example
UPPER("We All Live In ...") = "WE ALL LIVE IN ..."

Associated Functions
LOWER and PROPER



Trim
Definition

Deletes spaces in text strings, leaving only single spaces between words
Syntax

Trim(text)
Notes and Error Messages

If the argument is not a text string, TRIM returns the #BAD DATA! error value.
The argument can be a reference to a cell containing a corresponding value.

Examples
TRIM = ("Profit Per Unit X                Units X          = Total Profit" = Profit Per Unit X Units X=Total
Profit
TRIM = ("... attention    is consistently    paid to ..." = ... attention is consistently paid to

Associated Functions
CLEAN, SEARCH and SUBST



VALUE
Description

Converts a text argument to a number
Syntax

VALUE(text)
 Argument

text any text string; must be enclosed in quotation marks
Notes and Error Messages

If the argument is non-numeric, VALUE returns the #BAD DATA! error value.
The argument can be a reference to a cell which contains a corresponding value.

Examples
VALUE($588.00) = 588
VALUE("12,136.00") = 12,1360.0

Associated Functions
DOLLAR and FIXED






